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Getting Started

This section describes how to get started with Leapfrog Geo. The first three topics describe how
to activate your Leapfrog Geo licence, how to launch Leapfrog Geo and how to run the
graphics test to check the capabilities of your computer’s video card. The next topic, An
Overview of Leapfrog Geo, describes the different parts of the Leapfrog Geomain window.
The final section is an introduction to importantConcepts in Leapfrog Geo.

Licences
To run Leapfrog Geo, you need a licence. There are two types, one that requires a Leapfrog
USB dongle and one that requires the entry of a code.

Dongle Licences
If you have a USB dongle and need to activate your licence, plug the dongle in to your
computer and start Leapfrog Geo. Leapfrog Geowill check the dongle and prompt you to start
the activation process. Follow the instructions that appear on the screen.

If the licence cannot be installed, contact Customer Support as described inGetting Support.

Once the licence has been activated, the licence detailswill be displayed. TheModule Licences
tab showswhether you have licences for any specialist modules.

If you have an OnDemand licence, you will be prompted to check out days. In thewindow that
appears, the bars shows themaximumcheckout period, divided into blocks that each represent
one day. Green blocks are active days remaining on your licence, and blue blocks are days
available for checkout. Click blue blocks to select additional days; the blockswill turn orange to
indicate the additional days you will be checking out.

You may also havemodule licences available, in which case you can click on the button for that
licence and select the required number of days:
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ClickGet Licence to update your licence and check out the days indicated in orange.

Once Leapfrog Geo is running, you can check out additional days by selecting Extend Licence
from the Leapfrog Geomenu or by clicking on the button at the bottomof themain window:

Code Licences
You may have a licence that requires the entry of a code. Start Leapfrog Geo and click Enter
Licence Code in thewindow that appears. Enter the code you have been given and clickGet
Started.

You can copy the licence code from the email or document you received and paste it into
the first Licence Code field.

If the code cannot be validated and you are sure you have entered the code correctly, contact
Customer Support as described inGetting Support.

Module Licences
Some Leapfrog Geo features are only available if you have a licence for a specialist module.
Yourmodule licencemay be activated as part of your Leapfrog Geo licence activation. If,
however, your licence has already been activated and you wish to activate or extend a module
licence, select Install Licence (for a normal licence) or Extend Licence (for an OnDemand
licence) from the Leapfrog Geomenu.

Launching Leapfrog Geo
This topic is divided into:

l Starting a New Project

l Managing Project Files

l Saving Projects

l Saving Zipped Copies of Projects

l Saving Backup Copies of Projects

l Compacting Projects

l Upgrading Projects

l Leapfrog Hydro Projects
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When you launch Leapfrog Geo, themain windowwill appear with the Projects tab displayed:

Thumbnails for themost recent projects are displayed in theRecent projects list. Click on a
thumbnail to open a project.

You can also navigate directly to the required project file by clicking onOpen Project File.

Once a project file has been opened, Leapfrog Geo switches to displaying the Scene View tab.

The second set of thumbnails is for projects contained in the Search folder:

l Click on the folder button ( ) or press the F5 key to change the Search folder. The Search
folder is useful if you have one folder in which you keep most of your Leapfrog Geo projects.

l Click on theRefresh button ( ) or press the F4 key to update the list of projects in the Search
folder.

Starting a New Project
To start a new project, clickNew Project at the top of the Projects tab. The new project will be
saved in the Search folder.

Managing Project Files
Leapfrog Geo project files use the extension .aproj. A folder is also created that contains
information used by the project.

Do not change the name of your project folder or alter its contents. Doing so could render
your project file unusable.
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A .lock file is created when a project is opened. The .lock file protects the project frombeing
moved while the project is open and frombeing opened by another instance of Leapfrog Geo,
which can happen when projects are saved on shared network drives.

If processing and display of objects in your project is too slow and your project is stored on a
network drive or on a USB drive, considermoving your project onto a local drive. Leapfrog
Geo is optimised for working off your local hard drive, and working fromnetwork drives and
USB drives risks corrupting the project.

Saving Projects
Leapfrog Geo automatically saves an open project each time a processing task has been
completed or settings have changed. Projects are also saved when they are closed so that scene
settings can be restored when the project is next opened.

Saving Zipped Copies of Projects
You can save a zipped copy of a project by selecting Save A Zipped Copy from the Leapfrog
Geomenu. You will be prompted to choose a name and location for the zipped project. Click
Save to create the zip file.

Saving Backup Copies of Projects
You can save a backup copy of a project by selecting Save A Copy from the Leapfrog Geo
menu. You will be prompted to choose a new name and location for the saved project. ClickOK
to create the new project file. Leapfrog Geowill save a copy of the project in the location
selected.

Once the backup copy is saved, you can open and use it from the Projects tab. Otherwise,
you can keep working in the original copy of the project.

Compacting Projects
When you delete objects froma project file, Leapfrog Geo retains those objects but notes that
they are no longer used. Over time, the project file will grow in size and data stored in the
databasemay become fragmented.

Compacting a project removes these unused objects and any unused space from the database.
When you compact a project, Leapfrog Geowill close the project and back it up before
compacting it. Depending on the size of the project, compacting it may take several minutes.
Leapfrog Geowill then reopen the project.

To compact a project, selectCompact This Project from the Leapfrog Geomenu. You will be
asked to confirm your choice.
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Upgrading Projects
When you open a project that was last saved in an earlier version of Leapfrog Geo, you may be
prompted to upgrade the project. A list of affected objectswill be displayed. For large projects
with many objects that need to be reprocessed, the upgrade processmay take some time.

It is a good idea to back up the project before opening it. Tick the Back up the project before
upgrading button, then clickUpgrade and Open. Navigate to the folder in which to save the
backup and click Save.

For large projectswith many objects, upgrading without backing up the project is not
recommended.

Leapfrog Hydro Projects
Leapfrog Hydro projects can be converted to Leapfrog Geo projects. However, the process is
one-way, and projects opened in Leapfrog Geo can no longer be opened in Leapfrog Hydro.

When you open a Leapfrog Hydro project, you will be prompted to save a backup before
converting the project:

Once a Leapfrog Hydro project has been converted to Leapfrog Geo, it can no longer be
opened in Leapfrog Hydro. It is strongly recommended that you back up the project before
converting it.
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In the Projects tab, the thumbnails for unconverted Leapfrog Hydro projects in the Search
folder will bemarked as Leapfrog Hydro projects:

The Graphics Test
Leapfrog Geo can run in one of three acceleration modes. Thesemodes are selected by clicking
on the button at the bottomof themain window:

See 3D Acceleration Mode in Settings formore information on these settings.

When you first run Leapfrog Geo, run the graphics test to test the capability of your computer’s
video card.

To start the test, open Leapfrog Geo and select Test Graphics from the Leapfrog Geomenu:
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The graphics test displays a series of image pairs that test the capabilities of your video card for
the currently selected acceleration mode. For each pair, compare the images:

Even if the differences are slight, click the Images Differ button. If the imagesmatch, click the
Images Match button. The next test will be displayed.

At the conclusion of the test, the result is displayed. If one ormore tests have failed, information
about solving problemswill be displayed.

If you click on Save Report, you will be prompted to save the file on your computer.

If the test has failed, try switching to a different acceleration mode and running the test again. If
possible, avoid using Software Rendering as it can be very slow.

If you cannot resolve the problem following the steps described in Video Card Issues, save a
copy of the graphics test report and contact technical support as described inGetting Support.
Be sure to include information about your systemcopied from the About > System Info tab.

Video Card Issues
If the graphics test fails, there are two steps you can take to correct the problem:

l Ensure your video driver is up-to-date. SeeUpdating Your Video Card Driver.

l Check your video card’s 3D/OpenGL settings. SeeChecking Your 3D/OpenGL Settings.
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Updating Your Video Card Driver
The best way to update your video driver is to do this using any tools that your computer’s
manufacturer provides. For example, somemanufacturers allow you to update drivers using a
tool installed in the Start screen (Windows8 or later) or Startmenu (Windows 7). Look for items
that carry themanufacturer’s name. Another option is to right-click on the desktop to see if
there is an update tool available. In the example below, themanufacturer has included an
option for updating video drivers called “NVIDIA Control Panel”:

If your computer appears to have nomanufacturer-installed tools for updating drivers, you can
go to themanufacturer’swebsite and see if updates are available there. Look for parts of the
website relating to support and driver downloads or driver updates.

If your computer’smanufacturer does not provide information to help you update your video
driver, you can run theHardware Update Wizard to see if a newer driver is available. To do this:

1. Open theControl Panel.

2. Open the Systemoption.

3. Switch to theHardware tab (Windows 7, Windows8, Windows8.1, Windows 10).

4. Click on theDevice Manager option.

5. Click to open theDisplay adapters option.
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6. Right-click on the display adapter and choose theUpdate Driver Software option:

Next, follow the steps to complete thewizard. If the wizard cannot update your software
because your computer already has the latest software, it may be that your video driver is
already up-to-date and that the reason the graphics test failsmay lie in the card’s 3D/OpenGL
settings. SeeChecking Your 3D/OpenGL Settings.

If your video card’s driver has been updated, run the graphics test again to see if the computer
passes the tests. If the test still fails, contact technical support as described inGetting Support.
Be sure to include information about your systemcopied from the About > System Info tab.

Checking Your 3D/OpenGL Settings
The step or steps at which your computer fails the graphics test may indicate what 3D/OpenGL
settings need to be changed. Save the graphics test report, as described in The Graphics Test
and contact technical support as described inGetting Support.
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An Overview of Leapfrog Geo
This topic provides an overview of the different parts of the Leapfrog Geomain window. It is
divided into:

l Organising Your Workspace

l Detaching and Minimising the Project Tree

l Organising the Scene View Tab

l Keyboard Shortcuts in the Main Window

If you are new to Leapfrog Geo, it is a good idea to go through the tutorials, which introduce
basic concepts. The tutorials take two to four hours to complete and will get you to the point
where you can start processing your own data.

The Leapfrog Geomain window is divided into threemain parts:

The Project Tree contains all the data in the project and tools for working with that data. When you
want to change how this data is used in the project, work with the objects in the project tree. See
The Project Tree.

The Scene View tab displays a 3D representation of selected objects from the project tree.
Changing how you view objects in the scenewindow does not change those objects in the project
tree. See The 3D Scene.

Tools for changing the appearance of data in the scenewindow are available in the shape list and
the shape properties panel. Changing the appearance of these objects does not change those
objects in the project tree. See Visualising Data.
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You can add objects to the scenewindow by dragging them from the project tree. You can
temporarily hide them in the scene or remove themaltogether using the controls in the shape
list.

When you open a Leapfrog Geo project, the project is displayed in the state it was in when it was
closed.

Organising Your Workspace
You can split the Leapfrog Geomain window into separate parts tomake better use of your
screen space. In addition, some Leapfrog Geowindowsopen in separate tabs that can be used
either docked or detached.

To detach a tab, either:

l Click on it and drag it away from themain window.

l Right-click on it and selectingMove to New Window.

You can then move and resize the detached tab.

To dock a detached tab, click on it and drag it to where you want to dock it:

When the plus sign appears, release themouse and the tab will dock.

Tabs can be docked to themain window or to other tabs. Drag tabs to reorder them.

You can view a list of all open tabs by selecting the down arrow to the right of the processing
queue button:

When you close a project, the position of open tabswill be saved and restored when the project
is next opened.
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Some Leapfrog Geowindowsopen in separate tabs that can be used either docked or
detached. The position in which tabs open is determined by theNew tab position setting in the
Settingswindow:

l Open all tabs in themain window.

l Open all tabs in separate windows.

l Tabs can open where the last tab wasmoved to. This setting can be used for creating a
window in which all tables and dockable windowsopen, with the scenewindow, project tree
and shape list in another window.

To change this setting, click on the Leapfrog Geomenu, select Settings and then click on the
User Interface tab.

Detaching and Minimising the Project Tree
The project tree can also be detached from themain window. To do this, right-click at the top
of the project tree and selectDetach:

To reattach the project tree, click the red X to close the tab. It will reappear docked to themain
window.

You can alsominimise the project tree. To do this, right-click on it and chooseMinimise or press
the F8 key. Restore the project tree by pressing the button:

Pressing the F8 key once again also restores the project tree.
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Organising the Scene View Tab
The Scene View tab ismade up of the scenewindow, the shape list and the shape properties
panel. The shape list and shape properties panel can be displayed on the righthand side of the
scene rather than below the scene. To do this, right-click in the shape list and selectMove List
to Right:

You can also detach the shape list and display it as a tab, which can then be detached from the
main window. To do this, right-click in the shape list and select Put List in Separate Tab:

You can then detach the tab from themain window:

To dock the shape list to the Scene View tab, right-click in the Shape List tab and choosewhere
you wish to dock the list:
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Keyboard Shortcuts in the Main Window
Use the Tab and Shift+Tab keys tomove between the different parts of themain window in the
following order:

l Project tree

l Scene toolbar

l Scenewindow

l Shape list

l Shape properties panel

Key(s) Action

F8
Maximise scene, minimise project tree and shape list. Press F8 again to
restore.

Ctrl+1 Activate the Select tool ( )

Ctrl+2 Activate the Draw slicer line tool ( )

Ctrl+3 Activate the Draw plane line tool ( )

Ctrl+4 Activate the Ruler tool ( )

F10 or Alt L Open the Leapfrog Geomenu

F1 Open Leapfrog Geo help

Ctrl+Q Quit Leapfrog Geo

The Project Tree
This topic provides an introduction toworking with the project tree. It is divided into:

l Project Tree Keyboard Shortcuts

l Restricted Objects

l Subfolders

l Finding Objects

l Deleting Objects

l Renaming Objects

l Copying Objects

l Comments

l Sharing Objects

l Unsharing a Polyline

The series of folders in the project tree are used to organise objects such asmaps, images and
data sets into categories. These folders also provide tools that let you import information into
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the project and generatemodels. Right-click on each folder to view the actions you can
performusing that folder.

You can also right-click on objectswithin the top-level folders to viewmore information on that
object or carry out actions specific to that object. For example, right-clicking on a table of
imported drillhole data reveals a menu showing possible actions:

When a bold option appears in the right-clickmenu, asOpen does in themenu above, that
option can also be selected by double-clicking on the object.

You can select more than one object in the project tree by holding down the Shift key or the Ctrl
keywhile clicking. This is useful for viewing or deleting multiple objects at once.
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Theway folders and objects are organised in the project tree lets you reveal or hide information
about an object to focus on objects you are currentlyworking with. This is also useful when you
are exploring a project and want to determine how something was put together. The arrows
next to objects in the project tree let you reveal or hide an object’s details to focus on objects
you are currentlyworking with. Here, the Topographies folder is expanded to show a
Topography object that ismade up of a mesh:

Themesh itself is stored in theMeshes folder, but is hyperlinked to fromwherever it is used in
the project.

TheDrillhole Data folder and theDrillholes object have been expanded to show the drillhole
data tables. Tables shown in bold are those displayed in the scene.

Folders that have no arrow have no detail stored.
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Expanding a geological model reveals information about how it was built. Here, a geological
model has been expanded to show the basic objects that make up a model:

The five objects underneath the geological model “GM” represent the five basic parts of a
geological model:

l The Boundary object defines the outer limits of the geological model.

l The Fault Systemobject defines faults and their interactions in the geological model.

l The Lithologies object defines the lithologies in themodel.

l The Surface Chronology object defines the structure of themodel’s contact surfaces.

l TheOutput Volumes folder contains the generated units (outputs) that make up the
geological model.

Here, boundary objects for a geological model have been expanded to show how theywere
created:

The Topography object is included as themodel’s upper boundary. The “East boundary” object
was created using a polyline from the Polylines folder and the “West boundary” object was
created using a GIS data object in theGIS Data, Maps and Photos folder. Clicking on the
hyperlinkswill locate the object fromwhich the extent was created.
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Project Tree Keyboard Shortcuts
Keyboard shortcuts for navigating in the project tree are as follows:

Key(s) Action

Up and down arrows Navigate up and down the tree

Right arrow Expand folder/object or go down one level

Left arrow Close folder/object or go up one level

Ctrl+shift+left arrow Close all folders/objects

Shift+right arrow Expand the selected folder/object and any objects in it

Shift+left arrow Close the selected folder/object and any objects in it

Ctrl+A and Ctrl+/ Selects all folders and objects

Ctrl+F Search for objects

Enter The equivalent of double-clicking on an object

Ctrl-X Cut an object or subfolder. Use with Ctrl-V tomove objects and subfolders.

Ctrl-V Paste an object or subfolder

Some actions are not available until data has been imported into the project.

Restricted Objects
Some objectsmay appear in the project tree as restricted:

Restricted objectswere created using features only available in modules. You can display
restricted objects in the scene and change how they are displayed, but you cannot make
changes to the objects themselves. Contact Customer Support as described inGetting Support
formore information about licensing modules.
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Subfolders
In many top-level project tree folders, you can create subfolders that help in organising large
numbers of data objects. For example, here colour gradients have been organised into
subfolders:

To add a subfolder, right-click on a folder in the project tree and selectNew Subfolder. Add
objects to subfolders by dragging and dropping them. You can also useCut (Ctrl-X) and Paste
(Ctrl-V) shortcuts tomove objects and subfolders.

Subfolders can be renamed, moved and deleted, but cannot bemoved to other top-level
folders.

Subfolders have the same right-click commands as their parent folder, which means you can
import or create new data objects inside the subfolder rather than in the parent folder. You can
also add comments to folders to aid in keeping data organised:

You can view all objects in the subfolder by dragging the folder into the scene or by right-
clicking on the subfolder and selecting View All.
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When lists of objects are displayed, the subfolder organisation will be reflected in the list. For
example, when creating an interpolant, the list of data objects that can be interpolated is
displayed organised by subfolder:

Subfolders cannot be created in theDrillhole Data folder, although they can be created in the
Composites and Planned Drillholes folders.

Finding Objects
To find objects in the project tree, click the search button at the top of the project tree:

You can also click anywhere in the project tree and type “Ctrl-F”.

The Findwindowwill be displayed:

Enter the information you are searching for, then clickBackwards or Forwards to locate the
object in the project tree.

Deleting Objects
When you delete an object from the project tree, a windowwill be displayed listing all other
objects in the project that will also be deleted and those that will be reprocessed. Some objects
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will be put into an error state; you will need to correct those errors before the affected object
can be used elsewhere in the project.

Consider carefully the effects on other objects in the project, as once an object is deleted, it
cannot be recovered.

Deleting data from the project may cause other objects to be reprocessed, which can take some
time.

To deletemore than one object from the tree, hold down the Shift key or the Ctrl keywhile
selecting objects.

Renaming Objects
When an object is created in Leapfrog Geo, it is given a default name. It is a good idea to give
objects in Leapfrog Geo names that will help you distinguish them fromother objects, as large
projectswith complicated modelswill contain many objects.

To rename an object in the project tree right-click on the object and select Rename. The
Rename Objectwindowwill be displayed:

Enter a new name for the object. ClickRename to change the object’s name.

Copying Objects
Many objects in the project tree can be copied. Right-click on an object and selectCopy. You
will be prompted to enter a name for the object’s copy.

The copied object is not linked to the original object. However, if the original object is linked to
other objects in the project, the copywill also be linked to those objects.

Comments
Another aid to documenting work in a project is comments.
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You can record comments on many objects in the project tree, including subfolders. This can be
helpful when the project containsmany objects and when several different people are working
on a model. Objects that have comments are indicated in the project tree by a comment
balloon ( ). The comment will be displayed when you right-click on the object:

Tab or click to add a new comment or edit an existing one. You can also add standard
information to a comment, such as date and time.

You can add information about the project as a whole using theNotes object ( ), which is the
last object in the project tree. Double-click on theNotes object to open it and add information.

Sharing Objects
Some objects are created as part of working with other objects and are not available elsewhere
in the project. An example of this is a polyline drawn as part of creating a geological model
boundary. To share such objectswithin the project, right-click on the object in the project tree
and click Share. The shared object will be copied to the relevant location in the project tree and
a hyperlink added to the object it was shared from.

For example, here a polyline created as part of a lateral extent is shared:

The polyline is saved to the Polylines folder and a hyperlink to it appears as part of the
geological model’s boundary. Whenever the polyline is updated, changeswill bemade
wherever it is shared in the project.
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Unsharing a Polyline
Polylines that have been shared can be unshared bymaking a local copy of the polyline. To do
this, right-click on the shared polyline and selectCreate Local Copy:

The polyline in the Polylines folder remains, but a local copy of it ismade and the hyperlink to
the Polylines folder copy is deleted. Thismeans you can nowwork on, for example, the
Polylines folder copywithout changes to it affecting the geological model’s copy.

Processing Tasks
The processing queue button showshowmany tasks are currently being processed:

Objectswill be added to the processing queuewhen you make changes to themvia the project
tree.

l To view the queue and progress on processing, click the queue button or press Alt + P.

l To pause processing, pressCtrl + P. To resume processing, pressCtrl + P again.

The button will turn greywhen all processing is complete.

You can close a project while is still running tasks. When you next open the project, the
remainder of the tasks in the processing queuewill be processed.
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Prioritising Tasks

Tasks can be prioritised and their inputs processed before other objects. To prioritise a task,
right-click on an object in the project tree and select Prioritise. Prioritised tasks aremarked in
the project tree with an arrow:

Prioritising an object is useful when you are editing it and wish to view the effect of changes
without reprocessing all objects in the project. For example, you may bemodifying a
boundary or contact surface for a geological model. You can prioritise the surface, then run
it each time you make changes.

To run only prioritised tasks, click the processing queue button, then clickPriority Only:

The processing queue button will change to show that only priority taskswill be run:

The number of objects that have been prioritised is indicated by the button at the top of the
project tree ( ). To view prioritised tasks, click the button. All prioritised objectswill be selected
and displayed in the project tree.

To reset a priority object, right-click on it and selectClear Priority.

Click the processing queue button, then clickRun All to resume normal processing.
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Correcting Errors

If processing of an object fails, all other objects dependent on that object will also fail. Click the
processing queue button to view the errors. To inspect the source of error, right-click on the
object in the task queue and selectGo to Project Tree > Show Error:

The object’sPropertieswindowwill be opened with the Errors tab displayed. The information
in this tab may be helpful in fixing the error.

Object Properties
You can view the properties of most objects imported into or created in Leapfrog Geo. To do
this, right-click on the object in the project tree and select Properties.

The information available in the Propertieswindow dependson the type of object. There are
two tabs that appear for each type of object:

l The Processing tab shows the current status of the processing (queued to process,
processing, finished).

l The Errors tab shows errors that have occurred while processing the object. See Processing
Tasks.

Many objects also have a General tab that summarises information about the object. The
amount of information in theGeneral tab will vary according to the type of object. For example,
for table objects, theGeneral tab shows the table’s data structure.

AHistogram tab is included in the Propertieswindow for some objects. See Statistics formore
information.

The 3D Scene
This topic describes how to interact with the 3D scene. It is divided into:

l Navigation

l Locating an Object from the Scene

l Clicking in the Scene

l Clicking in the Shape List

l Slicing Through the Data

l Measuring in the Scene

l Determining a Location

l The Moving Plane
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l The Ruler

For information on how to display objects in the scene, see Visualising Data.

Navigation
The best way to navigate the 3D scene in Leapfrog Geo is using themouse. If you are running
Leapfrog Geo on a laptop, it is recommended that you plug in a mouse rather than using the
laptop’s touchpad for navigation. However, you can also navigate in the scene using the
keyboard.

Action Mouse Keyboard

Changing the
viewing angle

Click and drag to rotate the
scene

Press the arrow keys to rotate the scene

For smaller steps, hold down the Shift key while
pressing the arrow keys

Zooming in and out
of the scene

Use the scroll wheel

Hold the right mouse button
while moving the mouse

Press the Page Up or Page Down keys

For smaller steps, hold down the Shift key while
pressing the Page Up or Page Down keys

Panning the scene
Click and hold both mouse
buttons, then drag

Hold the scroll wheel and drag

Hold down the Alt key while pressing the arrow keys

Centre an object in
the scene

Click the scroll wheel

Click both mouse buttons
together

Use the Lookmenu above the scenewindow to switch to different viewing angles:
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If you prefer to navigate using the keyboard, use the following keyboard shortcuts:

Key(s) Action

Arrow keys Rotate the scene in 10 degree steps

Shift+Arrow keys Rotate the scene in 2 degree steps

Home Reset the view, showing all visible objects in scene

U, D, E, W, N, S Look Up, Down, East, West, North and South

L Look at the slicing plane

Shift+L Look at the back of the slicing plane

M Look at the moving plane

Shift+M Look at the back of the moving plane

Ctrl+M Look down the moving plane pitch

Shift+Ctrl+M Look up the moving plane pitch

P Select Perspective view

O Select Orthographic view

Ctrl+Delete Clear the scene

Ctrl+B Bookmark the viewing angle and zoom

B Display the bookmarked viewing angle and zoom

Ctrl+’ Save the scene

Ctrl+C
Copies the scene to the clipboard. The image can then be pasted into
another application, such as an image editor.

Ctrl+/ Add the slicer to the scene. Press Ctrl+/ to remove the slicer from the scene.

Ctrl+;
Add the moving plane to the scene. Press Ctrl+; to remove the moving plane
from the scene.

The current viewing angle and scale are displayed in the lower righthand corner of the scene
window:
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You can change how the viewing angle and scale are displayed in theOverlays tab of the
Settingswindow.

You can save the current viewing angle as a bookmark by selecting Bookmark Viewing Angle
from the Lookmenu or by pressing Ctrl+B. Restore the bookmark by selecting Look > Restore
Bookmark or by pressing B.

Only one viewing angle bookmark can be saved. The bookmark is not saved when Leapfrog
Geo is shut down.

The scenewindow displays a 3D representation of selected data from the project tree. You can
add objects from the project tree to the scene in twoways:

l Click on the object and drag it into the scene. Hold down the Shift key or the Ctrl keywhile
clicking to select multiple items, then add them to the scene.

l Right-click on the object and tick the View Object box.

Dragging objects into the scenewindowmay be blocked by other applications on your
computer. For example, if you are sharing a screen using Skype, you will not be able to drag
objects into the scene.

Once you have added objects to the scenewindow, you can change the appearance of those
objects using the controls in the shape list and the shape properties panel.

Changing how you view objects in the scenewindow does not change those objects in the
project tree.

Visualising Data describes in detail how to change the visualisation of data in the scene, which
is an important part of interpreting data in the project and making modelling decisions.
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Locating an Object from the Scene
When you have a number of objects displayed in the scene, it may not be readily apparent
where you can find more information about those objects. Leapfrog Geo helps you find the
object in the project tree and the shape list in twoways, byClicking in the Scene and by
Clicking in the Shape List.

Clicking in the Scene

Clicking on an object in the scene displays a window that contains a summary of the data and,
formany objects, a link to the corresponding data in the project tree. For example, here drillhole
data is displayed in the scene and clicking on a segment displays the corresponding data:

Note that clicking on an object in the scene also selects it in the shape list.
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Clicking in the Shape List

When you have objects displayed in the shape list and want to locate them in the project tree,
simply right-click on the object in the shape list and selectGo to Project Tree:

The object’s location in the project tree will be expanded and the object will be selected.

Slicing Through the Data
The slicer is a powerful tool for revealing data that is concealed behind other objects and for
emphasising data. Slicing can be considered a formof dynamic sectioning. Two buttons in the
toolbar can be used to add the slicer to the scene:

You can add the slicer to the scene by clicking the Show slicer button ( ). The slicer will appear
in the scene and you can adjust its position using the controls in the shape list:

You can also click theDraw slicer line button ( ), then click and drag in the scene to cut a slice
through the scene.

The scenemay appear empty because the slicer has removed all visible data. Reposition the

© 2017 ARANZ Geo Limited



Slicing Through the Data | 31

slicer or turn it off.

You can change theway the slice appears in the scene using the controls in the shape list, and
finer controls are available in the shape properties panel:

Right-click on the slicer in the shape list to viewmore information about each option:

The Lock to Camera ( ) option locks the slice to the current view so that moving the scene
changes the direction of the slice.

These options can also be controlled from the Lookmenu:

The Set to list in the shape properties panel contains standard views, together with any sections
displayed in the scene:
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Tomove the slicing plane in a direction orthogonal to the slicing plane, hold down the Ctrl key
and the right mouse button while dragging themouse.

To change the thickness of a thick slice, hold down the Ctrl key and themiddlemouse button
while dragging themouse. If you have a two-button mouse, hold both buttons.

Use the following keyboard shortcuts to control the slicer:

Key(s) Action

Ctrl+/ Add the slicer to the scene. Press Ctrl+/ to remove the slicer from the scene.

L Look at the slicing plane

Shift+L Look at the back of the slicing plane

T Thick slice ( )

F Remove front ( )

K Remove back ( )

Ctrl+V Orient the slicer to the current view

Ctrl+E Slice the east (X) axis ( )

Ctrl+N Slice the north (Y) axis ( )

Ctrl+D Slice the elevation (Z) axis ( )

Ctrl+L Lock the slicer to the camera ( )

C Centre the slicer in the scene

Ctrl+right mouse button Move the slicer forward and backward in the scene

Ctrl+middle (or left+right) mouse
button

Change the slice width

, (comma) Step the slicer forward

. (full stop) Step the slicer backward

L and Shift+L Look orthogonally at the slicer plane

Measuring in the Scene
Leapfrog Geo has a number of tools formaking quantitativemeasurements in the scene. These
include:

l Clicking on an object in the scene. Thiswill open a window containing more information
about the object.

l Viewing an object’s properties to determine its size. Right-click on the object in the project
tree and select Properties. Information on the size of the object will be displayed in the
General tab.

l Using the cursor to determine an approximate location in the scene. SeeDetermining a
Location.
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l Using themoving plane tomeasure trends. See The Moving Plane.

l Using the ruler tomeasure in the scene. See The Ruler.

Determining a Location

The simplest way of measuring an approximate location in the scene is to first display an object
in the scenewindow, then position the cursor over the location. The position of the cursor is
displayed at the bottomof the Leapfrog Geowindow:

The position of the cursor in the scene is calculated using the depth buffer on the graphics card
and so is not an exact method of measuring in the scene.

If you require an exact position, click on the object. Leapfrog Geowill compute the exact
position and display it in a pop-up window:

The point selected is highlighted in the scene.
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The Moving Plane

In Leapfrog Geo, themoving plane is used formeasuring planar structures and defining
coordinate systemorientations. There are two tools in the toolbar that relate to themoving
plane:

To use themoving plane, click the Show plane button ( ) and position the plane in the scene.
Themain axis of themoving plane is defined by the green line. The second axis is defined to be
in the plane at right angles (orthogonal) to themain axis. Third axis is perpendicular to the
plane.

There are threeways to position the plane. You can:

l Use the handles in the scenewindow tomove the plane. If you cannot see the handles, click
on themoving plane.

l Use the Plane controls in the shape properties panel to change theDip, Dip Azimuth, Pitch
and Centre Point.

l Orient the scene to look parallel to the required plane position, then click on theDraw plane
line button ( ). Draw the required line in the scene.

Planemovement can be aligned to the Axes or to theCamera:

l With the Axes option, the handlesmove in cartesian coordinates. This is the only option
available in older versions of Leapfrog Geo.

l With theCamera option, the handlesmove relative to the camera angle. This is theway the
moving plane handlesworked in Leapfrog Mining.

Drawing the plane line is usually themost convenient method of defining a planar structure.
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To remove themoving plane from the scene:

l Click the Show plane button ( ).

l In the shape list, click the delete button ( ) for themoving plane.

Use the following keyboard shortcuts to control themoving plane:

Key(s) Action

Ctrl+;
Add the moving plane to the scene. Press Ctrl+; to remove the moving plane
from the scene.

M Look at the moving plane

Shift+M Look at the back of the moving plane

Ctrl+M Look down the moving plane pitch

Shift+Ctrl+M Look up the moving plane pitch

The Ruler

You can use the ruler tomeasure distances in three dimensional space and between drillholes
and planned drillholes.

The easiest way to use the ruler is to click on theRuler button ( ) and click and drag between
points in the scene to start making measurements. A ruler line will appear in the scene to
indicate themeasurement. Information about the distancemeasured will appear in the scene
and in the shape properties panel:

The ruler tool stays active in the scene so you can make asmanymeasurements as required.
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You can alsomeasure the distance between drillholes or between drillholes and a point. To do
this, click on theCalculate Distance button in the shape properties panel. TheDistance
Calculatorwindowwill appear:

You can select both drillholes and planned drillholes. ClickCalculate to calculate the distance
and update the ruler in the scene. The distance valuewill appear in theDistance Calculator
window.

You can also select a point in the scene by clicking the Select button ( ) in theDistance
Calculatorwindow, then clicking in the scene. The location of the point in the scenewill
appear in theDistance Calculatorwindow.

Aftermeasuring a distance, it is a good idea to change the viewing angle to confirm that the
measurement has been made between the correct points in three dimensions.

There are twoways to remove the ruler from the scene:

l Click the Select button ( ).

l Click the delete button ( ) for the ruler object in the shape list.
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Drawing in the Scene
In Leapfrog Geo, you can draw polylines to definemany surfaces, including lateral extents and
contact surfaces. You can also use polylines tomake adjustments to surfaces and create new
GIS lines.

This topic describes drawing polylines in Leapfrog Geo. It is divided into:

l The Drawing Toolbar

l Drawing Hotkeys

l Drawing 3D Lines

l Drawing 2D Lines

l Polyline Properties

l Tangents and Ribbons

l Drawing Points

l Editing Normals

For information on importing and exporting polylines, see Polylines.

When drawing in Leapfrog Geo, you can draw on surfaces or on the slicer.

l If you are drawing on surfaces, the line will be in 3D.

l If you are drawing on the slicer, the line will be in 2D and locked to the plane it was drawn in.
It can be converted to a 3D line.

When you start drawing a polyline, drawing tools are added to the scenewindow. If you are
drawing a GIS line or if the slicer was already in the scene, the drawing modewill be set to be on
the slicer.

Toggle between the two options using the toolbar buttons:
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When drawing and otherwise working with the polyline, tooltips are displayed in the scene that
showwhat actions are currently possible:

For example, if the drawing mode is set to on slicer ( ), you will be warned if the slicer is not in
the scene:

You can disable these tooltips once you aremore familiar with how the polyline tool works.
Open the Settingswindow by clicking on the Leapfrog Geomenu and selecting Settings.
Click onOverlays and disable the Polyline help text option.

The Drawing Toolbar
TheDraw lines( ) and Draw points( ) tools are used to create new lines and points. The tools
in the second row are for controlling whether the polyline is drawn (on the slicer ( ) or on
surfaces ( )). The Select list lets you select different parts of the polyline.

The other tools are for working with selected parts of the polyline:

l Making line segments straight ( ) or curved ( )

l Adding nodes ( ) to lines

l Adding tangents to lines or reorienting selected tangents ( )

l Flipping selected tangents and disks ( )

l Add disks to points ( )

l Converting a 2D polyline to 3D ( )

l Setting the slicer to a 2D polyline ( )
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There are also buttons for undoing ( ) and redoing actions ( ), aswell as saving the polyline ( )
or deleting selected parts of it ( ).

Drawing Hotkeys
Use the following keyboard shortcutswhile drawing:

Key(s) Action

Ctrl+5 Draw lines ( )

Ctrl+6 Draw points/disks ( )

Ctrl+S Save ( )

Ctrl+W Close editor ( )

Ctrl+Z Undo ( )

Ctrl+Y Redo ( )

Delete Delete the selected segment, node, tangent or disk ( )

X Draw/move on slicer ( )

Shift+X Draw/move on objects ( )

Q Make segments curved ( )

Shift+Q Make segments straight ( )

Shift-A Add node ( )

A Add/reorient tangent ( )

V Flip tangent/disks ( )

Shift+D Add/remove disk ( )

Shift+E Make selected line 3D ( )

Shift+W Set slicer to selected 2D line ( )

Ctrl+A Select all

Shift+Ctrl+Alt+L Select all lines

Shift+Ctrl+Alt+T Select all tangents

Shift+Ctrl+Alt+P Select all points without disks

Shift+Ctrl+Alt+D Select all points with disks
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Drawing 3D Lines
Polylines aremade up of nodes, which are added where you click in the scene using theDraw
lines( ) tool. This is a 3D polyline, which is indicated in the scene by the dashed line:

Click to select a node and drag tomove it in the scene parallel to the screen. If you hold down
the Ctrl keywhilemoving the node, it will snap onto surfaces in the scene.

When drillhole segments are in the scene, the polyline tool will snap to the end of nearby
intervals.

When you click to add a node, dragging themouse before releasing the button lets you control
the curvature:

When you start drawing a polyline, a tangent is automatically added to the first node. This is
oriented in the direction of the camera, and you will need to rotate the scene to see that it is a
cone.
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There are also bezier control points for curved segments. Bezier control points are, used to
control the curvature of the segment. Click on a control point and drag it to change the curve
of the segment:

When you have finished drawing, right-click to end the polyline. Switch to the Select tool ( ) to
make changes to the polyline.

l Click on a node tomove it.

l Click on a segment away froma node and drag it to change its curvature.

l Click on one ormore segments, then make themstraight ( ) or curved ( ).

l Select a point on the polyline, then click ( ) to add a node.

l Select a point on the polyline. The point selected is indicated in the scene by a red cone. Click (
) to add a tangent oriented in the direction of the camera.

l Select a tangent and click ( ) to change the orientation of the segment to that of the
camera.

l Select a tangent and click ( ) to flip it.

Begin drawing again by selecting theDraw lines button ( ). To continue froman existing node
at the start or end of a polyline, click on the node.

Although you can make the line curved while adding nodes, an easyway to draw a curved
polyline is to simply click to add a series of points. Set the curvature of thewhole line by
selecting all segments and then clicking theMake selected segments curved button ( ):
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You can then make any adjustments to the curves required by dragging the segments or using
the bezier control points.

Drawing 2D Lines
Working with a 2D polyline is similar to working with a 3D polyline, except that drawing is
restricted to the 2D plane set by the slicer.

In this scene, a 2D polyline is indicated by an unbroken line:

To convert a 2D polyline into a 3D polyline, click the 3D polyline button ( ).

Polyline Properties
In the shape list, you can control the colour of the positive (red) and negative (blue) surfaces of
the line and of the line itself (green):

For contact surfaces, the colour of the positive and negative sides of a ribbon will be
determined by the lithologies or categories assigned to either side of the surface.

With theNode size and Point size controls in the properties panel, you can change the size of
nodes and points in the scene tomakeworking with the polyline easier.

Tangents and Ribbons
The Surface ribbon( ) and Normal ribbon( ) help you to determine the orientation of the
polyline in the scene. The surface ribbon reflects the orientation of the polyline and normal
ribbon is perpendicular to the surface ribbon.
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For example, click on the Surface ribbon button ( ) to determinewhich side of the polyline is
positive (red) and which side is negative (blue):

If you are having trouble seeing the ribbons, you can change their size using theRibbon width
control in the properties panel.

When you first draw a polyline, it has only one tangent, located at the first node and oriented in
the direction of the camera. You can add more nodes by clicking at a point along the polyline
and then clicking the Tangent button ( ). A tangent is added to the polyline, which is updated
to reflect the new information. The tangent’s orientation is taken from the camera angle. To
reorient a tangent, click on it in the scene, change the camera angle to reflect the orientation
you wish to set, then click the Tangent button ( ).

You can also flip selected tangents by clicking on the Flip tangents and disks button ( ).

You can add asmany tangents as required, although it is best to keep them to a minimum.

Drawing Points
Polylines can also include points, which are drawn using theDraw points tool ( ). Clicking
adds a point, and clicking and dragging adds a point with a normal:

Normals are shown in the scene as disks intersecting the points.
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The scene below showsone point with a normal and onewithout:

Tomove a point without a normal, switch to the Select tool ( ). Click on the point and drag it.
To add a normal to the point, click on it in the scene and click the Add disk button ( ).

Editing Normals
To edit the orientation of a point with a normal, click on it in the scene. There are two rotation
modes. In the first, the handles adjust the dip and azimuth of the disk:

Click on the disk to change the rotation mode.

In the second rotation mode, dragging the disk rotates it in the plane indicated by the handles:

Change the angle of the plane bymoving themouse cursor over the disk.
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You can also change the orientation of a disk by drawing over it. To do this, make sure theDraw
points tool ( ) is selected. Hold the cursor over the point you want to edit. The cursor will turn
green to indicate that you can adjust the disk’s angle:

Drag to adjust the angle and release themouse button when finished:

You can also flip selected disks by clicking on the Flip tangents and disks button ( ).

Open Mining Format (OMF) Export and Import
Open Mining Format is a convenient format for exchanging data with other applications
becausemultiple geosciences objects can bemoved as a single file. Leapfrog Geo supports the
export and import of Open Mining Format v0.9.

OMF export and import are available from the Leapfrog Geomenu:
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OMF Export
To export surfaces froma project in OMF format, click on the Leapfrog Geomenu and select
OMF > Export. A list of objects in the project will be displayed:
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Select the objects you wish to export, then specify the file name and the folder where it will be
saved. ClickOK to export the file.

Exporting the filemay take some time if you have selected a large number of objects.

OMF Import
To import surfaces in OMF format, click on the Leapfrog Geomenu and selectOMF > Import.
In thewindow that appears, select the file you wish to import and clickOpen. The objects in the
file will be displayed:

Select the objects you wish to import and clickOK. Selected objectswill be imported and added
to the project tree. GIS data will be added to theGIS Data, Maps and Photos folder and points,
meshes and blockmodelswill be added to their respective folders.
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Settings
Open the Settingswindow by clicking on the Leapfrog Geomenu and selecting Settings:

The settings available in thiswindow are described below:

l Display and Navigation Settings

l 3D Acceleration Mode

l Font Size

l Z Axis Scale

l Rotation Settings

l Camera Settings

l Overlay Settings

l Screen Grid Settings

l Axis Lines Settings

l Other Overlay Settings

l Colour Scheme

l Lighting Settings

l Processing Settings

l User Interface Settings

l Leapfrog Central Settings

l Help Settings

To close the Settingswindow and leave settings unchanged, click theRevert button, then click
Close.

Display and Navigation Settings
In the Settingswindow, click on Scene to change scene display and navigation settings.
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3D Acceleration Mode

Leapfrog Geo can run in one of three acceleration modes. Click the Acceleration mode button
in the Settings > Scenewindow to use a different mode. Themodes available are:

l Software Rendering uses software only, formaximumcompatibility with any hardware. This
option can be very slow displaying all but the simplest scenes, and is provided as a fall-back if
display issues cannot be resolved with either of the other two options.

l Partial Acceleration uses hardware acceleration that has been provided on graphics cards
formany generations of graphics cards. In thismode, Leapfrog Geo renders scenes using
“fixed function pipeline” hardware acceleration features that have been superseded in
modern graphics cards by programmable shaders, but this legacy capability iswidely
supported and offers performance advantages over software rendering. Using Partial
Acceleration can sometimes fix anomalies or problems encountered in Full Acceleration
mode that may be due to bugs in old drivers, and it should workwith even old or lower-
featured hardware.

l Full Acceleration is the best option, assuming you have good hardware and up-to-date
drivers. Because it makes use of programmable shaders provided bymodern graphics cards, it
is the fastest of the threemodes and uses your available graphicsmemorymore efficiently. It
is themode you should use, if your system supports it.

First, try using Full Acceleration and see how it renders scenes. If you seem to be having issues
with how data is displayed in the scene, see The Graphics Test for information on testing your
computer’s graphics capabilities. Note that especially when graphics cards are new on the
market, theremay be a number of driver versions released to address anomalies, so the use of a
recent driver version is important. If using a laptop with dual graphics cards, use it with the
power supply connected, and select the Performance Graphics option over the Power Saving
option.

If that doesn’t resolve the graphics problems, then tryPartial Accelerationmode. If possible,
avoid using Software Rendering as it can be very slow.

If your current hardware is unable to support Full Accelerationmode, it may beworth
considering upgrading your graphics card. Medium- to high-end home PC and gaming
graphics cards are sufficient. High-end workstation grade cards alsowork verywell, but you will
also be paying for further capabilities that are not utilised by Leapfrog Geo.

The acceleration mode can also be changed by clicking the button at the bottomof the
Leapfrog Geomain window:

Font Size

This setting is the size of text used to display information on the grid and axes.
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Z Axis Scale

The Z-axis scale setting lets you set a value greater than 1.0 for the z-axis relative to the x- and
y-axes. This is useful when the area under study is very planar and extends over a wide area. In
such cases, scaling the z-axis can accentuate the distribution of data along the z-axis. If you
have a project open when you change this setting, the changewill be reflected in the scene so
you can experiment with different values before choosing the one that best accentuates the
distribution of data.

The z-axis setting can also be changed by clicking the Z-Scale button at the bottomof the
Leapfrog Geomain window:

The Scale Z Axiswindowwill appear:

Note that each project saves the z-axis scaling setting when the project is closed. In addition,
when saving scenes (see Saved Scenes), the z-axis scale is saved as part of the scene.

Rotation Settings

TheGeographic rotation and Free rotation settings determinewhether or not themodel
displayed in the scenewindow can be “rolled”. With theGeographic rotation option, the
azimuth and elevation can be varied, but the Z axis is constrained to be vertical. With the Free
rotation option, however, the rotation of themodel is not fixed to any axis and themodel can
be freely rolled around any axis. Select the option you prefer. When Leapfrog Geo is installed,
Geographic rotation is set as the default option as it is themost commonly used.

TheRotate with left button and Rotate with right button settings determine how themouse
is used to rotate the scene:

l When Rotate with left button is selected, you can rotate the scene by holding down the left
mouse button and dragging in the scene. Clicking and holding the right mouse button
zooms in and out of the scene.

l When Rotate with right button is selected, holding down the right mouse button and
dragging rotates the scene. However, zooming and rotating functions are not swapped.
Instead, the left mouse button can only be used for clicking on different objects in the scene.
Select this option if you tend to accidentallymove the scenewhen you intend to click.
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Camera Settings

TheOrthographic projection and Perspective projection settings determine the view of the
model in the scenewindow.

If Perspective projection is selected, you can change the Perspective angle using the slider.
This is similar to adjusting the zoomsetting on a camera. Higher anglesmake nearby objects
larger and more distant objects smaller. Lower angleswill compress the scene. Experiment with
the settings to see the effect on objects in the scene.

Select the option you prefer.

Overlay Settings
In the Settingswindow, click on Scene > Overlays to changewhat objects are included in the
scene.

Changes you make to these settings are automatically updated in the scene so you can easily
experiment to seewhat overlays you prefer.

Select Revert to return to the settings in placewhen the Settingswindowwas first opened.

Screen Grid Settings

The Show screen grid setting determineswhether or not the screen grid is displayed. Select the
option you prefer. The Loose Spacing, Normal Spacing and Fine Spacing options determine
the spacing of the grid.

Axis Lines Settings

The Axis Lines settings determine how X-Y-Z coordinates are displayed in the scene. When axis
lines are enabled, the axes indicate the extent of data currently displayed in the scene.

l Enable Show axis lines to display the east (red), north (green) and elevation (blue) axis lines.

l Enable Put numbers on axes to display scale ticks along the grid. These are automatically
adjusted to fit the extent of the data and the current zoomsetting.

l Enable Show whole box to display the axis lines as a box that encloses the current data set.

Other Overlay Settings

The scale bar, compass ball and viewing angle text are the navigation aids in the lower
righthand corner of the scenewindow.

When the slicer is in the scene, text describing its position will be displayed in the lower lefthand
corner if the Slicer position text option is enabled.

When drawing polylines, tooltips are displayed. If you do not wish to view these tooltips, untick
the box for Polyline help text.
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Colour Scheme
In the Settingswindow, click on Scene > Colour Scheme to change the colour scheme used in
the scene.

Leapfrog Geo is installed with three colours schemes:Default, Black Background andWhite
Background. The scheme selected in the Schemes list will be used for all new Leapfrog Geo
projects and for existing projectswhen they are next opened.

l Experiment with the settings to see how they affect the scenewindow. The scenewill be
updated as you make changes.

l Select Revert to return to the settings in placewhen the Settingswindowwas first opened.

l To create a new scheme, click on an existing scheme. This is the scheme that will be used as a
basis for defining the new scheme. Next, click theNew Scheme button and change its
settings.

l Click Factory Reset to revert to the colour schemesdefined when Leapfrog Geowas first
installed.

Clicking on Factory Reset to revert to the original colour schemesdeletes any custom
colour schemes.

Lighting Settings
In the Settingswindow, click on Scene > Lighting to change how visual effects are displayed in
the scenewindow. You may be able to use these settings to emphasise significance in the data
displayed in the scene.

l The Ambient level setting determines the overall brightness of the scene.

l The Specular brightness and Specular shininess settings determine how light appears to fall
on the surfaces in the scene. The Specular brightness setting has a stronger effect when
Specular shininess is soft.

You can have up to four light sources defined for a project. By default, two light sources are
defined.

Changesmade to these settings are automatically applied to the scene.

l ClickRevert to return to the settings in placewhen the Settingswindowwas first opened.

l Click Factory Reset to revert to the lighting sources and settings defined when Leapfrog Geo
was first installed.

Processing Settings
In the Settingswindow, click on Scene > Processing to change how background processing is
used to run changes to data and models.

l For the Automatic option, the number of background processeswill be set based on your
computer’s CPU and RAM.
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l For theDisabled option, taskswill be run in themain process and no background processes
will be used.

Select Revert to return to the settings in placewhen the Settingswindowwas first opened.

User Interface Settings
In the Settingswindow, click on User Interface to change project tree and scene toolbar
options.

Show Tree Lines

Ticking the box for Show Tree Lines displays objects in the project tree with lines:

Enable this option if you find it useful for displaying relationships between objects in the project
tree.

Show Save Scene Button

Ticking the box for Show Save Scene toolbar adds an extra button to the scene toolbar:

Click this button to save the current scene.

You can also change the scene toolbar by right-clicking on it and selecting Customise.

Tab Position

Some Leapfrog Geowindowsopen in separate tabs that can be used either docked or
detached. The position in which tabs open is determined by theNew tab position setting:

l Open all tabs in themain window.

l Open all tabs in separate windows.

l Tabs can open where the last tab wasmoved to. This setting can be used for creating a
window in which all tables and dockable windowsopen, with the scenewindow, project tree
and shape list in another window.
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Leapfrog Central Settings
See Enabling Leapfrog Central formore information on the settings in thiswindow.

Help Settings
If you are working on a slow connection, you can download a copy of the help that can be
saved to your hard drive. To do this:

l Visit Leapfrog Geo Downloads.

l Once you have downloaded a copy of the help and installed it, select Settings from the
Leapfrog Geomenu.

l Click on theHelp tab and then select Local folder.

Leapfrog Geo help is updated at each release. If you are using a downloaded copy, you will
need to download a new copy each time you update Leapfrog Geo.
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Reporting a Problem
If Leapfrog Geo encounters an error, the Leapfrog Geo Problemwindowwill be displayed.
Enter asmuch information as you can about the problem, then click Send.

Getting Support
Technical support is available by visiting http://www.leapfrog3d.com/contact/support.

When contacting technical support, please include your licence number and a full description
of the problemor query, including any information provided in systemerrormessages.

You can access your licence information by selecting About from the Leapfrog Geomenu:

You may also be asked to provide a copy of the log files. To find out where these are stored,
select About from the Leapfrog Geomenu, then click on the System Info. tab. Click on the link
to open the folder that contains the log files:
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Leapfrog Central Integration
The Leapfrog Central platform is a model management system. Leapfrog Central’s integration
with Leapfrog Geo lets you work in different project revisions, publish models to the server, view
documents and annotations and make your own annotations. The Leapfrog Browser displays
the project history so you can navigate through revisions and branches, exploremodels, view
documents and annotations and make your own annotations.

Projects shared within Leapfrog Central can be downloaded and worked on locally in Leapfrog
Geo. When you have finished working on a project, select the objects you wish to publish to
Leapfrog Central and add notes about the revision. New projects can be added to Leapfrog
Central by building them fromscratch or by uploading an existing project.

This topic describes how to set up and workwith Leapfrog Central fromwithin Leapfrog Geo. It
is divided into:

l Enabling Leapfrog Central

l Setting Up the Connection

l Connecting to Leapfrog Central

l Viewing a Project’s History

l Locking Branches

l Project Included

l Project Stages

l Annotations and Attachments

l Downloading a Local Copy of a Project

l Publishing to Leapfrog Central

l Selecting Objects

l Setting the Project Workflow Stage

l Including the Project

l Adding Revision Information

l Preparing the Package

l New Leapfrog Central Projects

l Creating a New Leapfrog Central Project

l Adding a Project to Leapfrog Central

l Disconnecting a Project from Leapfrog Central

To learn more about Leapfrog Central, see the Leapfrog Central help.

Enabling Leapfrog Central
To enable Leapfrog Central, open the Settingswindow by clicking on the Leapfrog Geomenu.
Select Leapfrog Central and tick the box to enable Leapfrog Central. ACentral Projects tab
will appear in themain window.
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When you connect to Leapfrog Central, you can download projects and work on them locally.
To change the location where projects are saved, click theChange button under Project
Management and navigate towhere you want to save projects:

TheConnection settings determine the timeout settings for connection to the Leapfrog Central
server. The Large request timeout is used for publishing, uploading attachments and getting a
revision. All other communication with the Leapfrog Central server uses theDefault request
timeout. TheDefault request timeout and Large request timeout should only be adjusted
upward if you have problemswith a poor connection. The default values are 20 seconds and
600 seconds.

There is an option for checking the integrity of a revision after it has been uploaded. If you wish
to do this, enable theCheck file consistency after upload option.

Setting Up the Connection
The first time you connect to Leapfrog Central, you will need to set up your connection.
Request an account fromyour Leapfrog Central administrator, whowill provide you with your
login and connection details. Once you have these details, click on theCentral Projects tab.
Click the Add button to add a new server:

Enter the information provided to you by your Leapfrog Central administrator and clickNew
user to enter your login token.

Create a password, then click Save.
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Connecting to Leapfrog Central
Once Leapfrog Central integration has been enabled, you can see the status of your
connection to Leapfrog Central in the lower lefthand corner of the Leapfrog Geomain
window. Click this button to logout or change Leapfrog Central settings:

If you are logged out, click on theCentral Projects tab and click the server you wish to log in to:

To hide theCentral Servers panel, click the button:

Viewing a Project’s History
TheCentral Projects tab shows the projects available in Leapfrog Central.

Leapfrog Central projects are organised into revisions and branches:

l Different points in themodelling process are captured as revisions, which are specific points
in time.

l Any revision can be the basis for any number of alternate revisions, forming the start of a new
branch.

These are displayed visually in a project’s history tab. Revisions are displayed chronologically,
from themost recent down to the oldest. In theGraph, offshoots froma revision are branches
where an alternative hypothesis has been investigated. Changesmade in a branch do not
appear in other branches; branches effectively diverge from the base revision. The dots on the
graph line up with the revision information.

To viewmore information about a revision, click on it in the history.
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Locking Branches
When working on a branch in Leapfrog Geo, the branch can be locked so no other Leapfrog
Central users can make changes to it. This is useful for letting others users know that a model is
being worked on.

The Locked column indicateswhether or not the branch is available to beworked on. If a
branch is locked, hold the cursor over it to seewho locked it and when it will be available once
again:

To lock a branch, right-click on it in the project history and select Lock branch:

In thewindow that appears, set the Lock duration and add any comments. The lock can be set
for as little as one day; when the lock expires or when a new publish is completed, the branch
will be unlocked for other users. While the branch is locked, other users are still able to
download projects, create new branches and publish to branches that are not locked.

If you locked a branch, you can unlock it before the lock expires by right-clicking on it and
selecting Unlock branch:

The Leapfrog Central administrator can also unlock branches via the Admin Portal.

Project Included
The Project column indicateswhether or not the Leapfrog Geo project was included when the
revision was published. If there is no icon displayed, then no project was uploaded when the
revision was published. You can view the revision in the Leapfrog Browser, but you cannot work
on it in Leapfrog Geo.
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When Leapfrog Geo projects are included in a revision, they can be published in a Complete
state ( ) or in an Unprocessed state ( ). The difference between the two iswhether or not
stored modelling calculations are included in the published project. Removing stored
modelling calculations can make the upload/download size of a revision considerably smaller
and is useful when internet connectivity is poor. The tradeoff is that when the project is
downloaded by a Leapfrog Geo user, the project will have to be reprocessed before they can
use it. Thismay take some time.

Project Stages
The Project Stage is useful for promoting projects through an organisation’s procedures. For
example, your organisation may have project stages defined that include “Experimental”, “Ready
for Peer Review” and “Ready for Production”. Different stages are displayed in different colours
so it is easy to see at a glancewhat revisions belong to each stage.

Annotations and Attachments
With Annotations, Leapfrog Browser and Leapfrog Geo users can carry out conversations
about specific aspects of themodel. Annotations include a scene. If you already have the
project open in Leapfrog Geo, you can load any scene from that project’s history by clicking on
it. Information about the selected scenewill be displayed and you will be prompted to load all
the objects or only the unchanged objects:

If the selected scene has a geotag, it will be added to the shape list and displayed in the scene.

Leapfrog Browser users can also attach files, which can be downloaded in Leapfrog Geo.

Downloading a Local Copy of a Project
Select a revision and then clickDownload to download a local copy of the project. The project
will be downloaded to the location on your local drive specified in the Settings > Leapfrog
Centralwindow. A new revision of the project will be created in the history, as an unpublished
project.

Click theOpen button at the bottomof the tab to open the project.

Work in the project as you would any other Leapfrog Geo project.
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Publishing to Leapfrog Central
When you are ready to submit your project to Leapfrog Central, you can start the publishing
process by clicking on the Leapfrog Central button in the lower lefthand corner of the screen
and selecting Publish:

You can also select the Publish button in the Project Historywindow:

The steps in publishing a project to Leapfrog Central are:

l Selecting Objects

l Setting the Project Workflow Stage

l Including the Project

l Adding Revision Information

l Preparing the Package

When you clickPublish, you may receive a message saying there is an unfinished publish
event:
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This occurswhen a previous publish event was interrupted. Choose from the options
presented.

If the publish was abandoned, it can be removed via the Admin Portal.

Selecting Objects
Select the objects you wish to publish from those available in the project:

Although sub-blocked models can be published to Leapfrog Central, the dip will not be
included.

ClickNext to choose options choose options for how the project will be uploaded.

Setting the Project Workflow Stage
Project stages are useful for advancing projects through an organisation’s processes. If the
project is ready to bemoved on to a different stage, select a different Project Workflow Stage
from the list.

Project stages can later be changed in the Leapfrog Browser.

Including the Project
Select whether or not to include the Leapfrog Geo project. There are three options:

l No. The Leapfrog Geo project will not be published. Other Leapfrog Central userswill not be
able to download the project and work on it in Leapfrog Geo.
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l Complete.This option publishes the complete Leapfrog Geo project, including stored
modelling calculations. Other Leapfrog Central userswill be able to download the project
and work on it in Leapfrog Geowithout reprocessing the project.

l Unprocessed. An unprocessed project has a smaller upload/download size because stored
modelling calculations are removed. When an unprocessed project is downloaded again, all
of themodelling calculationswill need to be reprocessed from the underlying data. Other
Leapfrog Central userswill be able to download the project and work on it in Leapfrog Geo.
Depending on the size of the project, reprocessing may take some time.

ClickNext.

Adding Revision Information
Enter information about the new revision. If you want to create a new branch, click theNew
Branch button and enter a name for the branch.

Preparing the Package
ClickNext to begin the processes of packaging the project for publication. There are two
options for starting the upload:

l If you want the upload to begin automatically once the package has been prepared, tick the
Auto upload box.

l If you want the option to cancel the upload once it has been packaged, leave the Auto
upload box unticked. Once the project has been packaged, clickPublish to upload the
project to Leapfrog Central.

If for some reason you need to stop the upload, click on the Leapfrog Central button in the
lower lefthand corner of the screen and select Stop Upload:

You can resume the download by clicking Publish in the project history. You will be prompted
to resume the unfinished publish event, as described in Publishing to Leapfrog Central above.

If the upload is interrupted because the connection to the server is lost, you will be prompted to
finish the publish event the next time you log in to Leapfrog Central.

New Leapfrog Central Projects
There are two options for putting a project into Leapfrog Central:

l Create a new Leapfrog Central project.

l Put an existing project into Leapfrog Central.
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Creating a New Leapfrog Central Project
Use this option to create a new Leapfrog Geo project and put it into Leapfrog Central. In the
Central Projects tab, clickCreate blank project. Enter a name for the project and clickOK. A
new Leapfrog Geo project will be created and saved in the location on your local drive specified
in the Settings > Leapfrog Centralwindow.

Work in the project as you would any other Leapfrog Geo project. When you are ready to
publish the project to Leapfrog Central, do so as described in Publishing to Leapfrog Central
above.

Adding a Project to Leapfrog Central
Use this option to add an existing project to Leapfrog Central.

Open the project you wish to import, then in theCentral Projects tab, click Import open
project. Enter a new name for the project, if you wish, then clickOK. The project will be opened
and copied to the location on your local drive specified in the Settings > Leapfrog Central
window.

Work in the project as you would any other Leapfrog Geo project. When you are ready to
publish the project to Leapfrog Central, do so as described in Publishing to Leapfrog Central
above.

Disconnecting a Project from Leapfrog Central
Disconnecting a project from its Leapfrog Central server saves a copy of the project in a new
location on your computer. When a project is disconnected, it will no longer be possible to
publish the project to Leapfrog Central and its historywill no longer be tracked.

If you wish to remove a project fromLeapfrog Central, selectDisconnect This Project from the
Leapfrog Geomenu. You will be prompted to confirm your choice. Once you clickProceed,
you will be prompted for a new location in which to save the project.
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Concepts
This section describes important Leapfrog Geo concepts:

l What is Implicit Modelling? provides an introduction to the advantages implicit modelling
brings to the geological modelling world.

l Surfaces describes the different types of surfaces in Leapfrog Geo and important concepts
such as surface resolution. It also describes the different tools for working with surfaces that
are available in a Leapfrog Geo project.

l Boundaries describes the different boundaries and their uses, including defining a
topography that can be used as an upper boundary formodels.

l Leapfrog Geo’s powerful 3D interpolation engine can interpolate any numeric data (e.g. ore
grade or piezometric head measurements) to describe how a real, numerical quantity varies in
three dimensional space. Interpolant Functions provides a brief introduction to
interpolation.
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What is Implicit Modelling?
Implicit modelling is a game-changing innovation in geological modelling.

Traditionally, geological models are produced using a manual drawing process. Sections are
defined, and lithologies, faults and veins are drawn on the sections. Lines are then drawn to
connect surfaces acrossmultiple sections. Modelling geology in thismanner is time-consuming
and inflexible as it is difficult to update themodel whenmore data becomes available. Early
assumptions that later are proved incorrect could shape a model in a way that is never corrected
because of the effort involved in starting over. Instead of using their knowledge to reveal
important information about the study site, geologists spend significant proportions of their
time engaged in mechanical drawing.

Implicit modelling, on the other hand, allows geologists to spend more time thinking about the
geology. Implicit modelling eliminates the laborious legwork by using mathematical tools to
derive themodel from the data. Amathematical construct is built that can be used to visualise
different aspects of the data in 3D. Leapfrog Geo uses FastRBF™, a mathematical algorithm
developed from radial basis functions. FastRBF uses the data and parameters supplied by the
geologist to derive any one of a number of variables to bemodelled. Discrete variables such as
lithologies can be used to construct surfaces, aswell as continuous variables such as ore
grades.

Instead of presenting a model constructed from rigid geometric constructs, the visualisations
echo the natural forms found in reality.

What are the Advantages of Implicit Modelling?
Implicit models are easy to keep up-to-date with the latest data. New drillhole data can quickly
be integrated, instead of taking weeks or longermanuallymodifying themodel.

Implicit modelling allows several alternative hypothetical models to be produced from the data,
quickly and easily. New data that affects themodel, even in very significant or fundamental
ways, can be assimilated and integrated with little effort. Models can be built rapidly, which
means that a range of geological interpretations can be continually tested.

Because less effort is involved in creating a model, more time is available to spend on
understanding the geology and studying more complex details such as faulting, stratigraphic
sequences, trends and veins. Themodel can be developed to reflect reality to a greater degree
of precision than was previously possible.

Geological risk is reduced whenmodelling is done implicitly. With traditional modelling, the
effort involved means that the first model developed may be held to as the ground truth,
despitemounting evidence that may discredit it. Instead, implicit modelling supports an
approach that follows the proven scientific method, developing hypothetical models,
experimenting to find new data to corroborate or discredit models and, ultimately, allowing the
best model to be revealed. A geologist can experiment with alternative parameters at the limits
of what is geologically reasonable to determine if there is any significant variation in the
resulting models, which can then bracket themodel with conceptual error bars. Geostatistical
analysis can be conducted to identifywhat models are themost valid.
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It is easy to change yourmind whenmodelling implicitly. Perhapsmodels have been produced
demonstrating isometric shells enclosing specific grades of ore. Commodity price changes then
make it desirable to recreate themodel using alternative ore grade values. If themodel had
been produced manually, doing sowould not be practical. But with implicit modelling, the ease
of generating a newmodel with new interpolation parametersmeans this valuable business
information can be readily produced.

New questions can be answered more easily. Amodel tends to answer one question or class of
questionswell, and new questions require newmodels. If a model takesmonths to produce,
those new questionsmay remain forever unanswered. If it can be produced with only days or
hoursworth of effort, valuable insights can be gained that could provide critical business value.

Implicit Modelling Makes Assumptions Explicit
Often, there is insufficient information in the data alone. For instance, drillhole data maywell
need to be supplemented with known details about the geology. When a geologist is
constructing a model using traditional techniques, they use their knowledge of the geology to
make decisions about themodel as it is constructed. This is something the geologist will do
automatically, which irretrievably conflatesmeasured data with hypothesised data, hiding away
subjective assumptions that have influenced the development of themodel.

Implicit modelling, however, keeps themeasured data separate from interpretations. The
geologist can use polylines and structural disks to interpret the data without equating them to
measured data. Implicit modelling makes assumptions explicit; there is a clear separation
between hard data and user-introduced interpretations.

Implicit modelling and the presentation of a selection of models communicating different
aspects of the geology provide new tools a geologist can use to communicate with
professionals in other parts of the business.

On a purely business level, specialist staff can be putting their skills to use in productive,
valuable geological modelling, rather than drawing lines on sections ad infinitum.

Implicit models aremore repeatable and, therefore, more auditable, because they are derived
fromactual data and explicitly communicated geological interpretations, with selected
parametric variables as inputs and processed using a mathematical algorithm.

The only thing implied in implicit modelling is the unknown value between two known values.
Everything else is explicit. For this reason, it is best to refer to traditional modelling techniques as
‘traditional modelling’ rather than ‘explicit modelling’, assuming that it should be labelled with a
name that is the inverse of ‘implicit modelling’. Implicit modelling ismuchmore explicit than
traditional modelling.

Best Practices

l Analyse data. Analyse your data using Leapfrog Geo’s drillhole interpretation and data
visualisation tools. Use 3D visualisation to look for errors in the data set.

l Stay focussed. Produce a model that answers a specific question or addresses a specific
problem. Don’t unnecessarilymodel all the data available just because it is there. When a new
question is asked, produce a model that answers that question using the necessary data.
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l Experiment and explore. Produce variations of the samemodel, or even models, using quite
different fundamental assumptions. Plan drillholes that will help reveal what model fits best
and then discard models that are inconsistent with new data.

l Understand risk. Model using a range of input parameters and assumptions to understand the
level of geologic risk.

l Share. Discuss and explore alternatives.

l Adapt. Previously, the effort of production and review of traditional modelsmeant that there
is reluctance to rebuild a model when new data becomes available soon aftermodel
completion. However, with implicit modelling, you should integrate new data and refine the
model as soon as the new data is available. The revised model could indicate that planned
activities should be redirected as expensive resourceswould bewasted persisting with the
original plan, for little return.

l Evaluate and review. Don’t assume that because it’s easy to generate a model that you have
quickly produced the right model. Understanding the geology is vital for validating themodel
and producing something that is geologically reasonable.
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Surfaces
In Leapfrog Geo, meshes are used to represent surfaces in the formof vertices and triangles that
define the 3D shape of the surface. Meshes can be open or closed.

Meshes are generated as part of themodel-building process, but can also be imported into a
project or created directly in the project. Leapfrog Geo has several tools for adjusting meshes.

This section describes different aspects of working with surfaces in Leapfrog Geo.

Surface Resolution in Leapfrog Geo
In Leapfrog Geo, meshes are used to represent surfaces in the formof vertices and triangles that
define the 3D shape of the surface. The resolution of a surface is controlled by the size of the
triangles used to create a surface. A lower surface resolution valuemeans smaller triangles and,
therefore, a finer resolution. A higher surface resolution valuewill take less time to process but
the surfacemay not show the level of detail required.

When a surface is imported, Leapfrog Geo automatically sets a surface resolution based on the
information in the file. It is not possible to change the resolution of surfaces imported into
Leapfrog Geo. The exception is elevation grids (see Importing an Elevation Grid).

When surfaces are created, Leapfrog Geo sets a default resolution based on the data available.
You can set a lower value, but calculationswill take longer. In addition, the resolution formany
surfaces can be adaptive; that is, areas closer to data will have a finer resolution than areas
further away fromdata.

To see the effect of different resolution settings, consider a simple geological model of three
rock types. Here, the surface resolution is set to 50 and the adaptive isosurfacer is disabled:
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Here, the resolution has been reduced, which results in smaller triangles:

For both resolution settings above, the triangles are the same size everywhere in each surface,
even where real data is available. Once the adaptive isosurfacer has been enabled, the triangles
closer to the drillholes are smaller than those further away:

Areas of the surface that have large triangles indicate that there is less data in those areas to
guide the interpolation of the surface.

In Leapfrog Geo, the resolution for different types of surfaces can be controlled as follows:

l For geological models, a resolution can be set for themodel as a whole, but individual
surfaces can have different settings. See Surface Resolution for a Geological Model.

l For interpolants, the resolution of the output isosurfaces is controlled by a single setting that
can be overridden for individual surfaces. SeeOutput Settings for an RBF Interpolant and
Indicator RBF Interpolant Surfacing and Volume Options.

l The resolution can be changed for editable interpolated meshes ( ) and can be adaptive.
See Interpolated Meshes.

l When the topography has been defined using multiple data sources, the resolution can be
set and the adaptive option is available. SeeChanging Topography Settings.

Adding Data to Surfaces
Many surfaces can be refined by adding points, structural data, GIS data and polylines. If a
surface can bemodified in thisway, an Addmenu will appear for the object when you right-
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click on it in the project tree. For example, the Addmenu for this contact surface shows the
data types that can be used to refine the surface:

Select the type of data you wish to use tomodify the surface. Leapfrog Geowill display all the
suitable objects in the project. Select the required object and clickOK. A hyperlink to the added
data will appear under the surface in the project tree. The added data can be removed from the
surface by expanding the surface in the project tree, then right-clicking on the hyperlinked data
object and selecting Remove.

Contact Honouring

In Leapfrog Geo, surfaces can be created fromdrillhole data, points data, structural data, GIS
data and polylines. When surfaces are created from several different objects, it may be desirable
to snap the surface to some data objects but not to others.

There are several options for snapping surfaces to data:

l Off. The surface does not snap to the data used to create it.

l All data. The surface snaps to data within theMaximum snap distance, which includes
drillhole data and any data added to the surface.

l Drilling only. The surface snaps to drillhole data and data objects derived fromdrillhole data
within theMaximum snap distance but not to other data used tomodify the surface. For
example, the surfacewill honour points data derived fromdrillhole data, but not points data
imported into the Points folder.

l Custom. The surface snaps to selected data objectswithin theMaximum snap distance.

Snapping to data is off by default. Although you can snap to all data, this is not
recommended as it increases the possibility that errors in the data or assumptions inherent in
interpretations (e.g. polylines) will cause distortions in themeshes. If you do enable snapping,
is best to snap only to drilling data.
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For example, here the Snap to data has been set toDrilling only for a mesh created from
multiple data objects:

Note that the only objects Snap is enabled for are the contacts derived fromdrillhole data.

Here, Snap to data has been set toCustom, which makes it possible to enable Snap for only the
selected data objects:

In Leapfrog Geo, the snap settings for different types of surfaces can be controlled as follows:

l For geological models, Snap to data can be set for themodel as a whole, but individual
surfaces can have different settings. Formore information, see:
o Editing a Geological Model

o Surfacing Options for Deposits and Erosions

o Surfacing Options for Intrusions

o Surfacing Options for Veins
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o Surfacing Options for Faults

o Changing Fault Inputs

l For editable interpolated meshes and offset meshes ( ), Snap to data can be set by double-
clicking on themesh and changing the settings in theGeneral tab. SeeRefining an
Interpolated Mesh andOffset Meshes formore information.

Global Trends
In Leapfrog Geo, many surfaces can be adjusted by applying a trend to the surface. To do this,
add the surface you wish to adjust to the scene so that it can be used in setting the trend.
Double-click on the surface in the project tree and select the Trend tab. Here, the Trend tab is
displayed for a contact surface:

Often the easiest way to apply a trend is to click on theDraw plane line button ( ) and draw a
plane line in the scene in the direction in which you wish to adjust the surface. You may need to
rotate the scene to see the plane properly.

The Ellipsoid Ratios determine the relative shape and strength of the ellipsoids in the scene,
where:

l TheMaximum value is the relative strength in the direction of the green line on themoving
plane.

l The Intermed. value is the relative strength in the direction perpendicular to the green line on
themoving plane.

l TheMinimum value is the relative strength in the direction orthogonal to the plane.

Once you have adjusted the plane to represent the trend you wish to use, click the Set From
Plane button to copy themoving plane settings.

The Set to list contains a number of different options Leapfrog Geo has generated based on the
data used in the project. Isotropic is the default option used when the surfacewas created.
Settingsmade to other surfaces in the project will also be listed, which makes it easy to apply the
same settings tomany surfaces.

ClickOK to apply the changes.
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How themoving plane can be used to adjust a surface in thismanner is illustrated by the
following intrusive contact surface:

The intrusion surface has two bodies that are not connected, and we can apply a trend to
connect the two parts. Here, the intrusion surface has been hidden in the scene and the scene
rotated to line up theQzP segments. A plane line can then be drawn through theQzP
segments:

Using the plane settings to adjust the surface results in the two parts of the intrusion joining up:
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Structural Trends
Structural trends create a flat ellipsoid anisotropy that varies in direction with its inputs. This
topic describesworking with structural trends. It is divided into:

l Creating a Structural Trend

l Displaying a Structural Trend

l Applying a Structural Trend

Creating a Structural Trend

To create a new structural trend, right-click on the Structural Trends folder (in the Structural
Modelling folder) and selectNew Structural Trend. The Structural Trendwindowwill appear:

Structural trends can be created from surfaces and from structural data. ClickAdd to select
from the suitable inputs available in the project. The list of inputswill be displayed:
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Tick the box for each input required, then clickOK. The selected inputswill be added to the
Structural Trendwindow:

The Strength parameter determines the shape of the ellipsoid, and theRange parameter
indicates how far the influence of thismesh reaches. If the Trend Type isNon-decaying, the
distance from themesh no longer affects the anisotropy and theRange value cannot be set.

Trends that are Strongest along meshes orBlending can include a global trend. To set this,
click on theGlobal Mean Trend tab.

You can enter the trend manually or add themoving plane to the scene and set the trend using
themoving plane, as described inGlobal Trends.

TheCompatibility setting determines the algorithmused to create the structural trend.
Structural trends created in earlier versions of Leapfrog Geo (before 2.2) used the Version 1
algorithm. When these structural trends are upgraded, you can change themso they use
Version 2, which may be desirable if adding more data to the trend results in significant
changes in areas that are not close to new data.
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Enter a Name for the trend and clickOK. The new trend will appear under the Structural
Trends folder.

Displaying a Structural Trend

When displayed in the scene, the trend is shown using disks placed on a regular grid:

The orientation of the disk gives the direction of the anisotropy. The size of a disk is proportional
to the anisotropy strength. Where there are no disks (or the size is very small) the trend is
isotropic.

If the Trend Type is set toNon-decaying, the distance from themesh no longer affects the
anisotropy and all disks have the same size:

The Blending option requiresmultiplemeshes and blends themaccording to their individual
strength settings. A trend with higher strength makes a stronger impact on the blending. The
blended trend is of decaying-type, and its strength weakens further away from themesh.
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Applying a Structural Trend

To apply a structural trend to an interpolated editablemesh or an interpolant, double-click on
the object in the project tree and click on the Trend tab:

To apply a structural trend to an intrusion contact surface, enable Show additional surfacing
options in the Surfacing tab, then click on the Trend tab.

Click on Structural Trend, then select the required trend from the list. ClickOK to apply the
trend to the surface.

When a structural trend is applied, surfacesmay appear distorted further away from the data:
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If this is the case, experiment with theOutside value setting. TheOutside value is the long-
rangemean value of the data. Setting a value of -1 for intrusions (where the positive values are
on the inside) and +1 for other surfaceswill result in a smoother surface in most cases. For
example, here, theOutside value has been set to -1 for this intrusion, resulting in a much
smoother surface:

Editing Surfaces with Polylines
In Leapfrog Geo, many surfaces can be edited using polylines, including contact surfaces,
geological model extents and editablemeshes.

To edit a surfacewith a polyline, it is a good idea to first add the object you wish to edit to the
scene and draw a slice across the scenewhere you plan to edit the surface. Next, right-click on
the surface in the project tree and select Edit > With Polyline.

The drawing toolbar will appear for the type of polyline selected and a new polyline will be
added to the scene. Draw the polyline and adjust it as described in Drawing in the Scene, then
click the Save button ( ) to view the effect of the polyline on the surface. To remove the
polyline from the surface, expand the surface in the project tree. Right-click on the polyline
object and select Remove.

In caseswhere you have existing polyline edits (control points), you can import themand add
them to the surface. To do this, import the polylines to the Polylines folder, then add them to
the surface by right-clicking on the surface and selecting Add > Polyline.
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How a polyline can be used to edit a surface can be illustrated by the following surface, where a
small volume is disconnected from themain surface:

First, a slice is drawn through the surfacewhere it will be edited:

Next, a polyline is created, using two lines to represent contacts that link up the surfaces:

© 2017 ARANZ Geo Limited



Editing Surfaces with Structural Data | 81

When the polyline edits are saved, the surface is updated to reflect the edits:

It is best to keep polyline edits to a minimum, as small edits can have significant effects on the
shapes of surfaces.

If editing a surfacewith a polyline results in a distorted surface, use the surface and normal
ribbons to check the orientation of the polyline and its segments. See Tangents and
Ribbons formore information.

When you save the polyline, the object will be updated to reflect the additional points. The
polyline will be added to the project tree as part of the object that was edited. You can edit the
polyline by double-clicking on it or by right-clicking and selecting Edit Polyline.

Editing Surfaces with Structural Data
In Leapfrog Geo, many surfaces can be edited using planar structural data points drawn in the
scene. Surfaces that can be edited in thisway include contact surfaces, model extents and
interpolated editablemeshes. There are twoways to do this:

l If you have a structural data table created in or imported into Leapfrog Geo that you want to
use to adjust the surface, right-click on the surface in the project tree and select Add >
Structural Data. You will be prompted to select from the structural data tables available in
the project.

l If you want to create structural data points to use to adjust the surface, right-click on the
surface in the project tree and select Edit > With Structural Data.
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To edit a surfacewith structural data using the second option, it is a good idea to first add the
object you wish to edit to the scene. Next, right-click on the surface in the project tree and
select the Edit > With Structural Data option.

The structural data toolbar will appear and a new structural data object will be added to the
scene. Draw the structural data points and adjust themas described in Creating New Planar
Structural Data Tables, then click the Save button ( ) to view the effect on the surface.
Structural data tables created in thisway cannot be used by other objects in the project until the
table has been shared. To do this, right-click on the table in the project tree and select Share.
The structural data table will be saved to the Structural Modelling folder.

To remove the structural data from the surface, expand the surface in the project tree. Right-
click on the structural data object and select Remove.

Extending a Surface
Geological models created in a Leapfrog Geo project automatically use the defined topography
as an upper boundary. If a model is defined that extends outside the topography, an error will
occur. A similar error occurswhen surfaces used in geological models do not extend outside the
model’s extents. In all cases, Leapfrog Geo cannot process the surface and an error will be
displayed.

In this example, an error has occurred during the process of creating a geological model
because the topography (yellow) does not enclose themodel extents (pink):
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In order for Leapfrog Geo to be able to divide themodel into separate volumes, the topography
needs to be extended to enclose themodel’s boundary or themodel’s boundary needs to be
restricted so it falls inside the topography. When themodel is processed, the following error
results:

The solutions proposed will depend upon the data used to create the surfaces that conflict, but
fall into three broad categories:

l Reduce the size of themodel’s or interpolant’s extents. Click the Edit Extents button. Thiswill
open the object’sBoundarywindow and you can change the boundary.

l Enlarge the topography bymanually adjusting it. Click on the Edit Topography Extents
button. This option is only available when the topography has been created frommore than
one data source. See Adding Height Data to the Topography and Changing Topography
Settings.

l Use the surface’s vertices to create the boundary or contact with extents large enough to be
used in themodel or interpolant. Click theUse Vertices button to create a new vertices
object and use it as the source data for the boundary or contact.

If you have a solution to the problem that is not covered by the options presented, clickDo
Nothing. For example:

l If the topography is not large enough, theremay be additional data available. If it is not
already in the project, import the data and add it to the topography as described in Adding
Height Data to the Topography.

l If a surface being used to define a contact surface or boundary in a geological model or
interpolant is not large enough, you can add additional data to the surface.

Using vertices to create the boundary or contact results in the creation of a new points object
that will be saved in the Points folder.

Earlier versions of Leapfrog Geo (up to 1.3) would automatically create the new vertices
object and use it to interpolate the surface.
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In the case of using topography vertices as an upper boundary, the verticeswill be applied as a
lateral extent and the defined topographywill not be used. For example, here the geological
model does not use the defined topography but instead uses the “GM: Topography” surface
created from the vertices:

Using topography vertices can take some time to process.

An additional disadvantage to using vertices is that the vertices object created is not linked to the
original object. When the object used to create the vertices changes, the verticeswill not be
updated.
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Boundaries
A newly-created project has only a basic set of X-Y-Z coordinates, and the coordinate system
used by the project is determined by the data imported to the project. It is not necessary to
specifywhat coordinate system is used; however, it is necessary to ensure that data you import
into the project uses the same coordinate system.

If you are importing data that uses different coordinate systems, you will need to process the
data outside of Leapfrog Geo so that it is using the same coordinate system.

Often the best way to set the coordinates for the project as a whole is to import a map or aerial
photo. Adding georeference data to a map will set the location of themap in three-dimensional
space and set the coordinates for the project. See Importing a Map or Image formore
information.

An important consideration in defining the project space is setting the clipping boundary. See
The Clipping Boundary.

It is not necessary to define a topography tomodel in Leapfrog Geo, but a defined topography
can be used as an upper boundary for all models built in the project. SeeDefining a
Topography.

Part of creating many objects in Leapfrog Geo is defining the basic rectangular boundary that
defines the object’s extents. SeeObject Extents.

You can modify the extents of geological models and interpolants using surfaces created from
different types of data. SeeModifying a Geological Model’s Boundary andModifying an RBF
Interpolant’s Boundary with Lateral Extents.

The Clipping Boundary
An important consideration in defining the project space is setting the clipping boundary.

The default clipping boundary in a new project file encompasses everything in the project and
grows asmore data is added to the project. It is not necessary to set the clipping boundary.
However, the clipping boundary defines the limits of the X-Y coordinates for the region in which
data will be imported and models built and so defines the region in which calculations are
made. Restricting the size of the clipping boundary limits the area in which calculations are
made and is especially important if you are working with a large dataset.

The best way to set the clipping boundary is using an imported map or aerial photo, as this
provides a visual reference that is helpful in working with data added to the project in the future.
GIS data or drillhole data can also be used to set the clipping boundary.
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To set the clipping boundary, add to the scene the objects you wish to reference in setting the
boundary. Right-click on the Topographies folder or on theGIS Data, Maps and Photos folder
and select Set Clipping Boundary. The Set Clipping Boundarywindowwill be displayed,
together with controls in the scene you can use to resize the clipping boundary:

There are threeways to define the rectangular clipping boundary:

l Enter the coordinates.

l Select Enclose Object and choose from the list of objects in the project. The clipping
boundarywill be updated using the selected object.

l Use the controls that appear in the scene. The orange handle adjusts the corner of the
clipping boundary and the red handles adjusts its size.

When you have finished adjusting the clipping boundary, clickOK.

If you are going to import elevation data and use it to create a topography, it is important to set
the clipping boundary before creating the topography. For example, here a map has been
imported and a topography (yellow) created froman elevation grid. Themap is displayed
draped on the topography:

The red arrows and orange handle show the clipping boundary, which has been allowed to
expand to encompass all data imported to the project. Because the topographywas created
before the clipping boundarywas set, all the data in the imported elevation grid has been used
and the resulting topography is larger than might be practical. Clearly, if the intention is to
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model within the area on themap, the clipping boundary should be limited to the region
indicated by themap.

If themap is the only object in the project, it can easily be used to set the clipping boundary by
selecting <Everything> from the Enclose Object list:

This results in a clipping boundary that is limited to the extents of themap:

Once the clipping boundary has been set, further data imported into the project will be clipped
to it. For example, importing the elevation grid and using it to create a topography only after the
clipping boundary has been set to themap extentswill result in a topography (with themap
draped) that looks like this:
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Once the clipping boundary has been set, a good next step is defining the topography. See
Defining a Topography.

Defining a Topography
It is not necessary to define a topography tomodel in Leapfrog Geo, but a defined topography
can be used as an upper boundary for all models built in the project.

A key advantage of defining a topography is that it provides consistent elevation data for objects
imported to and created in the project. The quality of elevation information can be poor
compared to X- and Y-coordinates, which can create problemswhen using objects to build a
model. A topography can be created from themost reliable elevation data, and other objects
can have elevation set from this topography.

An important consideration when defining the topography is ensuring that it is large enough to
encompass themodels you will be building in the project. If you create a small topography but
then later create a model that extends outside the topography, you will need to enlarge the
topography, which can result in considerable reprocessing of all objects in the project that use
the topography as a boundary. See Extending a Surface formore information.

This topic describes creating and working with a topography. It is divided into:

l Topography From Elevation Grid

l Topography From Surfaces, Points or GIS Vector Data

l Fixed Elevation Topography

l Adding Height Data to the Topography

l Changing Topography Settings

l Changing the Size of the Topography

l Topography Resolution

l Applying a Trend to the Topography

l Topography Display Options

l Projecting Collars onto the Topography

The topography can be created froman imported elevation grid, points data, surfaces and GIS
data. It is not necessary to decide on a single source of information, as information can be
combined, and you can add and remove data as required.

Once defined, you can export the topography as a mesh or as an elevation grid. See:

l Mesh Export

l Elevation Grid Export

Topography From Elevation Grid

There are twoways to create the topography froman elevation grid:

l Right-click on the Topographies folder and selectNew Topography > Import Elevation
Grid. Import the grid as described in Importing an Elevation Grid.

© 2017 ARANZ Geo Limited



Topography From Surfaces, Points or GIS Vector Data | 89

l Import the grid using theMeshes folder and then right-click on the Topographies folder and
selectNew Topography > From Surface.

Enter a name for the topography and clickOK. A hyperlink to the elevation grid will appear in
the Topographies folder under the defined topography.

Once the topography has been defined, additional height data can be added by right-clicking
on the topography and selecting from the options available. See See "Adding Height Data to
the Topography" formore information.

Topography From Surfaces, Points or GIS Vector Data

To create the topography froma surface, points or GIS data, first import the data into the
project.

l Import surfaces into theMeshes folder.

l Import drillhole data into the project or points data into the Points folder.

l Import GIS vector data into theGIS Data, Maps and Photos folder.

Next, right-click on the Topographies folder and select one of theNew Topography options. A
list of suitable objects available in the project will be displayed. Select the required object and
clickOK. Enter a name for the topography and clickOK. A hyperlink to the source object will
appear in the Topographies folder under the defined topography.

Once the topography has been defined, additional height data can be added by right-clicking
on the topography and selecting from the options available. See See "Adding Height Data to
the Topography" formore information.

See alsoChanging Topography Settings below.

Fixed Elevation Topography

If you don’t have any data suitable for creating a topography, you can set a fixed elevation. To
do this, right-click on the Topographies folder and selectNew Topography > Fixed Elevation.
In thewindow that appears, enter a value for the elevation and clickOK. Enter a name for the
new topography and clickOK.

The new topographywill appear in the project tree under the Topographies folder.

Once a topography has been defined, the onlyway to set a fixed elevation is to remove the
objects that have been used to define the topography. To do this, right-click on the hyperlinked
object and clickRemove. You will then be able to set a fixed elevation for the topography.
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Adding Height Data to the Topography

When creating the topography, it is not necessary to decide on a single source of information,
as information can be combined. Once the topography has been defined, additional height
data can be added by right-clicking on the topography and selecting from the options
available:

For points, surfaces and GIS vector data, you will be prompted to select from the data sources
available in the project. For an elevation grid, see Importing an Elevation Grid.

All data objects used to define the topographywill appear under the topography, hyperlinked
to their parent objects:

When you have added data to the topography, you may need to enlarge the topography
extents. SeeChanging Topography Settings below.

To remove data objects from the topography, either:

l Delete the object from the topography. To do this, right-click on the hyperlinked object and
clickRemove.

l Delete the object from the project. If you choose this option, consider carefully the effects on
other objects in the project, as once an object is deleted, it cannot be recovered.

When the topography is defined frommultiple objects, you can set the resolution of the
topography by double-clicking on it. SeeChanging Topography Settings below.

Changing Topography Settings

When the topography is created frompoints or GIS data or when the topography is created by
combining data, you can change its boundary and resolution and apply a trend. To do this,
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double-click on the topography in the project tree. The Edit Topographywindowwill appear:

Changing the Size of the Topography

In theGeneral tab, you can change the topography extents. Use the controls in the scene or
enter the required values in the Bounding Box fields.

Topography Resolution

The resolution of the topography dependson how it was created.

l When the topography is created froma singlemesh, the resolution of the topography is set
from the resolution of themesh and can only be changed when themesh is imported. If you
wish to change the resolution of the topography, you must first add more height data to the
topography. See Adding Height Data to the Topography.

l When the topography is created by setting a fixed elevation, the resolution cannot be set.

When the topography is created frompoints or GIS data or when the topography is created
fromcombining data, you can set its resolution in the Edit Topographywindow.

When you set a specific Surface resolutionwithout enabling the Adaptive option, the triangles
used will be the same size for thewhole topography. When you enable the Adaptive option, the
resolution of the topographywill be affected by the availability and density of real data. See
Surface Resolution in Leapfrog Geo formore information on these settings.
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Applying a Trend to the Topography

In the Trend tab, you can apply a trend to the topography:

SeeGlobal Trends formore information.

Topography Display Options

To display the topography in the scenewindow, either:

l Right-click on the topography in the project tree and select View Object.

l Click on the topography object and drag it into the scene.

The topographywill be displayed in the scenewindow and in the shape list:
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The topography object in the shape list provides additional controls that can be used to change
theway the topography is displayed and highlight features of interest. For example, selecting an
imported map from the list results in it being displayed draped onto the topography:

The list is organised into:

l Views. This contains options for creating and editing custom topography views and also lists
any views already defined. With custom topography views, you can viewmultiple GIS objects,
maps and contours. SeeCustom Topography Views formore information.

l Maps and Photos. This lists all images stored in theGIS Data, Maps and Photos folder.

l GIS objects. This lists all GIS data objects stored in theGIS Data, Maps and Photos folder.

Projecting Collars onto the Topography

If the collars are not lying on the topography, Leapfrog Geo can make adjustments to the collar
depth values so that the collars lie on the topography. This adjustment is reversible.

Tomake this adjustment, right-click on the collars table and tick the box for the Project Collars
Onto Topography option. If you then open the collar table, the depth valueswill reflect the
topography. Right-click on the collar table and untick the box for Project Collars Onto
Topography to return to the uncorrected collar depth values.

Object Extents
Part of creating many objects in Leapfrog Geo is defining the basic rectangular boundary that
defines the object’s extents. There are generally two options for defining an object’s extents:

l The first option is to define extents that are independent of other objects in the project. You
can do this by entering coordinates or adjusting controls in the scene to set the size and
shape of the extents. The new object’s extents are fixed to the specified size. This is a good
choice if, for example, you are building a geological model froma map and wish to define the
model extents based on information on themap.

l The second option is to define extents based on other objects in the project. This is done by
selecting the other object from the Enclose Object list that appears in many Leapfrog Geo
screens.

For both methods, the new object’s extents are fixed to the selected size. Using the Enclose
Object list does not link the two objects, it is simply using the X-Y-Z coordinates of the
original object as the basis for the new extents.
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For example, here, a geological model’s extents could be defined using the lithology segments
used as the base lithology:

When creating some objects, you have the option of sharing extentswith another object. This is
the casewith editablemeshes ( ), where you can choosewhether themesh has its own extents
or shares extentswith other objects in the project. Shared extents are updated when the original
object’s extents are updated.

If you are unsure about relationships between objects, expand them in the project tree to view
more information. Here, twomeshes have been defined from the same set of points:

The first mesh shares its extentswith another object in the project, which is indicated by the
hyperlink. The second mesh has no hyperlink; it has its own extents that are not updated by
other objects in the project.

Geological models and interpolants are created with a basic set of rectangular extents that can
then be refined by adding extents created fromother data in the project. Creating extents is a
useful way of restricting modelling to a particular area of interest. For example, modelling can
be restricted to a known distance fromdrillhole data by applying a distance function as a lateral
extent. SeeModifying a Geological Model’s Boundary formore information.
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Interpolant Functions
Leapfrog Geo’s powerful 3D interpolation engine can interpolate any numeric data (e.g. ore
grade or piezometric head measurements) to describe how a real, numerical quantity varies in
three dimensional space. Interpolation produces an estimate or “interpolated value” of a
quantity that is not known at a point of interest but is known at other points.

The simplest way to estimate values is to take the average of known values. Using thismethod,
estimated values are the same everywhere, regardless of the distance fromknown data.
However, this is not ideal as it is reasonable to assume that an estimated valuewill bemore
heavily influenced by nearby known values than by those that are further away. The estimates
for unknown pointswhen varying the distance fromknown point values is controlled by the
interpolant function. Any interpolation function and the various parameters that can be set for
each will produce a model that fits all the known values, but theywill produce different
estimates for the unknown points. It is important to select interpolation functions and
parameters that make geologic sense. It may be necessary to identify a location that models
predict differently, and plan drillholes to identify the best fit option.

Leapfrog Geo uses twomain interpolant functions: the spheroidal interpolant function and the
linear interpolant function. See The Spheroidal Interpolant Function and The Linear
Interpolant Function formore information.

The Spheroidal Interpolant Function
In common cases, including whenmodelling most metallic ores, there is a finite range beyond
which the influence of the data should fall to zero. The spheriodal interpolant function can be
used whenmodelling in these cases.

The spheroidal interpolant function closely resembles a spherical variogram, which has a fixed
range beyond which the value is the constant sill. Similarly, the spheroidal interpolant function
flattens out when the distance fromX is greater than a defined distance, the range. At the
range, the function value is 96% of the sill with no nugget, and beyond the range the function
asymptotically approaches the sill. The chart below labels the y-axis interpolant. A high value
on this axis represents a greater uncertainty relating to the known value, given its distance from
X. Another way to think of this is that higher values on this axis represent a decreasing weight
given to the known value.
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Known valueswithin the range are weighted proportionally to the distance fromX. Known
values further fromX than the rangewill all be given approximately the sameweight, and have
about the same influence on the unknown value. Here, points A and B are near X and so have
the greatest influence on the estimated value of point X. PointsC and D, however, are outside
the range, which puts themon the flat part of the spheroidal interpolant curve; they have
roughly the same influence on the value of X, and both have significantly less influence than A
or B:

The rest of this topic describes the parameters used to define a spheroidal interpolant. These
parameters are Sill, Nugget, Nugget to Sill Ratio, Base Range, Alpha, Drift and Accuracy.

To edit the parameters for an interpolant, double-click on the interpolant in the project tree and
click on the Interpolant tab. The graph on the tab showshow the interpolant function values
varywith distance and is updated as you change interpolant parameters:

The yellow line indicates the Base Range. For this interpolant, the value of the interpolant is
offset by the value ofNugget.
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Sill

The Sill defines the upper limit of the spheroidal interpolant function, where there ceases to be
any correlation between values. A spherical variogram reaches the sill at the range and stays
there for increasing distances beyond the range. A spheroidal interpolant approaches the sill
near the range, and approaches it asymptotically for increasing distances beyond the range.
The distinction is insignificant.

Nugget

TheNugget represents a local anomaly in sampled values, one that is substantially different
fromwhat would be predicted at that point, based on the surrounding data. Increasing the
value ofNugget effectively placesmore emphasis on the average values of surrounding
samples and less on the actual data point, and can be used to reduce noise caused by
inaccuratelymeasured samples.

Nugget to Sill Ratio

It is theNugget to Sill ratio that determines the shape of the interpolant function. Multiplying
both these parameters by the same constant will result in an identical interpolant. Here, the
interpolant on the left has a nugget of 3 and a sill of 10; the one on the right has a nugget of 9
and a sill of 30. Note that because the nugget and sill have been increased by the same factor,
the function has the same shape.

Base Range

The Base Range is the distance at which the interpolant value is 96% of the Sill, with noNugget.
The Base Range should be set to a distance that is not significantly less or greater than the
distance between drillholes, so it can reach between them. As a rule of thumb, it may be set to
approximately twice the average distance between drillholes.
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Here the effect of different range settings on the value of X is demonstrated using our trivial
example of four drillholes:

When the range is set to 1, it is too small to describe any real effect between drillholes. When the
range is set to 30, distant drillholes havemore influence, increasing the spatial continuity. Also
illustrated is the range set to approximately the average distance between drillholes (range = 4)
and the range set to about twice the average distance between drillholes (range = 8). Of these,
the range set to 8might be the best choice.
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Alpha

The Alpha constant determines how steeply the interpolant rises toward the Sill. A low Alpha
valuewill produce an interpolant function that risesmore steeply than a high Alpha value. A
high Alpha value gives points at intermediate distancesmoreweighting, compared to lower
Alpha values. This figure charts an interpolant function for each alpha setting, using a nugget of
8, sill of 28, and range of 5000. A spherical variogram function is included for comparative
purposes. The inset provides a detailed view near the intersection of the sill and range.

An alpha of 9 provides the curve that is closest in shape to a spherical variogram. In ideal
situations, it would probably be the first choice; however, high alpha values requiremore
computation and processing time, asmore complex approximation calculations are required. A
smaller value for alpha will result in shorter times to evaluate the interpolant.

The following demonstrates the difference between alpha = 3 and alpha = 9:

There is a measurable difference between the estimates at the point being examined, but for
many purposes, using a lower alpha will result in satisfactory estimates and reduced processing
time.
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The effect of the alpha parameter on the spheroidal interpolant in Leapfrog Geo is different
to the effect of the alpha parameter in Leapfrog Mining 2.x. If Alpha is set to 9 in Leapfrog
Geo, the range corresponds to the range in Leapfrog Mining 2.x. To convert fromLeapfrog
Mining 2.x to Leapfrog Geowhere the alpha is not 9, apply the following scale factors to the
Leapfrog Mining 2.x range value to find the corresponding range in Leapfrog Geo:

Alpha Scale factor

3 1.39

5 1.11

7 1.03

For example, if in a Leapfrog Mining 2.x project, the alpha is 5 for a range of 100, the
corresponding range in Leapfrog Geowill be 111.

Drift

TheDrift is a model of the value distribution away fromdata. It determines the behaviour a long
way from sampled data.

l Constant: The interpolant goes to the approximated declustered mean of the data.

l Linear: The interpolant behaves linearly away fromdata, which may result in negative values.

l None: The interpolant pulls down to zero away fromdata.
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Here, the threeDrift options for the interpolant are shown evaluated on grids:

In this example, the boundary is larger than the extent of the data to illustrate the effect of
differentDrift settings.

Away from the data, the value of the interpolant when Drift isConstant and Linear is not
reasonable in this case, given the distance from the data. The low valuewhen Drift isNone is
more realistic, given the distance from the data.
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If when using the spheroidal interpolant you get a grade shell that fills themodel extents, it is
likely that themean value of the data is higher than the threshold chosen for the grade shell in
question. If this occurs, try setting theDrift toNone.

Accuracy

Leapfrog Geo estimates the Accuracy from the data values by taking a fraction of the smallest
difference betweenmeasured data values. Although there is the temptation to set the Accuracy
as low as possible, there is little point to specifying an Accuracy significantly smaller than the
errors in themeasured data. For example, if values are specified to two decimal places, setting
the Accuracy to 0.001 ismore than adequate. Smaller valueswill cause the interpolation to run
more slowly and will degrade the interpolation result. For example, when recording to two
decimals, the range 0.035 to 0.044 will be recorded as 0.04. There is little point in setting the
accuracy to plus orminus 0.000001 when intrinsically values are only accurate to plus orminus
0.005.

The Linear Interpolant Function
Generally, estimates produced using the linear interpolant will strongly reflect values at nearby
points and the linear interpolant is a useful general-purpose interpolant for sparsely and/or
irregularly sampled data. It workswell for lithology data, but is not appropriate for valueswith a
distinct finite range of influence.

The linear interpolant function ismulti-scale, and, therefore, is a good general purposemodel.
It workswell for lithology data, which often has localised pockets of high-resolution data. It can
be used to quickly visualise data trends and whether or not compositing or transforming values
will be required. It is not appropriate for valueswith a distinct finite range of influence as it
aggressively extrapolates out from the data. Most ore grade data is not well interpolated using a
linear interpolant function.

The linear interpolant function simply assumes that known values closer to the point you wish
to estimate have a proportionally greater influence than points that are further away:

In the above diagram, points A and Bwill have themost effect on point X as they are closer to X
than pointsC and D. Using the linear interpolant function in Leapfrog Geo gives a value of 7.85,
which is between the nearby high grade values of A (10) and B (7). Because of their distance
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fromX, the low grade values at C and D have a much weaker effect on the estimate of point X,
and they have not dragged the estimate for X lower.

This topic describes the parameters used to define a linear interpolant. These parameters are Sill
and Base Range, Nugget, Drift and Accuracy.

To edit the parameters for an interpolant, double-click on the interpolant in the project tree and
click on the Interpolant tab. The graph on the tab showshow the interpolant function values
varywith distance and is updated as you change interpolant parameters:

The yellow line indicates the Base Range. For this interpolant, the value of the interpolant is
offset by the value ofNugget.
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Sill and Base Range

A linear interpolant has no sill or range in the traditional sense. Instead, the Sill and Base Range
set the slope of the interpolant. The Base Range is the distance at which the interpolant value is
the Sill. The two parameters sill and range are used instead of a single gradient parameter to
permit switching between linear and spheroidal interpolant functionswithout also
manipulating these settings.

Nugget

TheNugget represents a local anomaly in values, one that is substantially different fromwhat
would be predicted at that point based on the surrounding data. Increasing the value of
Nugget effectively placesmore emphasis on the average values of surrounding samples and
less on the actual data point, and can be used to reduce noise caused by inaccuratelymeasured
samples.

Drift

TheDrift is a model of the value distribution away fromdata. It determines the behaviour a long
way from sampled data.

l Constant: The interpolant goes to the approximated declustered mean of the data.

l Linear: The interpolant behaves linearly away fromdata, which may result in negative values.

© 2017 ARANZ Geo Limited



Accuracy | 105

Here, the twoDrift options for the interpolant are shown evaluated on grids:

In this example, the boundary is larger than the extent of the data to illustrate the effect of
differentDrift settings.

Accuracy

Leapfrog Geo estimates the Accuracy from the data values by taking a fraction of the smallest
difference betweenmeasured data values. Although there is the temptation to set the Accuracy
as low as possible, there is little point to specifying an Accuracy significantly smaller than the
errors in themeasured data. For example, if values are specified to two decimal places, setting
the Accuracy to 0.001 ismore than adequate. Smaller valueswill cause the interpolation to run
more slowly and will degrade the interpolation result. For example, when recording to two
decimals, the range 0.035 to 0.044 will be recorded as 0.04. There is little point in asking
Leapfrog Geo tomatch a value to plus orminus 0.000001 when intrinsically that value is only
accurate to plus orminus 0.005.
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Data Types

This section describes how to import and workwith data in Leapfrog Geo. The first section
describes how to use the table dialog, how to fix errors in data tables and how to build queries.
Later sections describeworking with the different types of data Leapfrog Geo supports.

See Visualising Data in Analysing Data for information about using the shape list and shape
properties panel to display data.

Leapfrog Geo is unit-less and adopts the units used in the data you import. For example, if
your imported data is in metres, the units displayed will bemetres, and figures such as
resolution, measured distances, slicer thicknesswill be in metres. It is important, therefore, to
be consistent in the units used in the data you import. If you are importing data that uses
different coordinate systems, you will need to pre-process the data so that it is using the
same coordinate system.

The Table Dialog
To view the contents of a data table, double-click on it in the project tree. The Tablewindow
will appear:

Click onQuery to open up the query editor. SeeQuery Filters formore information on how to
build and use queries.

If the Ignored column is ticked, then Leapfrog Geo completely ignores that row, as though it
had been deleted. This is useful for suppressing erroneous data frombeing processed. If a hole
in a collar table is ignored, then all other data associated with that hole (e.g. surveys and interval
measurements) are also ignored.

Collar tables have a trench column that indicateswhether or not the drillhole is froma trench.
When the trench column is ticked for a drillhole, the trench will be desurveyed in a different
manner fromother drillholes. Survey tables haveCompatibility options for changing the
desurveying method for the survey table as a whole. See Survey Table Options formore
information.
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Correcting Data Errors
Leapfrog Geo automatically identifies and flags common data errorswhen data tables are
imported. There are threeways Leapfrog Geomarks tables that contain conflicts or errors:

l Tablesmarked with a red X ( ) contain errors that mean data cannot be used for processing.
These errors can be corrected by opening theDatabase Errorswindow, which is described in
Correcting Errors in Leapfrog Geo.

l Numeric data columnsmarked with a red X ( ) contain non-numeric values, which means
that the rules that are used to handle non-numeric and negative values need to be reviewed.
If a table has data that contain non-numeric and negative values, the affected rows cannot
be used for further processing until the rules are verified, which is described in Special Values.

l Tablesmarked with a yellow exclamation mark ( ) contain warnings. Affected rows can be
used for further processing, but the information in thewarning can indicate that the data
requires further attention. For example, if a warning indicates there is data missing for a
drillhole defined in the collar table, it may be that a drillhole has been duplicated or that not
all required data files have been loaded. Warnings are listed along with table errors in the
Database Errorswindow.

Until errors are corrected, the rows that contain those errors are excluded for all processing that
uses the table, including viewing in the scene. For example, if the ID for a collar position
contains an invalid coordinate, that collar will not be displayed in the scene as its location is not
known. Likewise, any processing will ignore data associated with this drillhole.

It isworth correcting errors as soon as possible, as correcting them later can result in significant
recomputation time.

When a table contains errors and warnings, only the errorswill be apparent in the project
tree view. However, all errors and warnings relevant to a particular table will be displayed in
theDatabase Errorswindow.

There are two approaches to correcting errors in data:

l Correct the data in the primary source. Export the errors as described in Exporting Data
Errors. Then, when the errors have been corrected, reload the drillhole data as described in
Reloading Drillhole Data.

l Correct the data in Leapfrog Geo. If you need a record of corrected errors, first export the
errors as described in Exporting Data Errors. Thismust be done first, as once errors have
been corrected in Leapfrog Geo, they cannot be exported, as they no longer exist. Then
correct errors as described in Correcting Errors in Leapfrog Geo.

Exporting Data Errors

If you need a record of corrected errors, first export the errors. Thismust be done first, as
once errors have been corrected in Leapfrog Geo, they cannot be exported, as they no
longer exist.
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There are two options for exporting drillhole data errors:

l Export all errors in the drillhole data set.

l Export only the errors froma single table.

To export all errors in the drillhole data, right-click on theDrillholes object and select Export
Errors. The Export Drillhole Errorswindowwill appear:

The list shows the files that will be created, one for each table that contains errors. Choose a
folder where the fileswill be saved, then enter a Base file name, which will be added to the
front of each file name.

Click Export to export the error files.

To export errors froma single table, right-click on that table and select Export Errors. Choose a
location where the file will be saved and click Save.

Correcting Errors in Leapfrog Geo

If you require a record of the errors in drillhole data, export the errors as described in
Exporting Data Errors before starting to correct the errors in Leapfrog Geo.

To correct errors in a data table, right-click on the table and select Fix Errors. The Errors
windowwill appear. Expand the list to view the details of the selected error:

When a row that contains an error is selected, a red box indicates the source of the error.

Errors are automatically grouped by Typewhen the Errorswindow is opened. If there aremany
errors, you may find it useful to view themgrouped by Table orHoleID. You can change the size
of the Errorswindow and the columns in the table to viewmore information easily. When you
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have finished fixing errors, click the Save button ( ). Leapfrog Geowill then update the
database.

There aremany possible sources of errors. Some useful techniques for fixing errors are:

l Checking for Missing Files

l Ignoring Errors

l Ignoring Duplicates (Points Data Tables)

l Modifying Data

l Fixing Collar Max Depths (Drillhole Data Tables)

l Replacing All

l Replacing a Selection

Checking for Missing Files

Sometimes data is spread across several files and not all files have been imported. When you
havemany errors in freshly imported data, make sure that all necessary files have been
imported.

Ignoring Errors

Ticking the Ignored box for a row results in that row being omitted fromall processing, as
though it has been deleted.

Ignoring Duplicates (Points Data Tables)

In points data tables, duplicates rowswill be flagged as errors. Click the Ignore Duplicates
button ( ). When you save the table, all duplicate rowswill bemarked as Ignored.

Modifying Data

You can double click on any cell to edit its content, except for the id column. If the cell you wish
to edit is already selected, press the space bar to start editing.

Changesmade to data in thisway are immediately saved to the database.

Fixing Collar Max Depths (Drillhole Data Tables)

In drillhole data tables, if there is a drillhole segment that falls beyond themaximumdepth
defined in the collar table, a maxdepth exceeded error will be reported. To fix this error, click on
the Fix Max Depths button ( ). This results in the collar table being updated with a maximum
depth value that reflects the data in the interval tables.
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Replacing All

With Replace All, you can replace an incorrect value that occursmultiple times in a column. To
do this, click theReplace All button ( ). Select theColumn to search and enter the new value:

ClickReplace All Occurrences tomake the changes.

Replacing a Selection

You can also select a number of rows and replace values in a selected column with a single
value. To do this, use the Shift and Ctrl keys to select the rows you wish to edit, then click the
Edit button and selectWrite to Selected Rows:

In the fields that appear, enter theNew value, then click theWrite to Selected Rows button:
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Special Values
Assay data often contains special values to represent different situations, such as grade values
that are below a detection limit, cores that have been lost or segments that were not sampled.
In addition, it is not uncommon for a drillhole to contain some intervals that have no values.

When drillhole data tables and points data are imported, Leapfrog Geowill mark columns
containing non-numeric special values and missing intervals so that you can review these
missing and non-numeric values and determine how Leapfrog Geowill handle them. For
example, here numeric data columns that contain errors aremarked with a red X:

To review these errors, double-click on the column. The Invalid Value Handlingwindowwill
appear:

Leapfrog Geowill automatically set missing and non-numeric intervals to be omitted from
further processing. Negative values are automatically set to keep. To change the Action, select
another action from the list:

l Select replace to enter a numeric value to be used for further processing.

l Select keep to use a negative value in further processing.
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For non-numeric and negative values, all values are initially treated as a single rule. However, if
values have different meanings, you can define specific rules to determine how each value is
handled. To do this, click on the Add Rule button. Thewindow that appearswill show the
values present in the data. To define a new rule for a specific value:

l Select that value in the list.

l Tick the box for The value I want is not in the list.

l Enter the Value.

l ClickOK.

In the Invalid Value Handlingwindow, the valuewill be listed separately and you can choose
the Action to apply.

Once you have reviewed the rules that will be applied to the column, tick the These rules have
been reviewed box and clickOK. The ruleswill be applied and used in further processing.

When you open a data table, the original valueswill be displayed. In all further processing of
that data, the assigned special valueswill be used.

Query Filters
Query filters can be used to select or view a subset of rows in a table. When used on a collar
table, this amounts to selecting collars. When used on an interval table, measurement intervals
are selected. Query filters can be used tomodel using a subset of data and to filter information
displayed in the scenewindow.

A query can be created for any type of table in a project, including GIS data, points data and
structural data.

When a query filter has been defined for an object and the object is displayed in the scene, the
query filter can be applied by clicking on the object in the shape list and selecting the query filter
in the shape properties panel:
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For a drillhole data table, this displays only the data selected by the filter. The trace lines
remain displayed in the scene. To filter trace lines, tick the Filter trace lines box:

Query filters defined for collar tables are available to all other drillhole data tables.

The rest of this topic describes how to build queries. It is divided into:

l Creating a New Query Filter

l Leapfrog Geo Query Syntax

l Building a Query

l Advanced Queries

Creating a New Query Filter
To create a query filter, right-click on the required table in the project tree and selectNew
Query Filter. TheQuery Filterwindowwill appear:

Type the required criteria into theQuery box, using the query syntax described below. Press
Ctrl-Enter for a new line in longer queries. Click the ... button formore advanced query building
options, which are described in Building a Query and Advanced Queries below.

Assign the filter a name and clickOK to save it. It will appear in the project tree under the table to
which it applies. To apply a query filter to the scene, select the object in the shape list, then
select the filter from theQuery filter list in the shape properties panel:

© 2017 ARANZ Geo Limited



Leapfrog GeoQuery Syntax | 114

In this case, because the query filter was created for the collar table, it is also available for the
lithology table.

Leapfrog Geo Query Syntax
The Leapfrog Geo query syntax is based on theWHERE clause of the Structured Query
Language (SQL) with some restrictions:

l Unary operators are not allowed

l SQL functions cannot be used

l The SELECT statement should not be used (as in 'holeid in (SELECT holeid FROM ...)')

l Following statements are also prohibited: CASE, WHEN orMATCH

There is also onemain SQL extension:

l IN and NOT INwill accept a partition group for the value list. E.g. 'zone IN layers.weathered'
where "layers" is a partition of the "zone" column that has a group called 'weathered'.

These are some examples of valid Leapfrog Geo query statements:

l holeid in ('m-001', 'm-002')

l holeid not in ('m-001', 'm-002')

l holeid not like 'MAR%'

To enter a query that contains an apostrophe, enter two apostrophes. For example, the
following querywill result in an error:

Adding the second apostrophe results in a valid query:

TheQuery box allows the following shortcut queries:

l Typing a single word will match all hole-ids starting with that string. For example, typing
"MAR" is a shortcut for "holeid like 'MAR%'"
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l Typing a comma-separated list of wordswill match all hole-ids that exactlymatch the given
words. For example typing "M001, M002" is a shortcut for "holeid in ('M001', 'M002')".

Building a Query
Many common queries can be built using the Build Querywindow:

Thiswindow aims to be easy to use rather than comprehensive in its support for the full
Leapfrog Geo query syntax. Formore advanced queries, click on the Advanced button. See
Advanced Queries formore information.

To add a criteria, clickColumn to view a list of columns available in the table. Select a Test and
enter a Value. What can be entered for the Value dependson the type of column and test
selected.

Quotes are not required around text values entered in the value column as they are in SQL.
Leapfrog Geowill add quotes and brackets to the value "MX, PM" tomake a valid SQL list of
strings "('MX', 'PM')" when the query is saved.

Click on the Apply button to apply to query to the context in which the dialog wasopened.

Use theDelete button to delete the criteria in the selected row and the Add button to add a
blank row.
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Advanced Queries
The Advanced Querywindow provides a powerful and flexible query building using the
Leapfrog Geo query language.

Enter the query in theCriteria to Match area on the left. The query is displayed as a tree
structure with AND and OR terms as the branch nodes and conditions as the leaves. Use the
Delete button to delete a row from the query and the Add button to add a blank row. The
Check button can be used at any time to check if the current query statement is valid. Below the
buttons is a box showing the raw SQL formof the query.

Except for the arrow buttons, the buttons down themiddle of the dialog are used for entering
values into the query. The arrow buttons are used formoving the currently selected criteria to a
different position in the query. TheDate, List and Value buttonswill open a builder dialog for
the column selected in the current row. If there is no column found or the column is of the
wrong type, an errormessage is displayed.

The tree on the right contains all the columns available to the query. Double-click on a column
name to insert it into the query.
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GIS Data, Maps and Images
Often the first data imported into a new project is information that sets the coordinates for the
project as a whole. This includesGIS data, maps, aerial photos and 2D grids. This section
describes importing and working with GIS data and images.

You can view the attribute table formost GIS data objects by right-clicking and selecting
Attribute Table. You can also create query filters that can be used when displaying the GIS
object. See The Table Dialog andQuery Filters formore information.

If, during the course of a project, GIS data changes, it can be reloaded and models that are
dependent on that data will automatically be updated.

Importing Vector Data
Vector data formats Leapfrog Geo supports include:

l Shape Files (*.shp)

l MapInfo Files (*.tab, *.mif)

l ESRI Personal GeoDatabase Files (*.mdb, *.accdb)

You can also import data fromMapInfo and ESRI databases. See Importing a MapInfo
Batch File and Importing Data from an ESRI Geodatabase formore information.

To import vector data, right-click on theGIS Data, Maps and Photos folder and select Import
Vector Data. Navigate to the folder that contains the GIS data and select the file. You can select
multiple files using the Shift and Ctrl keys.

ClickOpen to begin importing the data.

If you are importing a single file, the Import GIS Vector Datawindowwill show a summary of
the data in the selected file:

You can choosewhat field in the data to use for the Elevation Field from the list.
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If you are importing multiple files, all files being imported are listed in the Import GIS Vector
Datawindow and no summary of each file is displayed:

Data is automatically clipped to the clipping boundary, but you can change how the data is
filtered to suit any bounding box that exists in the project. If you do not wish to clip the data,
untick the Filter Data box.

ClickOK to add the data to the project. The object or objectswill appear in the project tree
under theGIS Data, Maps and Photos folder. You can then view an object’s attributes by right-
clicking on it and selecting Attribute Table.

When importing files, you may be prompted to select whether or not to filter elevation data.
If you wish to use another data source for your elevation data, select Filter Data. For
example, if you import a GIS line that has suspect elevation data, you can discard the
elevation data and set the elevation from the topography, as described in Setting Elevation
for GIS Objects and Images.

If data changes outside the project, it can be reloaded as described in Reloading GIS Data.

Importing a MapInfo Batch File
You can import a collection of GIS data exported fromMapInfo. TheMapInfo file can include
points, lines, polygons, images and elevation grids.

To import GIS data in thisway, right-click on theGIS Data, Maps and Photos folder and select
Batch Import > from MapInfo. In thewindow that appears, navigate to the folder that contains
theMapInfo batch file, which is an XML file. ClickOpen.
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The data that can be imported will be displayed and you can select which files to import:

You can select multiple files using the Shift and Ctrl keys.

Data is automatically clipped to the clipping boundary, but you can change how the data is
filtered to suit any bounding box that exists in the project. If you do not wish to clip the data,
untick the Filter Data box.

ClickOK to import the selected files, which will be added to theGIS Data, Maps and Photos
folder as a group ( ), with the exception of elevation grids, which will be added to theMeshes
folder.

Points, lines and polygons can be reloaded on an individual basis, which is described in
Reloading GIS Data.

Importing Data from an ESRI Geodatabase
You can import points, lines and polygons froman ESRI geodatabase. However, the import of
raster data is not supported.

To import GIS points, lines and polygons in thisway, right-click on theGIS Data, Maps and
Photos folder and select Batch Import > from ESRI Geodatabase. In thewindow that appears,
navigate to the folder that contains the database and clickOpen.

Leapfrog Geo imports uncompressed ESRI geodatabases.
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The data that can be imported will be displayed and you can select which files to import:

You can select multiple files using the Shift and Ctrl keys.

Data is automatically clipped to the clipping boundary, but you can change how the data is
filtered to suit any bounding box that exists in the project. If you do not wish to clip the data,
untick the Filter Data box.

ClickOK to import the selected files, which will be added to theGIS Data, Maps and Photos
folder as a group ( ). Data in the group can be reloaded individually or as a group, which is
described in Reloading GIS Data.

Reloading GIS Data
If, during the course of a project, GIS points, lines and polygons change, they can be reloaded
and dependent modelswill automatically be updated. Objects originally imported as part of an
ESRI database ( ) can be reloaded individually or as part of the group.

Although the GIS data will be overwritten, any elevation data set in Leapfrog Geowill be
retained.

Reloading Points, Lines and Polygons
To reload a GIS point, line or polygon, right-click on it in the project tree and select Reload
Data. Navigate to the folder containing the GIS file and select the file. ClickOpen.

The process is the same as importing GIS data. ClickOK to reload the data. The original data will
be overwritten and dependent objectswill be updated to reflect the new data.

Reloading an ESRI Database
To reload an ESRI database, right-click on it in the project tree and select Reload Data. In the
window that appears, select the layers to reload, then clickOK.

Points, lines and polygons imported as part of an ESRI database can also be reloaded on an
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individual basis.

2D Grids
Leapfrog Geo imports the following 2D grid formats:

l Arc/Info ASCII Grid (*.asc, *.txt)

l Arco/Info BinaryGrid (*.adf)

l Digital Elevation Model (*.dem)

l Intergraph ERDAS ERMapper 2D Grid (*.ers)

l ESRI .hdr Labelled Image (*.img, *.bil)

l SRTM .hgt (*.hgt)

l Surfer ASCII or BinaryGrid (*.grd)

2D grids can also be imported fromMapInfo files. See Importing a MapInfo Batch File for
more information.

To import a 2D grid, right-click on theGIS Data, Maps and Photos folder and select Import 2D
Grid. Navigate to the folder that contains grid and select the file. ClickOpen to begin importing
the data.

The Import 2D Gridwindowwill appear, displaying the grid and each of the bands available.
Select the data type for each band and set the georeference information, if necessary. See
Importing a Map or Image for information on georeferencing imported files.

Once the grid has been imported, you can set its elevation, which is described in Setting
Elevation for GIS Objects and Images.

When you display the grid in the scene, select the imported bands from the shape list:

Grids can be displayed as points ( ) or as cells and the values filtered, as described in Displaying
Points.

Importing a Map or Image
Image formats Leapfrog Geo supports include:

l PNG Files (*.png)

l JPEG Files (*.jpg, *.jpeg)

l TIFF and GeoTIFF Files (*.tiff, *.tif)
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l WindowsBitmap Files (*.bmp)

l Graphics Interchange Format Files (*.gif)

Images larger than 16384 by 16384 pixelswill be scaled down. Reducing your images in size
below this limit will avoid scaling; you can do this by cropping the image during the import
process or by scaling down the image in an external image editor.

If the file contains georeference information, it toowill be imported.

To import a map or image, right-click on theGIS Data, Maps and Photos folder and select
Import Map. Navigate to the folder that contains the GIS data file and select the file. The
Import Imagewindowwill be displayed:

The rest of this topic describes georeferencing images. It is divided into:

l Georeferencing the Image

l Manual Georeferencing

l Automatic Georeferencing

l Exporting a Georeferenced Image

The three referencemarkers ( , , ) are used to set coordinates for the image in the scene. If
the image is the first object added to the project, thiswill, in effect, set the coordinate system for
the project.

The scenemarkers ( , , ) let you copy georeference information from the scene.

Cropping the image to only the area of interest will reduce video RAM usage and may improve
graphics performance. To crop the image, click on theCrop Image button ( ) at the top of the
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window, then drag around the part of the image you wish to use. Click on theRemove Crop
button ( ) to clear the cropping.

Georeferencing the Image
Adding georeference data to a map will set the location of themap in the three-dimensional
viewer. It is often used as a first step in setting the coordinates for the project as a whole.

Manual Georeferencing
If the image does not contain georeference information, you will need to add it manually by
adding the three referencemarkers ( , , ) to the image. To select a marker, click on its
marker button (Marker 1,Marker 2 orMarker 3), then move it to the required location on the
image using themouse or the arrow keys.

Once each marker is correctly positioned, enter the real-world X and Y coordinates for each
marker:

There are twoways to do this:

l Enter the coordinates for each marker in the East (X) and North (Y) fields. As you enter the
coordinates, the positions of themarkerswill be displayed in the scene.

l Copy coordinates from the scene using the three scenemarkers ( , , ).
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The second method is useful when you already have other objects correctly georeferenced in
the project. For example, if you have a largermap in the project and wish to import a more
detailed map, you can copy the coordinates from the georeferenced map to the detailed one.
To do this, move the Import Map tab so you can see enough of the scene towork in both
windows. Next:

l In the Import Map tab, position themarker ( , , ) on the image being imported.

l Click the corresponding copy coordinatesmarker ( , , ).

l Zoom in to the point in the scenewindowwhere you wish to place themarker and click.

The coordinates in the scenewill be copied to the Import Map tab.

Once you have set the coordinates for each marker, clickOK to return to themain window.
Once Leapfrog Geo saves the image, it will appear in the project tree under theGIS Data, Maps
and Photos folder.

Automatic Georeferencing
If the image contains georeference data, it will automatically be displayed. If the georeference
data in the imported image uses a different coordinate system than that used for the project,
you can change the georeference data by ticking theOverride georeference data from image
box, then editing the information.

ClickOK to import the image. It will appear in the project tree under theGIS Data, Maps and
Photos folder.

Exporting a Georeferenced Image
Leapfrog Geo exports georeferenced images asGeoTIFFs. To do this, right-click on it in the
project tree and select Export. You will be prompted for a filename and location. Click Save.

Setting Elevation for GIS Objects and Images
You can set the elevation for GIS objects and images by:

l Using a fixed elevation

l Using the elevation data fromone of the object’s attributes

l Using the elevation data froma surface in the project

The options available depend upon the type of object.

Fixed Elevation From Attribute From Surface

GIS lines X X X

GIS points X X X

2D grids X - X

GIS lines drawn in Leapfrog Geo X - -
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Fixed Elevation From Attribute From Surface

GIS lines extracted from polylines X - X

Images X - -

To set the elevation for a GIS object or an image, right-click on it in the project tree and select
Set Elevation. The Set Elevationwindowwill appear, displaying the available options. Select
the option required and clickOK.

Creating a New GIS Line
There are threeways to create a new GIS lines object in Leapfrog Geo:

l If you do not have GIS data for a topographical feature you wish to use in model building, you
can draw a new GIS line. SeeDrawing a New GIS Line

l If you have two surfaces that intersect, you can generate a new GIS line from their
intersection. You can use any surface in the project, including those that are generated in
building models. SeeCreating a New GIS Line from Intersecting Meshes.

l If you have a polyline you wish to use as a GIS lines object, right-click on it in the project tree
and select Extract GIS Line. The new GIS line ( ) will appear in theGIS Data, Maps and
Photos folder. It is not linked to the original polyline.

To view new GIS line draped on the topography, select the object from theGIS data > GIS
objects list, as described in Topography Display Options.
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Drawing a New GIS Line
GIS lines can be drawn on the slicer or on a surface.

Right-click on theGIS Data, Maps and Photos folder and selectNew GIS Line > From New
Drawing. In thewindow that appears, enter a name for the new object and clickOK.

The object will be created in the project tree and added to the shape list. The scene view will
change to view the objects in the scene fromabove and tools for drawing polylineswill appear.
Click on theDraw lines button ( ) and start drawing in the scene, as described in Drawing in
the Scene.

When you have finished drawing, click the Save button ( ). The new line ( ) will be saved in the
project tree.

You can edit the GIS line by right-clicking on it in the project tree and selecting Edit. If it is in the
shape list, you can edit it by clicking on the Edit button ( ).

Creating a New GIS Line from Intersecting Meshes
You can create a new GIS line from two intersecting meshes. You can use any surface in the
project, including those that are generated in building models.

To create a new GIS line from two intersecting meshes, right-click on theGIS Data, Maps and
Photos folder and selectNew GIS Line > From Intersecting Meshes. In thewindow that
appears, select themeshes to use, enter a name for the new object and clickOK.

The new line ( ) will be saved in the project tree. It is not linked to themeshes used to create it
and will not be updated when themeshes are updated.
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Exporting GIS Data
To export GIS data, right-click on the GIS data object in theGIS Data, Maps and Photos folder
and select Export. The Export GISwindowwill be displayed:

Select whether elevation information will come from the topography or from theGIS object
itself, or untick theUse 2.5D format with elevations from box to export the object without
elevation information.

Click Export. You be prompted for a filename and location.

© 2017 ARANZ Geo Limited



Drillhole Data
Drillhole data forms the basis for creating models in Leapfrog Geo. Because drillhole data often
contains errors that reduce the reliability of a model, Leapfrog Geo has tools that help you to
identify and correct errors in the data and workwith the data.

In Leapfrog Geo, drillhole data defines the physical 3D shape of drillholes. It ismade up of:

l A collar table, containing information on the location of the drillhole.

l A survey table, containing information that describes the deviation of each drillhole.

l At least one interval table, containing information onmeasurements such as lithology, date
or any numeric or textual values. An interval tablemust also include collar IDs that
correspond to those in the collar table and sample start and end depth.

If you have the Hydrogeologymodule, a screens table can also be imported.

When a project is first created, the only options available via theDrillhole Data folder are for
importing data. See Importing Drillhole Data formore information on these options.

Once data has been added to the project, a Drillholes object will be created that serves as a
container for the tables imported:

When there are errors in the data, the relevant table will bemarked with a red X ( ). See
Correcting Data Errors formore information on fixing drillhole data errors.

Leapfrog Geo also has tools for creating new lithology data columns fromexisting columns in
order to solve problemswith the drillhole data. See Processing Drillhole Data formore
information.

You can open each table by double-clicking on the table ( ). The table will be displayed and
you can make changes. See The Table Dialog.

SeeDisplaying Drillholes in Visualising Data for information about displaying drillhole data in
the scene.

With Leapfrog Geo, you can also plan drillholes and evaluate themagainst anymodel in the
project. See Planning Drillholes formore information.
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Importing Drillhole Data
Drillhole data can be imported from:

l Files stored on your computer or a network location. This process is described below.

l Fromany database that runs an ODBC interface. See Selecting the ODBC Data Source.

l Froman acQuire database. SeeConnecting to an acQuire Database.

For each of these options, once the data source is selected, the process of importing drillhole
data is the same.

Leapfrog Geo expects drillhole data that is stored in a collar table, a survey table and at least
one interval table. Each project can have only one collar file and survey table, but multiple
interval tables can be imported.

A screens table can be imported if you have the Hydrogeologymodule.

Leapfrog Geo imports tables from text files in CSV, ASCII and text formats. See Expected
Drillhole Data Format below formore detailed information on the information required in each
file type.

To import drillhole data, right-click on theDrillhole Data folder and select Import Drillholes.
The Import Drillhole Datawindowwill appear:

For theCollar, click on the Browse button to locate the collar file.

When a collar file is added to the Import Drillhole Datawindow, Leapfrog Geowill look for
interval tableswith names such as “lithology” or “geology” in the same location and will add
them to the Interval Tables list. If an interval table file is not automatically added to the list,
clickAdd and browse for the required file.

If you have the Hydrogeologymodule, you can also add any screens to import by clicking on
the Screens – Browse button.
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In the screen below, a collar file, a survey file and two interval tables have been selected for
import:

Clicking on Import starts the process of importing data. Leapfrog Geowill display a series of
windows, one for each file, and will attempt tomatch the data found in the fileswith the
columns expected, based on the header row in each file. Progress in working through the files is
shown at the top of thewindow:

The file currently displayed is shown in bold.

For *.csv files that use characters other than the comma as the separator, you can specify the
delimiter, comment leader, quote and decimal characters in the Import Drillhole Data
window. Click on CSV characters to enter the characters used in the data files:

The row at the top of the table indicates the data type towhich Leapfrog Geowill assign each
column:
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Click at the top of a column to view the column assignments available. The columns
highlighted below are the column types required for the collar table:

Each type of table being imported will have different column assignments available, but all
table typeswill display:

l The categories columns can be assigned to (top of the list)

l The option to not import the column

l The required columns, e.g. Hole Id, East (X), North (Y) and Elev (Z) for the collar table

l Any optional columns, e.g. Max Depth and Trench

l The option to select a customname

If the header row for a column cannot bematched, Leapfrog Geowill mark the column as “Not
Imported” and you can select from the column assignments available. If you choose not to
import a column then wish to do so later, you can add it later using the Import Column option.
See Importing Columns.

You can alsoworkwith theColumn Summary:
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If you wish to import all columns, click on the Import All Columns button, then check that all
columnshave been correctlymapped.

You can select a column for import, then use it as a Unique Row ID. This can specify the
column being used in other data systems to uniquely identify rows in a table. The columnmust
not contain duplicate values. If a Unique Row ID is specified, Leapfrog Geowill use this column
tomatch rowswhen appending columnsor reloading tables.

If the data contains date and time information and the date and time format is not detected,
click on Date and Time Formats to reveal more information:

If the date and time format you wish to use is not among the options, you can create a custom
format.

For each file, check the columnmapping and clickNext to proceed to the next step. If any of
the information Leapfrog Geo expects ismissing, an errormessagewill appear. Return to the
table and correct the problemdescribed.

Once you have checked the last file, click on Finish. Once Leapfrog Geo has imported the data,
it will appear in the project tree under a newDrillholes object.

SeeCorrecting Data Errors.

Expected Drillhole Data Format
Drillhole data can be imported from files stored on your computer or a network location, from
any database that runs an ODBC interface or froman acQuire database. Once the data source
is selected, the process of importing drillhole data is similar for each data source.

l See Selecting the ODBC Data Source for information on using theODBC interface.

l SeeConnecting to an acQuire Database for information on importing froman acQuire
database.

Leapfrog Geo expects drillhole data that is stored in a collar table and at least one interval table.
Each project can have only one collar file, but multiple interval tables can be imported. This
topic describes the expected format for each type of file:

l The Collar Table

l Interval Tables

l The Screens Table (Hydrogeologymodule only)

l The Survey Table

Leapfrog Geo imports tables from text files in CSV, ASCII and text formats.
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The Collar Table

The collar table should contain five columns:

l A drillhole identifier

l The location of the drillhole in X, Y and Z coordinates

l Themaximumdepth of the drillhole

A collar table can also contain a trench column, and collarsmarked as trencheswill be
desurveyed in a manner different fromother drillholes.

The Hole ID is used to associate data in different tableswith a single drillhole. The Hole ID for a
drillholemust be identical in all tables in order for data to be associated with that drillhole.
Inconsistencies in theway drillholes are identified are common sources of errors.

Themaximumdepth column is optional. If it is present, is used to validate the data imported for
the interval tables. Themaximumdepth specified is often a planned quantity, whereas the
interval table records actual measurements. For this reason, Leapfrog Geo has an option for
fixing themaximumdepth value in the collar table tomatch the data in an interval table.

If maximumdepth information is not included in a collar file, Leapfrog Geowill determine it
from themaximumdepth sampled as indicated by data in the interval tables.

Interval Tables

For interval tables, Leapfrog Geo expects, at minimum, four columns:

l A drillhole identifier

l Start/fromand end/to depths

l A column of measurements

If a drillhole ID in an interval table does not correspond to one in the collar file, the file can still
be imported but the interval table will contain errors.

Supported column types are:

l Lithology columns containing lithologic data, which can be used for geological modelling.

l Numeric columns containing numeric values, which can be used for interpolating data.

l Category columns, which is text representing categories such as company, geologist, or
mineralisation.

l Text columns containing text data that is not categorical, such as comments. Text columns
are not validated when imported.

l Date columns containing date data. Customdate and timestamps formats are supported.

l URL columns. Use the prefix file:/// to link to local files.
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When an interval table is displayed in the scene and an interval is selected, clicking on a link in
the URL column will open the link. This is a useful way of linking to, for example, data files or
core photo images fromwithin Leapfrog Geo:

The Screens Table

A screens table can only be imported if you have the Hydrogeologymodule.

For the screens table, Leapfrog Geo expects a minimumof four columns:

l A drillhole identifier

l Start/fromand end/to depths

l A value column

The Survey Table

For the survey table, Leapfrog Geo expects a minimumof four columns:

l A drillhole identifier

l Depth, dip and azimuth values

By default, Leapfrog Geo assumes that negative dip values point up. If this is not the case, tick
theNegative survey dip points down option.

See Survey Table Options formore information on the drillhole desurveying algorithmsused in
Leapfrog Geo.
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Selecting the ODBC Data Source
To import drillhole data directly fromany database that uses an ODBC interface, right-click on
theDrillhole Data folder and select Import Drillhole Data via ODBC. The Select ODBC Data
Sourcewindowwill appear:

Enter the information supplied by your database administrator and clickOK.

Once the data source is selected, the import process is similar to that described in Importing
Drillhole Data.

Connecting to an acQuire Database
There are two options for connecting to an acQuire database:

l Create a new connection. To do this, right-click on theDrillhole Data folder and select
Import Drillhole Data via acQuire > New Selection. In thewindow that appears, choose
whether to connect using ODBC or DAP. Select the server and clickConnect. Next, enter the
login details supplied by your database administrator.

l Create a connection froman existing selection file. Right-click on theDrillhole Data folder
and select Import Drillhole Data via acQuire > Existing Selection. Navigate to the location
where the selection file is stored and open the file.

Once connected to the database, you will be able to select the required data. When you have
finished specifying the selection, clickOK to import the data. The import process is similar to that
described in Importing Drillhole Data.

Once the drillhole data has been loaded, you can:

l Import additional interval tables. See Importing Interval Tables.

l Appending drillhole data. See Appending Drillholes.

l Reload drillhole data. SeeReloading Drillhole Data.

Saving a Selection

Saving a selection saves the acQuire database in its current state. You can use a selection to
import the same set of drillhole data in new Leapfrog Geo projects.
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To save an acQuire selection, right-click on theDrillholes object in the project tree and select
Save Selection. You will be prompted for a filename and location.

Appending Drillholes
If drillhole data is stored in multiple files or new drillhole data is available, you can import other
files into the project and add them to the existing drillhole data. To do this, right-click on the
Drillholes object and select Append Drillholes.

Append drillhole data when you have new drillholes or wish to add extra length to existing
drillholes. If you wish to refresh drillhole data, overwriting all existing drillhole data, use the
Reload Drillholes option.

The Append Drillholeswindowwill be displayed. Appending drillhole data is similar to
importing the original data (see Importing Drillhole Data):

l If the drillhole data was loaded froma file on your computer or a network location, you will
be asked to specify the file locations. Step through the files, checking theColumn Summary
for each file to ensure that the correct information will be imported, then click Finish to add
the new files.

l If the interval table is stored in an ODBC database, you will be prompted to connect to the
database. See Selecting the ODBC Data Source.

l If your drillhole data is stored in an acQuire database, you will be prompted to connect to the
database. SeeConnecting to an acQuire Database.

Importing Interval Tables
Interval tables that have not been imported during the drillhole data import process can be
added to the project at any time. To add an interval table, right-click on theDrillholes object in
the project tree and select from the options available:

l If the interval table is stored in a file on your computer or a network location, select Import
From File > Interval Values. Leapfrog Geowill ask you to specify the file location, and then
will display the data in the file in the Import Intervalwindow.

l If the interval table is stored in an ODBC database, select Import From ODBC > Interval
Values. You will be prompted to select the data source. See Selecting the ODBC Data
Source.

l If your drillhole data is stored in an acQuire database, select Import From acQuire > Interval
Values. SeeConnecting to an acQuire Database.

Columns required are:

l A drillhole identifier

l Start/fromand end/to depths

l A column of measurements

See Expected Drillhole Data Format formore information on the supported column types.
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Select the required columns and assign the data type for each column. Click Finish to import
the file, which will appear under theDrillholes object.

Importing Columns
Columnsof an interval table that have not been imported during the drillhole data import or
that are stored in a separate file can be added to the table at any time. To do this, right-click on
the interval table in the project tree and selectNew Column > Import Column.

Importing a column is similar to importing interval tables themselves. Leapfrog Geowill ask you
to specify the file location, and then will display the data in the file in the Add Column To Table
window. Select asmany columns to import as required and assign the appropriate data type.
Before finishing, check theColumn Summary to ensure that the correct information will be
imported.

It is not necessary to re-import any columns that are already part of the project. The drillhole ID
and To and Fromdata columns, however, will be used to check the validity of the new column
against existing data. Any rows that do not match will not be imported.

Click Finish to import the new column.

Importing Screens

This feature is only available as part of the Hydrogeologymodule. See Flow Modelling for
more information.

Screens that have not been imported during the drillhole data import process can be added to
the project at any time. To do this, right-click on theDrillholes object in the project tree and
select Import From File > Screens or Import From ODBC > Screens.

When importing froma file, Leapfrog Geowill ask you to specify the file location, and then will
display the data in the file in the Import Screenwindow.

When importing fromODBC, you will first be prompted to select the data source. See Selecting
the ODBC Data Source.

Columns required are:

l A drillhole identifier

l Start/fromand end/to depths

l A value column

Select the required columns and assign the data type for each column. Click Finish to import
the file, which will appear under theDrillholes object.

A Leapfrog Geo project can have only one screens table.
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Importing Point Values Down Drillholes
To import a set of points on drillholes, right-click on theDrillholes object in the project tree and
select Import From File > Point Values or Import From ODBC > Point Values.

When importing froma file, Leapfrog Geowill ask you to specify the file location and then will
display the data in the file in the Import Depth Pointswindow.

When importing fromODBC, you will first be prompted to select the data source. See Selecting
the ODBC Data Source.

Columns required are:

l A drillhole identifier

l Depth

Select the required columns and assign the data type for each column. Click Finish to import
the file, which will appear under theDrillholes object.

Importing LAS Points Down Drillholes
Leapfrog Geo imports LAS points down drillholes in LAS 1.2 and LAS 2.0 formats. An imported
set of LAS files appears as one object with its associated data columnsplus a LAS Drillholes
folder that contains a filter for each drillhole. Importing the data preserves themetadata from
the LAS files, which can be viewed in the Propertieswindow for the LAS points object and in the
Propertieswindow for each drillhole.

To import LAS points down drillholes, right-click on theDrillholes object and select Import
From File > LAS Data. Select the files you wish to import and clickOpen.

Next, the Import LAS Datawindowwill appear. The data displayed in thiswindow is combined
from the selected files, with blank and invalid values indicated by “nan”. For example, if a
drillhole file does not contain columns that are included in other drillhole files, thosemissing
columnswill bemarked as “nan”.

Leapfrog Geo expectsHoleID and Depth columns and will attempt tomatch the data in the
fileswith the expected format. Select the columns to import, then click Finish. The fileswill be
added to the project tree as part of theDrillholes object, as described above.

To view LAS points, add the LAS points object ( ) to the scene. You can also display individual
drillholes by adding their filters to the scene.
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LAS File Mapping

The Propertieswindow for LAS drillholes includes a LAS Mapping tab that showswhat data
files have been used for the selected drillhole:

Right-click on the drillhole and select Properties. This is useful when data for a drillhole
originates in different files.

LAS File Inconsistencies

When importing LAS files, inconsistencies in the files are handled as follows:

l If there are two fileswith the same curve values at the same depth, the duplicate valueswill
be added to the existing column and flagged as overlapping segments. SeeCorrecting Data
Errors formore information about correcting drillhole data errors.

l If there aremore than two fileswith the same curve values at the same depth, Leapfrog Geo
will not be able to import the files. Note the conflicting files shown in the errormessage and
reimport the files, leaving the conflicting files out.

l If there aremultiple logs of the same name in the files, Leapfrog Geowill not be able to
import the data. Edit the LAS file header outside of Leapfrog Geo to change the names.

Importing Downhole Structural Data
Leapfrog Geo supports structural measurements in .csv or text formats. This topic describes
importing downhole structural data tables. Structural data tables that include location
information can also be imported to the Structural Modelling folder. See Importing Planar
Structural Data.
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To import a set of structural data on drillholes, right-click on theDrillholes object in the project
tree and select Import From File > Planar Structural Data or Import From ODBC > Planar
Structural Data.

When importing froma file, Leapfrog Geowill ask you to specify the file location and then will
display the data in the file in the Import Planar Structural Datawindow.

When importing fromODBC, you will first be prompted to select the data source. See Selecting
the ODBC Data Source.

Leapfrog Geo expects columnsdescribing the drillhole identifier, the depth and the structural
orientation. Structural orientation can be specified using either dip and dip azimuth or alpha
and beta.

Match the values in the file to the required column headers, then click Finish to import the file.
The table will appear under theDrillholes object.

If the structural orientation is specified using alpha and beta, the reference line fromwhich the
beta ismeasured can be the bottomor top of the drillhole. When the table is imported, the
default setting isBottom of core. To change this, double-click on the structural data table in
the project tree. Next, click on Compatibility to change the Beta reference mark setting to Top
of core:
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Survey Table Options
To view drillhole desurveying options, double-click on the survey table to open it, then click on
Compatibility. There are two options for changing theway survey table data is handled in
Leapfrog Geo:

When the survey table is imported, Leapfrog Geo sets theNegative survey dip points down
value according to the data in the imported table. When themajority of the dip data in the table
is positive, Leapfrog Geo assumes all these drillholeswill point down and leaves the field
Negative survey dip points down disabled. Whenmost of the values are negative, the field is
enabled. If you are going to change the automatically set value of this field, consider carefully
the implications if there is a mix of drillholes pointing down and up.

When drillhole data is imported, theDesurveying method applied is Leapfrog spherical arc
approximation. The Balanced tangent algorithmoption is compatible with Vulcan and
Minesight. These options are described in more detail below.

Drillhole desurveying computes the geometry of a drillhole in three-dimensional space based
on the data contained in the survey table.

Under ideal conditions, the drillhole path follows the original dip and azimuth established at the
top of the drillhole. Usually, though, the path deflects away from the original direction as a
result of layering in the rock, variation in the hardness of the layers and the angle of the drill bit
relative to those layers. The drill bit will be able to penetrate softer layersmore easily than harder
layers, resulting in a preferential direction of drill bit deviation.

There are a number of paths a drillhole could take through available surveymeasurements, but
the physical constraints imposed by drilling aremore likely to produce smoother paths.
Selecting the desurveying method that gives the best likely approximation of the actual path of
the drillhole will ensure that subsequent modelling is as accurate as possible.

Leapfrog Geo implements three algorithms for desurveying drillholes.
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Spherical Arc Approximation
The default algorithmused in Leapfrog Geo is spherical arc approximation, which is sometimes
referred to as theminimumcurvature algorithm. Downhole distances are desurveyed exactly as
distances along a circular arc:

The algorithmmatches the survey at the starting and end positions exactly and the curvature is
constant between these twomeasurements. At the survey points, the direction remains
continuous and, therefore, there are no unrealistic sharp changes in direction.

If you wish to use spherical arc approximation, there is no need to change any settings.

Raw Tangent
The raw tangent algorithmassumes the drillholemaintains the direction given by the last survey
measurement until the next newmeasurement is reached:

This implies that the drillholemakes sharp jumps in direction whenever a measurement is taken,
which is unlikely, except when the drillhole is being used to define a trench.

To use the raw tangent algorithm for a drillhole, double-click on the collar table in the project
tree. Tick the trench box for the drillholes you wish to desurvey using the raw tangent
algorithm.

Balanced Tangent
The balanced tangent algorithmuses straight lines but attempts to improve the accuracy of the
raw tangent algorithmby assigning equal weights to the starting and end survey
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measurements:

It is an improvement on the raw tangent algorithmbut still suffers froman unrealistic
discontinuity in the drillhole path. It is, however, a better approximation of the overall drillhole
path and is reasonably accurate when the spacing betweenmeasurements is small.

To use the balanced tangent algorithm, double-click on the survey table in the project tree.
Click on Compatibility tab and change theDesurveying method.

Processing Drillhole Data
Once imported and corrected, drillhole data usually requires further processing before any
models are built. Use the techniques described in Displaying Drillholes and Drillhole
Correlation Tool to aid in making decisions on what further processing is required.

Often, selecting a small portion of intervals can be achieved using a query filter (seeQuery
Filters). In some cases, however, you maywish to composite data to focus on a single unit.
Theremay also be issueswith how drillhole data has been recorded; for example, two units
have been catalogued as one, or a single unit may be divided intomultiple units.

Leapfrog Geo has a number of tools for processing drillhole data, including:

l Category Composites. Sometimes unit boundaries are poorly defined, with fragments of
other lithologieswithin the lithology of interest. This can result in very small segments near
the edges of the lithology of interest. Modelling the fine detail is not always necessary, and so
compositing can be used to smooth these boundaries.

l Numeric Composites. Compositing numeric data takes unevenly-spaced drillhole data and
turns it into regularly-spaced data, which is then interpolated. Numeric data can be
composited along the entire drillhole or in selected regions. You can also set the compositing
length from the base interval table.

l Majority Composites. Category data can be composited into interval lengths fromanother
table or into fixed interval lengths. The compositing is based on a majority percentagewhere
each interval is assigned a category based on the category that makes up the highest
percentage of the new interval.

l Grouping Lithologies. The group lithologies tool lets you define a new unit to which existing
units are added. For example, a sandstone deposit might appear in an interval table as
poorly-sorted and well-sorted units. The group lithologies tool lets you group both units into
a single sandstone unit.
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l Splitting Lithologies. Lithology unitsmay be incorrectly grouped, which can become
apparent when you display drillholes in the scene. The split lithologies tool lets you create
new units by selecting from intervals displayed in the scene.

l Interval Selection. If the lithologies in a column are poorly sorted, you can display the
column in the scene and use the interval selection tool to workwith all the segments and sort
them into new units.

l Overlaid Lithology Column. You may have two versions of an interval column, one that
contains draft data and one that contains the final version. The final version may contain
gaps, which can be filled in using the draft version. The overlaid lithology tool lets you
combine the two columns to create a new column.

l Category Column from Numeric Data. When you have numeric data you wish to usewith
the lithology and categorymodelling tools, you can convert the numeric data to a category
column.

l Back-flagging Drillhole Data. Evaluating geological models on drillholes creates a new
lithology table containing the lithologies from the selected model.

Each of these tools creates a new interval table or creates a new column in an existing interval
table, preserving the original data. New tables and columns can be used as the basis for new
models in the project and can be incorporated into existing models using From Other Contacts
options. When a new table is created, you can view it in the scene along with the original table
to see the differences between the processed and the unprocessed data.

If you are working with columns in different interval tables, you can create a newmerged table
that includes columns from these different tables. Columns created in Leapfrog Geo can be
included in a merged table. SeeMerged Drillhole Data Tables.

Category Composites
Sometimes unit boundaries are poorly defined, with fragments of other lithologieswithin the
lithology of interest. This can result in very small segments near the edges of the lithology of
interest. Modelling the fine detail is not always necessary, and so compositing can be used to
smooth these boundaries.

In Leapfrog Geo, you can composite category data in twoways:

l Composite the drillhole data directly. This creates a new interval table that can be used to
build models, and changesmade to the table will be reflected in all models based on that
table. This process is described below.

l Composite the points used to create an object.
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The rest of this topic describes compositing drillhole data directly.

Right-click on theComposites folder, which is in the project tree as part of theDrillholes
object, and selectNew Category Composite. You will be prompted to select from the category
columns available in the drillhole data. Next, theNew Composited Tablewindowwill appear,
showing the options for sorting intervals in the selected column:

Compositing category data sorts segments into three categories:

l Primary. This is the unit of interest. In the case of compositing on intrusion contact surfaces,
thiswill be the interior/intrusive lithology.

l Ignored. These are units that are, generally, younger than the unit of interest and should,
therefore, be ignored in generating contact surfaces.

l Exterior. These are units that occur outside of the unit of interest. For an intrusive lithology,
other lithologies the intrusion contacts should be classified asExterior.

Unspecified intervals can be handled as Ignored, Primary or Exterior.

The additional compositing parameters determine how ignored segments flanked by interior or
exterior segments are handled and the length of segments that will be filtered. Each of these
settings is discussed below.

ClickOK to create the table. Once you have created a composited table, you can edit it by right-
clicking on it and selecting Edit Composited Table.

Converting Ignored Segments

TheConvert enclosed ignored segments setting determines how ignored segments are
handled when they are flanked by either two interior segments or two exterior segments. If
Convert enclosed ignored segments is enabled, Leapfrog Geowill convert enclosed ignored
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segments tomatch the surrounding segments. In caseswhere an ignored segment does not lie
between two interior or exterior segments, it will remain ignored.

If you wish to set a maximumsize for ignored enclosed segments, tick the Shorter than box and
set themaximum length.

If Convert enclosed ignored segments is disabled, this processing does not occur and ignored
segments are never converted. When an intrusive contact surface is created, this setting is
disabled by default.

For example, this scene shows two ignored segments that are flanked by the unit of interest.
BecauseConvert enclosed ignored segments is disabled, the segments remain ignored:
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Enabling Convert enclosed ignored segments results in the segments being converted to the
Primary unit:

Enabling Shorter than and setting it to 4 results in the shorter segment being converted to the
Primary unit and the longer segment remaining Ignored:
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Zooming out, we can see that the ignored segments at the top of the drillholes have not been
converted:

Filtering Short Segments

The Filter primary segments and Filter exterior segments parameters determine how short a
segment must be before it is composited:

l Short Exterior segments flanked byPrimary segmentswill be converted to Primary
segments.

l Short Primary segments flanked by Exterior segmentswill be converted to Exterior
segments.

When the value is set the zero, no segmentswill be converted.

To see how these parameters can smooth the shape of a unit of interest, let’s look at a series of
drillholeswherewewish to create an intrusion boundary based on the red segments. Short
segments are highlighted in the uncomposited intervals:
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An intrusion generated from these uncomposited intervalswill havemore detail than is
necessary formodelling. However, when compositing settings are applied and the short
intervals are converted, we can see that the intrusion boundary ismore geologically reasonable:

Numeric Composites
Compositing numeric data takes unevenly-spaced drillhole data and turns it into regularly-
spaced data, which is then interpolated. Compositing parameters can be applied to entire
drillholes or onlywithin a selected region of the drillhole. For example, you maywish to
composite Au values onlywithin a specific lithology.

There are two approaches to compositing numeric data in Leapfrog Geo:

l Composite the drillhole data directly. This creates a new interval table that can be used to
build models, and changesmade to the table will be reflected in all models based on that
table. This process is described below.

l Composite the points used to create an interpolant. This is carried out by generating an
interpolant and then setting compositing parameters for the interpolant’s values object. This
isolates the effects of the compositing as the compositing settings are only applied to the
interpolant.

Intervals that have no data can have a significant effect when compositing data as they are
ignored by the compositing algorithm. The effect of thesemissing intervals can bemanaged
using theMinimum coverage parameter, but it’s best to assign special valueswhere intervals
have no data. For example, intervals that aremissing data can be assigned a value of 0 or that
of the background mineralisation. See Special Values formore information.

The rest of this topic describes compositing drillhole data directly. It is divided into:

l Creating a Numeric Composite

l Selecting the Compositing Region

l Compositing Parameters
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Creating a Numeric Composite

To create a numeric composite, right-click on theComposites folder and selectNew Numeric
Composite. TheNew Composited Tablewindowwill appear:

Set the compositing region and parameters; this is described in detail below. Then click on the
Output Columns tab to select from the available columnsof numeric data. ClickOK to create
the table.

Double-clicking on the table displays the data in its columns. Edit a composited table by right-
clicking on it and selecting Edit Composited Table.

Selecting the Compositing Region

Compositing parameters can be applied to entire drillholes or onlywithin a selected region of
the drillhole. There are four options for selecting the region in which numeric data will be
composited, and each is discussed below.

Compositing in the Entire Drillhole

For this option, Compositing Parameters are applied to all values down the length of drillholes.
Select Entire drillhole, then set the compositing parameters.

Compositing in a Subset of Codes

If you wish to select specific category codes in which to composite numeric data, there are two
options:

l Subset of codes, grouped

l Subset of codes, ungrouped
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The difference between the two is that for the grouped option, the selected codes are
combined and the sameCompositing Parameters are applied to the grouped intervals:

For the ungrouped option, however, you can set compositing parameters for each code in the
selected Base column:

For the Action column, the options are:

l Composite. Numeric data that fallswithin the selected codewill be composited according to
the parameters set.

l No compositing. Numeric data is not composited within the selected code. The raw,
uncomposited data will be used in creating the new data table.

l Filter out. Numeric data within the selected codewill not be included in the new data table.

Compositing in Intervals

For the Intervals from table option, the interval lengths from the Base table are used to
determine composite lengths. The value assigned to each interval is the length-weighted
average value, and there are no further compositing parameters to set.
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Compositing Parameters

When the compositing region isEntire drillhole, Subset of codes, grouped or Subset of
codes, ungrouped, the interval lengths are determined by applying three compositing
parameters. These parameters are applied as follows:

l The drillholes are divided into intervalswherever numeric data occurs. TheCompositing
length determines the length of each composite interval, and theMinimum coverage length
determineswhether or not residual segments (those shorter than theCompositing length)
are retained for further processing. Composite lengths are generated from the collar down
the drillhole, so any residual segments produced will be at the bottomof the drillhole and
where there is data missing down the length of the drillhole. How residual segments are
handled is described below.

Intervals that have no data can have a significant effect when compositing data as they are
ignored by the compositing algorithm. The effect of thesemissing intervals can bemanaged
using theMinimum coverage parameter, but it’s best to assign special valueswhere intervals
have no data. For example, intervals that aremissing data can be assigned a value of 0 or that
of the background mineralisation. See Special Values formore information.

l The For end lengths less than parameter is applied to determinewhat happens to the
residual segments that may result fromapplying theCompositing length andMinimum
coverage parameters. The three possibilities areDiscard, Add to Previous Interval and
Distribute Equally.

l Composite values are calculated for each composite interval. This is simply the length-
weighted average of all numeric drillhole data that fallswithin the composite interval.

l Composite points are generated at the centre of each composite interval from the composite
values.

Discard

With theDiscard option, residual segments that meet or exceed theMinimum coverage length
are retained; those shorter are discarded.

For example, consider two drillholes. A is 49 metres long and B is 44 metres long. The
Compositing length is set to 10 and the For end lengths less than length is set to 5. There will
be a residual segment 9 metres long for Drillhole A and one 4metres long for Drillhole B.
Drillhole A’s residual segment will be retained as a segment, whereasDrillhole B’s residual
segment will be discarded. This results in:

l Drillhole A: 10m, 10m, 10m, 10m, 9m (residual length >Minimum coverage length so the 9m
segment is kept)

l Drillhole B: 10m, 10m, 10m, 10m (residual length <Minimum coverage length so the 4m
segment is discarded)
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Add to Previous Interval

With the Add to previous interval option, theMinimum coverage length is automatically set to
zero. Residual segments longer than the For end lengths less than value are retained as
separate segments; those shorter are added to the previous interval.

For our two drillholes, when theCompositing length is 10, there will be a residual segment 9
metres long for Drillhole A and one 4metres long for Drillhole B. When For end lengths less
than is set to 5, Drillhole A’s residual segment will be retained as a segment, whereasDrillhole
B’s residual segment will be added to the previous interval. This results in:

l Drillhole A: 10m, 10m, 10m, 10m, 9m (residual length > For end lengths less than length so
the 9m length is kept as a separate segment)

l Drillhole B: 10m, 10m, 10m, 14m (residual length < For end lengths less than length so the
4msegment is added to the previous interval)

Distribute Equally

With theDistribute equally throughout drillhole option, theMinimum coverage parameter is
automatically set to zero. Residual segments longer than the For end lengths less than value
are retained as separate segments; those shorter will have their length distributed among the
other intervals.

For our two drillholes, Drillhole A’s residual segment will be retained as an individual segment,
whereasDrillhole B’s residual segment will have its length distributed among the rest of the
intervals. The segments for each composited drillhole will be:

l Drillhole A: 10m, 10m, 10m, 10m, 9m (residual length > For end lengths less than length so
the 9msegment is kept as a separate segment)

l Drillhole B: 11m, 11m, 11m, 11m (residual length < For end lengths less than length so the 4m
length is distributed among the other intervals)

Majority Composites
Category data can be composited into interval lengths fromanother table or into fixed interval
lengths. The compositing is based on a majority percentagewhere each interval is assigned a
category based on the category that makes up the highest percentage of the new interval. If
two categories are equally represented, the category that occurs further up the drillhole
(closest to the collar) is assigned.

This is useful for comparing lithology and assay data; the intervals froman assay table can be
applied to a category column to produce a new lithology column with the shorter intervals
typical of assay tables. Themajority composite column can then be used to create a merged
table containing both lithology and assay data.
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Drillhole data is composited from theComposites folder, which is in the project tree as part of
theDrillholes object. To create a majority composite, right-click on theComposites folder and
selectNew Majority Composite. TheNew Composited Tablewindowwill appear:

Select the interval table that will be used to specify the intervals for the newmajority composite
or specify a fixed Compositing Length. Next, select the columns that will be composited. Click
OK to create the composite. The composite will be added to theComposites folder in the
project tree. You can edit it by right-clicking on it and selecting Edit Composited Table.

Here assay intervals are shown inside themuch longer lithology intervals. The selected interval
goes from14.0 to 23.7 metres:
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Here a majority composite has been created based on the lithology table using the assay table
intervals. The category column displayed in the scene appears similar to the category column
used to create it, but selecting an interval in the scene shows that the lithology has been
composited into smaller intervals that match the assay intervals:

Grouping Lithologies
The group lithologies tool lets you define a new unit to which existing units are added. For
example, a sandstone deposit might appear in an interval table as poorly-sorted and well-
sorted units. With the group lithologies tool, you can group both units into a single sandstone
unit.

When you group lithologies, the original lithology column is preserved and a new lithology
column is added to the interval table. You can then select the original lithology column or the
new onewhen displaying data and creating models.

To start grouping two ormore lithologies, right-click on the interval table in the project tree and
selectNew Column > Group Lithologies. TheNew Lithology Columnwindowwill appear:

Select the lithology column you wish to use from the Base Column list, then enter a Name for
the new lithology column. ClickOK.
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Awindowwill appear displaying all lithologies in the base lithology column:

In this example, two spellings of Alluviumhave been used and these lithologies should be
combined into a single lithology.

Themost straightforward way to group lithologies is to select the first of the lithologies, then
clickNew Group. A group will be created for the selected lithologywith only that lithology as a
member:
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Next, click on a lithology in theUngrouped Lithologies pane and drag it onto the group:

Grouping lithologies creates a new lithology column and any lithologies left in the
Ungrouped Lithologies panewill be excluded from the new column. For this reason, once
you have grouped the required lithologies, move all remaining lithologies to theGroups
pane by clicking on each lithology, then on theNew Group button. Thiswill make each
remaining lithology a new group with a singlemember:

When you are finished, clickOK to create the new lithology column. It will appear in the project
tree as an additional lithology column in the interval table.

Select the new column from the shape list to display it:

Click on the Edit button ( ) to start editing the selected column.

The other way to group lithologies is to let Leapfrog Geo create the lithology groups.

© 2017 ARANZ Geo Limited



Automatic Lithology Groups | 158

Automatic Lithology Groups

Leapfrog Geo can automatically create lithology groups. To do this, create a new lithology
column, as described above. Click the Auto Group button to reveal more options:

The First letter(s) and Last letter(s) options let you create groups according the namesof the
existing lithologies. ClickGroup to create the new groups.

Here, the first two letters have been used to created a new set of lithologies:

The two alluvium lithologies have been added to a single group.

TheOne group per value option creates a group for each original lithology. You can then drag
and drop lithologies into different groups, move lithologies you do not wish to group back into
theUngrouped Lithologies pane and use theDelete Groups options to remove any empty
groups.

Splitting Lithologies
With the split lithologies tool, you can create new units froma single unit by selecting from
intervals displayed in the scene. When you split lithologies, the original lithology column is
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preserved and a new lithology column is added to the interval table. You can then select the
original lithology column or the new onewhen displaying data and creating models.

The difference between the interval selection tool and the split lithologies tool is that with
splitting lithologies, you are limited to selecting intervals froma single lithology. If you wish to
select intervals frommultiple lithologies, see Interval Selection.

To start splitting a lithology, first add the drillhole data to the scene. Then right-click on the
interval table in the project tree and selectNew Column > Split Lithologies. TheNew
Lithology Columnwindowwill appear:

Select the lithology column you wish to use from the Base Column list, then enter a Name for
the new lithology column. ClickOK.

The Lithologies and Splitswindowwill appear, together with a set of tools that will help you to
select intervals in the scene:

Alluvium (gold) appears both above and below Coarse Sand (blue) and so should be split into
two separate lithologies.

The first step is to select the lithology that will be split in the Lithologies and Splitswindow. In
the example above, Alluvium is already selected.
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Next, click on the Select Intervals button ( ) and click the Add Intervals button ( ). In the
scene, draw a line across each interval you wish to select.

To change thewidth of the line used to select intervals, click on theChange Line Width
button ( ) and enter a new value. You can keep the Set Line Widthwindow open while you
select intervals so you can change the line width as required.

Selected intervals are highlighted in the scene. If you accidentally select thewrong interval,
either:

l Click theRemove Intervals button ( ) and draw across the interval once again.

l Hold theCtrl keywhile drawing across the interval.

You can also:

l Select all visible intervals by clicking on the Select All button ( ) or by pressing Ctrl+A.

l Clear all selected intervals by clicking on theClear Selection button ( ) or by pressing
Ctrl+Shift+A.

l Swap the selected intervals for the unselected intervals by clicking on the Invert Selection
button ( ) or by pressing Ctrl+I.
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Once you have selected some segments, click on the Assign to button in the Lithologies and
Splitswindow and selectCreate New Split:

TheNew Splitwindowwill appear:

Enter a Name for the new lithology, then clickOK. The new lithologywill be created and the
scene updated to reflect the changes:
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Once you have created a new lithology, you can add to it by selecting intervals, then selecting
the lithology from the Assign to list.

When you are finished, click the Save button ( ) and close the Lithologies and Splitswindow.
The new lithology column will appear in the project tree as an additional lithology column in
the interval table.

Select the new column from the shape list to display it:

Click on the Edit button ( ) to start editing the selected column.

Interval Selection
When you wish to select a small portion of intervals or you don’t have suitable parameters to use
a query filter, you can select intervals fromdrillholes displayed in the scene to create a new
lithology column. The original lithology column is preserved and a new lithology column is
added to the interval table. You can then select the original lithology column or the new one
when displaying data and creating models.

The difference between the interval selection tool and the split lithologies tool is that with
splitting lithologies, you are limited to selecting intervals froma single lithology. With interval
selection, you can choose intervals fromany lithology displayed in the scene.

To start selecting intervals, first add the drillhole data to the scene. Then right-click on the
interval table in the project tree and selectNew Column > Interval Selection. For a merged
table, right-click on it and select Interval Selection.

TheNew Lithology Columnwindowwill appear:

Select the lithology column you wish to use from the Base Column list, then enter a Name for
the new lithology column. ClickOK.
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The Interval Selectionwindowwill appear, together with a set of tools that will help you to
select intervals in the scene. To select intervals, click on the Select Intervals button ( ) and
click the Add Intervals button ( ). In the scene, draw a line across each interval you wish to
select:

Selected intervals are highlighted in the scene. If you accidentally select thewrong interval,
either:

l Click theRemove Intervals button ( ) and draw across the interval once again.

l Hold theCtrl keywhile drawing across the interval.

You can also:

l Select all visible intervals by clicking on the Select All button ( ) or by pressing Ctrl+A.

l Clear all selected intervals by clicking on theClear Selection button ( ) or by pressing
Ctrl+Shift+A.

l Swap the selected intervals for the unselected intervals by clicking on the Invert Selection
button ( ) or by pressing Ctrl+I.

To change thewidth of the line used to select intervals, click on theChange Line Width
button ( ) and enter a new value. You can keep the Set Line Widthwindow open while you
select intervals so you can change the line width as required.
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When you have selected at least one interval, click on the Assign to button, then selectCreate
New Lithology:

Enter a Name for the new lithology, then clickOK:

The new lithologywill be created and the scene updated to reflect the changes:

Once you have created a new lithology, you can add to it by selecting intervals, then selecting
the lithology from the Assign to list.
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When you are finished, click the Save button ( ) and close the Interval Selectionwindow. The
new lithology column will appear in the project tree as an additional lithology column in the
interval table. Select the new column from the shape list to display it:

Overlaid Lithology Column
You may have two versions of an interval column, one that contains draft data and one that
contains the final version. The final version may contain gaps, which can be filled in using the
draft version. The overlaid lithology tool lets you combine the two columns to create a new
column.

Both columnsmust be part of the same interval table. If they are not, use themerged table tool
to create a new table that contains both columns. SeeMerged Drillhole Data Tables.

To create an overlaid lithology column, right-click on the interval table in the project tree and
selectNew Column > Overlaid Lithology Column. For a merged table, right-click on it and
selectOverlaid Lithology Column.

TheNew Overlaid Lithology Columnwindowwill appear:

For the Primary column, select the column that you wish to have precedence. Data in the
Fallback columnwill be used when no data is available from the Primary column.

ClickCreate to create the new column. The new column will appear in the project tree.

You can display drillhole data with the new column by selecting it from the shape list:

© 2017 ARANZ Geo Limited



Category Column from Numeric Data | 166

Category Column from Numeric Data
When you have numeric data you wish to usewith the lithology and categorymodelling tools,
you can convert the numeric data to a category column. To do this, right-click on the numeric
data column and selectNew Column > Category From Numeric. In thewindow that appears,
select the Base Column, then enter a name for the new column. ClickOK.

The next step is to sort the numeric data into categories:

Leapfrog Geo automatically assigns three categories calculated from the distribution of data.
To add a new category, click the Add button and enter the required value. Click the Show
Histogram button to view the distribution of data in deciding what categories to define.

ClickOK to create the new column, which will appear in the project tree as part of the original
interval table.

Back-flagging Drillhole Data
Evaluating geological models on drillholes creates a new lithology table containing the
lithologies from the selected model. This is useful for validating models created fromdrillhole
data as you can generate statistics for the correlation betweenmodelled geology and drilling
data.

To created a back-flagged drillhole data table, right-click on theDrillholes object in the project
tree and selectNew Evaluation. TheNew Evaluationwindowwill appear:

Select themodel to use and enter names for the column and table.
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When the selected model is a faulted model, the Evaluation Type setting determineswhether
themodel’s output volumes, faulted output volumesor fault blocks are evaluated.

ClickOK to create the new table, which will appear in the project tree as part of theDrillholes
object. The new table contains From, To and Lithology columnsdefined using the intersection
between themodel’s output volumes and the drillholes.

For output volume evaluations, you can view the correlation betweenmodelled geology and
actual logged drillhole segments. To do this, right-click on the table and select Statistics. In the
Correlation Statisticswindow, you can comparemodel values to drilled lithologies or vice
versa.

See:

l Comparing Modelled Values to Drilling Lithologies

l Comparing Drilling Lithologies to Modelled Values

l Refining the Geological Model to Improve Correlation Statistics

You can export the information displayed in theCorrelation Statisticswindow in CSV
format for use in other applications. To do this, click Export.

Comparing Modelled Values to Drilling Lithologies

Comparingmodel values to drilling lithologies showshow accurately drilling lithologies are
modelled in the selected geological model. High matching percentages for drilling lithologies
in the lefthand side of thewindowmean themodel closelymatches the drilling data for that
lithology:
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The righthand side of thewindow shows the composition of themodelled values for the
selected Drilling Lithology. Here, D1 in the geological model corresponds to D1 in the lithology
data for 88.2% of the length of the drillhole:

D1 in themodel is actually D2 for 2.37% of the length of the drillholes, and 9.44% of the drilled
D1 values fall outside of the boundary of the geological model.

In the images that follow, wewill look at the correlation between the D5 drilling lithology and
modelled D5. Here, two drillhole data tables are displayed with the D5-D4 contact surface from
the geological model:
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The inner drillholes show the original drillhole data. The outer drillholes show the geological
model back-flagged onto the drillhole data table. In the highlighted drillhole, we can see there
is a discrepancy between the actual lithology data and that modelled. When we view
correlation statistics for thismodel, we can see that this discrepancy is explained by the fact that
17.97% of the D5 drilling length ismodelled asD4:

You might consider this an acceptablematch, but if it is too low, there are several ways to refine
the geological model so that the geological model more closely reflects the original drillholes,
which are discussed below. For this example, wewill adjust the resolution of the geological
model. Themodelled segment now correspondsmore closely to the original drillhole data:

Viewing the correlation statistics shows that 99.62% of modelled drillholes nowmatch the
original data:
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Comparing Drilling Lithologies to Modelled Values

Comparing drilling lithologies to model values shows the lithological composition of
modelled values. Again, high matching percentages in the lefthand side of thewindowmean
themodel closelymatches the drilling data for that modelled lithology:

The non-matching percentage indicates howmuch of themodelled lithology is not the
drillhole lithology. You can see in the righthand side of thewindow the lithologies that make up
the non-matching portions of themodelled value.

In the images that follow, wewill look at the correlation between the D5 drilling lithology and
modelled D5 once again. The non-matching percentage is 4.8, and on the righthand side of
thewindow, we can see that this is exclusively drilling lithology I2:
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Adjusting the resolution of the geological model improves thematching percentage to the
point where only 0.09 percent of the D5modelled value is drilling lithology I2:

Refining the Geological Model to Improve Correlation Statistics

If thematching percentages are too low for the lithologies of interest, there are several ways to
refine the geological model so that the geological model more closelymatches the drillholes:

l Reduce the resolution of the geological model or of its contact surfaces. See Surface
Resolution for a Geological Model and Surface Resolution in Leapfrog Geo.

l Add more data to themodel’s surfaces. See Adding Data to Surfaces.

l Snap surfaces to the data used to create them. SeeContact Honouring.

Merged Drillhole Data Tables
When you havemore than one drillhole interval table in a project, you can create a new table
using selected columns fromexisting interval tables. You can include columns created by, for
example, grouping or splitting lithologies or compositing.

To create a merged table, right-click on theDrillholes object in the project tree and selectNew
Merged Table. TheNew Merged Tablewindowwill appear showing all interval columns
available in the project:
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You can change the columns included once you have created the table.

Select the columns you wish to include in the new table and clickOK. The new table will appear
in the project tree as part of theDrillholes object.

You can create query filters for a merged data table, as described inQuery Filters. You can also
select intervals (see Interval Selection) and create an overlaid lithology column (seeOverlaid
Lithology Column). You cannot, however, use the group lithologies and split lithology tools on
a merged table.

To edit the table, right-click on it and select Edit Merged Table.

Core Photo Links
Leapfrog Geo can link drillhole data to ALSWebtrieve and Coreshed core photo databases.
When drillhole data has been linked, a photo link object will appear in the project tree:

You can only have one type of core photo link associated with the drillhole data. To add a link,
right-click on theDrillholes object and select Add Core Photo Link. In thewindow that
appears, select the core photo provider and clickOK:

An alternative to linking to a core photo database is to link to files stored locally or on a
network drive. This can be achieved by having a URL column in an interval table. When the
interval is selected in the scene, you can click the link to view the file:
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Use the prefix file:/// to link to local files.

For information on setting up ALSWebtrieve and Coreshed links, see:

l Setting Up the ALS Interface

l Setting Up the Coreshed Interface

To use the core photo links, see:

l Using the ALS Interface

l Using the Coreshed Interface

The ALS Core Photo Interface
This topic describes how to set up and use the ALS core photo interface. It is divided into:

l Setting Up the ALS Interface

l Using the ALS Interface

l Removing the ALS Link

Setting Up the ALS Interface

Before you can view core photos, you must first log in to the ALS database. Two levels of
security are provided, one set up in Leapfrog Geo and the next via your browser.

To set up the interface between Leapfrog Geo and the ALS database, right-click on the
Drillholes object and select Add Core Photo Link. In thewindow that appears, select ALS
Webtrieve and clickOK. The ALS Core Photo Settingswindowwill appear. Information
required to access core data is the Project Name and the Encryption Key. This information
provides the first level of security for information in the ALS database. Click on each field and
enter the required information. The information is case-sensitive, so ensure that the characters
entered are correctly capitalised.

For Leapfrog depths measured in, ensure that the units used for depth match in Leapfrog Geo
and ALS.

ForOpen selection in new browser, choosewhether each core photowill be opened in a
separate browserWindow or Tab.
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ClickOK to save the information. If login is successful, the ALS Core Photos button ( ) will
appear in the toolbar:

A linkwill also appear in the project tree as part of theDrillholes object:

You can edit the link by double-clicking on it.

Using the ALS Interface

To view core photos, click on a drillhole in the scene, then click on the ALS Core Photo Link
button in thewindow that appears:

Your browser will be launched and you will be prompted to log in to the ALS database. Enter
theUser Name and Password, which are case-sensitive. Remember to allow the browser to
save the details so that you will not be prompted to log in each time you wish to view a photo.

Your browser settingsmay require that you install a plugin ormake changes to settings in
order to view core photos. If you are not able to access the ALS database fromLeapfrog Geo
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and have ensured your Project Name, Encryption Key, User Name and Password have
been entered correctly, contact Customer Support as described inGetting Support.

If you want to view core photos in rapid succession, click on the ALS Core Photos button ( ) in
the toolbar, then click on a drillhole in the scene. Thiswill simultaneously:

l Display information on the segment selected in Leapfrog Geo

l Display the core photo in your browser

Removing the ALS Link

To remove an ALS link, right-click on it in the project tree and selectDelete.

The Coreshed Core Photo Interface
This topic describes how to set up and use the Coreshed core photo interface. It is divided into:

l Setting Up the Coreshed Interface

l Using the Coreshed Interface

l Removing the Coreshed Link

Setting Up the Coreshed Interface

Before you can view core photos, you must first set up the Coreshed interface. To do this, right-
click on theDrillholes object and select Add Core Photo Link. In thewindow that appears,
selectCoreshed and clickOK. TheCoreshed Photo Settingswindowwill appear. Select
whether each core photowill be opened in a separate browserWindow or Tab.

ClickOK to save the information. TheCoreshed Core Photos button ( ) will appear in the
toolbar:
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A linkwill also appear in the project tree as part of theDrillholes object:

You can edit the link by double-clicking on it.

Using the Coreshed Interface

To view core photos, click on a drillhole in the scene, then click on theCoreshed Photo Link
button in thewindow that appears:

Your browser will be launched and you will be prompted to log in to the Coreshed database.
Enter theUsername and Password, which are case-sensitive. Remember to allow the browser
to save the details so that you will not be prompted to log in each time you wish to view a photo.

Your browser settingsmay require that you install a plugin ormake changes to settings in
order to view core photos. If you are not able to access the Coreshed database from
Leapfrog Geo and have ensured yourUsername and Password have been entered correctly,
contact Customer Support as described inGetting Support.

If you want to view core photos in rapid succession, click on theCoreshed Photo Link button (
) in the toolbar, then click on a drillhole in the scene. Thiswill simultaneously:

l Display information on the segment selected in Leapfrog Geo

l Display the core photo in your browser

Removing the Coreshed Link

To remove a Coreshed link, right-click on it in the project tree and selectDelete.
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Deleting Drillhole Data
To delete a lithology or numeric data table, right-click on the table in the project tree and select
Delete. You will be asked to confirm your choice.

When you right-click on the drillhole or collar table object in the project tree and selectDelete,
the resulting action will also remove all lithology and numeric data tables from the project. You
will be asked to confirm your choice.

Reloading Drillhole Data
Reloading data is necessarywhen the imported data ismodified externally. All drillhole data can
be reloaded by right-clicking on theDrillholes object and selecting Reload Drillholes. If you
only need to reload a single table, right-click on that table and select Reload Data.

Reloading drillhole data overwrites all existing drillhole data. If you have data you wish to
add to the project without overwriting existing data, use the Append Drillholes option.

The process is similar to that for importing drillhole data:

l If the drillhole data was loaded froma file on your computer or a network location, you will
be prompted to specify the file locations.

l If the interval table is stored in an ODBC database, you will be prompted to connect to the
database. See Selecting the ODBC Data Source.

l If your drillhole data is stored in an acQuire database, you will be prompted to connect to the
database. SeeConnecting to an acQuire Database.

When you reload data, Leapfrog Geo retains the table structure and refreshes the data
contained in the tables. This ensures that you do not need to reassign the data type for each
column and select the columns to be imported.

Exporting Drillhole Data
Changesmade to the drillhole data in Leapfrog Geo only affect the Leapfrog Geo database,
not the original data files. You can export Leapfrog Geo drillhole data, which is useful if you
wish to keep a copy of drillhole data outside the project.

You can:

l Export all data. See Exporting All Drillhole Data.

l Export only a single data table. See Exporting a Single Drillhole Data Table.

These export options export the drillhole data tables using To and Fromvalues to indicate
location information. If you wish to export data with X-Y-Z values, extract points data using
one of the following options:
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l Extracting Contact Points from Drillhole Data

l Extracting Intrusion Values from Drillhole Data

l Extracting Interval Midpoints from Drillhole Data

Then export the data object as described in Exporting Points Data.

Exporting All Drillhole Data
To export all drillhole data, right-click on theDrillholes object and select Export. The Export
Drillhole Datawindowwill appear:

Once you have selected how you wish to export the data, clickOK. The Export Drillhole Data
Fileswindowwill appear:

The list shows the files that will be created, one for each data table. Choose the Folderwhere
the fileswill be saved, then enter a Base file name, which will be added to the front of each file
name.

Click Export to save the files.

Exporting drillhole data in thisway uses To and Fromvalues to indicate location information.
If you wish to export data with X-Y-Z values, extract points data using one of the following
options:

l Extracting Contact Points from Drillhole Data

l Extracting Intrusion Values from Drillhole Data

l Extracting Interval Midpoints from Drillhole Data

Then export the data object as described in Exporting Points Data.
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Exporting a Single Drillhole Data Table
To export a single drillhole data table, right-click on that table and select Export. The Export
Drillhole Datawindowwill appear:

Once you have selected how you wish to export the data, clickOK. You will be prompted for a
filename and location.

Exporting a single drillhole data uses To and Fromvalues to indicate location information. If
you wish to export data with X-Y-Z values, extract points data using one of the following
options:

l Extracting Contact Points from Drillhole Data

l Extracting Intrusion Values from Drillhole Data

l Extracting Interval Midpoints from Drillhole Data

Then export the data object as described in Exporting Points Data.
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Points Data
Points are sets of X-Y-Z coordinates, with or without associated values. In Leapfrog Geo, points
are used to define surfaces and for interpolation. You can use the Points folder to:

l Import points data

l Import geophysical data in AESG_DFN format

l Extract contact points, intrusion values and interval midpoints fromdrillhole data

l Create guide points

l Create grids of points that can be evaluated against geological and numericmodels and
exported for use in othermodelling

The rest of this topic describes importing and exporting points, setting elevation for points and
evaluating points. It is divided into:

l Importing Points Data

l Selecting the ODBC Data Source

l Reloading Points Data

l Appending Points Data

l Importing a Column

l Importing ASEG_DFN Points

l Setting Elevation for Points

l Evaluating Points Data

l Exporting Points Data

l Exporting Intrusion Values

l Exporting Interval Midpoints

Importing Points Data
Leapfrog Geo supports the following file types for points data:

l CSV files (*.csv)

l ASCII text files (*.asc)

l DXF files (*.dxf)

l Leapfrog Geo 3D Point Data files (*.pl3, *.ara)

Points data can be imported from:

l Files stored on your computer or a network location. Right-click on the Points folder and
select Import Points. You will be prompted to select a file.

l Fromany database that runs an ODBC interface. Right-click on the Points folder and select
Import Points via ODBC. See Selecting the ODBC Data Source below.

For each of these options, once the data source is selected, the process of importing the data is
the same.
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When importing a file that hasmultiple features, you will be prompted to select which ones to
import. You can also choose to:

l Import the features as separate objects. Each feature will appear in the project tree as a
separate object.

l Flatten all features into one object. Leapfrog Geowill treat all features as a single object.

Once imported, the file will be added to the Points folder. If there are errors in the data, the
errors can be corrected as described in Correcting Data Errors.

To view the imported data, double-click on the object that has been added to the Points folder.

Once points data has been imported to the project, it can bemodified and evaluated against
geological models, numericmodels and estimators, as described in Evaluating Points Data.

Selecting the ODBC Data Source
When importing points data froman ODBC database, you will need to specify theODBC data
source. Enter the information supplied by your database administrator and clickOK.

Once the data source is selected, the import process is similar to that described above.

Reloading Points Data
Reloading data is necessarywhen the imported data ismodified externally. Points data can be
reloaded by right-clicking on the table and selecting Reload Data.

Reloading points data overwrites all data in the exisiting table. If you have data you wish to
add to the project without overwriting existing data, use the Append Data option.

The process is similar to that for importing the original table.

Appending Points Data
If points data is stored in multiple files, you can import these files into the project and add them
to existing points data. To do this, right-click on the object you wish to append and select
Append Data. You will be prompted to select a file.

Next, the Import Tables For Appendingwindowwill be displayed.

Check the data to ensure that the correct information will be imported, then click Finish to add
the new file.

Importing a Column
Columnsof points data that were not imported when the original data was imported or that are
stored in a separate file can be added to the table at any time. To do this, right-click on the
points table in the project tree and select Import Column.

The process is similar to importing the original table; select the file and map the columns you
wish to import.
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Importing ASEG_DFN Points
Leapfrog Geo imports ASEG_DFN points in *.dfn format. To import an ASEG_DFN file, right-
click on the Points folder and select Import ASEG_DFN. Leapfrog Geowill ask you to specify
the file location. ClickOpen to import the file. In thewindow that appears, enter a name for the
file, then clickOK. Next set the X, Y and Z coordinates and clickOK. If you select no column for
the Z coordinates, all Z valueswill be set to zero.

The file will appear in the Points folder.

Setting Elevation for Points
You can set the elevation for points objects ( ) by projecting themonto a surface. Any elevation
data in the points table will be overwritten by the elevation values from the selected surface.

To set the elevation for points, right-click on it in the project tree and select Set Elevation. The
Set Elevation from Surfacewindowwill appear:

Select from the surfaces available in the project.

Unprojected points are points that do not vertically intersect the selected surface. There are two
options for handling these points:

l Leave the elevation field empty.

l Assign a fixed elevation value.

ClickOK to set elevation values.

Evaluating Points Data
Once points data has been imported to the project, it can bemodified and evaluated against
geological models, numericmodels and estimators, as described in Evaluations.

In the case of geological models, you can also combine two ormoremodels to evaluate the
points data and set the priority used for evaluation. To do this, click on theCombined
Evaluation button in the Select Models To Evaluatewindow. In thewindow that appears,
select the evaluations to combined, then set their priority. ClickOK to create the combined
evaluation, then clickOK in the Select Models To Evaluatewindow. The combined evaluation
will be available from the colour list.
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To delete a combined evaluation, click on theDelete Combined button in the Select Models
To Evaluatewindow.

Exporting Points Data
To export points data, right-click on the points data object in the project tree and select Export.
Formany points objects, you will be prompted to select which rows to include. Points data can
be exported in CSV format (*.csv) or DXF format (*.dxf). Additional export options are available
for some types of points, which are described below.

Once you have selected how you wish to export the data, click Export. You will be prompted for
a filename and location.

Exporting Intrusion Values

Intrusion values can be extracted fromdrillhole data as described in Extracting Intrusion
Values from Drillhole Data.

There are two options for exporting intrusion values:

l Export only the contact points. To do this, right-click on the intrusion values object and select
Export. If you choose this option, you can export the points in CSV format (*.csv) or DXF
format (*.dxf).

l Export all the points used in creating an intrusion. To do this, right-click on the intrusion
values object and select Export Volume Points. If you choose this option, you can only
export the points in CSV format (*.csv).

In both cases, you will be prompted for a filename and location.

Exporting Interval Midpoints

Interval midpoints can be extracted fromdrillhole data, which is described in Extracting
Interval Midpoints from Drillhole Data. You can also export midpoints directly froman RBF
interpolant, which is described in Exporting Numeric Model Midpoints.

To export interval midpoints, right-click on the points data object in the project tree and select
Export. Interval midpoints can be exported in the following formats:

l CSV text file (*.csv)

l Snowden Supervisor CSV file (*.csv)

l Isatis 3D points file (*.asc)

The values exported are themidpoints of each segment, the X-Y-Z values and the hole ID. The
Snowden Supervisor and Isatis 3D points formats also include the interval length.

In each case, you will be prompted for a filename and location.
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Extracting Points from Drillhole Data
This topic describes extracting different types of points from imported drillhole data. It is divided
into:

l Extracting Contact Points from Drillhole Data

l Extracting Intrusion Values from Drillhole Data

l Intrusion Point Generation Parameters

l Extracting Interval Midpoints from Drillhole Data

If you wish to save and export points data with X-Y-Z information, use these options, then
right-click on the data object to export the data as described in Exporting Points Data.

Extracting Contact Points from Drillhole Data
Contact points define the boundary between two lithology layers. You can extract contact
points from interval tables to create a new points object in the Points folder. The values
extracted are the x-y-z values of the contact points.

To extract contact points froman interval table, right-click on the Points folder and selectNew
Contact Points. A windowwill appear listing the lithology and category columns available in
the project:

Select the required column and clickOK.
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Next, theNew Contact Pointswindowwill appear:

Select the lithology required from the Select primary lithology list, then select the adjacent
lithologies you wish to extract in theContacting lithologies list.

Unspecified intervals are intervals that have no data. By default, unspecified intervals are
ignored when creating new contact points, but you can also treat themas the primary lithology
or as contacting lithologies.

For complex geologies, the up and down directions for the surfacemay not be clear. If this is the
case, untick theHorizontal Plane box. A reference planewill appear in the scene, with the up-
facing surface labelled A and the downward-facing surface labelled B:

Controlling the position of the reference plane is similar to controlling the position of the
moving plane:

l Use the handles in the scenewindow tomove the plane.

l Set theDip and Dip Azimuth values in theNew Contact Pointswindow. The reference
planewill be updated in the scene.

Once the reference plane is correctly oriented, click the Set From Plane button.
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A reference plane set for contact points in the Points folder will be applied wherever the
contact points are used.

ClickOK to create the points, which will appear in the project tree under the Points folder. To
edit the points, double-click on them.

Extracted contact points can be exported as described in Exporting Points Data.

Extracting Intrusion Values from Drillhole Data
You can extract intrusion points from interval tables to create a new points object in the Points
folder.

To extract intrusion values froman interval table, right-click on the Points folder and select
New Intrusion Values. A windowwill appear listing the lithology and category columns
available in the project:

Select the required column and clickOK.

Next, theNew Intrusionwindowwill appear:

Select the intrusion lithology, then move any younger lithologies to the Ignore list.
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Unspecified intervals are intervals that have no data. By default, unspecified intervals are
ignored when extracting intrusion values, but you can also treat themas the interior lithology or
as exterior lithologies.

The settings in theCompositing tab are described in Category Composites.

ClickOK to create the new points object, which will appear in the project tree under the Points
folder. To edit the points, double-click on the points object ( ) in the project tree. See Intrusion
Point Generation Parameters below.

When you view the intrusion points in the scene, you can display only the contact points or all
the points used determining the extrusion values. To display all points, click on the points object
in the shape list and tick the box for Show volume points:

Extracted intrusion points and values can be exported as described in Exporting Points Data.

Intrusion Point Generation Parameters

To change theway intrusion values are generated, double-click on the points object ( ) in the
project tree:

The Edit Intrusionwindowwill appear, displaying the Point Generation tab.

Here, the surface and volume points are displayed to show the effects of the Surface offset
distance and Background fill spacing parameters:
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The Surface offset distance parameter sets the top and bottomendsof the interval and affects
how a surface behaveswhen it approaches a contact point. A smaller distance restricts the
angles that an approaching surface can take. Another factor that affects the angles a surface
will take iswhether or not a trend has been applied to the surface.

The Background Fill Spacing parameter determines the approximate length of segments in the
remaining intervals. If the remaining interval is not a multiple of the Background Fill Spacing
value, Leapfrog Geowill automatically adjust the spacing to an appropriate value. A smaller
value forBackground Fill Spacingmeans higher resolution and, therefore, slightly smoother
surfaces. However, computation can take longer.

Extracting Interval Midpoints from Drillhole Data
You can extract interval midpoints from raw or composited numeric and category tables to
create a new points object in the Points folder. The extracted pointswill be dynamically linked
to the original drillhole segments and can be evaluated against other data in the project. The
values extracted are themidpoints of each segment, the X-Y-Z values and the hole ID.

If you are exporting points data for use in Snowden Supervisor, use this option for extracting
points fromdrillhole data. If you wish to export midpoints froman interpolant, see Exporting
Numeric Model Midpoints.

To extract midpoints froman interval table, right-click on the Points folder and selectNew
Interval Mid Points. In thewindow that appears, select the required Source table, then select
which data columns to use:

Apply a query filter, if required, then clickOK. The new points object will appear in the project
tree under the Points folder. To edit the points, double-click on the points object ( ) in the
project tree.
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Changesmade to the source data table, such as changes to compositing parameters or special
values rules, will be reflected in the extracted points object.

Extracted interval midpoints can be exported as described in Exporting Points Data.

Creating Guide Points
Guide points can be created fromany category data in the project and added to surfaces.
Category data that can be used to create guide points includes:

l Downhole category data

l LAS points

l Category data on imported points

l Interval midpoints

Guide points are classified into interior or exterior, and each guide point is assigned a distance
value that is the distance to the nearest point on the opposite side. Interior values are positive
and exterior values are negative.

Guide points are a good way of using blasthole data to control surfaces: create the guide points
from the downhole points, then add the guide points to the surface.

To create guide points, right-click on the Points folder and selectNew Guide Points. A window
will appear listing the category columns available in the project:

Select the categories to assign to Interior (the positive side) and Exterior (the negative side).

You can also filter out distant values by ticking the Ignore distant values box and entering a
value. Often distant values have little effect on a surface and filtering out these values can
improve processing time.

ClickOK. The guide pointswill appear in the project tree under the Points folder. To edit the
points, double-click on them.
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Guide points can be exported as described in Exporting Points Data.

Grids of Points
You can create a grid of points that can be evaluated against geological and numericmodels
and exported for use in othermodelling packages. This topic describes creating and working
with grids of points. It is divided into:

l Creating a Grid of Points

l Evaluating a Grid of Points

l Exporting a Grid of Points

Creating a Grid of Points
You can create a grid of points that can be evaluated against geological models and
interpolants and exported for use in othermodelling packages.

To create a grid of points, right-click on the Points folder and selectNew Grid of Points. The
New Grid of Pointswindowwill appear, together with controls in the scene that will help in
setting the grid’s boundary:

If there are objects displayed in the scene, the initial grid dimensionswill be based on those
objects.

The controls in the scene adjust the size and position of the grid as follows:

l Red and pink handles adjust the Boundary Size.

l The orange handle adjusts the Base Point.

l The blue handles adjust the Azimuth.

Set the Spacing and Reference Point, which will control the number of points in the grid. You
can set theReference Point by clicking in the scene. To do this, first click on the Select button (
) for theReference Point, then click in the scene. The coordinates in the scenewill be copied

to theNew Grid of Pointswindow.

If the number of pointswill be very large, rendering of the grid in the scenewill be disabled.
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You will be able to change the settings in thiswindow once the grid has been created.

ClickOK to create the grid, which will appear in the Points folder. Double-click on the grid to
change its settings.

Evaluating a Grid of Points
Once you have created the grid, you will be able to evaluate it against geological models,
interpolants and distance functions in the project.

Evaluationswill be exported with the grid. See Exporting a Grid of Points below.

Exporting a Grid of Points
You can export a grid of points in the following formats:

l CSV file (*.csv)

l GSLIB Data file (*.dat)

l Surpac BlockModel file (*.mdl)

l Isatis BlockModel file (*.asc)

l Geo 3D Point Data file (*.pl3, *.ara)

For CSV, Surpac BlockModel and Isatis format files, all evaluations on the grid of pointswill be
exported as part of the file. For all other file types, only numeric evaluationswill be exported.

To export a grid of points, right-click on it in the project tree and select Export. Select the
format required, enter a filename and location, then click Save.

Categorising Points
When you wish to select a small portion of points and you don’t have suitable parameters to use
a query filter, you can select points in the scene and assign them to categories. This adds a new
column to the points object, preserving the original data.

To start categorising points, right-click on the points object ( ) in the project tree and select
New Category Selection.

TheNew Category Selectionwindowwill appear:

If you select an existing column as the Source Column, you can assign selected points to the
existing categories or create new categories. If you select <None> for the Source Column, you
will have to define each categorymanually.
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When you clickOK, the points object will be added to the scene, along with a set of tools for
selecting points. To select points, click on the Select Points button ( ) and click the Add Points
button ( ). In the scene, draw a line across each point you wish to select:

Selected points are highlighted in the scene. If you accidentally select thewrong point, either:

l Click theRemove Points button ( ) and draw across the point once again.

l Hold theCtrl keywhile drawing across the point.

You can also:

l Select all visible points by clicking on the Select All button ( ) or by pressing Ctrl+A.

l Clear all selected points by clicking on theClear Selection button ( ) or by pressing
Ctrl+Shift+A.

l Swap the selected points for the unselected points by clicking on the Invert Selection button (
) or by pressing Ctrl+I.

To change thewidth of the line used to select points, click on theChange Line Width
button ( ) and enter a new value. You can keep the Set Line Widthwindow open while you
select points so you can change the line width as required.
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When you have selected at least one point, click on the Assign to button, then selectCreate
New Lithology:

Enter a Name for the new category, then clickOK.

The new categorywill be created and the scene updated to reflect the changes:

Once you have created a new category, you can add to it by selecting further points, then
selecting the category from the Assign to list.

When you are finished, click the Save button ( ) and close theCategory Selectionwindow.
The new category column will appear in the project tree as an additional column in the points
table. Select the new column from the shape list to display it.
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Structural Data
In Leapfrog Geo, you can create and edit planar structural data tables directly or fromother
objects in the project. Structural data can also be used to create and edit many surfaces.
Downhole planar structural data and lineations can also be imported, although structural data
imported in thisway cannot be edited.

This topic describes how toworkwith structural data in Leapfrog Geo. It covers:

l Creating New Planar Structural Data Tables

l Importing Planar Structural Data

l Importing Lineations

l Assigning Structural Data to Categories

l Editing the Orientation of Planar Structural Data

l Declustering Planar Structural Data

l Setting Elevation for Structural Data

l Estimating Planar Structural Data

See Stereonets and Form Interpolants for information on tools for analysing structural data.

Creating New Planar Structural Data Tables
There are twoways to create a new planar structural data table in Leapfrog Geo:

l Create a new table as part of creating or editing another object. See Editing Surfaces with
Structural Data.

l Create a new table using the Structural Modelling folder. Use this techniquewhen, for
example, you are creating structural data points froma map or image. Right-click on the
Structural Modelling folder and selectNew Planar Structural Data. In thewindow that
appears, enter a name for the new table and clickOK.

Before creating the new data table, add themap, image or data object you wish towork from to
the scene and orient the scene for drawing the new data points.
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When a new structural data table is created, it will be added to the scene. The Planar Structural
Datawindowwill open, together with a set of tools for adding structural data points:

Click on theNew Structural Data Point button ( ) and click and drag along the strike line in
the scene to add a new data point:
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You can adjust the data point using the controls in the Planar Structural Datawindow:

Importing Planar Structural Data
Leapfrog Geo supports planar structural measurements in .csv or text formats. This topic
describes importing structural data tables that include location information. Downhole
structural data can also be imported, as described in Importing Downhole Structural Data.

Structural data containing location information can be imported from:

l Files stored on your computer or a network location. Right-click on the Structural Modelling
folder and select Import Planar Structural Data. You will be prompted to select a file.

l Fromany database that runs an ODBC interface. Right-click on the Structural Modelling
folder and select Import Planar Structural Data via ODBC. See Selecting the ODBC Data
Source below.
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For each of these options, once the data source is selected, the process of importing the data is
the same. Leapfrog Geowill display the data and you can select which columns to import:

Leapfrog Geo expectsEast (X), North (Y), Elev (Z), Dip and Dip Azimuth columns. The Polarity
column is optional. The Base Category column can be used for filtering data once it has been
imported.

Click Finish to import the data. The structural measurementswill appear in the Structural
Modelling folder.

Once the data has been imported, you can reload and append the data and add columns to the
data in a similarmanner to drillhole data. See Appending Drillholes, Reloading Drillhole Data
and Importing Columns formore information.

Selecting the ODBC Data Source
When importing planar structural data froman ODBC database, you will need to specify the
ODBC data source. Enter the information supplied by your database administrator and clickOK.

Once the data source is selected, the import process is similar to that described above.

Importing Lineations
Lineations containing location information can be imported from files stored on your computer
or a network location in .csv or text formats. To do this, right-click on the Structural Modelling
folder and select Import Lineations. You will be prompted to select a file.

Leapfrog Geo expectsEast (X), North (Y), Elev (Z), Trend and Plunge columns. The Polarity
column is optional. TheCategory column can be used for filtering data once it has been
imported.
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Click Finish to import the data. The lineationswill appear in the Structural Modelling folder.

Once the data has been imported, you can reload and append the data and add columns to the
data in a similarmanner to drillhole data. See Appending Drillholes, Reloading Drillhole Data
and Importing Columns formore information.

Assigning Structural Data to Categories

There are twoways to initiate structural data selection: from the data object in the project
tree/shape list and froma stereonet. The advantage of initiating structural data selection
froma stereonet is that the data will be displayed both on the stereonet and in the scene
window. This provides themost flexibility for analysing what data belongs towhat category.
See Selecting Data in the Stereonet and Using the Scene Window with the Stereonet for
more information.

If you wish to assign planar structural data points or lineations to categories, right-click on the
data table in the project tree and selectNew Category Selection. First, select the Source
Column. If you select an existing column as the Source Column, you can assign selected data
points to existing categories or create new categories. If you select <None> for the Source
Column, you will have to define each categorymanually.

Select points by clicking on the Select points tool ( ), then drawing over those points in the
scene:
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Once you have selected points, you can assign them to existing categories or create new ones.
To create a new category, click on the Assign to > Create New Category button:

Enter a name for the new category and clickOK.

When you have finished selecting points and adding them to categories, close theCategory
Selectionwindow to close the editor.

Editing the Orientation of Planar Structural Data
If you need to edit the orientation of planar structural data points, you can do so in twoways:

l Edit the data in the table directly by double-clicking on the structural data table in the project
tree. See The Table Dialog.

l Edit the structural data orientation in the scene.

To edit the structural data in the scene, right-click on the table in the project tree and select Edit
Orientation in Scene. If the table is displayed in the scene, in the shape list, click on the Edit
button ( ). The Planar Structural Datawindowwill appear in the scene, together with controls
for editing the data points. To edit a data point, click on it. Information about the selected point
will be displayed in the Planar Structural Datawindow, together with controls in the scene you
can use to adjust the point:
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You can also add new data points in the samemanner described in Creating New Planar
Structural Data Tables.

Declustering Planar Structural Data
If a planar structural data table containsmultiple duplicate or near-duplicatemeasurements,
you can create a declustered structural data set that will make the table easier to workwith.
Declustering is intended toworkwith large, machine-collected data sets rather than smaller
sets that might be edited manually.

Declustering preserves the original data table and creates the set as a “filter” by applying two
parameters: the Spatial search radius and the Angular tolerance.

l The Spatial search radius determines the size of the declustering space. All points inside the
Spatial search radius are compared searching for duplicates.

l The Angular tolerancemeasureswhether points have the same or similar orientation. The
orientation of all points inside the Spatial search radius ismeasured and themean taken. If a
point’s orientation is less than the Angular tolerance from themean, then the point is
regarded as a duplicate. The point that is retained is the one that is closest to themean.

When a structural data set has a numeric column that gives some indication of the
measurement’s uncertainty, this column can be used to prioritise values. Select the Priority
column and set how the values should be handled.

Another factor in declustering the points is the category columns selected. When you choose
multiple category columns, all criteria must match for points to be regarded as duplicates. What
thismeans is that pointswill be kept if they have different category values in just one column,
even if theymeet the criteria for duplicates established by the Spatial search radius and the
Angular tolerance and match in other columns. For example, in this table, assume that
applying the Spatial search radius and the Angular tolerance parameterswithout using the
Lithology category results in three points. However, including the Lithology column results in
five points, indicated by the colours:

Themore columns you select, the lower the likelihood that pointswill be regarded as duplicate.

The declustered set can be used like an ordinary structural data table. However, it is a filter on a
planar structural data table and can be used as such when the parent table is displayed in the
scene. For example, here the filters available for the planar structural data table include the
query filters ( ) defined for the table aswell as the declustered set ( ):
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To create a declustered structural data set, right-click on the Structural Modelling folder and
selectNew Declustered Structural Data. Select the source data table and a query filter, if
required. Set the parameters and the columns you wish to use, then clickOK. The declustered
set will be added to the Structural Modelling folder.

Edit the set by right-clicking on it in the project tree and selecting Edit Declustered Structural
Data.

Setting Elevation for Structural Data
You can set the elevation for planar structural data points or lineations by projecting the data
onto a surface. Any elevation data in the data table will be overwritten by the elevation values
from the selected surface.

To set the elevation for planar structural data points or lineations, right-click on the table in the
project tree and select Set Elevation. The Set Elevation from Surfacewindowwill appear:

Select from the surfaces available in the project.

Unprojected points are data points that do not vertically intersect the selected surface. There
are two options for handling these points:

l Leave the elevation field empty.

l Assign a fixed elevation value.

ClickOK to set elevation values.

Estimating Planar Structural Data
You can generate a set of planar structural measurements frompoints, polylines and GIS lines.
To do this, right-click on the points or lines object in the project tree and select Estimate
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Structural Data. In thewindow that appears, enter a name for the structural data table, then
clickOK. The new structural data table will appear in the project tree and you can view and edit
it as described in Displaying Structural Data and Editing the Orientation of Planar Structural
Data.
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Meshes
TheMeshes folder contains all meshes imported into Leapfrog Geo and created in Leapfrog
Geo outside of themodel building process.

Two types of meshes are stored in theMeshes folder:

l Non-editablemeshes ( ) aremeshes imported into Leapfrog Geo and meshes created in
Leapfrog Geo from themoving plane,Meshes > Mesh Operations tools and by extracting
mesh parts fromother surfaces in the project.

l Editablemeshes ( ) are created in Leapfrog Geo fromdata objects such as points data, GIS
data and polylines. Editablemeshes can be refined by adding more data. Editablemeshes can
be interpolated meshes (using FastRBF) or triangulated meshes (using Delaunay
triangulation). Interpolated meshes can also be created from structural data and values
objects.

This topic describes importing meshes, creating meshes and modifying editablemeshes. See
Adding Data to Surfaces, Global Trends and Editing Surfaces with Polylines for information
about different techniques for refining other surfaces in the project.

Importing a Mesh
Mesh formats Leapfrog Geo supports include:

l Leapfrog Files (*.msh, *.ara)

l Gocad Files (*.ts)

l DXF Files (*.dxf)

l Surpac Files (*.str, *.dtm)

l GemcomFiles (*.tri)

l Datamine Files (*pt.asc, *tr.asc)

l Micromine Files (*MMpt.dat, *MMtr.dat)

l DXF Polyface Files (*.dxf)

l AliasWavefront Object Files (*.obj)

l Vulcan Files (*.00t) (with Maptek Link)

If you have theMaptek Linkmodule, you can also import meshes in VULCAN .00t format.
Contact Customer Support as described inGetting Support formore information about
licensing theMaptek Linkmodule.

Once a mesh has been imported to the project, you can evaluate it against any interpolant or
distance function in the project. See Evaluations formore information.

To import a mesh, right-click on theMeshes folder and select Import Mesh. Navigate to the
folder that contains themesh file and select the file. You can select multiple files using the Shift
and Ctrl keys. ClickOpen to import the file.

TheCleanup Meshwindowwill be displayed. SeeCleaning Up a Mesh below.
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Meshes with Textures
Leapfrog Geo can import OBJ mesheswith textures. If you have theMaptek Linkmodule, you
can also import Vulcan 8mesheswith textures.

Textured OBJ Meshes

ForOBJ meshes, a materials file (.mtl) is required, together with the referenced images. Image
formats supported include:

l PNG Files (*.png)

l JPEG Files (*.jpg, *.jpeg)

l TIFF and GeoTIFF Files (*.tiff, *.tif)

l WindowsBitmap Files (*.bmp)

l Graphics Interchange Format Files (*.gif)

The texture is automatically imported when themesh is imported and will appear in the project
tree under themesh.

Textured Vulcan 8 Meshes

This feature is only available if you have theMaptek Linkmodule.

When importing a Vulcan 8mesh that contains a path to an associated texture, Leapfrog Geo
will also import the texture. If the path to the texture does not exist, you can import it once the
mesh has been imported. Do this by right-clicking on themesh in the project tree and selecting
Import Texture. Navigate to the folder containing the texture file and clickOpen. The texture
will be imported and stored in the project tree as part of themesh.
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Cleaning Up a Mesh
There are several options for cleaning up a mesh that can be applied tomeshes imported into
Leapfrog Geo and to non-editablemeshes created in Leapfrog Geo.

To clean up a mesh, double-click on themesh in theMeshes folder or right-click on themesh
and selectOpen. TheCleanup Meshwindowwill be displayed:

TheCleanup Meshwindowwill also be displayed when you import meshes.

The first four options are automatically applied tomeshes created in or imported into Leapfrog
Geo:

l Consistently orient faces ensures that a mesh can be used for inside/outside testing.

l Remove non-vertex points removes points that are not used by any triangles.

l Remove degenerate faces removes triangleswith duplicate vertices.

l Orient concentric parts ensures that internal parts have the correct orientation.

Other options are:

l Invert mesh orientation reverses the polarity of themesh.

l Remove vertical edges removes any vertical faces from themesh boundary.

l Rotate locations about X axis lets you rotate themesh 90 degrees clockwise or
anticlockwise.

l Move Mesh lets you offset themesh by a vector. Tick theMove Mesh box and enter the
required values. The offset values can be changed by opening theClean Meshwindow once
again.

Select the options required, then clickOK.

Themesh will be added to the project tree under theMeshes folder.
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Importing an Elevation Grid
Elevation grid formats Leapfrog Geo supports include:

l Arc/Info ASCII Grid Files (*.asc, *.txt)

l Arc/Info BinaryGrid Files (*.adf)

l Digital Elevation Model Files (*.dem)

l Surfer ASCII or BinaryGrid Files (*.grd)

l SRTM Files (*.hgt)

l ESRI.hdr Labelled Image Files (*.img, *.bil)

l GeoTIFF Image Files (*.tiff, *.tif)

There are twoways to import an elevation grid:

l Import the grid to theMeshes folder. Right-click on theMeshes folder and select Import
Elevation Grid.

l Import the grid as part of creating a topography. Right-click on the Topographies folder and
selectNew Topography > Import Elevation Grid.

Navigate to the folder that contains the elevation grid file and open the file. The Import
Elevation Gridwindowwill be displayed:

Leapfrog Geo automatically sets a Surface resolution based on the information in the file, but
you can change the value if you wish. A lower valuewill producemore detail, but calculations
will take longer. See Surface Resolution in Leapfrog Geo formore information.

When importing an elevation grid, note that the resolution cannot be changed once the file
has been imported.

Data is automatically clipped to the clipping boundary, but you can change how the data is
filtered to suit any bounding box that exists in the project. If you do not wish to clip the data,
untickClip data to bounding box.

TheMargin value determines how far outside the selected Bounding box the elevation grid will
extend.
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TheNo Data Handling option determineswhether NoData values are displayed as gaps or at a
fixed elevation setting.

Click Import. If you are creating a new topography, you will then be prompted to enter a name
for it and clickOK.

The elevation grid will be added to theMeshes folder. If you imported the grid as part of
creating a topography, a hyperlink to the grid in theMeshes folder will appear as part of the
defined topography.

Creating a Mesh
Leapfrog Geo provides you with several tools for creating meshes:

l Mesh from the Moving Plane

l Combining Meshes

l Clipping a Volume

l Clipping a Mesh

l Extracting Mesh Parts

These tools produce non-editablemeshes ( ).

You can also create editablemeshes ( ) that are interpolated or triangulated:

l An interpolated mesh uses FastRBF to fit and interpolate surface data. The FastRBF is useful
for creating meshes from sparse datasets or when data has large areaswhere there are no
points. Interpolated meshes can be created frompoints data, GIS data, polylines, structural
data and values objects.

l A triangulated mesh usesDelaunay triangulation to create themesh. Triangulated meshes
can be created frompoints data, GIS data and polylines. A triangulated mesh is suitable only
for horizontal surfaces.

Editablemeshes can bemodified using other data in the project. See:

l Interpolated Meshes

l Triangulated Meshes

l Offset Meshes

Mesh from the Moving Plane
When a vertical wall, flat fault plane or other flat geological surface is required, themoving
plane can be used to create a simplemesh.
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To create a newmesh from themoving plane, first display the plane in the scene by clicking on
the Show Plane button ( ). Use the controls in the scene to position the plane, then right-click
on theMeshes folder and selectMesh From Moving Plane. TheMesh From Planewindowwill
appear:

Set theResolution for themesh, enter a name and clickOK. The newmesh will appear in the
Meshes folder.

See Surface Resolution in Leapfrog Geo formore information on the resolution setting.

Combining Meshes
To create a newmesh from two existing closed meshes, right-click on theMeshes folder and
selectMesh Operations > Boolean Volume. The Boolean Volumewindowwill appear:

The Available list shows all closed meshes available in the project. Select a mesh by double-
clicking on it or by clicking on it, then on the arrow.

TheOperation type can be Intersect orUnion.

ClickOK to save the newmesh, which will appear in theMeshes folder. To edit themesh,
double-click on it. The Boolean Volumewindowwill appear.

When any of themeshes used to create the volume ismodified, the volumewill be updated.
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Clipping a Volume
To clip a closed mesh using anothermesh, right-click on theMeshes folder and selectMesh
Operations > Clip Volume. TheClip Volumewindowwill appear. Select themeshes you wish
to use and whether to retain the inside or outside of the clipped mesh.

ClickOK to save the newmesh, which will appear in theMeshes folder. To edit themesh,
double-click on it.

When either of themeshes used to create the clipped volume ismodified, the clipped volume
will also be updated.

Clipping a Mesh
This option creates a newmesh that consists of the parts of a Clipmesh that are inside, outside
or overlap with theUsingmesh. To clip onemesh using anothermesh or boundary in this
manner, right-click on theMeshes folder and selectMesh Operations > Clip Mesh. TheClip
Meshwindowwill appear:

Select themeshes to use, then choosewhether to retain the inside or the outside of the clipped
mesh. Tick the Include overlap box to include the overlap between the twomeshes as part of
the newmesh.

ClickOK to save the newmesh, which will appear in theMeshes folder. To edit themesh,
double-click on it. TheClip Meshwindowwill appear.

When either of themeshes used to create the clipped mesh ismodified, the clipped mesh will be
updated.
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Extracting Mesh Parts
To extract the triangles froma mesh and create a newmesh, right-click on the surface and
select Extract Mesh Parts. The Extract Mesh Partswindowwill appear:

The Extract clipped mesh option is only available formeshes that are clipped to a boundary.
The largest part is initially selected. You can sort themesh parts byVolume or byArea by clicking
the heading of the respective column. Other options are:

l Select all parts by clicking the Select All button. To de-select all parts click theRemove All
button.

l Inside-out parts have negative volume. To remove them, click theRemove Inside-Out
button.

l To remove parts smaller than a given size, first click the Select All button. Select the last item
you want to keep and click theRemove Below Current button.

ClickOK to save the newmesh, which will appear in theMeshes folder. Themesh generated is a
non-editablemesh ( ).

Meshes created in thisway are not connected to themesh theywere created from. Changes
to the original mesh will not be reflected in the selected parts.

If the quality of themesh produced is not acceptable, clip themesh as described in Clipping a
Mesh.

Interpolated Meshes
An interpolated mesh is a type of editablemesh ( ). An interpolated mesh uses FastRBF to fit
and interpolate surface data. The FastRBF is useful for creating meshes from sparse datasets or
when data has large areaswhere there are no points. Interpolated meshes can be created from
points data, GIS data, polylines, structural data and values objects.

Interpolated meshes can be edited by adding more data to themesh and changing settings.
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This topic describes creating and working with interpolated meshes. It is divided into:

l Creating an Interpolated Mesh

l Refining an Interpolated Mesh

l Surface Resolution Settings

l Snap Settings

l Other Options

Creating an Interpolated Mesh

The steps for creating a mesh fromdata in the project are similar, regardless of the data used to
create themesh. The exception is creating an offset mesh, which requires additional
parameters. SeeOffset Meshes formore information.

To create an interpolated mesh fromdata in the project, right-click on theMeshes folder and
select from theNew Mesh options.

Here, a newmesh is being created frompoints:

Select the required object from the list.

When defining themesh’s extents, you can set the extents to be independent of other objects in
the project (Own extents) or you can use the extents of another object (Shared with). When
you select the Shared with option, themesh will be updated when the extents object it shares is
updated.

Leapfrog Geo automatically sets the surface resolution based on the data available in the
project. You can experiment with the surface resolution and adaptive settings once you have
created themesh. See Surface Resolution in Leapfrog Geo formore information on the effects
of these settings.

Enter a name for the newmesh and clickOK.

If you are creating themesh froma polyline, you will be prompted to select an existing polyline
or draw a new one. If you draw a new polyline, it will not be able to be used elsewhere in the
project unless it has been shared. To share the polyline, expand themesh in the project tree,
right-click on the polyline and select Share.

The newmesh will appear in theMeshes folder. Expand themesh in the project tree to see how
it wasmade. As further refinements aremade to themesh, that information will also be added to
themesh in the project tree.
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Refining an Interpolated Mesh

Editable interpolated meshes ( ) can be refined by adding data, as described in Adding Data to
Surfaces. The options available depend on how themesh was created.

To add data to an editablemesh, right-click on it and select one of the options from the Add
menu. A list of objects available in the project will be displayed. Select the required object and
clickOK. Themesh will be updated and the object used tomodify it will appear under it in the
project tree.

You can also refine editable interpolated meshes by changing the trend, transforming values,
adjusting the interpolant and changing the boundary. To do this, double-click on themesh.
The Edit Meshwindowwill be opened:

SeeOffset Meshes for the options available formeshes fromoffset points.

Surface Resolution Settings

See Surface Resolution in Leapfrog Geo formore information on the Surface resolution
settings in theGeneral tab.

Snap Settings

Themesh can be set to snap to the data objects used to create it. There are four options:

l Off. Themesh does not snap to the data.

l All data. Themesh snaps to data within theMaximum snap distance.

l Drilling only. Themesh snaps only to drillhole data and data objects derived fromdrillhole
data within theMaximum snap distance but not to other data. For example, themesh will
honour points data derived fromdrillhole data, but not points data imported into the Points
folder.

l Custom. Themesh snaps to selected data objectswithin theMaximum snap distance.
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Snapping to data is off by default. Although you can snap to all data, this is not
recommended as it increases the possibility that errors in the data or assumptions inherent in
interpretations (e.g. polylines) will cause distortions in themeshes. If you do enable snapping,
is best to snap only to drilling data.

When Snap to data is set toCustom, you can then set whether or not Snap is enabled for the
objects used to create themesh, as discussed in Contact Honouring. Custom is themost
flexible options as you can select the specific data objects themesh will or will not snap to.

If you will be exporting themesh for use in another application, you maywish to adjust the snap
settings.

Data used to create themesh will appear in the Input list. When you add more data to themesh,
those objectswill also be listed. You can remove those additional objects by expanding the
mesh in the project tree, then right-clicking on the data object and selecting Remove.

Other Options

In the Boundary tab, you can changewhether themesh boundary is independent of other
objects in the project (Own extents) or you can use the extents of another object (Shared with).
When you select the Shared with option, themesh will be updated when the extents object it
shares is updated.

Options available in other tabs are similar to those available for interpolants. See:

l Structural Trends

l Clipping and Transforming Values for an RBF Interpolant

For information on the parameters in the Interpolants tab, see:

l Interpolant Functions

l The Spheroidal Interpolant Function

l The Linear Interpolant Function

Triangulated Meshes
A triangulated mesh is a type of editablemesh ( ). A triangulated mesh usesDelaunay
triangulation to create themesh and can handlemore points than an interpolated mesh.
Triangulated meshes can be created frompoints data, GIS data and polylines. Large datasets
representing horizontal surfaces can be used to create a triangulated mesh.
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The steps for creating a mesh fromdata in the project are similar, regardless of the data used to
create themesh. To create a triangulated mesh fromdata in the project, right-click on the
Meshes folder and select from theNew Triangulated Mesh options.

Here, a new triangulated mesh is being created frompoints:

Select the required object from the list.

When defining themesh’s extents, you can set the extents to be independent of other objects in
the project (Own extents) or you can use the extents of another object (Shared with). When
you select the Shared with option, themesh will be updated when the extents object it shares is
updated.

TheUse error threshold setting lets you exclude data points that fall within the threshold. This
can be useful if you are using a large dataset and you require a more coarse surface that omits
some data. When Use error threshold is disabled, themesh will follow all the data.

Here, a mesh created frompoints has theUse error threshold disabled. Themesh follows all
the points:
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Here, a mesh has been created with theDistance set to 20. Themesh ignores points that fall
outside the threshold:

You will be able to change theUse error threshold setting once themesh has been created.

Enter a name for the newmesh and clickOK.

If you are creating themesh froma polyline, you will be prompted to select an existing polyline
or draw a new one. If you draw a new polyline, it will not be able to be used elsewhere in the
project unless it has been shared. To share the polyline, expand themesh in the project tree,
right-click on the polyline and select Share.

The newmesh will appear in theMeshes folder and you can edit its settings by double-clicking
on it.

To add data to a triangulated mesh, right-click on it and select one of the options from the Add
menu. A list of objects available in the project will be displayed. Select the required object and
clickOK. Themesh will be updated and the object used tomodify it will appear under it in the
project tree.

Offset Meshes
You can create a new interpolated mesh by offsetting an existing mesh with any points object in
the project. To do this, first ensure the points and mesh you wish to use are already in the
project. Next, right-click on theMeshes folder and selectNew Mesh > From Offset Points. In
thewindow that appears, select theMesh and Points to use:
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When themesh is created, it will automatically snap to the points, and points outside the
Distance Limitswill be ignored. These settings can be changed once themesh has been
created.

An offset mesh may be distorted if points used to offset themesh lie too far outside themesh
extents. If this occurs, set aMaximum distance to exclude points far away from themesh
extents.

Enter a name for the newmesh and clickOK. The newmesh will appear in theMeshes folder.

Editing an Offset Mesh

To edit themesh, double-click on it. The Edit Offset Meshwindowwill appear:

Themesh can be set to snap to the data objects used to create it. There are four options:

l Off. Themesh does not snap to the data.

l All data. Themesh snaps to data within theMaximum snap distance.

l Drilling only. Themesh snaps only to drillhole data and data objects derived fromdrillhole
data within theMaximum snap distance but not to other data. For example, themesh will
honour points data derived fromdrillhole data, but not points data imported into the Points
folder.

l Custom. Themesh snaps to selected data objectswithin theMaximum snap distance.

Snapping to data is off by default. Although you can snap to all data, this is not
recommended as it increases the possibility that errors in the data or assumptions inherent in
interpretations (e.g. polylines) will cause distortions in themeshes. If you do enable snapping,
is best to snap only to drilling data.
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When Snap to data is set toCustom, you can then set whether or not Snap is enabled for the
objects used to create themesh, as discussed in Contact Honouring. Custom is themost
flexible options as you can select the specific data objects themesh will or will not snap to.

If you will be exporting themesh for use in another application, you maywish to adjust the snap
settings.

Data used to create themesh will appear in the Input list. When you add more data to themesh,
those objectswill also be listed. You can remove those additional objects by expanding the
mesh in the project tree, then right-clicking on the data object and selecting Remove.

You can modify an offset mesh by adding data, as described in Refining an Interpolated Mesh.
You can also edit themesh’s boundary, but you cannot apply a trend, clip and transformvalues
or adjust the interpolant as you can for other interpolated editablemeshes.

Draping an Image on a Mesh
You can drape images on anymesh in theMeshes folder. To do this, right-click on themesh in
theMeshes folder and select one of theDrape Image options.

l For the Import Image option, you will be prompted for a file location. Navigate to the folder
containing the image you wish to drape, select the file and clickOpen. Set georeferencing
information for the image, if required, then clickOK. See Importing a Map or Image formore
information on georeferencing images. The imported imagewill appear in the project tree
under themesh.

l For the Select Existing Image option, select from the images available in the project and click
OK. A hyperlink to the imagewill appear in the project tree under themesh.

You can drape asmany images as required. When themesh is displayed in the scene, you will be
able to select any draped images from the list of display options.

When you import and georeference an image, you can then export it as a GeoTIFF. To do
this, right-click on it in the project tree and select Export. You will be prompted for a
filename and location. Click Save.

Mesh Export
You can export a mesh created in Leapfrog Geo for use in other software. Formats Leapfrog
Geo can export are:

l Leapfrog Files (*.msh)

l Gocad Files (*.ts)

l DXF Files (*.dxf)

l Surpac Files (*.dtm, *.str)

l GemcomFiles (*.tri)

l Datamine Files (*pt.asc, *tr.asc)

l Micromine Files (*MMpt.dat, *MMtr.dat)
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l DXF Polyface Files (MineCAD) (*.dxf)

l AliasWavefront Object Files (*.obj)

If you have theMaptek Linkmodule, you can also export meshes in VULCAN .00t format.
Contact Customer Support as described inGetting Support formore information about
licensing thismodule.

The rest of this topic describes the different ways to export meshes. It is divided into:

l Exporting a Single Mesh

l Exporting Multiple Meshes from the Meshes Folder

l Exporting Multiple Meshes from Models

Exporting a Single Mesh
To export a mesh, right-click on themesh and select Export. The Export Mesh Partswindow
will appear:

The Export clipped mesh option is only available formeshes that are clipped to a boundary.
If the quality of themesh produced is not acceptable, clip themesh as described in Clipping
a Mesh, then export themesh.

Select the Parts to Export and Number of Significant Digits, then clickOK. You will be
prompted for a filename and location.
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Exporting Multiple Meshes from the Meshes Folder
To export multiplemeshes from those in theMeshes folder, right-click on theMeshes folder
and select Export Meshes. In thewindow that appears, select themeshes you wish to export:

The filename that will be used for each mesh is shown in the Filenames column. To change the
filename for any of themeshes, click on its name in the Filenames column.

Next, select the format required and where to save the exported meshes. Click Export to save
themeshes.
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Exporting Multiple Meshes from Models
You can export multiplemeshes from individual geological models, numericmodels, combined
models and staticmodels. To export meshes in thisway, right-click on a model or interpolant
and select Export. In thewindow that appears, select the volumes and surfaces you wish to
export:

For geological models, if you wish to export surfaces other than the output volumes, untick the
Only Output Volumes option. For faulted geological models, you also can select from the
faulted volumes by ticking the Faulted Volumes box.

The filename that will be used for each mesh is shown in the Filenames column. To change the
filename for any of themeshes, click on its name in the Filenames column.

Next, select the format required and where to save the exported meshes. For any of the export
options other than Leapfrog Model Files format, you can save themeshes as a zip file.

The Leapfrog Model File format exports a single *.lfm file. If the file is imported into the
Meshes folder, each output volumewill appear as a singlemesh.

Click Export to save themeshes.

Elevation Grid Export
For anymesh in a project, you can export an elevation grid for use in other software. Formats
Leapfrog Geo can export are:

l ARC/Info ASCII Grid (*.asc)

l ESRI.hdr Labelled (*.bil)
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l ENVI Raster Image (*.img)

l Surfer ASCII Grid (*.grd)

If you have theMaptek Linkmodule, you can also export an elevation grid in VULCAN v7
.00g format. Contact Customer Support as described inGetting Support formore
information about licensing thismodule.

To export an elevation grid, right-click on themesh and select Export Elevation Grid. The
Export Gridwindowwill appear:

The Snap to Grid option changes the extents of the exported grid so that they coincidewith the
elevation grid spacing.

Enter the information required, then click Export to enter a filename and choose a location and
format for the file.

Thickness Grid Export
For anymesh in a project, you can export a grid made up of the area between two surfaces.
Formats Leapfrog Geo can export are:

l ARC/Info ASCII Grid (*.asc)

l ESRI.hdr Labelled (*.bil)

l ENVI Raster Image (*.img)

l Surfer ASCII Grid (*.grd)
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To export a thickness grid, right-click on themesh and select Export Thickness Grid. The
Export Thickness Gridwindowwill appear:

Select the surfaces required from the lists.

Enter the information required, then click Export. You will be prompted for a filename and
location.
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Polylines
Leapfrog Geo importsmany common polyline formats and also has tools for drawing and
exporting polylines. See Import Polyline below. Polylines imported into Leapfrog Geo are
stored in the Polylines folder.

There are threeways to create polylines in Leapfrog Geo:

l Create a new polyline using the Polylines folder. These polylines are stored in the Polylines
folder.

l Create a new polyline as part of working with another tool. For example, a polyline can be
drawn to create a lateral extent in a geological model. These polylines are stored in the tool
used to create themand cannot be used elsewhere in the project unless they have been
shared. To share a polyline, right-click on it and select Share. The polyline will bemoved to
the Polylines folder and can be used elsewhere in the project.

l Create a new polyline froma GIS line. To do this, right-click on the GIS lines object ( or ) in
theGIS Data, Maps and Photos folder and select Extract Polyline. The new polyline object
will appear in the Polylines folder. It is not linked to the original GIS lines object.

Polylines can be drawn using the curved polyline drawing tool or the straight line drawing tool.
SeeDrawing in the Scene formore information on both tools.

Polylines can be exported in the formats described in Export Polyline below.

Import Polyline
Polyline formats Leapfrog Geo supports include:

l Datamine Polylines (*.asc)

l Surpac String Polylines (*.str)

l GemcomPolylines (*.asc)

l Micromine Polylines (*.str, *.asc)

l MineSight Polylines (*.srg)

l Gocad Polylines (*.pl, *.ts)

l Drawing Interchange Polylines (*.dxf)

l Leapfrog Polylines (*.lfpl)

l Leapfrog Polylines (*.csv, *.txt)

There are twoways to import a polyline:

l Right-click on the Polylines folder and select Import Polyline. In the Import Polyline
window, navigate to the location where the polyline file is saved and select it. ClickOpen.

l Drag and drop polyline files directly into Leapfrog Geo.

If the polyline file is in Leapfrog, Gocad or DXF formats, the importing will start immediately. For
all other formats, the Polyline Importwindowwill appear. If the polyline file is in one of the
standard formats listed above, the default settings can be used. Click Import to finish the
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process. If, however, you wish to specify polyline import parameters, two pieces of information
are required:

l The columns the polyline vertex coordinates are in

l How the polyline sections are separated in the file

Select the vertex coordinate columnsby clicking on the heading at the top of a column and
selecting one of East (X), North (Y) or Elev (Z) from the list.

When importing a file that hasmultiple features, you will be prompted to select which ones to
import. You can also choose to:

l Import the features as separate objects. Each feature will appear in the project tree as a
separate object.

l Flatten all features into one object. Leapfrog Geowill treat all features as a single object.

The polyline will be imported and added to the project tree under the Polylines folder.

Reload Polyline
Reloading data is necessarywhen the imported data ismodified externally. To reload a polyline,
right-click on it in the project tree and select Reload Data.

Reloading a polyline overwrites any changes you havemade to the polyline. Any dependent
objectswill be updated, which can take some time.

Select the file to be reloaded and clickOpen. The polyline will be updated, aswill any
dependent objects.

Export Polyline
Export a polyline by right-clicking on it and selecting Export. Leapfrog Geo exports polylines in
the following formats:

l Leapfrog Polylines (*.lfpl)

l Leapfrog Polylines (*.csv)

l Drawing Interchange Polylines (*.dxf)

l Surpac String Polylines (*.str)

l Gocad Polylines (*.pl, *.ts)

l MineSight Polylines (*.srg)

l Datamine Polylines (*.asc)

l Micromine Polylines (*.str, *.asc)
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Geochemical Data
With theGeochemistry folder, you can establish a live link to ioGAS and visualise geochemical
data in real time. You can also transfer data between Leapfrog Geo and ioGAS, including data
towhich query filters have been applied.

TheGeochemistry folder and related features are only available as part of the Geochemistry
module. Contact Customer Support as described inGetting Support formore information
about licensing thismodule.

To connect to ioGAS, make sure ioGAS is running. Next, right-click on the ioGAS object in the
project tree and selectConnect:

Once the connection is established, any dataset open in ioGAS will be available from the ioGAS
object and can be displayed in the Leapfrog Geo scenewindow:

The status of the connection to ioGAS is indicated in Leapfrog Geo, and the data file open in
ioGAS appears in theGeochemistry folder (e.g. demo.gas).

You can view the data in Leapfrog Geo by adding the ioGAS data object to the scene. When
attributes are changed in ioGAS, the displaywill be updated in Leapfrog Geo. You can also:

l Send fromand to data columns across the ioGAS link, analyse the data in ioGAS and import
calculated columns as interval tables. This data can then be used formodelling in Leapfrog
Geo. See Sending Data to ioGAS.

l Import ioGAS data into Leapfrog Geo as points or intervals. See Importing ioGAS Data.
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To terminate the connection to ioGAS, right-click on the ioGAS object and selectDisconnect:

Once the connection to ioGAS is terminated, ioGAS data (*.gas) will no longer be available in
Leapfrog Geo.

Sending Data to ioGAS

This feature is only available as part of the Geochemistrymodule. SeeGeochemical Data for
more information.

This topic describes sending data to ioGAS and return it to Leapfrog Geo. Topics are:

l Creating a New ioGAS Data Object

l Opening the Data in ioGAS

l Sending a New Data Column Back to Leapfrog Geo

ioGAS version 6.1 and later recognise holeid, Fromand To columns sent fromLeapfrog Geo.
Earlier versions of ioGAS can only import point data.

Creating a New ioGAS Data Object
To send data to ioGAS, you must first create a data object from the drillhole data in the project.
This process uses data froma single interval table to create a new ioGAS object that can then be
opened in ioGAS.

Note that interpretation tables cannot be used to send data to ioGAS. If you wish to send an
interpretation table to ioGAS, export it fromLeapfrog Geo and then import it back into the
project.

There are two considerationswhen creating an ioGAS data object:

l Are all data columns you wish to send over the ioGAS link in the same table? Creating an
ioGAS data object uses a single interval table. If the data you wish to send is in different tables,
create a merged table.

l Are lithology intervals similar in length to assay data intervals or are there significant
differences? The solution is to apply a majority composite to the lithology data using the
interval lengths from the assay table and then create a merged table containing all the data
columns you wish to send over the link.

SeeMerged Drillhole Data Tables andMajority Composites formore information.
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To create a new ioGAS data object, right-click on the ioGAS object and selectNew ioGAS Data:

You can filter the data you send to ioGAS using any of the query filters defined in the project.
Make sure the query filter you wish to use has been defined before you start creating a new
data column.

In thewindow that appears, select the table you wish to use for the Base table, then select the
columns to send to ioGAS. If you wish to filter the data, select the query filter required from the
list.

Enter a Name for the data column and clickOK. The new data column will appear as part of the
ioGAS folder:

Note that any filter applied to the data is part of the new data object and will be sent to ioGAS
over the link.

The next step is to open the data in ioGAS.
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Opening the Data in ioGAS
Ensure that Leapfrog Geo is connected to ioGAS.

Make sure no tasks are being processed in Leapfrog Geo before opening the link from ioGAS.
An errormay result in ioGAS if Leapfrog Geo is processing tasks.

In ioGAS, select File > Open Link Data. Once the column has been opened, you can use the
tools available in ioGAS to analyse the data. That the data is open in ioGAS is indicated in the
project tree:

If a connection cannot bemade between Leapfrog Geo and ioGAS, it could be that the
Timeout setting in ioGAS is too low. To change this, navigate to the folder
C:\Users\....\AppData\Roaming\ioGAS\userConfig. Open the file link.ini in a text editor and
set the Timeout parameter to a higher value. The Timeout is in milliseconds.

If you have the data visible in the Leapfrog Geo scene, changesmadewill be displayed in
Leapfrog Geo. Here the ioGAS attributemanager has been used to assign colours to the
selected values in ten equal ranges:

The changes to attributes are automatically updated in the Leapfrog Geo scenewindow as
long as the link is live.
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Sending a New Data Column Back to Leapfrog Geo
To save the changes and send a new data column back to Leapfrog Geowhile the ioGAS link is
live, select one of theMake Variable Fromoptions from theDatamenu in ioGAS.

In Leapfrog Geo, the column will be added to the base interval table used to create the new
lithology. Here, a column called MRV_Au ( ) has been added to the base table:

When the connection to ioGAS is terminated, the ioGAS data column will remain in the
project tree as part of the ioGAS folder. Data columns created in ioGAS will also be available
and will appear in the base interval table.

Importing ioGAS Data

This feature is only available as part of the Geochemistrymodule. SeeGeochemical Data for
more information.

When Leapfrog Geo is connected to ioGAS and a dataset is open, you can import the ioGAS
data into Leapfrog Geo. There are two options:

l Importing ioGAS Data as Points

l Importing ioGAS Data as Intervals

When data is imported as points, it is added to the Points folder. When imported as intervals,
data is added to an existing interval table or used to create a new interval table. Whichever
method is selected, if the data is changed in ioGAS, it will need to be reimported.
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ioGAS version 6.1 and later can send a “Filter” attribute to Leapfrog Geo. If you wish to import
this attribute, set it to a category column. This imported column will appear in Leapfrog Geo as
a query filter:

Importing ioGAS Data as Points
To import ioGAS data as points, right-click on the ioGAS data object in the project tree and
select Import as Points:

In thewindow that appears, select the data columns you wish to import and how theywill be
imported. Click Finish to import the data, which will appear in the Points folder. You can then
display the points in the scene and workwith themas you would any other points object. The
new points object will remain in Leapfrog Geo once the connection to ioGAS is terminated.

Importing ioGAS Data as Intervals
To import ioGAS data as intervals, right-click on the ioGAS data object in the project tree and
select Import as Interval Values. Select the table towhich the imported column will be added
or select the option to create a new table. Click Import.

l For a new table, select the columns you wish to import and enter a name for the table. Click
Finish. The new table will be added to theDrillholes object.

l For adding the data to an existing table, the process is similar to that for adding a column.
Select the columns to import, then click Finish.
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Analysing Data

This part describes the tools available in Leapfrog Geo for analysing data.

l Visualising data using the shape list and the shape properties panel is an important part of
interpreting and refining data and making modelling decisions. The tools available depend
on the type of object being displayed, and many objects can be displayed evaluated on other
objects.

l Viewing statistical information about objects helps you to analyse your data.

l Stereonets are useful for visualising structural data and identifying trends in 2D. Errors in
categorisation of structural data can also become apparent when the data is viewed on a
stereonet.

l Form interpolants are useful for visualising structural data and identifying broad trends in 3D.
The form interpolant’smeshes can then be used to control other surfaces in the project.

l With the drillhole correlation tool, you can view and compare selected drillholes in a 2D view.
You can then create interpretation tables in which you can assign and adjust intervals and
create new intervals. Interpretation tables are like any other interval table in a project and can
be used to createmodels.

l You can plan drillholes, view prognoses formodels in the project and export planned
drillholes in .csv format. Leapfrog Geo can also import planned drillholes.
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Visualising Data
Visualising data is an important part of interpreting and refining data and making modelling
decisions.

This part describes the tools available in Leapfrog Geo for visualising data. These tools are
accessed via the shape list and the shape properties panel:

The tools available depend on the type of object being displayed:

l Drillholes can be displayed as lines or points and with the data associated with each segment.
Data can be filtered using the shape properties panel controls and by applying query filters.

l Multiple drillhole data tables can be displayed in the scene so that relationships between data
in different tables can be explored.

l Some data can be displayed using a colour gradient, with the colourmap adjusted to
enhance values of interest. Discrete colourmaps can also be applied to view numeric data in
groups.

l Points data can be viewed as simple points or using the size of spheres to display associated
values.

l GIS data can be viewed in its native form, on the topography or as part of a custom
topography view.

Many objects in Leapfrog Geo can be displayed evaluated on other objects. See Evaluations.

Presentation describes how to display data and create scenes, movies and scene files for
presentation purposes.
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The Shape List and Shape Properties Panel
Once objects have been added to the scenewindow, theywill appear in the shape list, which
can be treated as a working set of objects:

You can use controls in the shape list and the shape properties panel to change theway those
objects are displayed. This is useful in interpreting data and making modelling decisions.

Changing how you view objects in the scenewindow does not change those objects in the
project tree.

This topic is divided into:

l Removing Objects from the Scene

l The View List

l Colour Options

l Opacity

l Property Buttons

l Legends

l The Shape Properties Panel

Removing Objects from the Scene
All objects in the shape list have a button ( ) that will remove the object from the scene. Most
objects also have a visibility button ( ) that can temporarily hide that object in the scene. It is
often easier tomake an object temporarily invisible than to remove it from the list. Some objects
have an edit button ( ) that you can click to begin editing the object.

The View List
The view list is available for objects that can be displayed in different ways. For example, a
lithology data tablemay contain several columns and the column displayed can be selected
from the view list:
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Geological and numericmodel evaluations are also selected from the view list. See Evaluations.

Colour Options
The colour options for an object depend on the type of object. Three different colour display
options are shown below:

l The Contaminant table uses a continuous colourmap to display the numeric data. See
Colourmaps and Colour Gradients formore information.

l The collar table is displayed using a single colour. Click the colour chip to change the colour.
SeeDisplay Colours.

l TheGeology table is displayed according to a colourmap of the categories in the table. These
colours can be changed by clicking on the Edit Colours button, then clicking on each colour
chip in the Legendwindow.

If your organisation uses standard colour coding for category and numeric data, you can import
colourmaps for these data types. SeeColourmap Import and Colour Gradients in Colourmaps
and Colour Gradients.

Opacity
The opacity slider controls the transparency of objects in the scene:

Property Buttons
Property buttons vary according to the type of object. For example, property buttons can show
or hide the triangles on a mesh, render points as spheres or display a surface clipped to a model
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boundary. You can always find out what a button does by holding the cursor over the button:

Legends
You can display a legend formany objects, including lithologies. To do this, click the legend
button in the shape list:

To remove the legend from the scene, either click the legend button again or click the red X in
the scenewindow:

The Shape Properties Panel
The shape properties panel adjacent to the shape list providesmore detailed control of the
appearance of the selected object:

Slice Mode

The properties available depend on the type of object, but the Slice mode appears for all
objects. SeeDisplaying Sliced Data formore information.
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Filtering Data Using Queries

When a data table is selected in the shape list, you can use the controls in the shape properties
panel to apply filters to the data in the scene. If query filters are available for the selected object,
theywill be listed in theQuery filter list:

Filtering Data Using Values and Categories

You can also filter the range of values displayed by ticking the Value filter box, then setting the
upper and lower limits of the range of data displayed:

If the data includes date information, you can use the Value filter option to restrict the display
to a range of dates.

Selecting Multiple Objects

You can select multiple objects in the shape list and change their display properties using the
shape properties panel. To do this, hold down the Shift or Ctrl keywhile clicking each object
you wish to change:

Only controls common to the selected objects are available.
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Display Colours
Many objects viewed in the scene are displayed using a single colour. To change the colour,
add the object to the scenewindow, then click on the colour chip in the shape list. A window
will appear in which you can change the colour:

You can:

l Click and drag the ring to pick a colour, then select the darkness or lightness of the colour
from the triangle.

l Click on the eyedropper tool ( ), then click on something elsewhere on the screen to select
the colour of that part of the screen.

l Select a colour chip from the palette.

l Set a randomcolour.

l Enter specific values for the colour to use.

Changesmade are automatically applied to the scene. TheRevert button changes back to the
colour assigned when thewindowwas first opened.

Colourmaps and Colour Gradients
Some objects viewed in the scene are displayed using a colourmap based on continuous colour
mapping or discrete categories. Leapfrog Geo automatically generates a colourmap based on
the data, but manually altering a colourmap often helps in understanding the data. In addition,
if your organisation uses standard colourmaps, you can import colourmaps and colour
gradients to standardise the display of data across projects.

l Category data colourmaps can be edited by adding the data column to the scene, then
clicking on the Edit Colours button in the shape list, as described in Colour Options. Then
click on each colour chip in the Legendwindow. Category colourmaps can also be imported
and exported.

l Numeric data colourmaps can be continuous and discrete and can also be used to display
date information. Numeric colourmaps can be imported and exported and can also use
imported colour gradients.
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This topic describes how to use colourmaps and colour gradients. It is divided into:

l Colourmap Import and Export

l Colourmap Import

l Colourmap Export

l Editing a Colourmap

l Continuous Colourmaps

l Discrete Colourmaps

l Displaying Dates

l Colour Gradients

l Deleting Colour Gradients

For information on the colour display options available for different objects, seeColour
Options in The Shape List and Shape Properties Panel.

Colourmap Import and Export

Colourmaps for category and numeric data can easily be shared between projects on a
column-by-column basis. To import or export a colourmap, expand the data object in the
project tree and right-click on a column. The Import and Export options are available from the
Coloursmenu:

Colourmap Import

When you import a colourmap:

l For category colourmaps, the existing colourmap will be overwritten.

l For numeric colourmaps, the imported colourmap will be added to those already defined.

To import a colourmap, right-click on the data object and selectColours > Import. Navigate to
the folder containing the colourmap file and clickOpen.

If the object hasmore than one colourmap associated with it, you will be prompted to choose
which one to overwrite.

If the column you expected is not listed, check to see if you have selected the correct file.
The columnsdisplayed are those that correspond to the type of data in the selected file
(category or numeric).

Click Import.

Leapfrog Geowill map the information in the file to the information in the selected data
column.
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Colourmap Export

To export a colourmap, right-click on the data object and selectColours > Export. If more than
one colourmap is associated with the selected object, you will be prompted to choose from
those available. Click Export.

In thewindow that appears, navigate to the folder where you wish to save the colourmap. Enter
a filename and click Save. The colourmap will be saved in *.lfc format.

Editing a Colourmap

To edit the colourmap for an object, add the object to the scene. Click on the colourmap in the
shape list and select Edit Colourmaps:

The Edit Colourmapswindowwill display the colourmap that is currently being used to display
the data. Changes you make in thiswindowwill be updated in the scene.

To save the currently displayed colourmap and return to themain window, clickClose.

Clicking Revert All deletes all customcolourmaps and cannot be undone.

Continuous Colourmaps

When using a continuous colourmap, theGradient list includes built-in gradients aswell as any
that have been imported into theColour Gradients folder. The scenewill be updated to reflect
the changes you make in this screen.

Once you have selected a gradient, you can change how it is used to display the data by
adjusting the limits and the curve points.

The values that lie outside the Limits are coloured with the last colour at the relevant end of the
colourmap. If theDynamic box is ticked, the gradient will be updated when the data is updated,
such aswhen drillhole data is appended. If the box is unticked, the valuesmanually set for the
Minimum andMaximum limitswill control the lower and upper boundsof the colourmap.
Reducing the range of the upper and lower bounds is useful if the bulk of the data points have
values in a rangemuch smaller than the overall range of the data. This is common in skewed
data.

The From Input Data button automatically adjusts theMinimum andMaximum Limit values so
that the colourmap would follow the actual data distribution of the input data. Click this button
and see if these values are adjusted.
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The transformation of the colourmap can be adjusted by dragging the dots:

It can be helpful to view the histogramof the data when adjusting the curve points. Both the
Propertieswindow and the Edit Colourmapswindow can be open at the same time.

Discrete Colourmaps

When you create new colourmaps, there are two types to choose from: continuous and
discrete.

When you create a discrete colourmap, categories are defined and applied to the data
displayed in the scene:
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Click the Add button to add new categories. The scenewill be updated to reflect the new
categories:

Displaying Dates

A colourmap can be used to display date information:
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If a date is displayed using a continuous colourmap, the curve points represent the start and end
dates.

If you use a discrete colourmap, you can use the colours to show the different stages of, for
example, a drilling campaign:

Colour Gradients

Colour gradients can be imported in the following formats:

l Geosoft Colour Files (*.tbl)

l ERMapper Lookup Tables (*.lut)

l MapInfo Colour Files (*.clr)

l Leapfrog Colour Files (*.lfc)

Perceptually uniformcolourmaps are available at
http://peterkovesi.com/projects/colourmaps/, where they can be downloaded in
ERMapper (*.lut), Geosoft (*.tbl) and Golden Software Surfer (*.clr) format.

To import a colour gradient right-click on theColour Gradients folder in the project tree and
select Import Gradient. In thewindow that appears, navigate to the folder containing the
gradient file and clickOpen. The gradient will be added to theColour Gradients folder.
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To apply a gradient to a colourmap, add an object to the scene and click on the colourmap in
the shape list. Select Edit Colourmaps. All colour gradients in theColour Gradients folder are
available from theGradient list:

Deleting Colour Gradients

If you delete a colour gradient from theColour Gradients folder and it is in use in the project,
you will need to select a replacement gradient for all colourmaps that use that gradient. Select
the replacement colour gradient from those available in the project:

Displaying Drillholes
Viewing drillhole data in the scene is an important part of refining drillhole data and building a
geological model. Therefore, Leapfrog Geo has a number of different tools for displaying
drillhole data that can help in making drillhole data processing and modelling decisions. This
topic describes those display options and is divided into:

l Displaying Drillholes as Lines or Cylinders

l Hiding Lithologies

l Displaying a Legend
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l Changing Colourmaps

l Viewing Multiple Interval Tables

l Selecting from Multiple Columns

l Displaying Interval Data in the Scene

Display drillhole data in the scene by dragging theDrillholes object into the scene. You can also
drag individual tables into the scene.

Once drillhole data is visible in the scene, click on a drillhole to view the data being displayed.
You can also display the data associated with each interval by clicking on the Show text button (
) in the shape list. Here, data display is enabled for two interval tables:

The Show trace lines button ( ) in the shape list displays all trace lines, even if there is no data
defined for some intervals. The Filter trace lines option in the shape properties panel displays
only trace lines for drillholes selected by a query filter. SeeQuery Filters formore information.
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Displaying Drillholes as Lines or Cylinders
You can display drillholes as lines or points. You can also display the data associated with each
segment. Here, the drillholes are displayed as flat lines:

Thewidth of the lines is set in the shape properties panel.

When theMake lines solid button ( ) is enabled, the drillhole data is displayed as cylinders and
the property that can be controlled is the Line radius:
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Hiding Lithologies
When lithology tables are displayed, you can hide some of the lithologies to help make better
sense of the information in the scene. Click on the Edit Colours button in the shape list. In the
window that appears, use the Show/Hide buttons ( ) to determinewhat segments are
displayed:

To select multiple lithologies, use the Shift or Ctrl keyswhile clicking. You can then change the
visibility of all selected lithologies by clicking one of the visibility ( ) buttons.

Hiding lithologies in thisway only changes how the data is displayed in the scene. Another
way of limiting the data displayed is to use a query filter (seeQuery Filters), which can later
be used in selecting a subset of data for further processing.

Displaying a Legend
To display a legend in the scene, click the Show legend button ( ) for the table:

The legend in the scenewill be updated to reflect lithologies that are hidden in the scenewhen
you click Edit Colours and hide some lithologies.
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Changing Colourmaps
To change the colours used to display lithologies, click on the Edit Colours button in the shape
list. In thewindow that appears, click on the colour chip for each lithology and change it as
described in Display Colours.

To set multiple lithologies to a single colour, use the Shift or Ctrl keys to select the colour
chips you wish to change, then click on one of the colour chips. The colour changes you
makewill bemade to all selected lithologies.

You can also import a colourmap, which is described in Colourmap Import.

Viewing Multiple Interval Tables
When viewing multiple interval tables, use the line and point size controls and the transparency
settings to see all the data at once. For example, here, the geology table has been made
transparent to show the contaminant intervals inside:

Selecting from Multiple Columns
When an interval table hasmore than one column of data, select the column to view from the
view list:
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Some columns are editable, in which case you can click on the Edit button ( ) to start editing
the table:

Displaying Interval Data in the Scene
Drillholes can be displayed with the data associated with each segment. For example, in the
scene below, contaminant values are displayed along the drillhole:

To view data in thisway, select the table in the shape list, then click on the Format Text button.
In the Text Formatwindow, click Insert Column to choose from the columns available:

You can displaymultiple columns and add text:

ClickOK to update the formatting in the scene. You can conceal the formatting in the scene by
clicking on the Show text button ( ) in the shape list:

Clear text formatting by clicking on the Format Text button, then on Clear.
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Displaying Points
Points data can be displayed using a single flat colour, using a colour gradient (seeColourmaps
and Colour Gradients) or using the points values. You can also import a colourmap, which is
described in Colourmap Import.

Aswith drillholes, points data can be displayed as flat points or as spheres. WhenMake points
solid button ( ) is enabled for points data, the data points are displayed as spheres. Here, the
values are displayed as flat points:

You can restrict the range of values displayed using the Value filter in the properties panel.

When using the spheres option ( ), the points can be displayed using the values. To do this, the
Radius values list displays the columns available:

Select the column that will be used to determine the point size.
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The Point radius control then determines themaximumpoint size displayed in the scene.

Displaying Surfaces
Leapfrog Geo assigns different colours to each side of a surface.

A basicmesh will have an inside (coloured red) and an outside (coloured blue):

In the case of contact surfaces, each sidewill be assigned a lithology. “Unknown” will be used if
multiple lithologies are contacted. Contact surfaces can be displayed using the assigned
lithologies or the younging direction:

Veins can also be displayed coloured with the thickness values.

Surfaces that are part of a geological model or interpolant are, by default, displayed clipped to
themodel boundary:

Disable theClipped surface button ( ) to view the surface unclipped.

Displaying Structural Data
Planar structural data is displayed as disks and lineations are displayed as cones. There are
several ways to change how this data is displayed.
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Planar Structural Data
In the scene below, planar structural data is displayed using the Flat colour option, with positive
(red) and negative (blue) sides shown:

You can change the colours used to display the positive and negative sides using the controls in
the shape list. You can also display the data points asThick disks, Flat disks or asOutlined flat
disks. You can change theDisk radius and theDisk size using the controls in the shape
properties panel.

Another way of displaying planar structural data is to display the categories as different colours:

You can change the colours used to display the different categories by clicking on Edit Colours
in the shape list. In thewindow that appears, click on the colour chip for each category and
change it as described in Display Colours.

To set multiple categories to a single colour, use the Shift or Ctrl keys to select the colour
chips you wish to change, then click on one of the colour chips. The colour changes you
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makewill bemade to all selected categories.

The categories displayed can also be filtered by other columns in the data table, as described in
Filtering Data Using Values and Categories.

Lineations
In the scene below, lineations are displayed using the Flat colour option in green:

Click the colour chip to change the colour used to display the cones in the shape list or select
one of the table’s columns:
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The length of the cones displayed in the scene is set in the properties panel. This can be a Fixed
Length, defined by theCone length setting, or it can be scaled using the values fromone of the
table’s columns:

Another way of displaying lineations is to display the categories as different colours:

You can change the colours used to display the different categories by clicking on Edit Colours
in the shape list. In thewindow that appears, click on the colour chip for each category and
change it as described in Display Colours.

To set multiple categories to a single colour, use the Shift or Ctrl keys to select the colour
chips you wish to change, then click on one of the colour chips. The colour changes you
makewill bemade to all selected categories.

The categories displayed can also be filtered by other columns in the data table, as described in
Filtering Data Using Values and Categories.
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Displaying Sliced Data
When you draw a slice in the scene, how objects in the scene are displayed in relation to the
slicer is controlled in the properties panel:

The From Scene setting is the default; the object is sliced according to the properties set for the
slicer.

By changing the Slice mode for objects in the scene, you can illustrate how a model has been
constructed:

Displaying GIS Data
In Leapfrog Geo, there are threeways of viewing GIS data:

l In its “native” form, as it was imported to the project. Add the GIS data object to the scene as
you would any other object.

l On the topography. GIS data objects added to a project are automatically projected onto the
topography and saved in the Topographies > Draped GIS Objects folder. Add the draped
GIS object to the scene.
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l Combined with other data draped on the topography. SeeCustom Topography Views
below.

The reason for having different ways of displaying GIS data is the difficulty posed by inconsistent
height data. Not all height data is correct or wanted. In practice, it is important for all the data to
be consistent. For this reason, a single elevation field is defined as part of the topography and
available data is assigned heights from this object. The native height information is available and
can be used to define the height of layers in themodels.

Custom Topography Views
In Leapfrog Geo, topography can be displayed with any of the GIS data and images available in
the project. With a customview, you can displaymultiple GIS data objects, maps and aerial
photos.

To create a customview, add the topography object to the scene. Select Views > Edit views
from theGIS data list:

The Edit GIS Views windowwill appear. ClickNew to create a new view. Enter a name for the
new view and clickCreate:
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The new view will be created in the Edit GIS Viewswindow, together with a list of Available
layers. Click the Add button tomove layers into theCurrent layers list and use theRaise and
Lower buttons to arrange them:

Use the transparency and point and line size controls to emphasise data.

ClickClose. The topographywill be displayed in the scenewith the new view applied:
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Evaluations
Many objects in Leapfrog Geo can be evaluated on geological models, interpolants, blocks
models, flowmodels and surfaces. To do this, right-click on an object and select Evaluations:

See Back-flagging Drillhole Data for information on evaluating drillholes on geological
models, and see Sections for information on evaluating surfaces on cross sections and fence
sections.

A windowwill appear listing all objects in the project that can be used for an evaluation. Once
you have selected one ormore objects, clickOK.

The evaluationswill be added to the object in the project tree:

When you display objects in the scene, you can select the evaluations from the view list:

© 2017 ARANZ Geo Limited



Statistics
Leapfrog Geo has a number of tools that help you to statistically analyse your data. Themost
basic information about an object is contained in the object’sPropertieswindow, as described
inObject Properties. Other tools include:

l The Histogram Tab

l Statistics

Note that a reminder of the reference for theOuter fence and Inner fence can be found by
holding yourmouse cursor over these fields to see the tooltip.

The Histogram Tab
When you view properties for some objects, a Histogram tab is available. For example, when
you view the properties for interval tables and numeric data tables, theHistogram tab shows
the distribution of the data in a particular column:

If the table contains several columns, you can display histograms for each column. If so, you will
be able to choose the other columns from the list. You can also:

l Adjust the number of intervals in the histogramby changing the Bin count.

l Remove values less than zero by ticking the Semilog X box.

Changesmade to theway the histogram is displayed are not saved when the Properties
window is closed.
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Object Statistics
Statistics are available for some objects in a Leapfrog Geo project. The information displayed is
specific to the type of object.

l For grids of points, see Evaluating a Grid of Points.

l For back-flagged drillholes see:
o Comparing Modelled Values to Drilling Lithologies

o Comparing Drilling Lithologies to Modelled Values

o Refining the Geological Model to Improve Correlation Statistics

l For RBF interpolants, seeRBF Interpolant Statistics.

l Formulti-domained RBF interpolants, see Sub-interpolant Statistics.

l For indicator RBF interpolants, see Indicator RBF Interpolant Statistics.

l For statistics on blockmodels, see Statistics in the Block Models topic.
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Drillhole Correlation Tool
With the drillhole correlation tool, you can view and compare selected drillholes in a 2D view.
You can then create interpretation tables in which you can assign and adjust intervals and
create new intervals. Interpretation tables are like any other interval table in a project and can be
used to createmodels. You can also save and export correlation set layouts and styles that can
be exported and used in other Leapfrog Geo projects.

This topic describes creating correlation sets and creating interpretation tables. It is divided into:

l Selecting Collars

l The Correlation Set Window

l Navigating in the Correlation Set Window

l Correlation Column Layouts

l Managing Styles

l Interpretation Tables

l Assigning Lithologies

l Modifying the Interpretation Table

Selecting Collars
To select collars, you need to create a drillhole correlation set, which you can do from the
scene. First, add the collars you wish toworkwith to the scene. A useful way of limiting the
number of collars displayed is to draw a slice in the scene and set it to a thick slice ( ) and set the
slice width to hide collars on either side of the slice.

Next, right-click on theDrillhole Correlation folder and selectNew Drillhole Set. The new set
will be created and opened, but is empty until you select collars. Click the Select Collars button (
) to switch to the scene and begin selecting collars:
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The line in the scene indicates the order in which collarswill appear in the set.

l To select collars one-by-one, click on the Select collar button ( ), then on the Add collar
button ( ). Click on a collar to add it to the nearest end of the set. Hold down the Ctrl key
while clicking to remove a collar from the set.

l To temporarily switch to the Select button ( ), hold down the Shift keywhile clicking.

l To select all collars visible in the scene, click on the Select all collars button ( ). Thiswill
select collars using the best fit line.

l To remove a collar from the selection, click on theRemove collar button ( ), then click on
the collar you wish to remove from the set.

l To clear the selection, click on theClear collar selection button ( ).

If you want to change the order, you can easily do so in the set tab once you have selected
collars.

Once you have selected the required collars, click the Save button ( ). The selected collarswill
be added to the set window:

© 2017 ARANZ Geo Limited



262 | Leapfrog Geo User Manual

The Correlation Set Window
Remove collars from the correlation set by either editing the set in the scene, as described in
Selecting Collars above, or right-click on a column and select Remove collar:

You can change how data is displayed by clicking on the column header, then selecting
Format:

The options available depend on the type of column being formatted.
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Click on drillholes and drag them in the correlation set window to change the order in which
they appear:

Add columns to the set by dragging them from the project tree into the set window. Here, four
columnshave been added to the set. From right to left they are a lithology column, an assay
data column, a points data column formatted as a line and a points data column formatted as
points:
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You can then format the columns to get a better view of relationships between them. Format
columnsby right-clicking on their headers and selecting Format:

The styles used to display columns can be used by other sets in the project and can be exported
to other projects. SeeManaging Styles below.

You can also drag some types of columnson top of other columns, although it is not possible to
display category data on top of other category data. You can select multiple columnsusing the
Shift and Ctrl keys.

Navigating in the Correlation Set Window
Navigate in the correlation set window using the following mouse and keyboard combinations:

l Use the scroll wheel tomove up and down.

l Hold down the Shift keywhile scrolling tomove right and left.

l Hold down the Ctrl keywhile scrolling to zoom in and out.

l Hold down the Alt keywhile scrolling to stretch the data vertically.

Correlation Column Layouts
Once you have organised data columns and how they are displayed, you can save this
information as a column layout that can be applied to other correlation sets. To do this, click the
Layout button in the toolbar and select Save Current Layout from the list:

You will be prompted for a name. ClickOK to save the layout, which can then be applied to
other correlation sets by selecting the layout from the list.

© 2017 ARANZ Geo Limited



Managing Styles | 265

To view the layouts available in the project, right-click on theDrillhole Correlation folder in the
project tree and select Layout Manager. In thewindow that appears, you can easily seewhat
columns are used for each layout and apply a layout to all correlation sets in a project:

You can also export column layouts for use in other projects and import layouts fromother
projects. Clicking Export all exports layouts as a text file.

Managing Styles
The styles used to display data columns can also be exported to other projects. To view the
styles used in the project, right-click on theDrillhole Correlation folder in the project tree and
select Style Manager:

Click Edit to change a style, which will update objects that use the selected style throughout
the project.

Click Export all to export the styles in the project as a text file that can be imported into other
projects.

Interpretation Tables
With interpretation tables, you can assign and adjust intervals and create new intervals.
Interpretation tables are like any other interval table in a project and can be used to create
models.
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To create an interpretation table, click theNew Interpretation button in the correlation set
window. TheNew Interpretation Tablewindowwill be displayed:

There are three options for creating an interpretation table:

l Create the table without using a base table. Each drillhole will have an empty legend and a
single empty interval from0 to itsmaximumdepth. Select <None> for the Source Column.

l Create the table froma base column but have no intervals. This copies the base column’s
legend but no intervals. Select the Source Column, then select Empty Table.

l Create a copy of a table. Select the Source Column, then select All Intervals.

ClickOK to create the table. A new interpretation table will be added to the project tree under
theDrillholes object and the column will be added to the correlation set window:

Assigning Lithologies
If you have created the interpretation table without using a base table, you will need to assign
lithologies to the new table. Do this as part of working with the table in the correlation set
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window, which is described below.

Modifying the Interpretation Table
In the correlation set window, the blue line is used to create intervals. Position the blue line then
right-click on it and select one of the options:

l TheCopy fromoption assigns intervals from the base table.

l The Insert interval option adds an empty interval that overrides any intervals already defined.

l TheUnassign interval option clears the lithology assigned to the interval.

l The Assign interval option opens the legend for the interpretation table so you can select a
lithology to assign to the interval. If you need to add lithologies, you can do so in thiswindow.

For example, to create an interval at the top of the table called “High Density”, move the blue
line near towhere you wish to create the interval. You do not need to be precise as you can
adjust the interval once you have added it. Right-click and select Insert interval:
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In the legend window, click the Add button and add a lithology called “High Density”:

ClickOK, then select the new lithology to close the legend window. The new lithology has
been assigned to the interval:

To resize the interval, click and drag the interval end points:

You can move the interval end point and snap it to a data point in another column. To do this:

1. Click on the interval end point and drag it into position without releasing themouse button.

2. Move themouse across to the data point you wish to snap to.
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3. Release themouse.

You can also snap to points along the depth axis.

Continuemaking changes to the interpretation table, using theUndo button to step backwards
if necessary. Save changes to update the table.
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Stereonets
Stereonets are useful for visualising structural data and identifying trends in 2D. Errors in
categorisation of structural data can also become apparent when the data is viewed on a
stereonet.

This topic describes how toworkwith stereonets in Leapfrog Geo. It covers:

l Creating a Stereonet

l Displaying the Stereonet in the 3D Scene

l Plot Options

l Data Display Options

l Viewing Stereonet Statistics

l Selecting Data in the Stereonet

l Using the Scene Window with the Stereonet

l Exporting a Stereonet

Creating a Stereonet
Create a stereonet by right-clicking on the Stereonets folder (in the Structural Modelling
folder) and selecting New Stereonet. The stereonet is created and opened in a new tab. Click
the Add button to add any structural data table in the project to the stereonet:

You can also drag and drop structural data objects from the project tree into the stereonet.
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Displaying the Stereonet in the 3D Scene
You can display the stereonet in the 3D scene by dragging the stereonet from the project tree
into the scene or by clicking on the View button ( ) in the stereonet window:

You can display planes and poles in the 3D scene, but not contours. In the shape list, you can
control whether planes or poles are displayed in the scene:

Otherwise, the appearance of the stereonet in the 3D scene is controlled from the stereonet
window.

You can also:

l Resize the stereonet. Click on it and use the green arrows to resize it.

l Move the stereonet around in the scene. The controls are the same as those for themoving
plane.

l Centre the stereonet on its input data. To do this, click on the stereonet in the shape list and
then select from its inputs in theMove to list.

© 2017 ARANZ Geo Limited



Plot Options | 272

Plot Options
ClickOptions to change plot options:

You can change the title and axes labels and select between Schmidt (equal area) and Wulff
(equal angle) plot types.

TheDesample rate affects how quickly data is displayed by combining pointswith duplicate
orientations, as determined by theDesample rate value. A low valuewill filter fewer data points,
whereas a higher valuewill filter out more data. Setting theDesample rate to 0 plots all points,
which may be slow for very large data sets that have not been declustered. TheDesample rate
applies only to how data is displayed; it does not affect the data in the table.

Data Display Options
Planar structural data can be can be displayed as planes ( ), poles ( ) or contours ( ), using
the colouring fromany column in the structural data table. Lineations can be displayed as poles (

) or contours ( ). Contourmethods available are Schmidt, Exponential Kamb and Kamb,
and contours can be displayed filled or outlined.
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Click on a line or pole to view information about the data point:

The information displayed includeswhether or not there are duplicates of the selected data
point in the data set.

Click themean button ( ) to view themean on the stereonet, which is displayed as a line for
planar structural data and as an X for lineations.
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A legend can be displayed for the stereonet as a whole ( ) and for the contours ( ). The
stereonet’s legend is generated from the categories that are visible in the list of colourings. Here,
the categories displayed are from the Bedding column:

You can also apply query filters from those available in the project.

Declustered data can be viewed on stereonets in twoways:

l Declustered data can be viewed directly on the stereonet. Simply drag the declustered table
into the stereonet.

l If the declustered data’s parent data table is displayed on the stereonet, the declustered data
is available as a filter.

For example, here a structural data table is displayed on a stereonet along with a declustered
table. The declustered table is available as a query filter for its parent object:
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Viewing Stereonet Statistics
Click the Statistics button to view statistics on the data displayed on the stereonet:

You can select specific rows and copy them to the clipboard or copy all data to the clipboard.

Selecting Data in the Stereonet
You can select data in the stereonet and assign it to new categories or existing ones. To do this,
click on the data table in the stereonet window and selectNew selection from the colouring
list:
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TheNew Category Selectionwindowwill appear:

The poleswill be displayed in the stereonet, if they are not already visible, and the data table will
also be added to the scenewindow, together with tools for selecting points in the scene.

Organising the stereonet tab and the Scene View tab so they are displayed side-by-side can
be useful in working with the data as you can select data in the stereonet or in the scene
window. This is described further in Using the Scene Window with the Stereonet below.

If you select an existing column as the Source Column, you can assign selected points to the
existing categories or create new categories. If you select <None> for the Source Column, you
will have to define each categorymanually.

When you clickOK, a set of tools for selecting data will be added to the stereonet window:

There are two tools for selecting data in the stereonet, the polygon tool ( ) and the bullseye ( )
tool.

l Use the polygon tool ( ) to draw around the points you wish to select. Closing the polygon
will select the points, and you can click on the vertices to refine the shape of the selection.
Click outside of the selection to clear the polygon.

l Use the bullseye tool ( ) to:

l Click on points one-by-one.

l Click and drag around points.

The Add button ( ) and theRemove button ( ) determinewhether selected points are being
added to or removed from the selection. For example, if you draw a polygon around a set of
pointswith the Add button enabled, the pointswill be added to the selection.
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You can also:

l Remove points froma selection while the Add button ( ) is enabled by holding down the Ctrl
key and selecting points.

l Select all visible points by clicking on the Select All button ( ) or by pressing Ctrl+A.

l Clear all selected points by clicking on theClear Selection button ( ) or by pressing
Ctrl+Shift+A.

l Swap the selected points for the unselected points by clicking on the Invert Selection button (
) or by pressing Ctrl+I.

l Show or hide all unassigned points using theUnspecified Measurements button ( ).

Statistics are shown for the currently selected set of points:

© 2017 ARANZ Geo Limited



Selecting Data in the Stereonet | 278

Once you have selected a set of points, click the Assign to button in the stereonet window,
then selectCreate New Category. In thewindow that appears, enter a name for the category
and assign a colour:

ClickOK. The new categorywill be created and the stereonet will be updated to reflect the
changes:

The scenewindowwill also be updated.
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Once you have created a new category, you can add to it by selecting further points, then
selecting the category from the Assign to list.

When you are finished, click the Save button ( ) and close the category editor. You can make
further edits by clicking the Edit button ( ) in the stereonet window.

Using the Scene Window with the Stereonet
You can also select points in the scenewindow by clicking on the Select points tool ( ), then
drawing over those points in the scene:

Controls for assigning points to categorieswill remain in the stereonet window, and both the
stereonet window and the scenewindowwill be updated to reflect the selected and assigned
points.

Exporting a Stereonet
Stereonets can be exported in the following formats:

l PDF Files (*.pdf)

l Scalable Vector Graphics Files (*.svg)

l PNG Image Files (*.png)

Click the Export button. Select a format and navigate to the folder where you wish to save the
file. Enter a name and click Save.
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Form Interpolants
A form interpolant is an RBF interpolant that uses planar structural data to control the RBF
gradient. The RBF gradient resembles the geology orientation, which makes form interpolants
useful for visualising structural data and identifying broad trends in 3D. The form interpolant’s
meshes can then be used to control other surfaces in the project.

This topic describes how toworkwith form interpolants in Leapfrog Geo. It covers:

l Creating a Form Interpolant

l The Form Interpolant in the Project Tree

l Form Interpolant Statistics

Once a form interpolant has been created, experiment with differentDistance values. To do
this, double-click on the interpolant in the project tree and click on theOutputs tab.

Creating a Form Interpolant
To create a form interpolant, right-click on the Form Interpolants folder (in the Structural
Modelling folder) and selectNew Form Interpolant. In thewindow that appears, click the Add
button to add structural data tables to the interpolant:

You can easily add and remove structural data tables and change the filtering and once the
interpolant has been created.
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Data can be filtered using the query filters defined for the selected structural data tables:

When generating the form interpolant, you can use the tangents and polarity or only the
tangents. To use both, leave theUse Polarity box ticked. To use only the tangents, untick the
box.

The Boundary filter setting determines how data is handled when it lies outside the
interpolant’s boundary:

l Boundary filter enabled. The interpolant is only influenced by the data that falls inside the
boundary.

l Boundary filter disabled. The interpolant is influenced by the data both inside and outside
the boundary.

Setting a Trend
In the Trend tab, you can set a trend using themoving plane or by entering the required values.
You can also use the Set to list to choose different options used in the project. Isotropic is the
default option used when the function is created.

The Ellipsoid Ratios determine the relative shape and strength of the ellipsoids in the scene,
where:

l TheMaximum value is the relative strength in the direction of the green line on themoving
plane.

l The Intermed. value is the relative strength in the direction perpendicular to the green line on
themoving plane.

l TheMinimum value is the relative strength in the direction orthogonal to the plane.

Adding Isosurfaces
The isosurfaces generated for the form interpolant are determined by the settings in the
Outputs tab. If you wish to add more isosurfaces to the interpolant, click the Add button and
enter the required Distance value. Click on an isosurface and then on theRemove button to
delete it.

TheDefault resolution setting is used for all new isosurfaces.
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The Form Interpolant in the Project Tree
In the project tree, the form interpolant contains objects that represent different parts of the
interpolant:

l The Extents object represents the interpolant’s boundary settings, from the Boundary tab.

l The Trend object describes the trend applied in the interpolant. SeeGlobal Trends formore
information.

l The structural data object ( ) contains a link to the data used in generating the interpolant.
See Form Interpolant Statistics formore information.

l The Isosurfaces folder contains the isosurfaces defined in theOutputs tab.

To display the form interpolant:

l Drag the interpolant into the scene.

l Right-click on the interpolant and select View Isosurfaces.
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Form Interpolant Statistics
To view information about the data used for the form interpolant, right-click on the structural
data object ( ) under the interpolant and select Properties. TheGeneral tab includes
information about how the data has been declustered:

You cannot change how data is declustered in the form interpolant, but if you wish to have
more control over this, create a declustered structural data set and use it as the input for the
form interpolant. SeeDeclustering Planar Structural Data formore information.
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Planning Drillholes
In Leapfrog Geo, you can plan drillholes, view prognoses formodels in the project and export
planned drillholes in .csv format. Leapfrog Geo can also import planned drillholes.

Planned drillholes are added to a project from the Planned Drillholes folder, which is in the
Drillhole Data folder. When displayed in the scene, the planned drillhole ismade up of a collar
point, a target location and a path defined by lift and drift parameters:

The rest of this topic is divided into:

l Adding Planned Drillholes

l Planning Options

l Drilling Prognoses

l Exporting Planned Drillholes

l Importing Planned Drillholes
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Adding Planned Drillholes
To plan a drillhole, first add the data objects to the scene that you will use in helping to define
the drillhole, such as the topography and any existing drillholes. Next, right click on the Planned
Drillholes folder and select Plan Drillhole. In thewindow that appears, you can define the
drillhole by specifying its collar or its target:

You can changewhetherCollar or Target is selected when thiswindow is opened by
clicking on theDefaults button. See Planning Options below.

A name is automatically generated for the new planned drillhole based on the IDs in the collar
table. If there ismore than one phase available, you can select a different phase from the list.

There are threeways to define the drillhole collar or target:

l Click in the scene to set the collar or target location. First, click on the Select button ( ) for
theCollar or Target, then click in the scene to define theCollar or Target. The drillhole will
appear in the scene and you can adjust the coordinates using the controls in theDrillhole
Planningwindow. Click the Slice along drillhole button to draw a slice in the scene. This is
useful in adjusting the drillhole path and in defining subsequent drillholes.

l Draw the drillhole in the scene. Click on the Select button ( ) for theCollar or Target, then
click and drag in the scene to define a basic path for the drillhole. If you are defining the
drillhole from the collar down, click first on or near the topography. Likewise, if you are
defining the drillhole from the target up, click first at or near the target point.

l Enter the coordinates for theCollar or the Target in theDrillhole Planningwindow.

Clicking theMove collar onto the Topography button adjusts the elevation of the drillhole so
that it lies on the topography.
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Click theNext Hole button to create another planned drillhole. The new planned drillhole will
be created at a specific distance from the currently displayed planned drillhole using the Path
settings for the currently displayed drillhole. The distance is determined by theOffset To Next
Hole settings in theDrillhole Planning Optionswindow. See Planning Options below.

Once you have specified the collar or target, adjust the drillhole path:

l Lift is howmuch the drillhole deviates upward.

l Drift is howmuch the drillhole deviates laterally.

l Leapfrog Geo automatically calculates theDepth valuewhen the drillhole is defined by the
Target location.

l Adding an End of hole length extends the drillhole past the Target location.

Planned drillholeswill appear in the Planned Drillholes folder. You can change a planned
drillhole by right-clicking on it and select Edit Drillhole.

Planning Options
When planning drillholes using theDrillhole Planningwindow, the Path values entered apply
only to the current drillhole. If you wish to set default values for these parameters for new
planned drillholes, either right-click on the Planned Drillholes folder and select Edit Planned
Drillholes Defaults or click on theDefaults button in theDrillhole Planningwindow. The
Drillhole Planning Optionswindowwill appear:

Select whether new planned drillholes are specified by theCollar or by the Target.

In theDrillhole Planningwindow, clicking Next adds a new planned drillhole. In theDrillhole
Planning Optionswindow, theOffset To Next Hole values determine how far the new
planned drillhole is from the selected planned drillhole.
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Enter the information required and clickOK. The new settingswill be applied to the next new
planned drillhole added to the project.

Drilling Prognoses
Planned drillholes can be evaluated against anymodel in the project. To view drilling prognoses
for a drillhole, right-click on it and selectDrilling Prognoses. TheDrilling Prognoseswindow
will appear:

You can display prognoses for different models by selecting them from the list. For numeric
models, you can view a plot of the data by clicking on the Plot tab.

In each tab, you can copy the information displayed to your computer’s clipboard by clicking
theCopy to Clipboard button. The information in theData tab will be copied as tab delimited
text, which can be copied into a spreadsheet application such as Excel. The plot displayed in the
Plot tab will be copied as a bitmap image.

Exporting Planned Drillholes
To export planned drillholes, either right-click on the Planned Drillholes object and select
Export Planned Drillholes or right-click on a planned drillhole and select Export. The Export
Planned Drillholeswindowwill appear:

Selecting a phase from the Show Phase list will select all planned drillholes in that phase.

The total length will be updated as you add or remove drillholes.
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In Leapfrog Geo, positive dip points down for planned drillholes. To invert the dip for exported
planned drillholes so that negative dip points down, tick the box for Invert dip on export.

Click Export. You will be prompted for a filename and location.

Importing Planned Drillholes
Leapfrog Geo imports planned drillholes from files in CSV format. The columns expected are:

l A drillhole identifier

l X-Y-Z coordinates for the planned drillhole

l Azimuth

l Dip

l Lift rate

l Drift rate

l Distance

l Extension

l Target Depth

l Comment

To import planned drillholes, right-click on the Planned Drillholes folder and select Import
Planned Drillholes. If the IDs in the file are already in the project, you will be prompted to
resolve the conflict:

You can:

l Rename the imported drillholes. Leapfrog Geowill automatically assign new names and
import the planned drillholes.

l Exclude planned drillholes that already exist in the project. Planned drillholeswill only be
imported if they have an identifier that does not already exist in the project.

l Replace existing planned drillholeswith the imported drillholes. Use this option if you are
importing information previously exported from the project and subsequently updated in an
external application.

ClickOK to process the file.

If there are no conflicts, the planned drillholeswill be imported and added to the Planned
Drillholes folder.
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Modelling

This section describes how to build models in Leapfrog Geo.

l Geological models can be built from lithology data or fromany other suitable data in the
project. Visualising data in the scene is an important step in determining themodel that will
be built, and the tools for doing this are described in Visualising Data. Once this has been
determined, the next step is to define a basic geological model and refine its boundaries.
Modelling contact surfaces and setting their cutting relationships determine how the basic
model volume is divided into lithologies. Models can also have a fault system that, once
activated, will subdivided themodel into fault blocks.

l With theNumeric Models folder, you can interpolate downhole numeric data, composited
drillhole data and points data.

l Combined models use information fromup to four geological models, interpolants and
distance functions in order to visualise relationships between different types of data in the
project.

l When you have a licence for the Hydrogeologymodule, geological models created in
Leapfrog Geo can be used as the basis forModFlow and FEFLOWmodels. You can create
flowmodels directly in Leapfrog Geo and assign hydrological/material properties based on
the lithologies in the geological model. Flowmodels can be exported for use in other
applications, and you can import existing flowmodels and use themas the basis for the
construction of newmodels. Flowmodels can be displayed in the scene, and time-
dependent data can also be visualised.

l Leapfrog Geo can import Isatis files, UBC grids and blockmodels in CSV format. Leapfrog
Geo can import Isatis files and blockmodels in CSV format. Blockmodels imported in CSV
format must be regular, rotated only about the Z axis. Blockmodels and sub-blocked models
can also be created directly in Leapfrog Geo and exported for use in other applications.
Creating blockmodelswithin Leapfrog Geo has the advantage that the resolution can easily
be changed. Blockmodels can be evaluated against geological models and interpolants as
described in Evaluations.
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Geological Models
Themodel building process involves several key steps:

l Creating the project and setting up themodelling environment

l Importing drillhole data and correcting errors

l Importing other required data

l Visualising the data in the scene and inspecting it tomake sense of themodel that will be
built. It is at this stage that you might create new drillhole data columns to select data that
will be the basis of geological models.

l Creating a basic GM, then refining its boundary and defining a fault system

l Modelling the contact surfaces

l Setting the cutting relationships between the different contact surfaces and generating
volumes

A fault systemcan also be defined that divides the geological model into subunits in which the
internal structure can be defined independent of the other subunits in themodel. This is
described in Faulted Models.

The rest of this topic describes the process of creating a geological model. It is divided into:

l Creating a New Geological Model

l Surface Resolution

l Model Extents

l The Geological Model in the Project Tree

l Geological Model Display

l Copying a Geological Model

l Creating a Static Copy of a Geological Model

l Geological Model Volumes and Surfaces Export Options

A geological model can be created using only a basic set of parameters. The only parameter
that cannot be changed once themodel has been created is the base lithology.

Creating a New Geological Model
To create a new geological model, right-click on theGeological Models folder and selectNew
Geological Model. TheNew Geological Modelwindowwill open, together with a set of
controls in the scene that help in defining themodel extents.

The Base Lithology
Select the drillhole data column that will be used as the basis of a model from the Base
Lithology Column list. If you do not wish to use lithology data as the basis for themodel, select
<None>. Thismay be the case if, for example, you want to build a model frompoints data or
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froman imported map. If you select <None>, you will need tomanually define the lithologies
that will bemodelled.

If more than one column of lithology data is available for creating models, be sure to choose
the correct one as it cannot be changed once the initial model has been created. If after
creating and modifying themodel, you find you need tomodify the drillhole data, resulting
in a new lithology column, you can use that new column to create contact surfaces using
Other Contacts options.

You can also filter the drillhole data used to build the geological model using query filters. To
do so, tick the Filter Data box and select the required query filter from the list. Once themodel
has been created, you can remove the filter or select a different filter.

Surface Resolution
The surface resolution setting Leapfrog Geo automatically uses as the default is based on the
data available in the project. Set the surface resolution for themodel as a whole and choose
whether or not the resolution will be adaptive. See Surface Resolution in Leapfrog Geo for
more information on the effects of these settings.

Later, while refining themodel, you can change the resolution of each surface and enable or
disable adaptive resolution. See Surface Resolution for a Geological Model.

Model Extents
A geological model is initially created with a basic rectangular set of extents aligned with the
south/north and east/west axes. You can define themodel’s extents in threeways:

l Enter the coordinates.

l Select Enclose Object and choose from the list of objects in the project. If themodel is based
on drillhole data, select the lithology segments from the Enclose Object list.

l Use the controls that appear in the scene. The orange handle adjusts the centre of the plane
and the red handles adjust the size.

SeeObject Extents formore information.

Enter a Name for themodel that describes the purpose of themodel. ThisNamewill be used in
naming the objects that will be added to themodel. ClickOK to create the newmodel. The new
geological model will be created and added to theGeological Models folder.

See Editing a Geological Model for information on how to change the basic settings for the
model.
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The Geological Model in the Project Tree
The objects under the geological model in the project tree represent different parts of the
model:

l The Boundary object defines the limits of the geological model. When themodel is first
created, this is the rectangularmodel extents. If a topography has been defined, it is
automatically used for as the upper boundary. SeeModifying a Geological Model’s
Boundary formore information about modifying the boundary.

l The Fault Systemobject defines faults and their interactions in themodel. See Faulted
Models.

l The Lithologies object describes all the lithological units to bemodelled and the colours that
are used to display themon the screen. It is generated automatically fromall the lithologies
identified in drillhole data selected when themodel is created. If no column was selected,
you will need to define the lithologiesmanually before you start modelling the lithology
layers.

l The Surface Chronology object describes the contact surfaces in themodel, organised in
chronological order, fromyoungest to oldest. These surfaces and their chronology
determine how the volume inside themodel extents is divided into lithological units. When
themodel is first created, the Surface Chronology is empty, but it will eventually hold all
contact surfaces and inputs to them.

l TheOutput Volumes folder contains all the volumes generated in building the geological
model. When themodel is first created, the Surface Chronology is empty and so there is only
a single output volume in theOutput Volumes folder. This volume fills themodel’s extents
and is called “Unknown”. Once contact surfaces have been generated and added to the
Surface Chronology object, new volumeswill be generated and added to theOutput
Volumes folder.

Geological Model Display
Right-click on the geological model in the project tree to view its display options:

l The View Object option adds the geological model to the shape list as a single object. You
can also display the geological model in thisway by dragging it from the project tree into the
scene. Change the visibility of themodel’s volumes by clicking the Edit Colours button in the
shape list.
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l The View Output Volumes option adds themodel to the scene as a series of output volumes.
It is the equivalent of dragging theOutput Volumes folder into the scene. Change the
visibility of themodel’s volumes individually.

l The View Surface Chronology option displays the surfaces that are used to divided up the
model.

l The View Fault Block Boundaries option is only available when a fault systemhas been
defined and enabled for themodel. Selecting View Fault Block Boundaries displays the fault
blockswithout displaying the lithology layers.

Copying a Geological Model
Creating a copy of a geological model is a useful way of experimenting with changes to a
model.

To copy a geological model, right-click on it in the project tree and selectCopy. Enter a name
for the copy of themodel and clickOK. The copywill be added to the project tree.

Creating a Static Copy of a Geological Model
Creating a static copy preserves a snapshot of a geological model that does not change, even
when changes aremade to the data on which the original model was dependent. This is a
useful way of storing historical models and comparing models. Static copies can be exported
fromLeapfrog Geo, as described inGeological Model Volumes and Surfaces Export Options
below.

To create a static copy of a geological model, right-click on it in the project tree and select
Static Copy. Enter a name for the copy of themodel and clickOK. The copywill be added to
theGeological Models folder.

In the project tree, the static copy ( ) ismade up of a Legend object ( ), the output volumes ( )
and all surfaces created in building themodel.

Staticmodels created in versions of Leapfrog Geo before 2.2 copied only the output volumes
and the legend, and the staticmodel appeared in the shape list only as a single line. When
these staticmodels are upgraded and displayed in the scene, the individual output volumes
will be added to the shape list.

To view the date a static copywas created, right-click on it in the project tree and select
Properties. The date the copywas created is shown in theGeneral tab.

Geological Model Volumes and Surfaces Export Options
There are three options for exporting a geological model’s output volumes and surfaces. These
are:

l Export an output volume or a surface as a mesh. Right-click on it in the project tree and click
Export. You will be prompted for a file name and location. See Exporting a Single Mesh.
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l Export an output volume as a thickness grid. Right-click on it in the project tree and click
Export Thickness Grid. See Thickness Grid Export.

l Export multiple output volumes and surfaces. Right-click on the geological model in the
project tree and select Export. See Exporting Multiple Meshes from Models.

When exporting output volumes, theMerge output lithology volumes setting in the
geological model’sGeneral tab (see Editing a Geological Model) determines how the output
volumes are handled when they are exported. If this setting is enabled, internal walls and
surface seamswill be removed fromvolumesof the same lithology.

Editing a Geological Model
Once a geological model has been created, you can change themodel’s resolution and other
basic settings by double-clicking on themodel in the project tree. TheGeological Model
windowwill open with theGeneral tab selected. The other tabs in theGeological Model
window represent the different parts of the geological model. It is generallymore useful,
however, to workwith these parts of themodel on an individual basis by either double-clicking
on the object in the project tree or right-clicking and seeing what options are available.

The rest of this topic describes how to change the basic settings for a geological model. It is
divided into:

l Changing the Query Filter

l Surface Generation Options

l Volume Generation Options

Changing the Query Filter
Although the Base lithology column cannot be changed once a geological model has been
created, you can change the filters applied to the data. Any filters defined for the lithology table
used to define themodel can be applied to the Base lithology column.

Individual surfaces in the geological model can inherit the query filter from the parent
geological model or can use a different filter. To changewhat query filter is used for a surface,
double-click on the points used to create the surface and change theQuery filter setting in the
Lithology tab:

Surface Generation Options
The Surface resolution and Adaptive settings in theGeneral tab apply to themodel as a whole.
These settings can be overridden for individual surfaces. See Surface Resolution in Leapfrog
Geo and Surface Resolution for a Geological Model.

Surfaces created in building the geological model can be set to snap to the data used in the
model. There are three options:

l Off. Surfaces do not snap to the data used to create them.

l All data. Surfaces snap to all data within theMaximum snap distance, which includes
drillhole data and any data added to surfaces as part of themodel refinement process.
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l Drilling only. Surfaces snap to drillhole data within theMaximum snap distance but not to
other data used tomodify surfaces.

Snapping to data is off by default. Although you can snap to all data, this is not
recommended as it increases the possibility that errors in the data or assumptions inherent in
interpretations (e.g. polylines) will cause distortions in themeshes. If you do enable snapping,
is best to snap only to drilling data.

If you need surfaces to honour drillhole data but treat other data objects as interpretations,
selectDrilling only. If you want finer control over what objects are snapped to, you can do this
on a surface-by-surface basis. See:

l Surfacing Options for Deposits and Erosions

l Surfacing Options for Intrusions

l Surfacing Options for Veins

When Exact clipping is enabled, model surfaceswill be generated without “tags” that overhang
themodel boundary. This setting is enabled by default when you create geological model.

Volume Generation Options
TheMerge output volumes setting determineswhether or not output volumesof the same
lithology aremerged when the volumes are exported. IfMerge output volumes is set to Fast or
Robust, internal walls and surface seamswill be removed fromvolumesof the same lithology.
Either option is suitable when you are using output volumes as extents for othermodels.

The difference between Fast and Robust is the algorithmused:

l Fast removes back-to-back triangles before generating output volumes. This option is new in
Leapfrog Geo version 4.1 and is the default option selected when a geological model is
created.

l Robust is theMerge output lithology volumes option fromversions of Leapfrog Geo before
4.1. Robust uses the volume cutter, which trackswhere the triangles originated and is,
therefore, a slow option for building output volumes.

If there are issueswith surfaces exported to othermodelling packages using theDo not merge
output volumes setting, try the Fast setting. If there are still issues, try theRobust setting.

When projects created in earlier versions of Leapfrog Geo are opened in Leapfrog Geo 4.1,
the Volume Generation setting for any existing geological modelswill not be changed.

Surface Resolution for a Geological Model
When you create a geological model (seeCreating a New Geological Model), the surface
resolution is set for themodel as a whole. When surfaces and boundaries are created as part of
themodel-building process, their resolution is inherited from the geological model:

l For deposit and erosion contact surfaces, stratigraphic sequences and model boundaries, the
resolution is the same as the geological model.
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l For intrusion contact surfaces, the resolution is half that set for the geological model.

l For vein contact surfaces, the resolution is the same as the geological model, but the
Adaptive option does not apply.

You can change the resolution and enable or disable the adaptive isosurfacer on a surface-by-
surface basis. This is useful if you want to build a detailed model of some lithologieswithout
increasing processing time for other volumes.

To change the resolution settings for a contact surface, double-click on the surface in the
project tree, then click on the Surfacing tab:

For a lateral extent or fault, simply double-click on the surface in the project tree to change its
resolution settings.

Untick the Inherit resolution from GM box to change the resolution settings for a surface. This
setting may be disabled, depending on the data used to create the boundary or surface.

The resolution of intrusion contact surfaces is also affected by the point generation parameters.
See Intrusion Point Generation Parameters formore information.

Modifying a Geological Model’s Boundary
Geological models are created with a basic set of rectangular extents that can then be refined
using other data in the project. These extents usually correspond to the ground surface and
known boundaries. Creating extents can also be used to restrict modelling to a particular area
of interest; for example, modelling can be restricted to a known distance fromdrillholes by
applying a distance function as a lateral extent. Extents do not need to be strictly vertical
surfaces, and can bemodel volumes. It is also possible to define a base that serves as the
geological model’s base.

When a topography is defined for the project, it will be automatically applied as a geological
model’s upper boundarywhen themodel is created.
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The rest of this topic describes how to create and workwith geological model extents. It is
divided into:

l Creating Extents for a Geological Model

l Extent from a Polyline

l Extent from GIS Vector Data

l Extent from Points

l Extent from Structural Data

l Extent from a Surface

l Extent from Distance to Points

l Extent from a Distance Function

l Base from Lithology Contacts

l Changing an Extent’s Settings

l Surface Resolution

l Contact Honouring

l Applying a Trend

l Adding Data to an Extent

l Editing an Extent with a Polyline

l Editing an Extent with Structural Data

l Removing an Extent from a Geological Model

Creating Extents for a Geological Model
To create an extent, expand the geological model in the project tree. Right-click on the
Boundary object and select from theNew Lateral Extent orNew Base options. Follow the
prompts to create the extent, which will then appear in the project tree under themodel’s
Boundary object. For example, this geological model has two lateral extents, one froma
polyline and the other fromGIS data:

New extents are automatically applied to the boundary being modified. Leapfrog Geo usually
orients a new extent correctly, with red presenting the inside face of the extent and blue
representing the outside face. If this is not the case, you can change the orientation by right-
clicking on the extent in the project tree and selecting Swap Inside.
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Extent from a Polyline

You can create an extent froma polyline that already exists in the project or you can draw a new
one. If you want to use an imported polyline, import it into the Polylines folder before creating
the new extent.

To create a new extent froma polyline, right-click on themodel’sBoundary object and select
New Lateral Extent > From Polyline orNew Base > From Polyline. In thewindow that
appears, select whether you will create a new polyline or use an existing one:

For lateral extents, you can create the extent as a Vertical Wall or Surface. If you create the
lateral extent as a Surface, you will be able tomodify it using additional data, as described
below. A lateral extent created as a Vertical Wall, however, cannot bemodified. A base is
always created as a surface and so can bemodified as described below.

ClickOK to generate the new extent. If you have chosen to create a New Drawing, the drawing
controlswill appear in the scene and you can begin drawing, as described in Drawing in the
Scene.

The new extent will appear in the project tree as part of the Boundary object.

If the surface generated does not fit the polyline adequately, you can increase the quality of
the fit by adding more points to the polyline. SeeDrawing in the Scene for information on
adding points to polylines.

Extents created frompolylines can bemodified by adding points data, GIS vector data and
structural data. You can also add polylines and structural data to the extent. See Adding Data
to an Extent, Editing an Extent with a Polyline and Editing an Extent with Structural Data
formore information.
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Extent from GIS Vector Data

GIS data in the project can be used to create a lateral extent or a base for a geological model.
Once the data you wish to use has been imported into the project, right-click on themodel’s
Boundary object and selectNew Lateral Extent > From GIS Vector Data orNew Base > From
GIS Vector Data.

In thewindow that appears, select the data object you wish to use:

For lateral extents, you can create the extent as a Vertical Wall or Surface. If you create the
lateral extent as a Surface, you will be able tomodify it using additional data, as described
below. A lateral extent created as a Vertical Wall, however, cannot bemodified. A base is
always created as a surface and so can bemodified as described below.

If you select the Surface option, you can use the GIS data object with its own elevation data or
projected onto the topography:

Using theOn Topography option makes sense for GIS data as it is, by nature, on the
topography. TheOn Topography option alsomitigates any issues that may occur if elevation
information in the GIS data object conflictswith that in the project.

ClickOK to create the new extent. The new extent will appear in the project tree as part of the
Boundary object.

Extents created fromGIS data can bemodified by adding points data, GIS vector data and
structural data. You can also add polylines and structural data to the extent. See Adding Data
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to an Extent, Editing an Extent with a Polyline and Editing an Extent with Structural Data
formore information.

Extent from Points

To create a new extent frompoints data, right-click on the Boundary object for themodel you
are working on and selectNew Lateral Extent > From Points orNew Base > From Points. The
Select Points To Addwindowwill be displayed, showing points data available in the project:

Select the information you wish to use and clickOK.

The new extent will appear in the project tree as part of the Boundary object.

Extents created frompoints can bemodified by adding points data, GIS vector data and
structural data. You can also add polylines and structural data to the extent. See Adding Data
to an Extent, Editing an Extent with a Polyline and Editing an Extent with Structural Data
formore information.

Extent from Structural Data

Planar structural data can be used to create a lateral extent or a base for a geological model.
You can create a new structural data table or use a table that already exists in the project. If you
want to use categories of structural data in creating the extent, use an existing table and create
filters for those categories before creating the lateral extent.

To start, right-click on the Boundary object for themodel you are working on and selectNew
Lateral Extent > From Structural Data orNew Base > From Structural Data. TheNew
Structural Datawindowwill be displayed, showing structural data available in the project:

Select theNew Drawing option to draw the structural data points directly in the scene.
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Select the Existing Structural Data option to use a table in the Structural Modelling folder.
With this option, you will be able to select from the categories available in the data table, if
query filters have been created for those categories:

ClickOK to generate the new extent. If you have chosen to create a New Drawing, the drawing
controlswill appear in the scene and you can begin drawing, as described in Creating New
Planar Structural Data Tables. To share the new structural data table, right-click on it and
select Share. The table will be saved to the Structural Modelling folder.

The new extent will appear in the project tree as part of the Boundary object.

Extents created from structural data can bemodified by adding points data, GIS vector data and
structural data. You can also add polylines and structural data to the extent. See Adding Data
to an Extent, Editing an Extent with a Polyline and Editing an Extent with Structural Data
formore information.

Extent from a Surface

To use a surface as an extent for a geological model, right-click on themodel’sBoundary
object and selectNew Lateral Extent > From Surface orNew Base > From Surface. The Select
Boundarywindowwill appear, showing all themeshes that can be used as an extent:

Select the required mesh and clickOK. The extent will be added to themodel’sBoundary
object.

You cannot modify an extent created froma mesh by adding data, editing with polylines or
structural data or by applying a trend. However, the extent is linked to themesh used to create
it, and updating themesh will update the extent.
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Extent from Distance to Points

Leapfrog Geo can calculate the distance to set of points and use the resulting distance buffer as
a lateral extent for a geological model. To create a new lateral extent froma distance buffer,
right-click on the Boundary object for themodel you are working on and selectNew Lateral
Extent > From Distance To Points. The Smoothed Distance Bufferwindowwill appear:

Select theDistance and set an Anisotropy, if required.

The Ellipsoid Ratios determine the relative shape and strength of the ellipsoids in the scene,
where:

l TheMaximum value is the relative strength in the direction of the green line on themoving
plane.

l The Intermed. value is the relative strength in the direction perpendicular to the green line on
themoving plane.

l TheMinimum value is the relative strength in the direction orthogonal to the plane.

You can also use the Set to list to choose different options Leapfrog Geo has generated based
on the data used to build themodel. Isotropic is the default option used when themodel is
created.

ClickOK to create the new extent, which will appear in the project tree as part of the Boundary
object.

To change the extent’s settings, expand themodel’sBoundary object in the project tree and
double-click on the extent.

Adjust theDistance and Anisotropy, if required.

The resolution of extents is automatically inherited from the geological model. You can change
the resolution for an extent if you want more or less detail than for the geological model as a
whole. To do so, untick the box for Inherit resolution from GM and change the setting.
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Extents created froma distance to points function can bemodified by adding points data and
GIS vector data. See Adding Data to an Extent.

Extent from a Distance Function

A distance function calculates the distance to a set of points and can be used to bound a
geological model. You can use an existing distance function as a lateral extent or create a new
one.

To use a distance function as a lateral extent, right-click on the Boundary object for themodel
you are working on and selectNew Lateral Extent > From Distance Function. If there are no
distance functions in the project, you will be prompted to create a new one. SeeDistance
Functions for information on defining and editing the distance function.

When there are already distance functions in the project, you will be prompted to choose
between creating a new function or using an existing one:

To use an existing function, select it from the list and set a Buffer distance. ClickOK to create
the lateral extent.

When you create a new distance function, it will be part of themodel’sBoundary object and
will not be available elsewhere in the project. To share it within the project, expand the lateral
extent in the project tree and right-click on the distance function. Select Share. The distance
function will be saved to theNumeric Models folder.

To change the extent’s settings, expand themodel’sBoundary object in the project tree and
double-click on the extent.

Adjust theDistance and Anisotropy, if required.

The resolution of extents is automatically inherited from the geological model. You can change
the resolution for an extent if you want more or less detail than for the geological model as a
whole. To do so, untick the box for Inherit resolution from GM and change the setting.
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Base from Lithology Contacts

To create a base from lithlogy contacts, right-click on the Boundary object and select either
New Base > From Base Lithology orNew Base > From Other Contacts.

The only difference in the twomethods is that when creating a base fromother contacts,
you must first select the lithology column from those available in the project.

When defining the base, select the primary lithology and the contacts to use:

For complex geologies, the up and down directions for the basemay not be clear. If this is the
case, untick theHorizontal Plane box. A reference planewill appear in the scene, with the up-
facing surface labelled A and the downward-facing surface labelled B. Controlling the position
of the reference plane is similar to controlling the position of themoving plane:

l Use the handles in the scenewindow tomove the plane.

l Set theDip and Dip Azimuth values in theNew Contact Pointswindow. The reference
planewill be updated in the scene.

Once the reference plane is correctly oriented, click the Set From Plane button.

ClickOK to create the base, which will appear under the Boundary object. The new basewill
automatically be added to themodel.

Each geological model can have only one base defined, so if you wish to define a new base,
you must first delete the existing base from themodel. Do this by right-clicking on the Base
object and selecting Delete. You can also choose not to use the base you have defined. See
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Removing an Extent from a Geological Model formore information.

Changing an Extent’s Settings
For geological model extents created from frompolylines, GIS data, points and structural data,
you can change the extent’s settings by double-clicking on it in the project tree.

In the Surfacing tab, you can change surface resolution and contact honouring options, which
are described below. In the Trend tab, you can apply a trend to the extent, which is described in
Applying a Trend.

Surface Resolution

For geological models, the resolution of extents and whether or not the adaptive isosurfacer is
used is automatically inherited from the geological model. You can change these settings for an
extent if you want more or less detail than for the geological model as a whole. To do so, untick
the box for Inherit resolution from GM and make the required changes.

Contact Honouring

Often, surfaces should honour drillhole data and treat data objects such as polylines and GIS
data as interpretations. For extents, the Snap to data setting in the Surfacing tab determines
whether or not the extent honours the data used to create it. Options are:

l Off. The extent does not snap to the data used to create it. This is the default setting.

l All data. The extent snaps to all data within theMaximum snap distance, which includes
drillhole data and any data added to the extent.

l Drilling only. The extent snaps to drillhole data and data objects derived fromdrillhole data
within theMaximum snap distance, but not to other data used tomodify the extent. For
example, the extent will honour points data derived fromdrillhole data, but not points data
imported into the Points folder.

l Custom. The extent snaps to the data objects indicated in the Inputs tab that are within the
Maximum snap distance.

Snapping to data is off by default. Although you can snap to all data, this is not
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recommended as it increases the possibility that errors in the data or assumptions inherent in
interpretations (e.g. polylines) will cause distortions in themeshes. If you do enable snapping,
is best to snap only to drilling data.

The snap setting for the geological model will be used if Snap to data is set to Inherit from GM.

Whatever the setting, you can seewhat objects are snapped to by clicking on the Inputs tab.

If you need the extent to honour drillhole data but treat other data objects as interpretations,
selectDrilling only. To honour some data objectswhile treating others as interpretations, select
Custom, then click on the Inputs tab to enable snapping for individual objects.

Applying a Trend

You can adjust an extent created frompolylines, GIS data, points and structural data by
applying a trend to it. To do this, add the extent to the scene. Next, double-click on the extent in
the project tree and click the Trend tab.

Often the easiest way to apply a trend is to click on theDraw plane line button ( ) and draw a
plane line in the scene in the direction in which you wish to adjust the surface. You may need to
rotate the scene to see the plane properly.

The Ellipsoid Ratios determine the relative shape and strength of the ellipsoids in the scene,
where:

l TheMaximum value is the relative strength in the direction of the green line on themoving
plane.

l The Intermed. value is the relative strength in the direction perpendicular to the green line on
themoving plane.

l TheMinimum value is the relative strength in the direction orthogonal to the plane.

Once you have adjusted the plane to represent the trend you wish to use, click the Set From
Plane button to copy themoving plane settings.

The Set to list contains a number of different options Leapfrog Geo has generated based on the
data used in the project. Isotropic is the default option used when the extent was created.
Settingsmade to other surfaces in the project will also be listed, which makes it easy to apply the
same settings tomany surfaces.

ClickOK to apply the changes.

SeeGlobal Trends formore information.

Adding Data to an Extent
Extents created frompolylines, GIS data, points and structural data can bemodified by adding
points data objects, GIS vector data and structural data. Extents created froma distance to
points function can bemodified by adding points data and GIS vector data. To add data to an
extent, right-click on the extent in the project tree and select the data type you wish to use from
the Addmenu.
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l Points data. Select from the points data objects available in the project and clickOK.

l GIS vector data. Select from theGIS vector data available in the project and clickOK.

l Structural data. Select from the structural data tables available in the project. If the selected
table has query filters defined, you can apply one of these filters by ticking Use query filter
and then selecting the required filter from the list. ClickOK to add the selected data to the
extent. An alternative to adding an existing structural data table to an extent is to edit the
extent with structural data. This is described in Editing an Extent with Structural Data
below.

You can also add a polyline that already exists in the project. To do this, right-click on the extent
in the project tree and select Add > Polyline. You will be prompted to choose from the polylines
in the Polylines folder.

Editing an Extent with a Polyline
You can edit an extent using a polyline, which is described in Surfaces. A polyline used to edit an
extent will be added to the project tree as part of the extent. To edit the polyline, right-click on it
and select Edit Polyline or add it to the scene and click the Edit button ( ) in the shape list. If
you wish to remove the polyline from the extent, right-click on it in the project tree and select
Delete orRemove.

To add an existing polyline to a geological model extent, use the Add > Polyline option.

Editing an Extent with Structural Data
You can edit an extent using structural data, which is described in Surfaces. A structural data
table will be added to the project tree as part of the extent. To edit the table, right-click on it
and select Edit In Scene or add it to the scene and click the Edit button ( ) in the shape list. If
you wish to remove the table from the extent, right-click on it in the project tree and select
Delete orRemove.

Removing an Extent from a Geological Model
If you have defined an extent and want to remove it from themodel, there are two options. The
first is to right-click on the extent in the project tree and clickDelete. This deletes the extent
from themodel, but does not delete parent objects from the project unless theywere created as
part of themodel, e.g. a polyline used as a lateral extent but not shared within the project. Use
this option only if you are sure you do not want to use the extent.
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The second method is useful if you aremaking changes to the extent and do not want to
recompute themodel with each change. Double-click on themodel’sBoundary object or
double-click on themodel and click on the Boundary tab. The Boundaries part of thewindow
lists all objects used as extents for a geological model:

Untick the box for extents to temporarily disable them in themodel. Themodel will be
reprocessed, but you can then work on the extent without reprocessing themodel. Disabled
extentswill bemarked as inactive in the project tree:

Model Lithologies
To view the lithologies used for a geological model, you can:

l Double-click on the geological model in the project tree and then click on the Lithologies
tab.

l Double-click on the Lithologies object for the geological model in the project tree.
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All the lithologies defined for the geological model are displayed, together with the colours
used to display them:

Click a colour chip to change the colours used to display the lithologies.

To set multiple lithologies to a single colour, use the Shift or Ctrl keys to select the colour
chips you wish to change, then click on one of the colour chips. The colour changes you
makewill bemade to all selected lithologies.

If the geological model was created fromdrillhole data, the lithologies are automatically
generated from that data. There is also an additional lithology, “Unknown”, which is used to
label lithologies that cannot be labelled using known lithologies. This is the casewhen a
geological model is first created and no contact surfaces have been defined. The entiremodel
volume has no identified lithologies and so is assigned as “Unknown”.

An alternative to setting unidentified lithologies to “Unknown” is to select one of the defined
lithologies as the “background lithology”. To do this, double-click on themodel’s Surface
Chronology and set Background lithology to one of the available lithologies. When you set the
background lithology for a geological model and then enable the fault system, the background
lithologywill be copied to each fault block.

If there is no drillhole data in the project or if themodel is not based on drillhole data, you will
need to define the lithologies one-by-one. To do this, click on the Add button, enter a name for
the lithology and choose a colour.

Faulted Models
This topic describes how to use the fault system to create and organise faults:

l The Fault System

l Fault Interactions

l Activating the Fault System
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l Copying the Surface Chronology to an Empty Fault Block

l Faulted Model Display Options

Each geological model is created with a Fault Systemobject that is used to construct faults.
Once the faults are active in the geological model, the geological model will be divided into
separate fault blocks, which will appear in the project tree as part of themodel:

Each fault block has its own Surface Chronology, which can bemodified without affecting
other fault blocks in the geological model. There is no top-level Surface Chronology for the
geological model once the Fault Systemhas been activated. Thismeans that lithology layers
can be constructed for a faulted model in twoways:

l Define the Surface Chronology before enabling the Fault System. All surfaces defined for
the unfaulted model will automatically be copied to each fault block. Some surfaces defined
for themodel as a whole will not occur in every fault block, which can be corrected by
working with the surfaces in each fault block.

l Enable the Fault System before any surfaces are defined in the unfaulted model, then define
the Surface Chronology for each fault block. An aid toworking with a faulted model in this
way is the ability to copy contact surfaces fromone faulted block to another. SeeCopying
the Surface Chronology to an Empty Fault Block below.

Which approach is best dependson themodel being built. You may already knowwhere the
faults are and choose to define themand subdivide the geological model before defining any
lithology layers. On the other hand, sometimes it is not apparent where the faults are until the
layers have been built, in which case you can add the new fault, activate it in themodel, then
workwith the surfaces in each fault block.

The Fault System
When a geological model is first created, the Fault Systemobject is empty. To create faults,
right-click on the Fault Systemobject and select from the options available. Many of these
options are similar to those for creating lateral extents. Formore information, see:

l Extent from a Polyline

l Extent from GIS Vector Data

l Extent from Points

© 2017 ARANZ Geo Limited



The Fault System | 311

l Extent from Structural Data

l Extent from a Surface

Faults created frompolylines and GIS vector data can be created as vertical walls or surfaces.
Faults created as surfaces can bemodified by adding further data, as described in Editing
Faults.

Creating a fault from the base lithology or other contacts is similar to creating contact surfaces.
SeeDeposits and Erosions From the Base Lithology and Deposits and Erosions From Other
Lithology Contacts formore information.

Faultswill appear in the project tree as part of the Fault Systemobject and can be expanded to
show how theywere created:

Once faults have been created, you can modify themas described in Editing Faults.
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Fault Interactions
Once all the faults required have been created, you can start defining the interactions between
the faults by double-clicking on the Fault Systemobject. TheGeological Modelwill be opened
with the Fault System tab displayed:

To add an interaction, click on a fault, then click the Add button. Select the Interaction Type
and set how the faults interact:

© 2017 ARANZ Geo Limited



Activating the Fault System | 313

Once you have defined each fault interaction, clickOK to generate the fault system. Add the
Fault Systemobject to the scene to check that the faults interact correctly.

You can also edit fault interactions by double-clicking on individual faults. The Edit Fault
windowwill open, which showsonly the interactions for the selected fault:

Faults are not active in the geological model until the box is ticked for each fault in the Fault
Systemwindow, as described in Editing Faults. Thismeans you can check the fault system
without regenerating the geological model.

Activating the Fault System

Activating the fault systemdivides the geological model into fault blocks, which can result in
considerable processing time for complexmodels. It is important, therefore, to define fault
interactions before enabling the fault system, otherwise a large number of fault blocks could
be generated that significantly increase processing time. See Fault Interactions above.

To activate the fault system in the geological model, double-click on the Fault Systemobject
once again and tick the box for each fault. Themodel will be divided into separate fault blocks
that can beworked with in a similarmanner to the geological model as a whole.

Copying the Surface Chronology to an Empty Fault Block
If you are working with a faulted model and have defined the Surface Chronology for one fault
block, you can copy the Surface Chronology to the empty fault blocks. To do this, right-click
on the Surface Chronology for which you have defined surfaces and selectCopy Chronology
To. In thewindow that appears, select the fault blocks you want to copy contacts to and click
OK. The surfaceswill be copied and you can modify themwithout affecting the surfaces in the
other fault blocks.
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Faulted Model Display Options
Drag themodel into the scene or right-click on it and select View Object; these options add the
model to the shape list as a single object and you can change the visibility of each lithology by
clicking the Edit Colours button. You can also add themodel to the scene as a series of output
volumes by right-clicking on themodel and selecting View Output Volumes.

Another display option lets you view the individual fault blockswithout displaying the lithology
layers. Right-click on themodel and select View Fault Block Boundaries.

Toworkwith a specific fault block, click on it in the scene. Thewindow that appears displays the
name of the selected fault block:

You can also view the output volumes for each individual fault block by right-clicking on the
fault block in the project tree and selecting View Output Volumes.

Editing Faults
Once a fault has been defined, you can refine it in several ways:

l Add other data. This option is available for faults created as surfaces, but not for those
created as vertical walls. Right-click on the surface to see the options available, which will
depend on how the surfacewas created.

l Edit the surfacewith a polyline. Right-click on the surface in the project tree and select either
Edit > With Polyline. See Editing Surfaces with Polylines formore information.

l Edit the surface using structural data. Right-click on the surface and select Edit > With
Structural Data. See Editing Surfaces with Structural Data formore information.

The rest of this topic describes other options for editing faults. It is divided into:

l Surfacing Options for Faults

l Boundary Filtering

l Snapping to Data

l Changing Fault Inputs

l Replacing Fault Inputs with a Single Mesh

l Adding Data to the Fault
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l Snap Settings for Individual Inputs

l Boundary Filtering Settings for Individual Inputs

l Applying a Trend to a Fault

Surfacing Options for Faults

To change surfacing options for a fault, double-click on the fault in the project tree, then click
on the Surfacing tab.

See Surface Resolution for a Geological Model and Contact Honouring for information
about the settings in the Surfacing tab.

The settings in the Surfacing tab will be disabled if the fault inputs have been replaced with a
mesh.

Boundary Filtering

When data objects are added to a fault, there are twoways to handle the data that lies outside
the fault boundary:

l Filter the data. The fault is only influenced by the data that falls inside the fault boundary.

l Leave the data unfiltered. The fault is influenced by the data both inside and outside the fault
boundary.

The Boundary filter setting determines how data used to define the fault is filtered:

l Off. Data is not filtered.

l All data. All data is filtered.

l Drilling only. Only drillhole data and data objects derived fromdrillhole data are filtered.

l Custom. Only the data objects specified in the Inputs tab are filtered.

Snapping to Data

There is a Snap to data setting for a geological model as a whole that is set in theGeological
Model > General tab (see Editing a Geological Model). Snap-to-data can also be set on a
surface-by-surface basis by double-clicking on the surface in the project tree and then clicking
on the Surfacing tab.

For faults, the options are:

l Inherit from GM. The setting for the geological model as a whole is used. This is the default
setting.

l Off. The fault does not snap to the data used to create it.

l All data. The fault surface snaps to all data within theMaximum snap distance, which
includes drillhole data and any data added to the fault.

l Drilling only. The fault surface snaps to drillhole data and data objects derived fromdrillhole
data within theMaximum snap distance but not to other data used tomodify the fault. For
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example, the fault surfacewill honour points data derived fromdrillhole data, but not points
data imported into the Points folder.

l Custom. The fault snaps to the data objects indicated in the Inputs tab.

Snapping to data is off by default. Although you can snap to all data, this is not
recommended as it increases the possibility that errors in the data or assumptions inherent in
interpretations (e.g. polylines) will cause distortions in themeshes. If you do enable snapping,
is best to snap only to drilling data.

If you need the fault surface to honour drillhole data but treat other data objects as
interpretations, selectDrilling only. To honour some data objectswhile treating others as
interpretations, selectCustom, then click on the Inputs tab to enable snapping for individual
objects.

Changing Fault Inputs

For faults, the Inputs tab shows all the data objects used to create the fault and whether the
Snap and Boundary filter options are enabled for each object used to define the fault:

You can also replace the fault’s inputswith a singlemesh or add more data to the fault.

Replacing Fault Inputs with a Single Mesh

To replace the fault inputswith a singlemesh, click on theMesh option, then select from the
meshes available in the project.

When you select a singlemesh to define the fault, all other inputs listed in the Inputs tab will
be removed from the fault. This can result in objects being deleted from the project. For
example, if the fault has been edited using a polyline, the polyline will be deleted when the
inputs are replaced with themesh. If you wish to retain such inputs, be sure to share the
object before changing the inputs. See Sharing Objects formore information.

The snap and boundary filtering controls in the Surfacing tab will be disabled as the settings
from the geological model will be used. The settings in the Trend tab will also be disabled as it is
not possible to set a trend for a fault defined froma mesh.
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Adding Data to the Fault

To add more data to the fault, click on the Select Objects button, then select from the suitable
objects available in the project.

Snap Settings for Individual Inputs

The Snap setting determineswhether or not the faults surface honours a particular data object.
Often, surfaces should honour drillhole data and treat data objects such as polylines and GIS
data as interpretations, as discussed in Contact Honouring. To change snap settings for a fault,
click on the Surfacing tab and set Snap to data toCustom. You will then be able to change
Snap settings in the Inputs tab.

Boundary Filtering Settings for Individual Inputs

When data objects are added to a fault, there are twoways to handle the data that lies outside
the fault boundary:

l Filter the data. The fault is only influenced by the data that falls inside the fault boundary.

l Leave the data unfiltered. The fault is influenced by the data both inside and outside the fault
boundary.

To change the Boundary filter settings for each object used to define a fault, click on the
Surfacing tab and set Boundary filter toCustom. You will then be able to change Boundary
filter settings in the Inputs tab.

Applying a Trend to a Fault

To apply a trend to a fault, either:

l Double-click on the fault in the project tree, then click on the Trend tab.

l Right-click on the fault in the project tree and select Adjust Surface. This opens the Edit
Faultwindowwith the Trend tab displayed.

SeeGlobal Trends for information on using the controls in this tab.

The settings in the Trend tab will be disabled if the fault inputs have been replaced with a
mesh.
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Contact Surfaces
Defining the internal structure of a geological model involves generating contact surfaces that
correspond to the boundaries between lithological units, refining the contact surfaces,
arranging them in chronological order and then using the surfaces and the chronological order
to divide the geological model into units. The Surface Chronology object represents the
collection of contact surfaces and defines how they interact to produce the volumesof the
geological model. Factors that influence the interaction of contact surfaceswith the volumes
of the geological model are:

l The order of the contact surfaces in the Surface Chronology. SeeContact Surfaces in the
Surface Chronology.

l The type of contact surface. SeeContact Surfaces Types formore information.

l The orientation of the older and younger sides of the surface. See Younging Direction.

The remainder of this topic describes how the different types of contact surface interact and will
help you in deciding how tomodel different units. For specific information on creating the
different types of contact surfaces, see:

l Deposits and Erosions

l Intrusions

l Veins

l Vein Systems

l Stratigraphic Sequences

Contact Surfaces in the Surface Chronology
When a geological model is first created, it is simply a volume that is assigned the background
lithology. This background lithology is initially “Unknown”, as although themodel has
lithologies defined, Leapfrog Geo cannot determinewhat lithology to use for the background
lithology.
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The contact surfaces and their order in the Surface Chronology determine how they divide this
larger “Unknown” volume into known lithological units. The scene below shows the Surface
Chronology for four deposit contact surfaces and two intrusion contact surfaces, bounded by
the geological model extents (pink). The two intrusion contacts are labelled asUnknown on the
outside and the intrusion lithology on the inside:

The Surface Chronology is open, showing the contact surfaces in chronological order, with the
youngest at the top of the list. This is the order in which contact surfaceswill be used to cut the
“Unknown” volume of a newly created model. The different types of contact surfaces cut older
volumes in different ways, which are described below in Contact Surfaces Types.

For themodel shown above, the first contact surface to cut the geological model volume is the
oldest surface, D5 -D4 contacts. The volume is divided into D5 (red) below and D4 (green)
above:
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When the next contact surface (D4 -D3 contacts) is enabled in themodel, the volume above
the contact surface is labelled with the lithology assigned to the surface’s younger side (blue):

Therefore, any volume in a geological model is labelled with the lithology assigned to the
youngest side of the surface that last cut the volume.

With a simple deposit geological model, as long as each side of each contact surface is assigned
a lithology, all volumeswill be labelled with known lithologies. Intrusive contact surfaces,
however, are often of unknown lithology on the outside, as they contact multiple lithologies.
When the two intrusive surfaces in themodel above are enabled but all deposit surfaces are
disabled, the unknown lithology is replaced with each intrusive lithology on the inner sides of
each contact surface, but outside each intrusive contact surface the lithology is not known:

If the outside of the older contact surface (green) is assigned a lithology (red), the volume
outside each intrusion is known and, therefore, the surrounding volume can be labelled:
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If, however, the outside of the younger intrusion is known but the outside of the older intrusion
is unknown, it is not possible to determine the lithology of the surrounding volume as the
lithology on the outer side of the surfacemaking the first cut is not known:

Contact Surfaces Types
The different types of contact surfaces result in different shapes and cut older volumes in
different ways. The contact surface types are:

l Deposit. Deposit contact surfaces tend to be sheet-like, with the primary lithology on the
young side and the contacting/avoided lithologies on the older side. Deposits do not cut
older volumes. A volume defined by a deposit contact surfacewill, therefore, appear
conformably on top of older volumes.

l Erosion. Erosion contact surfaces are similar to deposits, but cut away other contact surfaces
on the older side of the erosion contact surface.

l Intrusion. Intrusion contact surfaces are rounder in shape, with an interior lithology that
represents the intrusion lithology. The intrusion removes existing lithologies and replaces
themwith the intrusive lithology on the younger side of the contact surface. Often, the older
side of an intrusion contact surface is labelled “Unknown” as typically intrusions displace
multiple older lithologies.

l Vein. Vein contact surfaces remove existing lithologies and replace themwith the vein
lithologywithin the boundaries defined by hangingwall and footwall surfaces and points and
a reference surface.

These terms are indicative of the resulting shape and cutting behaviour of a surface rather than
of the geological formations that can bemodelled. In fact, it might make sense tomodel
something like basement granite as a deposit rather than as an intrusion when it forms the
lowest layer in the geological model. If there are no older layers for an intrusion-type contact
surface to remove and it is apparent from the drillhole data that the lithology simply fills the
lowermost parts of themodel, then it makes sense tomodel it as a deposit.
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An important consideration in building contact surfaces is that they have an older side and a
younger side. This is described in more detail in Younging Direction below, but it is sufficient to
understand, at this point, that younging direction is one factor in determining how the different
types of contact surfaces cut older surfaces.

Deposit and Erosion Contact Surfaces

Deposits and erosions are both roughly flat surfaces. The difference between the two is that
deposits appear conformably on top of underlying older volumes and do not occur in regions
defined by older deposits, while erosions remove existing lithologies on the older side of the
erosion. This difference is illustrated here, using a model made up of three deposits, A, B and C:

The contact surfaces that define the three output volumes are the B-C contacts surface (pink)
toward the top of themodel extents and the A-B contacts surface (gold) lower down:

An erosion contact surface (C-D contacts) added to themodel cuts across the A-B and B-C
contacts. The younger (purple) side of the C-D contact surface faces up:
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Once themodel is recalculated, the erosion (D) has cut away the deposits on the older side of
the erosion:

However, if the C-D contact surface is changed to be a deposit surface, D only occurs on the
younger side of the C-D contact surface and does not cut away the A, B and C volumes:

SeeDeposits and Erosions for information on techniques for creating deposits and erosions.

Intrusion Contact Surfaces

An intrusion is a type of contact surface that removes existing lithologies and replaces them
with the intrusive lithology. Intrusions are rounder in shape than deposits and erosions, with an
interior lithology that represents the intrusion lithology on the inside of the shape.

Adding an intrusion (E) surface added to the examplemodel above as the youngest surface cuts
away the other lithologies on the inside of the surface:

Note that the intrusion contactsmultiple units. This is typical of intrusion contact surfaces as an
intrusion will usually displacemultiple older lithologies. Although the outside of the intrusion is
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not labelled with a lithology, the lithology of each volume the intrusion comes into contact with
can be known from the lithologies assigned to the deposit contact surfaces.

However, when all contact surfaces are intrusions, the lithology of the surrounding volume
cannot be known, which results in intrusion volumes surrounded by an Unknown volume:

In this instance, the contact surfaces each have a known side and an unknown side:

Adding the drillholes to the scene helps in understanding what lithology the outside of each
intrusion should be:
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In this case, opening the Surface Chronology and assigning AvT as the background lithology
results in a model for which all volumes are labelled with a known lithology:

See Intrusions for information on techniques for creating intrusions.

Vein Contact Surfaces

Veins remove existing lithologies and replace themwith the vein lithologywithin the boundaries
defined by hangingwall and footwall surfaces and points and a reference surface. Here, a slice
has been made horizontally through a model made up of three deposits:
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Adding five dykesmodelled as veins and enabling them in themodel results in the veins cutting
away each deposit at the point of contact:

Here the sliced deposits are displayed but the veins are hidden in order to show how they cut
away the deposits:

See Veins for information on techniques for creating veins.

Younging Direction
An important factor in determining how surfaces interact is the younging direction of each
surface. Each contact surface has a younger side and an older side. For deposit and erosion
contact surfaces, Leapfrog Geowill, by default, put the younger side up, since this is
geologically reasonable in most situations. If, for example, you know that the geology is
overturned, you can change the younging direction once the surface has been created.

For intrusion contact surfaces, the younger side of the surface is the inside, although this can be
swapped if Leapfrog Geo has assigned it incorrectly, asmay be the casewith flatter intrusion
surfaces.

When contact surfaces are displayed in the scene, you can choosewhether to display the
surfaces using the lithology or the younging direction. When the younging direction is
displayed, the younger side is typically green and the older side is brown:
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When a contact surface is displayed using the younging direction, Leapfrog Geo by default
colours the younger side green and the older side brown.

Deposits and Erosions
This topic describes creating and editing deposits and erosions. The topic is divided into:

l Creating Deposits and Erosions

l Deposits and Erosions From the Base Lithology

l Deposits and Erosions From Other Lithology Contacts

l Deposits and Erosions From Other Data

l Deposits/Erosions in the Project Tree

l Refining Deposits and Erosions

l Surfacing Options for Deposits and Erosions

l Boundary Filtering

l Snapping to Data

l Setting the Surface Resolution

l Applying a Trend to a Deposit/Erosion

For a general introduction to how deposits and erosions interact with other contact surfaces,
seeDeposit and Erosion Contact Surfaces in Contact Surfaces.

Creating Deposits and Erosions

Lithology data is often themost reliable data source to usewhen building geological surfaces,
and it is best to derive contact surfaces from lithology data when it is available. If no lithology
data is available, you can create deposits and erosions fromother data in the project. You can
also create offset surfaces fromother surfaces in the project, which is useful for creating a series
of surfaces. SeeOffset Surfaces formore information.

Deposits and Erosions From the Base Lithology

It is best to derive contact surfaces from lithology data, when it is available. There are twoways
to create contact surfaces from lithology data:

l Using the base lithology column assigned when themodel was created. This is the process
described below.

l Using other lithology information available in the project. This is useful when you have
created an additional lithology column as part of correcting and working with the drillhole
data. For example, if when building a geological model it becomes apparent that changes
need to bemade to the drillhole data, you can import additional data or create a new column
using the split lithology, group lithology or interval selection tools. SeeDeposits and
Erosions From Other Lithology Contacts formore information.
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Selecting the From Base Lithology option opens theNew Contact Pointswindow:

Select the lithology you wish to use to create the surface from the Select primary lithology list;
thiswill be the older lithology (lower down) in the geological model. TheContacting/Avoided
lithologies list shows the lithologies that contact the primary lithology and the number of
contacts. This helps in selecting which contacts to use to create the contact surface.

The options in the Lithology tab are useful for creating a surfacewhen one lithology is
interbedded with another. For example, here we can see that the coarse sand is interbedded
with alluvium:
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The solution to this is to create two surfaces from the Alluviumcontacts, one using the contacts
above (younger contacts) and the other using the contacts below (older contacts):
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Note that the gravel contacts should be excluded for the surface created from theUse
contacts below option, aswe can see from the drillhole data that gravel appears lower down in
themodel than the surfacewe are creating. Do this by dragging the contacts that should be
excluded to the Ignored lithologies list:

Unspecified intervals are intervals that have no data. By default, unspecified intervals are
ignored when creating a contact surface, but you can also treat themas the primary lithology or
as avoided lithologies.
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For complex geologies, the up and down directions for the surfacemay not be clear. If this is the
case, untick theHorizontal Plane box. A reference planewill appear in the scene, with the up-
facing surface labelled A and the downward-facing surface labelled B:

Controlling the position of the reference plane is similar to controlling the position of the
moving plane:

l Use the handles in the scenewindow tomove the plane.

l Set theDip and Dip Azimuth values in theNew Contact Pointswindow. The reference
planewill be updated in the scene.

Once the reference plane is correctly oriented, click the Set From Plane button.

Setting a reference plane for contact points is different fromapplying a global trend to a
surface. To apply a global trend to a surface, double-click on the surface in the project tree
and click on the Trend tab. SeeGlobal Trends.

Data can be composited at the drillhole level or on a surface-by-surface basis. To composite
the data used to generate the contact surface, click on theCompositing tab. SeeCategory
Composites formore information.

ClickOK to create the contact surface, which will appear in the project tree under the Surface
Chronology. SeeRefining Deposits and Erosions below formore information on refining the
contact surface.
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Deposits and Erosions From Other Lithology Contacts

Creating deposit and erosion contact surfaces using the From Other Contacts option is useful
when you have created an additional lithology column as part of correcting and working with
the drillhole data. For example, if when building a geological model it becomes apparent that
changes need to bemade to the drillhole data, you can import additional data or create a new
column using the split lithology, group lithology or interval selection tools. See Splitting
Lithologies, Grouping Lithologies and Interval Selection formore information.

The process is similar to creating a surface from the base lithology column, but you must first
select the lithology column you will use:

Select the First Lithology and Second Lithology, if known. ClickOK. TheNew Contact Points
windowwill appear. Assign the Primary lithology, Contacting/Avoided lithologies and the
Ignored lithologies. These can only be selected from themodel’s base lithology.

The rest of the process is similar to defining a contact surface from the base lithology. See
Deposits and Erosions From the Base Lithology above formore information.

Be sure to add the contact surface to the scene to view it and check that it is oriented correctly.

SeeRefining Deposits and Erosions below formore information on the different techniques
that can be used for adjusting a contact surface.

Deposits and Erosions From Other Data

If suitable lithology data is not available, deposits and erosions can be created fromother data
in the project, such asGIS data, structural data, points, polylines and surfaces. The steps for
creating deposits and erosions fromother data are similar, regardless of the data used to create
the surface:

l Right-click on the Surface Chronology and select one of the data types from theNew
Deposit/Erosionmenu.

l Select the data object that will be used to define the surface. Thismust already be in the
project, unless you are using a polyline, in which case you are given the option to create a
new polyline.

l Select the First lithology and Second lithology. These are the lithologies that will be
assigned to each side of the contact surface. The lithologies you can choose fromare those
defined for the geological model in the Lithologies object (seeModel Lithologies).

l Set whether the First lithology is older or younger than the Second lithology. Leapfrog Geo
will, by default, put the younger side of a contact surface up, but this can be changed later.
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Here, a points data object is being used to create a deposit:

For polylines, you first set the lithologies and the younging order:

ClickOK tomove on to the next step:

You can draw the polyline in the scene directly by selecting theNew Drawing option. You can
also use any polyline in the project by selecting the Existing Polyline option. You can then
select the required polyline from the list.

The new contact surfacewill appear in the project tree under the Surface Chronology. Add the
contact surface to the scene to view it and check that it is oriented correctly.

Expand the surface in the project tree to see how it wasmade. Here, a number of surfaces have
been created using different types of data:

If creating a surface froma new polyline, the polyline will not be able to be used elsewhere in
the project unless it has been shared. To share the polyline, expand the contact surface in the
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project tree, right-click on the polyline and select Share. The polyline will then be available
elsewhere in the project.

As further refinements aremade to the surface, that information will also be added to the
contact surface in the project tree.

Deposits/Erosions in the Project Tree

The name Leapfrog Geo automatically assigns to a deposit or an erosion is the lithologies
assigned to each side of the surface. In the project tree, expand the surface to see how it was
made:

Double-click on the surface to edit it. Double-click on the contact points object ( ) to edit the
lithology and change compositing parameters.

As further refinements aremade to the surface, that information will also be added to the
project tree. SeeRefining Deposits and Erosions below formore information.

Refining Deposits and Erosions

You can refine deposits and erosions in several ways:

l Add other data. Right-click on the surface to see the options available, which will depend on
how the surfacewas created. See Adding Data to Surfaces formore information.

l Edit the surfacewith a polyline. Right-click on the surface in the project tree and select either
Edit > With Polyline. See Editing Surfaces with Polylines formore information.

l Edit the surface using structural data. Right-click on the surface and select Edit > With
Structural Data. This option is available for deposits and erosions created from lithology data
and other data in the project, but not for offset surfaces. See Editing Surfaces with
Structural Data formore information.

To edit the surface’s settings, double-click on it in the project tree. In the Lithologies tab,
change the lithologies assigned to each side of the surface, if required.

You can swap the younging direction if the direction was assigned incorrectlywhen the surface
was created. The changewill be reflected in the scene. Note that changing the younging
direction does not changewhich lithology is older or younger.

The difference between deposit and erosion contact surfaces is how they cut older lithologies,
as described in Contact Surfaces. For this reason, it is possible to change between the two types
using theContact Type setting.

For information on other techniques for refining deposits and erosions, see:

l Surfacing Options for Deposits and Erosions

l Offset Surfaces
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Surfacing Options for Deposits and Erosions

Surfacing options for deposits and erosions can be changed by double-clicking on the surface
in the project tree and then clicking on the Surfacing tab. There are additional settings related
to boundary filtering and snapping to data in the Inputs tab.

Boundary Filtering

When data objects are added to a surface, there are twoways to handle the data that lies
outside the surface’s boundary:

l Filter the data. The surface is only influenced by the data that falls inside the surface’s
boundary.

l Leave the data unfiltered. The surface is influenced by the data both inside and outside the
surface’s boundary.

The Boundary filter setting determines how data used to define the surface is filtered:

l Off. Data is not filtered.

l All data. All data is filtered.

l Drilling only. Only drillhole data and data objects derived fromdrillhole data are filtered.

l Custom. Only the data objects specified in the Inputs tab are filtered.

Snapping to Data

Often, surfaces should honour drillhole data and treat data objects such as polylines and GIS
data as interpretations. SeeContact Honouring.

There is a Snap to data setting for a geological model as a whole that is set in theGeological
Model > General tab (see Editing a Geological Model). Snap-to-data can also be set on a
surface-by-surface basis by double-clicking on the surface in the project tree and then clicking
on the Surfacing tab.

For individual contact surfaces, the options are:

l Inherit from GM. The setting for the geological model as a whole is used. This is the default
setting.

l Off. Surfaces do not snap to the data used to create them.

l All data. Surfaces snap to all data within theMaximum snap distance, which includes
drillhole data and any data added to the surfaces.

l Drilling only. Surfaces snap to drillhole data and data objects derived fromdrillhole data
within theMaximum snap distance but not to other data used tomodify the surfaces.

l Custom. Surfaces snap to the data objects indicated in the Inputs tab for each surface.

Snapping to data is off by default. Although you can snap to all data, this is not
recommended as it increases the possibility that errors in the data or assumptions inherent in
interpretations (e.g. polylines) will cause distortions in themeshes. If you do enable snapping,
is best to snap only to drilling data.
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If you need a surface to honour drillhole data but treat other data objects as interpretations,
selectDrilling only. To honour some data objectswhile treating others as interpretations, select
Custom, then click on the Inputs tab to enable snapping for individual objects.

Setting the Surface Resolution

See Surface Resolution for a Geological Model for information about the surface resolution
settings in the Surfacing tab.

Applying a Trend to a Deposit/Erosion

There are twoways to change the trend for a deposit or an erosion:

l Right-click on the surface in the project tree and select Adjust Surface.

l Double-click on the surface in the project tree and then click on the Trend tab.

SeeGlobal Trends formore information.

Intrusions
This topic describes creating and editing intrusions. The topic is divided into:

l Creating Intrusions

l Intrusions from Lithology Contacts

l Intrusions from Other Data

l Intrusions in the Project Tree

l Displaying Intrusion Points

l Refining Intrusions

l Surfacing Options for Intrusions

l Boundary Filtering

l Snapping to Data

l Surface Resolution

l Applying a Trend to an Intrusion

l Clipping Values for Intrusions

l Interpolation Settings
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For a general introduction to how intrusions interact with other contact surfaces, see Intrusion
Contact Surfaces in Contact Surfaces.

Creating Intrusions

Lithology data is often themost reliable data source to usewhen building geological surfaces,
and it is best to derive contact surfaces from lithology data when it is available. If no lithology
data is available, you can create intrusions fromother data in the project.

One thing to keep in mind for all intrusion contact surfaces is that an intrusion removes all the
existing material on the younger side of the contact surface. Therefore:

l An intrusion should always have the younger side of its surface labelled with the intruded
material. This is called the “interior lithology”.

l The older side will typically be labelled “Unknown” as an intrusion will usually displace
multiple older lithologies. This is called the “exterior lithology”.

Intrusions from Lithology Contacts

Lithology data is often themost reliable data source to usewhen building geological surfaces,
and it is best to derive contact surfaces from lithology data when it is available. There are two
ways to create intrusions from lithology data:

l Using the base lithology column assigned when themodel was created.

l Using other lithology information available in the project. This is useful when you have
created an additional lithology column as part of correcting and working with the drillhole
data. For example, if when building a geological model it becomes apparent that changes
need to bemade to the drillhole data, you can import additional data or create a new column
using the split lithology, group lithology or interval selection tools.

To create a new intrusion from lithology contacts, right-click on the Surface Chronology
object and select eitherNew Intrusion > From Base Lithology orNew Intrusion > From Other
Contacts. The only difference in the twomethods is that when creating an intrusion fromother
contacts, you must first select the lithology column from those available in the project and
specify the First lithology and the Second lithology.
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Select the intrusive lithology as the interior lithology. Other lithologieswill be displayed in the
Exterior lithologies list. Drag any younger lithologies to the Ignore list.

Unspecified intervals are intervals that have no data. By default, unspecified intervals are
ignored when creating an intrusion, but you can also treat themas the interior lithology or as
exterior lithologies.

Sometimes intrusive boundaries are poorly defined, with fragments of country rock intermixed
with the intrusive body. This can result in very small segments near the edges of the intrusion.
Modelling the fine detail is not always necessary, and so compositing can be used to smooth
these boundaries. Compositing parameters are set in theCompositing tab:

The settings in this tab are described in Category Composites.
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ClickOK to create the intrusion, which will be added to the project tree as part of the Surface
Chronology object.

Intrusions from Other Data

If suitable lithology data is not available, intrusions can be created fromother data in the
project, such asGIS data, structural data, points, polylines and surfaces. The steps for creating
intrusions fromother data are similar, regardless of the data used to create the surface:

l Right-click on the Surface Chronology and select one of the data types from theNew
Intrusionmenu.

l Select the data object that will be used to define the surface. Thismust already be in the
project, unless you are using a polyline, in which case you are given the option to create a
new polyline.

l Select the First lithology and Second lithology. These are the lithologies that will be
assigned to each side of the contact surface. The lithologies you can choose fromare those
defined for the geological model in the Lithologies object (seeModel Lithologies).

l Set whether the First lithology is older or younger than the Second lithology. Leapfrog Geo
will, by default, put the younger side of a contact surface up, but this can be changed later.

Here, a points data object is being used to create an intrusion:

For polylines, you first set the lithologies and the younging order:

ClickOK tomove on to the next step:
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You can draw the polyline in the scene directly by selecting theNew Drawing option. You can
also use any polyline in the project by selecting the Existing Polyline option. You can then
select the required polyline from the list.

The new intrusion will appear in the project tree under the Surface Chronology. Add the
contact surface to the scene to view it and check that it is oriented correctly.

Expand the surface in the project tree to see how it wasmade.

If creating a surface froma new polyline, the polyline will not be able to be used elsewhere in
the project unless it has been shared. To share the polyline, expand the contact surface in the
project tree, right-click on the polyline and select Share. The polyline will then be available
elsewhere in the project.

As further refinements aremade to the surface, that information will also be added to the
contact surface in the project tree.

Intrusions in the Project Tree

The name Leapfrog Geo automatically assigns to an intrusion is the name of the intrusive
lithology. In the project tee, expand the intrusion to see how it wasmade:

Double-click on the intrusion to edit it. Double-click on the points object ( ) to edit the
intrusion lithology, change compositing parameters and change point generation options.

As further refinements aremade to the surface, that information will also be added to the
project tree. SeeRefining Intrusions below formore information.

© 2017 ARANZ Geo Limited



Displaying Intrusion Points | 341

Displaying Intrusion Points

When you view the intrusion points in the scene, you can display only the contact points or all
the points used in creating the intrusion. To display all points, click on the points object ( ) in
the shape list and tick the box for Show volume points:

When the volume points are displayed, pointswith negative values are those outside the
surface, while pointswith positive values are those inside.

You can change theway intrusion points are generated by double-clicking on the points object (
) in the project tree. See Intrusion Point Generation Parameters.

Refining Intrusions

You can refine intrusions in several ways:

l Add other data. Right-click on the surface to see the options available, which will depend on
how the surfacewas created. See Adding Data to Surfaces formore information.

l Edit the surfacewith a polyline. Right-click on the surface in the project tree and select either
Edit > With Polyline. See Editing Surfaces with Polylines formore information.

l Edit the surface using structural data. Right-click on the surface and select Edit > With
Structural Data. See Editing Surfaces with Structural Data formore information.

To edit an intrusion’s settings, double-click on it in the project tree. In the Lithologies tab,
change the lithologies assigned to each side of the surface, if required.

Surfacing Options for Intrusions

Surfacing options for an intrusion can be changed by double-clicking on the surface in the
project tree and then clicking on the Surfacing tab. There are additional settings related to
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boundary filtering and snapping to data in the Inputs tab.

Boundary Filtering

When data objects are added to a surface, there are twoways to handle the data that lies
outside the surface’s boundary:

l Filter the data. The surface is only influenced by the data that falls inside the surface’s
boundary.

l Leave the data unfiltered. The surface is influenced by the data both inside and outside the
surface’s boundary.

The boundary of an intrusion can be the geological model boundary or a fault block boundary.

The Boundary filter setting determines how data used to define the surface is filtered:

l Off. Data is not filtered.

l All data. All data is filtered.

l Drilling only. Only drillhole data and data objects derived fromdrillhole data are filtered.

l Custom. Only the data objects specified in the Inputs tab are filtered.

Snapping to Data

Often, surfaces should honour drillhole data and treat data objects such as polylines and GIS
data as interpretations, as discussed in Contact Honouring.

There is a Snap to data setting for a geological model as a whole that is set in theGeological
Model > General tab (see Editing a Geological Model). Snap-to-data can also be set on a
surface-by-surface basis by double-clicking on the surface in the project tree and then clicking
on the Surfacing tab.

For individual contact surfaces, the options are:

l Inherit from GM. The setting for the geological model as a whole is used. This is the default
setting.

l Off. Surfaces do not snap to the data used to create them.

l All data. Surfaces snap to all data within theMaximum snap distance, which includes
drillhole data and any data added to the surfaces.

l Drilling only. Surfaces snap to drillhole data and data objects derived fromdrillhole data
within theMaximum snap distance but not to other data used tomodify the surfaces.

l Custom. Surfaces snap to the data objects indicated in the Inputs tab for each surface.

Snapping to data is off by default. Although you can snap to all data, this is not
recommended as it increases the possibility that errors in the data or assumptions inherent in
interpretations (e.g. polylines) will cause distortions in themeshes. If you do enable snapping,
is best to snap only to drilling data.

If you need a surface to honour drillhole data but treat other data objects as interpretations,
selectDrilling only. To honour some data objectswhile treating others as interpretations, select
Custom, then click on the Inputs tab to enable snapping for individual objects.
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Surface Resolution

See Surface Resolution for a Geological Model for information about the surface resolution
settings in the Surfacing tab.

Clicking Additional options addsValue Clipping and Interpolant tabs to thewindow and also
allows the use of a structural trend in the Trend tab:

These are described in Applying a Trend to an Intrusion, Clipping Values for Intrusions and
Interpolation Settings below.

Applying a Trend to an Intrusion

There are twoways to change the trend for an intrusion:

l Right-click on the surface in the project tree and select Adjust Surface.

l Double-click on the surface in the project tree and then click on the Trend tab.

SeeGlobal Trends formore information.

© 2017 ARANZ Geo Limited



344 | Leapfrog Geo User Manual

You can also use a structural trend for an intrusion. To do this, click the Additional options
button in the Surfacing tab, then click on the Trend tab.

Click on Structural Trend, then select the required trend from the list. See Structural Trends
formore information.

Clipping Values for Intrusions

You can change settings for intrusions by double-clicking on the contact surface in the project
tree. The Value Clipping tab is only available for intrusion contact surfaces.

In the Value Clipping tab, you can manipulate the data distribution by clipping the data:
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Clipping cuts off values that are outside the range set by the Lower bound and Upper bound
values. For example, if you change theUpper bound from16.00 to 10.00, distance values
above 10.00will be regarded as 10.00.

The Automatic clipping setting has different effects based on whether a global trend or
structural trend is set in the Trend tab:

l When a global trend is applied, Leapfrog Geo automatically clips the values. That is, the
Automatic clipping setting isDo clipping and Leapfrog Geo sets the Lower bound and
Upper bound from the data. To disable clipping, untickAutomatic clipping, then untickDo
clipping. To change the Lower bound and Upper bound, untickAutomatic clipping, then
change the values.

l When a structural trend is applied, Leapfrog Geo automatically does not clip the values. To
clip values, untickAutomatic clipping, then tickDo clipping. Again, Leapfrog Geo sets the
Lower bound and Upper bound values from the data and you can change them, if required.

Interpolation Settings

You can change settings for an intrusion by double-clicking on the intrusion in the project tree
and clicking on the Interpolant tab. Formore information on the settings in this tab, see:

l Interpolant Functions

l The Spheroidal Interpolant Function

l The Linear Interpolant Function

Veins
This topic describes creating and editing veins. It is divided into:

l Creating Veins

l Veins From Lithology Contacts

l Veins From Other Data

l Veins in the Project Tree

l Displaying Veins

l Refining Veins

l Surfacing Options for Veins

l Boundary Filtering

l Snapping to Data

l Surface Resolution

l Vein Thickness

l Vein Pinch Out

l The Vein Reference Surface

l Adding Data to the Reference Surface

l Using a Planar Reference Surface
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l The Vein Boundary

l Adding a Polyline to the Vein Boundary

l Adjusting the Vein Boundary Plane

l Editing Vein Segments

For a general introduction to how veins interact with other contact surfaces, see Vein Contact
Surfaces in Contact Surfaces.

A vein is a type of contact surface that removes existing lithologies and replaces themwith the
vein lithologywithin the boundaries defined by hangingwall and footwall surfaces constructed
from selected input data. A reference surface is defined that is the best fit for the hangingwall
and footwall surfaces. The reference surface can be curved or planar.

Creating Veins

Options for creating veins are:

l From lithology data, using the base lithology used to define the geological model or other
contacts available in the project. See Veins From Lithology Contacts below.

l FromGIS vector data, point data and polylines. See Veins From Other Data below.

l Creating a vein system. This results in a single lithology that represents all the veins in a model.
Veins and their interactions are defined within the vein system. See Vein Systems.

Veins From Lithology Contacts

To create a new vein from lithology contacts, right-click on the Surface Chronology object and
select eitherNew Vein > From Base Lithology orNew Vein > From Other Contacts. The only
difference in the twomethods is that when creating a vein fromother contacts, you must first
select the lithology column from those available in the project and specify the Vein lithology
andOutside lithology.

In theNew Veinwindow, select the Vein lithology:

When extracting the hangingwall and footwall points, Leapfrog Geo automatically includes
points at the ends of the drillholes. To exclude these points, untick the Include points at the
ends of holes. Once the vein has been created, this setting can be changed by double-clicking
on the vein segments object ( ) in the project tree.
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ClickOK to create the vein, which will be added to the project tree as part of the Surface
Chronology object.

Veins From Other Data

If suitable lithology data is not available, veins can be created fromother data in the project,
such asGIS data, points and polylines. The steps for creating veins fromother data are similar,
regardless of the data used to create the surface:

l Right-click on the Surface Chronology and select one of the data types from theNew Vein
menu.

l Select the data objects for theHangingwall and Footwall. These objectsmust already be in
the project.

l Select the Vein lithology and theOutside lithology. The lithologies you can choose fromare
those defined for the geological model in the Lithologies object (seeModel Lithologies).

Here, a points data object is being used to create a vein:

ClickOK to create the new vein. The new contact surfacewill appear in the project tree under
the Surface Chronology. Expand the vein in the project tree to see how it wasmade.

Veins in the Project Tree

Veins are stored in the project tree as part of the Surface Chronology object. Further
modifications can bemade to the vein byworking on the objects that make up the vein. Expand
the vein in the project tree to view these objects.
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Here, the hangingwall and footwall surfaces and points are displayed in the scene for a vein
defined from lithology data. The reference surface (yellow) and the vein segments (red and blue
cylinders) used to create the vein are also shown:

This vein ismade up of:

l Hangingwall and footwall surfaces ( ), which, when expanded, show the hangingwall and
footwall data objects used to create the surfaces.
o Export hangingwall and footwall surfaces as described inMesh Export and Elevation Grid

Export.

o Add points and GIS vector data to themeshes by right-clicking on themand selecting Add.

o Edit the hangingwall and footwall surfaceswith polylines by right-clicking on the surface
and selecting one of the Edit options.

o Change contact honouring and boundary filtering options as described in Surfacing
Options for Veins below.

l Vein segments and pinch out segments ( ) extracted fromdrillhole data. These are only
included when a vein is created from lithology contacts.

l A reference surface ( ) calculated as the best fit surface using the hangingwall and footwall
surfaces.
o The reference surface can be curved or planar.

o You can add points, GIS vector data and polylines to a curved reference surface.

o If a curved reference surface ismade up of multiple objects, you can switch between the
objects and change how they are filtered in order to see the effects on the vein.

l A boundary object ( ), which is emptywhen the vein is first created.
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Displaying Veins

You can change theway the different objects that make up the vein are displayed using options
in the shape list:

Refining Veins

To edit a vein’s settings, double-click on it in the project tree. In the Lithologies tab, change the
lithologies assigned to each side of the surface, if required. For information on the settings in the
Surfacing and Inputs tabs, see Surfacing Options for Veins below.

Surfacing Options for Veins

Surfacing options for veins can be changed by double-clicking on the surface in the project tree
and then clicking on the Surfacing tab. There are additional settings related to boundary
filtering and snapping to data in the Inputs tab.

Boundary Filtering

When data objects are added to a surface, there are twoways to handle the data that lies
outside the surface’s boundary:

l Filter the data. The surface is only influenced by the data that falls inside the surface’s
boundary.

l Leave the data unfiltered. The surface is influenced by the data both inside and outside the
surface’s boundary.

The boundary of a vein can be the geological model boundary or a fault block boundary.

The Boundary filter setting determines how data used to define the surface is filtered:

l Off. Data is not filtered.

l All data. All data is filtered.

l Drilling only. Only drillhole data and data objects derived fromdrillhole data are filtered.

l Custom. Only the data objects specified in the Inputs tab are filtered.

The Filter segments by boundary setting in the Inputs tab is enabled by default when the
Boundary filter setting in the Surfacing tab isAll data orDrilling only. When Filter segments
by boundary is enabled, the vein surfacewill only be influenced by the segments that falls
inside the vein boundary.
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Snapping to Data

Often, surfaces should honour drillhole data and treat data objects such as polylines and GIS
data as interpretations, as discussed in Contact Honouring.

There is a Snap to data setting for a geological model as a whole that is set in theGeological
Model > General tab (see Editing a Geological Model). Snap-to-data can also be set on a
surface-by-surface basis by double-clicking on the surface in the project tree and then clicking
on the Surfacing tab.

For individual contact surfaces, the options are:

l Inherit from GM. The setting for the geological model as a whole is used. This is the default
setting.

l Off. Surfaces do not snap to the data used to create them.

l All data. Surfaces snap to all data within theMaximum snap distance, which includes
drillhole data and any data added to the surfaces.

l Drilling only. Surfaces snap to drillhole data and data objects derived fromdrillhole data
within theMaximum snap distance but not to other data used tomodify the surfaces.

l Custom. Surfaces snap to the data objects indicated in the Inputs tab for each surface.

Snapping to data is off by default. Although you can snap to all data, this is not
recommended as it increases the possibility that errors in the data or assumptions inherent in
interpretations (e.g. polylines) will cause distortions in themeshes. If you do enable snapping,
is best to snap only to drilling data.

If you need a surface to honour drillhole data but treat other data objects as interpretations,
selectDrilling only. To honour some data objectswhile treating others as interpretations, select
Custom, then click on the Inputs tab to enable snapping for individual objects.

Surface Resolution

Note that although you can change the Surface resolution for a vein, the Adaptive option is
not available, even when the resolution for the geological model is set to be Adaptive.

Vein Thickness

Veins have two thickness settings that force the vein tomaintain a minimumormaximum
thickness. If footwall and hangingwall points are in pairs, it is not usually necessary to set the
Minimum thickness orMaximum thickness.

l If the vein intersects itself, set theMinimum thickness to a value that is less than theminimum
distance between any two contact points.

l If the vein widens out toward the edges of the geological model set theMaximum thickness
to a value that limits the effects of long segments.

If the Pinch out option is enabled, you will not be able to set theMinimum thickness.

If you set theMaximum thickness and Pinch out, the Pinch out is applied before theMaximum
thickness.
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Vein Pinch Out

Vein walls can be set to pinch out where drillhole data indicates they do not occur. This is
achieved by creating ‘outside’ intervals on drillholes that do not have an interior vein segment.
These intervals are then flipped with respect to interior vein intervals, which, in effect means the
footwall and hangingwall orientation has the opposite sense to the nearest interior intervals.
This forces the hangingwall and footwall surfaces to cross, thereby pinching out.

The Pinch out option is disabled when a vein is first created. To enable it, double-click on the
vein in the project tree and click on the Surfacing tab. Tick the box for Pinch out. ClickOK to
process the changes. The vein will be updated and pinch out points ( ) will be added to the
vein in the project tree.

For this vein, the surface occurs even where the vein lithology (green cylinders) does not occur
and terminates at the boundary of the geological model:

When the vein is set to pinch out, it tapers out where the vein lithology does not occur:
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You can change howmuch the vein pinches out by excluding some pinch out segments. To do
this, right-click on the pinch out segments ( ) in the project tree and select Edit in Scene. The
Pinch Out Propertieswindowwill appear in the scene. Click on a segment to view information
about it and set it to be Excluded, if required. Note that the segments displayed in the scene
below are the pinch out segments rather than the drillhole segments shown in earlier scenes.
The grey segments are excluded and the currently selected segment is highlighted in the scene:

Click the Save button ( ) to view the effect of the excluded pinch out segments on the vein.
Excluding the two segments results in the vein terminating at the boundary of the geological
model:

The Vein Reference Surface

A vein includes a reference surface ( ) that is the best fit for the objects that make up the
hangingwall and footwall surfaces. There are two types of reference surface.

l Curved. A curved reference surface can be used tomake a vein follow themedial trend of the
source data, which leads to a more natural modelled shape. This is the type of reference
surface used by default for veins created from lithology data. A curved reference surface can
be used for veins created fromother types of data by adding data to the reference surface, as
described in Adding Data to the Reference Surface.

l Planar. A planar reference surface is simply the best linear fit between the hangingwall and
footwall surfaces. SeeUsing a Planar Reference Surface.
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To adjust the reference surface ( ), double-click on it in the project tree or right-click on it and
selectOpen. TheReference Surfacewindowwill appear, showing the data used to for the
reference surface. This is the reference surface for a vein created from lithology data, and so the
midpoints for the vein lithology are used as Input values:

Boundary filtering for themidpoints used to create a curved reference is controlled by the
setting for the vein itself. See Boundary Filtering in Surfacing Options for Veins formore
information.

Adding Data to the Reference Surface

In order for a vein created fromdata other than lithology data to use a curved reference surface,
other data must be added to it. To add data, right-click on the reference surface in the project
tree and select Add or Edit. Once you have added data, theCurved reference surface option
will be enabled in theReference Datawindow and the objects used to adjust the surfacewill
appear in the list of Input values:

You can enable or disable the different data objects to see their effects on the vein by ticking
and unticking the Active box.
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The Boundary filter setting for each object determineswhether or not the data that lies outside
the reference surface’s boundary is filtered.

l TickBoundary filter so that the surface is only influenced by the data that falls inside the
reference surface’s boundary.

l UntickBoundary filter if you want the surface to be influenced by the data both inside and
outside the reference surface’s boundary.

ClickOK to process the changes.

Using a Planar Reference Surface

Veins created fromobjects other than lithology data use a planar reference surface, and this
option can also be selected for veins created from lithology data. To use a planar reference
surface, select the Planar reference surface option in theReference Surfacewindow. The
planewill be displayed in the scene, together with handles that can be used to adjust it:

These handleswork in the samemanner as themoving plane controls, as described in The
Moving Plane.

ClickOK to update the reference surface and view the results.

The Vein Boundary

Once a vein has been created, you can change its boundary by:

l Adding a Polyline to the Vein Boundary

l Adjusting the Vein Boundary Plane
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Adding a Polyline to the Vein Boundary

To change the boundary using a polyline, right-click on the boundary object ( ) in the project
tree and select Edit. The current vein boundarywill appear in the scene, together with drawing
controls. Begin drawing the new boundary, as described in Drawing in the Scene, ensuring
that the polyline drawn closes and does not intersect itself.

When you save the boundary, the vein will be updated to reflect the changes to the boundary.
If you want to revert to the original boundary, right-click on the boundary object ( ) and select
Delete Polyline.

Adjusting the Vein Boundary Plane

To adjust the boundary plane, right-click on the boundary object ( ) in the project tree and
select Adjust Plane. The Adjust Boundary Planewindowwill appear and handles to adjust the
planewill appear in the scene:
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ClickOK to apply the changes to the vein. To revert to the original boundary plane, right-click
on the boundary object and select Adjust Plane. In the Adjust Boundary Planewindow, click
on the Set to Default button and clickOK.

Editing Vein Segments

When a vein has been created fromcontact points, you can change the vein segment settings
by double-clicking on the vein segments object ( ) in the project tree. This opens the Edit Vein
window.

When extracting the hangingwall and footwall points, Leapfrog Geo automatically includes
points at the ends of the drillholes. To exclude these points, untick the Include points at the
ends of holes.

Vein Segment Orientation

If you need to change the orientation of individual vein segments, e.g. for curved veins, you can
do this by right-clicking on the vein segments object ( ) in the project tree and selecting Edit In
Scene. If the vein segments object is already in the scene, you can edit it by clicking the Edit
button ( ) in the shape list.

The Vein Segment Orientationswindowwill appear in the scene. Click on a vein segment to
view information about that segment:

Points A and B are labelled in the scene and can be changed by unticking the box for each point
and choosing whether to exclude the point ormake it a hangingwall or footwall point. Once
you have finished editing vein segments, click the Save button ( ).

If you wish to return to the default settings, ensure the Auto box is ticked for each point.

Vein Systems
This topic describes creating a vein system for a geological model. The topic is divided into:

l Creating a Vein System

l Adding Veins to the Vein System

l Editing the Veins
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l Vein System Lithology Settings

l Vein Interactions

An alternative to defining veins one-by-one is to create a vein system. The vein system
represents a single lithologywithin the geological model. For example, for a model of a
sedimentary systemcross-cut by vertical intersecting dykes, we could model the veins one-by-
one, in which case each “vein” in themodel is represented by a separate lithology:

Modelled as a vein system, however, the veins are grouped into a vein systemobject ( ) that
defines the lithology for the vein systemas a whole:

Note that the individual veins are part of the vein system.

The vein systemdefines how the veins interact, and veins can be added to it using the same
techniques used to create individual veins.
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Creating a Vein System

To create a vein system, right-click on the Surface Chronology and selectNew Vein System. In
thewindow that appears, select the Vein lithology:

If the vein systemcontacts only one lithology, set theOutside lithology. Otherwise, leave
Outside lithology set to Unknown.

ClickOK. An empty vein system ( ) will be added to the project tree under the Surface
Chronology. Double-click on it to change the lithologies.

Adding Veins to the Vein System

Once the vein systemhas been created, you can create veins using the same techniques
described in Veins From Lithology Contacts and Veins From Other Data.

To add veins to the vein system, right-click on the vein systemand select one of theNew Vein
options. Veinswill appear in the project tree as part of the vein systemobject and can be
expanded to show how theywere created.

Editing the Veins

The techniques for editing vein systemveins are the same as those for veins created one-by-
one. SeeRefining Veins.

Vein System Lithology Settings

You can change the lithology settings for a vein systemby double-clicking on the vein system (
) in the project tree. In the Lithology tab, change the Vein lithology or theOutside lithology.
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Vein Interactions

Once all the veins required have been created, you can start defining the interactions between
themby double-clicking on the vein system ( ), then clicking on the Vein System tab:

The veins appear in the list fromhighest priority to lowest. Organise the veins in chronological
order before defining interactions. You cannot define an interaction for the highest priority vein
in the list.

To add an interaction, click on a vein, then click the Add button. Select the Interaction Type
and set how the veins interact:

© 2017 ARANZ Geo Limited



360 | Leapfrog Geo User Manual

Once you have defined the required vein interactions, tick the box for each vein, then clickOK.
Add the Vein Systemobject to the scene to check that the veins interact correctly.

You can also edit vein interactions by double-clicking on the individual veins.

Veins and the vein systemare not active in the geological model until the box is ticked for
each vein in the Edit Vein Systemwindow and the vein system is enabled in the Surface
Chronology. Thismeans you can check the vein systemwithout regenerating the geological
model.

Stratigraphic Sequences
When you have a series of continuous layers in a geological model, you can model each layer
separately, as part of a single stratigraphic sequence or using the offset surface tool. Modelling
a stratigraphic sequenceworks best for sequences uniform in thicknesswith a consistent
stacking order. If a layer varies in thickness, the contact surfacemay not match the contact
points in some places. Thiswill be a consideration when choosing whether tomodel layers as
separate layers, as offset surfaces or as part of a stratigraphic sequence. For information on the
offset surface tool, seeOffset Surfaces.

Once you have created a stratigraphic sequence, you can refine it by adding and removing
layers and by adjusting the surfaces produced.

This topic describes using the stratigraphic sequence tool and is divided into:

l Creating a Stratigraphic Sequence

l Boundary Filtering

l Snapping to Data

l Surface Stiffness

l Editing the Stratigraphic Sequence

l Correcting Pinch-out Errors

l Surfacing Options

l Applying a Trend

l Editing Individual Surfaces

l Contact Honouring and Boundary Filtering for Individual Surfaces

l Adding Data to Individual Surfaces

l Editing Surface Contacts
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Creating a Stratigraphic Sequence

To create a stratigraphic sequence, right-click on the Surface Chronology object and select
New Stratigraphy. TheNew Stratigraphic Sequencewindowwill appear:

Select the lithologies at the top and bottomof the stratigraphic sequence. To do this, select the
Lithology Above and Lithology Below from the lithologies available in the geological model:
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Next, click the Add Lithologies button to view available lithologies:

Select the lithologies that you want to use in the stratigraphic sequence, then clickOK to add
the layers to the Stratigraphic Lithologies list. Make sure they arranged in the correct order.

In theNew Stratigraphic Sequencewindow, select whether the Bottom Contact Type is an
erosion or a deposit.

When the Surfaces avoid drillhole segments option is enabled, the surfaces in the stratigraphic
sequencewill not cut through intervals of lithologies that are selected for the stratigraphic
sequence.

Stratigraphic sequences created in earlier versions of Leapfrog Geo (before 3.0) used only the
contact information; intervalswere ignored and stratigraphic sequence surfaces could cut
through intervals. To upgrade a stratigraphic sequence created in earlier versions, edit the
stratigraphic sequence to enable Surfaces avoid drillhole segments.

Next, click on the Surfacing tab to set the surfacing settings for each surface created for the
sequence:
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For the Boundary filter and Snap to data options, it is possible to override these settings for the
individual contact surfaces that are part of the stratigraphic sequence. To do this, select
Custom. Once the stratigraphic sequence has been created, expand it in the project tree and
double-click on each surface to change its surfacing options, as described in Contact
Honouring and Boundary Filtering for Individual Surfaces below.

Boundary Filtering

When data objects are added to a surface, there are twoways to handle the data that lies
outside the surface’s boundary:

l Filter the data. The surface is only influenced by the data that falls inside the surface’s
boundary.

l Leave the data unfiltered. The surface is influenced by the data both inside and outside the
surface’s boundary.

The Boundary filter setting determines how data used to define the surface is filtered:

l Off. Data is not filtered.

l All data. All data is filtered.

l Drilling only. Only drillhole data and data objects derived fromdrillhole data are filtered.

l Custom. Only the data objects specified in the Inputs tab are filtered.

All contact surfaces that make up a stratigraphic sequencewill inherit the Boundary filter
setting from the stratigraphy unlessBoundary filter is set toCustom.

Snapping to Data

There is a Snap to data setting for a geological model as a whole that is set in theGeological
Model > General tab (see Editing a Geological Model). Snap-to-data can also be set on a
surface-by-surface basis by double-clicking on the surface in the project tree and then clicking
on the Surfacing tab.

For a stratigraphic sequence, the options are:

l Inherit from GM. The setting for the geological model as a whole is used. This is the default
setting.

l Off. Surfaces do not snap to the data used to create them.

l All data. Surfaces snap to all data within theMaximum snap distance, which includes
drillhole data and any data added to the surfaces.

l Drilling only. Surfaces snap to drillhole data and data objects derived fromdrillhole data
within theMaximum snap distance but not to other data used tomodify the surfaces.

l Custom. Surfaces snap to the data objects indicated in the Inputs tab for each surface.

Snapping to data is off by default. Although you can snap to all data, this is not
recommended as it increases the possibility that errors in the data or assumptions inherent in
interpretations (e.g. polylines) will cause distortions in themeshes. If you do enable snapping,
is best to snap only to drilling data.
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All contact surfaces that make up a stratigraphic sequencewill inherit the Snap to data setting
from the stratigraphy unless Snap to data is set toCustom.

Surface Stiffness

The Surface Stiffness controls the smallest bend a surfacewill make, where a higher valuewill
result in a smoother surface that bends less. The default value is 0, which is no stiffening.

ClickOK to create the stratigraphy, which will be added to the project tree as part of the Surface
Chronology object.

Editing the Stratigraphic Sequence

The objects that make up the stratigraphic sequence include the generated contact surfaces
and any points that result in pinch-out errors:

Correcting Pinch-out Errors

Add the pinch-out errors object ( ) to the scene to view the points that are causing errors. To
find out more about the errors, right-click on the sequence and select List Errors.

In the Stratigraphic Errorswindow, information is provided about the different errors that
occur in the stratigraphic sequence, with pinch-out errors and other errors listed separately:

Use this information, together with the pinch-out error points, to either remove lithologies from
the sequence or adjust surfaces using any of the tools available for individual surfaces, as
described in Editing Individual Surfaces below.

Remove lithologies from the sequence by double-clicking on the sequence in the project tree,
then reorganising the lithologies in theChronology tab. For example, here, the pinch-out errors
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shown in thewindow above have been corrected by removing the affected surfaces from the
sequence and changing the Lithology Above and Lithology Below:

You can also ignore an error by ticking the Ignored box in the Stratigraphic Errorswindow.

Surfacing Options

To change a stratigraphic sequence’s surfacing options, double-click on the sequence in the
project tree and click on the Surfacing tab. See Boundary Filtering and Snapping to Data
above formore information on the settings in this tab. Note that boundary filtering and snap
settings can also be set for the individual surfaces that make up the stratigraphic sequence,
which is described in Contact Honouring and Boundary Filtering for Individual Surfaces
below.

Applying a Trend

To apply a global trend to a stratigraphic sequence either right-click on it in the project tree and
select Adjust Surface or double-click on the stratigraphic sequence and then click on the
Trend tab. You can then apply a trend to the surface as described inGlobal Trends.

Editing Individual Surfaces

Individual surfaces that make up a stratigraphic sequence can bemodified by:

l Contact Honouring and Boundary Filtering for Individual Surfaces

l Adding Data to Individual Surfaces

l Editing Surface Contacts
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Contact Honouring and Boundary Filtering for Individual Surfaces

There are general boundary filtering and snap settings for the stratigraphic sequence as a
whole, but it is possible to override these settings for the individual surfaces that are part of the
stratigraphic sequence. To do this, first double-click on the stratigraphic sequence itself, then
click on the Surfacing tab.

l To change boundary filtering for an individual surface, Boundary filtermust be set to
Custom for the stratigraphic sequence.

l To change the snap setting for an individual surface, Snap to datamust be set toCustom for
the stratigraphic sequence.

Next, double-click on an individual surface in the project tree. Thewindow that appears shows
all the data objects used to create the surface:

See Boundary Filtering and Snapping to Data formore information.

Adding Data to Individual Surfaces

You can also refine the individual surfaces in a stratigraphic sequence in several ways:

l Add other data. Right-click on the surface to see the options available, which will depend on
how the surfacewas created. See Adding Data to Surfaces formore information.

l Edit the surfacewith a polyline. Right-click on the surface in the project tree and select either
Edit > With Polyline. See Editing Surfaces with Polylines formore information.

l Edit the surface using structural data. Right-click on the surface and select Edit > With
Structural Data. See Editing Surfaces with Structural Data formore information.

Editing Surface Contacts

You can edit the contacts used to generate the surface by expanding the contact surface in the
project tree and double-clicking on the points object ( ). See Extracting Contact Points from
Drillhole Data formore information on the settings in the Edit Contactswindow.
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Offset Surfaces
The offset surface tool is useful way of creating a series of deposit or erosion contact surfaces
froma referencemesh. The surface can be offset from the referencemesh by points or by a
fixed distance, and additional options for offsetting to points can be adjusted once the surface
has been created.

Here a deposit contact surface (blue) has been created using the referencemesh (green) offset
to points (red):

Important considerationswhen creating offset surfaces is the characteristics of the reference
mesh, especially in relation to the geological model’s boundary.

l It is best to use a referencemesh that extends beyond themodel’s boundary. If the reference
mesh is too small, the offset surfacemay be distorted where the referencemesh does not
occur.

l If the referencemesh changes significantly near themodel’s boundary, offset surfacesmay
show unexpected changes. Offset surfaces are projected in the direction the referencemesh
is going, and if the referencemesh changes direction just inside the boundary, that change
will be reflected in the offset surface. This is normal if there is data that takes the reference
mesh in a different direction, but if this is not desirable for the offset surface, considermaking
the geological model’s boundary smaller.

The rest of this topic describes creating and working with an offset surface. It is divided into:

l Creating an Offset Surface

l The Offset Surface in the Project Tree

l Refining an Offset Surface
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l Changing Surfacing Options for an Offset Surface

l Boundary Filtering

l Snapping to Data

l Surface Resolution

l Smoothing

l Changing Offset Limits

l Changing to a Constant Offset

l Changing to an Offset to Points

l Changing the Reference Mesh

l Editing the Reference Mesh

Creating an Offset Surface

To start creating an offset surface, right-click on the Surface Chronology and selectNew
Deposit/Erosion > From Offset Surface. TheNew Offset Surfacewindowwill appear:

In thewindow that appears, you need to select a referencemesh, then either select Surface
points to offset to or set a Constant offset.

Click Select reference mesh to view themeshes available in the project.

If you wish to offset from the referencemesh using a fixed distance, clickConstant offset and
set theDistance. ForDirection, selecting Forward offsets the surface on the younger side of
the referencemesh, and selecting Backward offsets on the older side.

If you wish to offset to points, clickAdd. You can offset to:

l Base lithology contacts or other lithology contacts in the project.

l Other data in the project. GIS data, points data and polylines can be used.

If you offset to points, you will be able to set additional options such as distance limits once the
surface has been created. SeeChanging Offset Limits below formore information.

© 2017 ARANZ Geo Limited



The Offset Surface in the Project Tree | 369

Select the First Lithology and Second Lithology from the lithologies defined for themodel. If
you have added base lithology contacts or other contacts to the surface, thesewill be set
automatically from the data used.

ClickOK to create the surface, which will appear in the project tree as part of the Surface
Chronology.

The Offset Surface in the Project Tree

The name Leapfrog Geo automatically assigns to an offset surface is the lithologies assigned to
each side of the surface. In the project tree, expand the surface to see how it wasmade:

Double-click on the surface to edit it. Double-click on the contact points object ( ) to edit the
lithology and change compositing parameters.

As further refinements aremade to the surface, that information will also be added to the
project tree. SeeRefining an Offset Surface below formore information.

Refining an Offset Surface

You can refine an offset surface by:

l Adding other data. Right-click on the surface to see the options available, which will depend
on how the surfacewas created. See Adding Data to Surfaces formore information.

l Editing the surfacewith a polyline. Right-click on the surface in the project tree and select
either Edit. See Editing Surfaces with Polylines formore information.

To edit the surface’s settings, double-click on it in the project tree. In the Lithologies tab,
change the lithologies assigned to each side of the surface, if required.

You can swap the younging direction if the direction was assigned incorrectlywhen the surface
was created. The changewill be reflected in the scene. Note that changing the younging
direction does not changewhich lithology is older or younger.

An offset surface can be created as a deposit or as an erosion. The difference between deposit
and erosion contact surfaces is how they cut older lithologies, as described in Contact
Surfaces. For this reason, it is possible to change between the two types using theContact
Type setting.

An offset surface cannot be adjusted by applying a trend.

Changing Surfacing Options for an Offset Surface

Surfacing options for an offset surface can be changed by double-clicking on the surface in the
project tree and then clicking on the Surfacing tab. There are additional settings related to
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boundary filtering and snapping to data in the Inputs tab.

Boundary Filtering

When data objects are added to a surface, there are twoways to handle the data that lies
outside the surface’s boundary:

l Filter the data. The surface is only influenced by the data that falls inside the surface’s
boundary.

l Leave the data unfiltered. The surface is influenced by the data both inside and outside the
surface’s boundary.

The Boundary filter setting determines how data used to define the surface is filtered:

l Off. Data is not filtered.

l All data. All data is filtered.

l Drilling only. Only drillhole data and data objects derived fromdrillhole data are filtered.

l Custom. Only the data objects specified in the Inputs tab are filtered.

Snapping to Data

Often, surfaces should honour drillhole data and treat data objects such as polylines and GIS
data as interpretations, as discussed in Contact Honouring.

There is a Snap to data setting for a geological model as a whole that is set in theGeological
Model > General tab (see Editing a Geological Model). Snap-to-data can also be set on a
surface-by-surface basis by double-clicking on the surface in the project tree and then clicking
on the Surfacing tab.

For individual contact surfaces, the options are:

l Inherit from GM. The setting for the geological model as a whole is used. This is the default
setting.

l Off. Surfaces do not snap to the data used to create them.

l All data. Surfaces snap to all data within theMaximum snap distance, which includes
drillhole data and any data added to the surfaces.

l Drilling only. Surfaces snap to drillhole data and data objects derived fromdrillhole data
within theMaximum snap distance but not to other data used tomodify the surfaces.

l Custom. Surfaces snap to the data objects indicated in the Inputs tab for each surface.

Snapping to data is off by default. Although you can snap to all data, this is not
recommended as it increases the possibility that errors in the data or assumptions inherent in
interpretations (e.g. polylines) will cause distortions in themeshes. If you do enable snapping,
is best to snap only to drilling data.

If you need a surface to honour drillhole data but treat other data objects as interpretations,
selectDrilling only. To honour some data objectswhile treating others as interpretations, select
Custom, then click on the Inputs tab to enable snapping for individual objects.
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There is also a snap setting that can be used when offset limits are used. This option is discussed
inOffset Surfaces below.

Surface Resolution

The surface resolution for an offset surface can be inherited from the geological model or it can
be set specifically for the surface. To change the surface resolution for an offset surface,
double-click on the surface in the project tree and then click on the Surfacing tab. See Surface
Resolution for a Geological Model for information about the surface resolution settings in the
Surfacing tab.

Smoothing

The Smoothing parameter in the Surfacing tab can be used for all offset types other than
Constant. If your reference surface is highly curved, you may see distortions in the offset
surface. If this is the case, set Smoothing to a higher value.

Increasing the Smoothing parameter will generally result in faster processing when offsetting to
large distances. If you are finding that processing time is excessively long for an offset surface,
consider increasing Smoothing. In some situations, however, increasing Smoothing can
exaggerate imperfections in the reference surface.

If you are offsetting by a small distance and processing is taking longer than expected, consider
setting Smoothing toNone.

Changing Offset Limits

There are four options forOffset limits in the Surfacing tab. Three relate to offsetting to points
and the fourth to offsetting to a fixed distance from the referencemesh.

l TheNone option is the default setting used when a surface is created as an offset to points.
No distance limits are used in creating the offset surface, and it simply follows the points used.

l TheUnidirectional limits option allows you to set distance limits in one direction. Points
outside the limitswill be disregarded.

l The Bidirectional limits option allows you to set distance limits in both directions, and points
outside these limits are disregarded. This setting is useful formodelling folded surfaces such
as veins.

l TheConstant offset option offsets the surface to a fixed distance from the referencemesh.

The Forward direction is the younger side of the referencemesh.

If the Snap to data outside limits setting is enabled, the surfacewill honour data, even if it is
outside the distance limits. This option will be greyed out if Snap to data is off.

Changing to a Constant Offset

To use a constant offset rather than points, select theConstant offset option and set the
Distance and Direction to offset the surface. Selecting Forward offsets the surface on the
younger side of the referencemesh, whereas selecting Backward offsets on the older side.
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If you created a surface as an offset to points and switch to using a constant offset, the points
added to the surfacewhen it was created will be disabled.

Changing to an Offset to Points

If you created an offset surface using a constant offset, you can change the surface to offset to
points, but you must first add data to it. Do this by right-clicking on it in the project tree and
selecting Add. Once you have added the data you wish to use, double-click on the surface and
click on the Surfacing tab. Change theOffset limits option fromConstant offset to one of the
other three options.

Changing the Reference Mesh

To change the surface used as the referencemesh, click on the Inputs tab, then click on the
referencemesh:

Select from the surfaces available in the project, keeping in mind the considerations discussed in
Changing the Reference Mesh.

Editing the Reference Mesh

You can also edit the referencemesh as you would other surfaces. All dependent offset surfaces
will be updated as you make changes to the referencemesh.

Changing the younging direction of the referencemesh affects how offset surfaces are
generated.

l For a constant offset surface, the younging direction of the referencemesh determines the
forward and backward direction of the offset surface and, therefore, determines the location
of the offset surface. Changing the younging direction of the referencemesh results in
dependent offset surfaces changing location; the updated offset surfacewill be themirror
image of the original relative to the referencemesh.

l For surfaces offset to points, the location is determined by the points themselves. If the
referencemesh’s younging direction is changed, the offset surface’s younging direction will
also be flipped. The offset surfacewill still honour the contact data and will still appear at the
same location relative to the referencemesh.

Structural Surfaces
A structural surface uses contact data and non-contact structural data to create a surface. A
structural surface can interact with other volumes in themodel as a deposit, an erosion or an
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intrusion contact surface. The shape of the structural surface is suggested by the non-contact
structural data used.

When creating a structural surface, there are two options for declustering the non-contact
structural data:

l The input data is automatically declustered as part of creating the structural surface. There
are no additional controls that determine how the data is declustered.

l Use a declustered structural data set as the non-contact input to the surface. This approach
is recommended over the first approach as you can change how the data is declustered.

The rest of this topic describes how to create and workwith a structural surface. It is divided
into:

l Creating a Structural Surface

l The Structural Surface in the Project Tree

l Refining a Structural Surface

l Surfacing Options for a Structural Surface

l Setting the Surface Resolution

l Boundary Filtering

l Snapping to Input Data

l Non-contact Structural Inputs Settings

l Applying a Trend to a Structural Surface

l Value Clipping

Creating a Structural Surface

To create a new structural surface, right-click on the Surface Chronology and selectNew
Structural Surface. TheNew Structural Surfacewindowwill appear:
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Use the Add buttons to add non-contact structural data and on-surface contacts, then set the
First lithology and Second lithology. Other settings are:

l Query Filter. Select from the query filters defined for the selected structural data object.

l Use Polarity. Untick the box to use tangents only.

l Contact Type. Structural surfaces can be deposit, erosion or intrusion contacts. The same
algorithm is used for each setting; the only difference is in how the surface interactswith
other surfaces.

The Structural Surface in the Project Tree

The name Leapfrog Geo automatically assigns to a structural surface is the lithologies assigned
to each side of the surface. In the project tree, expand the surface to see how it wasmade:

As further refinements aremade to the surface, that information will also be added to the
project tree. SeeRefining a Structural Surface below formore information.

To add more non-contact structural data to the surface, right-click on it in the project tree
and select Add > Structural Data. In thewindow that appears, tick the box forNon-contact
Structural Data:

Refining a Structural Surface

You can refine structural surfaces in several ways:

l Add other data. Right-click on the surface to see the options available, which will depend on
how the surfacewas created. See Adding Data to Surfaces formore information.

l Edit the surfacewith a polyline. Right-click on the surface in the project tree and select either
Edit > With Polyline. See Editing Surfaces with Polylines formore information.

l Edit the surface using structural data. Right-click on the surface and select Edit > With
Structural Data. See Editing Surfaces with Structural Data formore information.
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To edit the surface’s settings, double-click on it in the project tree. In the Lithologies tab,
change the lithologies assigned to each side of the surface, if required.

You can swap the younging direction if the direction was assigned incorrectlywhen the surface
was created. The changewill be reflected in the scene. Note that changing the younging
direction does not changewhich lithology is older or younger.

TheContact Type setting determines how the structural surface interactswith other
lithologies, as described in Contact Surfaces. A structural surface can be a deposit, erosion or
intrusion contact surface.

For information on other techniques for refining structural surfaces, see Surfacing Options for
a Structural Surface below.

Surfacing Options for a Structural Surface

Surfacing options for a structural surface are accessed by double-clicking on the surface in the
project tree and clicking on the Surfacing tab. There are additional settings related to boundary
filtering and snapping to data in the Inputs tab.

Setting the Surface Resolution

See Surface Resolution for a Geological Model for information about the surface resolution
settings in the Surfacing tab.

Boundary Filtering

When data objects are added to a surface, there are twoways to handle the data that lies
outside the surface’s boundary:

l Filter the data. The surface is only influenced by the data that falls inside the surface’s
boundary.

l Leave the data unfiltered. The surface is influenced by the data both inside and outside the
surface’s boundary.

The boundary of a structural surface can be the geological model boundary or a fault block
boundary.

The Boundary filter setting determines how data used to define the surface is filtered:

l Off. Data is not filtered.

l All data. All data is filtered.

l Drilling only. Only drillhole data and data objects derived fromdrillhole data are filtered.

l Custom. Only the data objects specified in the Inputs tab are filtered.

Snapping to Input Data

Often, surfaces should honour drillhole data and treat data objects such as polylines and GIS
data as interpretations. SeeContact Honouring.

There is a Snap to data setting for a geological model as a whole that is set in theGeological
Model > General tab (see Editing a Geological Model). Snap-to-data can also be set on a
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surface-by-surface basis by double-clicking on the surface in the project tree and then clicking
on the Surfacing tab.

For individual contact surfaces, the options are:

l Inherit from GM. The setting for the geological model as a whole is used. This is the default
setting.

l Off. Surfaces do not snap to the data used to create them.

l All data. Surfaces snap to all data within theMaximum snap distance, which includes
drillhole data and any data added to the surfaces.

l Drilling only. Surfaces snap to drillhole data and data objects derived fromdrillhole data
within theMaximum snap distance but not to other data used tomodify the surfaces.

l Custom. Surfaces snap to the data objects indicated in the Inputs tab for each surface.

Snapping to data is off by default. Although you can snap to all data, this is not
recommended as it increases the possibility that errors in the data or assumptions inherent in
interpretations (e.g. polylines) will cause distortions in themeshes. If you do enable snapping,
is best to snap only to drilling data.

If you need a surface to honour drillhole data but treat other input data objects as
interpretations, selectDrilling only. To honour some data objectswhile treating others as
interpretations, selectCustom, then click on the Inputs tab to enable snapping for individual
objects.

Non-contact Structural Inputs Settings

For the non-contact structural inputs, you can:

l Change theQuery Filter setting. Select from the query filters defined for the selected
structural data object.

l Change theUse Polarity setting. Untick the box to use tangents only.

l Change the Boundary filter setting, if the Boundary filter setting in the Surfacing tab is set to
Custom.

Applying a Trend to a Structural Surface

There are twoways to change the trend for a structural surface:

l Right-click on the surface in the project tree and select Adjust Surface.

l Double-click on the surface in the project tree and then click on the Trend tab.

SeeGlobal Trends formore information.

Value Clipping

In the Value Clipping tab, you can manipulate the data distribution by clipping the data.
Clipping cuts off values that are outside the range set by the Lower bound and Upper bound
values. For example, if you change theUpper bound from16.00 to 10.00, distance values
above 10.00will be regarded as 10.00.
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When Automatic clipping and Do clipping are enabled, Leapfrog Geo sets the Lower bound
and Upper bound from the data. To change the Lower bound and Upper bound, untick
Automatic clipping, tickDo clipping and then change the values.

The Surface Chronology

When you create a contact surface, it appears in the project tree under the Surface
Chronology object, but it is not enabled and, therefore, does not affect the geological
model volumes. Thismeans you can work on the surfacewithout having to reprocess the
model whenever you make a change to the surface. In Leapfrog Geo, you can easily define,
enable and remove contact surfaces froma model, and you can experiment with modelling
lithologies using different techniques in order to arrive at a geologically reasonablemodel.

To add a contact surface to the surface chronology, double-click on the Surface Chronology
object. The Surface Chronologywindowwill be displayed:

In the project tree, the surfaces are also arranged in chronological order:

The Surface Chronology determines the overall chronological order of the contact surfaces in
themodel. If you build yourmodels from the bottomup, you will find that often the contact
surfaces are in the correct chronological order when you first open the Surface Chronology
window. However, you can easily rearrange the chronology using the Younger andOlder
buttons. Tick the boxes for surfaces you wish to include in themodel. When you clickOK, the
included surfaceswill be used to subdivide the geological model into lithological volumes. The
volumeswill appear in theOutput Volumes folder.
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Output volumes are named according to the lithologies assigned to each side of the contact
surfaces that bound each volume. If the lithology assigned to an output volume cannot be
determined, it will be assigned the Background lithology.

If you are working with a faulted model and have defined the Surface Chronology for one
fault block, you can copy the Surface Chronology to the empty fault blocks. SeeCopying
the Surface Chronology to an Empty Fault Block.

Refined Lithological Volumes
When you have built a geological model and want tomodel further within one of the volumes,
you can do this by creating a refined geological model. This changes theway the original
(parent) geological model is organised in the project tree and makes it possible to create a sub-
model within one ormore of the lithological volumes.

Before starting to refine lithological volumes, it is a good idea tomake a copy of the original
geological model.

To start refining a lithological volume, first create the refined geological model. To do this,
right-click on theGeological Models folder and selectNew Refined Model:

In thewindow that appears, select the geological model to refine and then select from its
lithologies.

Next, set the Base lithology column, Filter data and Surface resolution. You cannot change
the Base lithology column once the refined geological model has been established, but you
will be able to change the resolution and data filter settings.

ClickOK to create the refined lithology.
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A new refined model ( ) will be created in the project tree and the parent geological model will
bemoved into it. Here, a model called “M Campaign GM” has been used to created a new
refined model, with theQzP volume selected as the refined lithology ( ):

The sub-model ( ) is created inside the refined geological model and has its own Boundary,
Lithologies, Surface Chronology andOutput Volumes objects.

You can workwith the sub-model in the samemanner you would a normal geological model.
The exceptions are:

l The sub-model’s boundary cannot be refined directly. However, changes to the parent
geological model will be updated in the sub-model’s boundary.

l The sub-model cannot have its own fault system. If the parent geological model is faulted,
the sub-model will have its own fault blocks in which you can work.

See Editing the Sub-Model for information on refining the sub-model.

You can still workwith the parent geological model in the usual manner. Any changes to the
parent geological model that change the extents of the sub-model will be reflected in the sub-
model’s boundary.

You can create additional sub-models by right-clicking on the refined model ( ) and selecting
Refine Lithology.

A sub-model can be viewed and evaluated in the samemanner as normal geological models.
However, sub-models cannot be used as layer guides for flowmodels.

Deleting the refined geological model deletes all models it contains. To return to the original
project tree organisation for a geological model, delete the sub-models:
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Once there are nomore sub-models, the refined model object is also deleted, leaving the
parent geological model.

The refined model has its own Lithologies table, which contains all the lithologies from the
parent model and any sub-model lithologies. You cannot add lithologies to this table, but you
can change the colours used to display them in the scene, as described inModel Lithologies.
To add more lithologies to a refined model, add them to the lithology table in either the sub-
model or the parent geological model.

The refined model also has its ownOutput Volumes folder that combines information from the
parent geological model and the sub-model. If no surfaces have been created in the sub-
model, adding the refined model to the scenewill simply display the volumes from the parent
geological model. If surfaces have been created in the sub-model, then the volumesof the
sub-model will be displayed alongside the volumes from the parent geological model.

Editing the Sub-Model
Workwith the sub-model in the samemanner described in Editing a Geological Model. See
Contact Surfaces and The Surface Chronology.

The sub-model can have resolution settings that are different from those of the parent model.
See Surface Resolution in Leapfrog Geo and Surface Resolution for a Geological Model.
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To change the lithology’s resolution settings, double-click on the sub-model ( ) in the project
tree. TheGeological Modelwindow appears:

Thiswindow has only three tabs:

l There is no Boundary tab because the sub-model’s boundary can only bemodified by
modifying the parent geological model.

l There is no Fault System tab because a sub-model cannot have its own fault system.
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Numeric Models
The FastRBF™ algorithmemploys interpolation functions to estimate values fromknown data.
From these estimated values, geological surfaces are constructed as part of themodel-building
process.

With theNumeric Models folder, you can create numericmodels and change their parameters.

l An RBF interpolant describes a physical quantity that varies continuously in space. An RBF
interpolant can be used tomodel, for example, grade distribution, with isosurface values set
to represent both minimumconcentrations of interest and regions of high value. SeeRBF
Interpolants.

l Amulti-domained RBF interpolant is an RBF interpolant that has a number of individual sub-
interpolants that are bounded by the fault blocks or output volumesof a selected geological
model. Changes to all sub-interpolants can bemade by editing the parent interpolant, while
sub-interpolants can be edited to account for local influences on the values used, the trend
and interpolation parameters. SeeMulti-domained RBF Interpolants.

l An indicator RBF interpolant calculates the likelihood that valueswill fall above and below a
specific threshold. An indicator RBF interpolant can be used to produce a volume inside
which furthermodelling is carried out. For example, you can create an indicator RBF
interpolant for grade values above a certain threshold, and then use the inside volume as a
lateral extent for anothermodel. See Indicator RBF Interpolants.

l A distance function calculates the distance to a set of points. Aswith an indicator RBF
interpolant, a distance function is useful for restricting processing to a specific region. To do
this, create a distance function, select the objects to use, then add at least one buffer. You
can then use one of the distance function’s isosurfaces as a lateral extent for anothermodel.
SeeDistance Functions.

Values that can be interpolated include downhole numeric data, composited drillhole data and
points data. See Interpolant Functions for a general introduction to interpolation.

The rest of this topic describes:

l Importing a Variogram Model

l Copying a Numeric Model

l Creating a Static Copy of a Numeric Model

l Exporting Numeric Model Volumes and Surfaces

l Exporting Numeric Model Midpoints

Importing a Variogram Model
Leapfrog Geo can import spheroidal variogrammodels exported fromSnowden Supervisor.
The settings that can be imported are:

l The anisotropy settings in the Trend tab

l TheNugget, Sill, Base Range and Alpha settings in the Interpolant tab
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To import a variogrammodel, first create an interpolant. Next, right-click on the interpolant and
select Import Variogram Parameters. In thewindow that appears, navigate to the folder that
contains the XML file and select it. ClickOpen. The interpolant will be updated with the
parameters in the XML file.

The imported variogrammodel overwrites the parameters in the interpolant, which cannot
be undone. If you wish to save the original settings, make a copy of the interpolant before
importing the new parameters.

Once the interpolant has been updated, you can edit it further by double-clicking on the
interpolant in the project tree.

Copying a Numeric Model
Creating a copy of a numericmodel is a useful way of experimenting with changes to a model.

To copy a numericmodel, right-click on it in the project tree and selectCopy. Enter a name for
the copy of themodel and clickOK. The copywill be added to the project tree.

Creating a Static Copy of a Numeric Model
Creating a static copy preserves a snapshot of a numericmodel that does not change, even
when changes aremade to the data on which the original model was dependent. This is a
useful way of storing historical models and comparing models. Static copies can be exported
fromLeapfrog Geo, as described in Exporting Numeric Model Volumes and Surfaces below.

To create a static copy of a numericmodel, right-click on it in the project tree and select Static
Copy. Enter a name for the copy of the numericmodel and clickOK. The copywill be added to
theNumeric Models folder.

The objects that make up a static copy of a numericmodel depend on the type of model:

l For an RBF interpolant, a static copy ismade up of a Legend object, a Boundary object, and
all isosurfaces and output volumes created in building themodel.

l For a multi-domained RBF interpolant, a static copy ismade up of a Legend object, a
Boundary object, and the output volumes created in building themodel. There are also static
copies of the sub-interpolants, which are the same as static copies of RBF interpolants.

l For an indicator RBF interpolant, a static copy ismade up of a Legend object, a Boundary
object, themodel’s isosurface and the output volumes.

Staticmodels created in versions of Leapfrog Geo before 2.2 copied only the output volumes
and the legend, and the staticmodel appeared in the shape list only as a single line. When
these staticmodels are upgraded and displayed in the scene, the individual output volumes
will be added to the shape list.

To view the date a static copywas created, right-click on it in the project tree and select
Properties. The date the copywas created is in theGeneral tab.
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Exporting Numeric Model Volumes and Surfaces
There are three options for exporting a numericmodel’s output volumes and surfaces. These
are:

l Export an output volume or a surface as a mesh. Right-click on it in the project tree and click
Export. You will be prompted for a file name and location. See Exporting a Single Mesh.

l Export an output volume as a thickness grid. Right-click on it in the project tree and click
Export Thickness Grid. See Thickness Grid Export.

l Export multiple output volumes and surfaces. Right-click on the interpolant in the project
tree and select Export. See Exporting Multiple Meshes from Models.

Exporting Numeric Model Midpoints
To export interval midpoints froma numericmodel, right-click on themodel’s values object ( )
and select Export. Interval midpoints can be exported in the following formats:

l CSV text file (*.csv)

l DXF file (*.dxf)

l Snowden Supervisor CSV file (*.csv)

l Isatis 3D points file (*.asc)

The values exported are themidpoints of each segment, the X-Y-Z values and the hole ID. The
Snowden Supervisor and Isatis 3D points formats also include the interval length, when the
model has been created fromdrillhole data.

In each case, you will be prompted for a filename and location.

You can extract interval midpoints fromdrillhole data and then export them from the Points
folder. See Extracting Interval Midpoints from Drillhole Data formore information.

RBF Interpolants
If the data is both regularly and adequately sampled, different RBF interpolantswill produce
similar results. In practice, however, it is rarely the case that data is so abundant and input is
required to ensure an interpolant produces geologically reasonable results. For this reason, only
a basic set of parameters are required when an RBF interpolant is first created. Once the
interpolant has been created, you can refine it to factor in real-world observations and account
for limitations in the data.

The rest of this topic describes how to create and modify RBF interpolants. It is divided into:

l Creating an RBF Interpolant

l Values Used

l The Interpolant Boundary
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l Compositing Options

l General Interpolant Properties

l The RBF Interpolant in the Project Tree

l Interpolant Display

l RBF Interpolant Statistics

l Modifying an RBF Interpolant’s Boundary with Lateral Extents

l Creating Lateral Extents

l Changing a Lateral Extent’s Settings

l Adding Data to an Extent

l Editing an Extent with a Polyline

l Editing an Extent with Structural Data

l Removing an Extent from an Interpolant

l Changing the Settings for an RBF Interpolant

l Adjusting the Values Used

l Compositing Parameters for an RBF Interpolant

l Adjusting the Interpolant Boundary

l Clipping and Transforming Values for an RBF Interpolant

l Changing the Trend for an RBF Interpolant

l Adjusting Interpolation Parameters

l Output Settings for an RBF Interpolant

Creating an RBF Interpolant
To create an RBF interpolant, right-click on theNumeric Models folder and selectNew RBF
Interpolant. TheNew RBF Interpolantwindowwill be displayed:
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Thiswindow is divided into four parts that determine the values used to create the interpolant,
the interpolant boundary, any compositing options and general interpolant properties.

If you are unsure of some settings, most can be changed later. However, theNumeric values
object selected when the interpolant is created cannot be changed.

Values Used

In the Values To Interpolate part of theNew RBF Interpolantwindow, you can select the
values that will be used and choosewhether or not to filter the data and use a subset of those
values in the interpolant.

You can build an interpolant fromeither:

l Numeric data contained in imported drillhole data.

l Points data imported into the Points folder.

All suitable data in the project is available from theNumeric values list.

Applying a Query Filter

If you have defined a query filter and wish to use it to create the interpolant, select the filter from
theQuery filter list. Once the interpolant has been created, you can remove the filter or select a
different filter.

Applying a Surface Filter

All available data can be used to generate the interpolant or the data can be filtered so that only
the data that iswithin the interpolant boundary or another boundary in the project influences
the interpolant. The Surface Filter option is enabled by default, but if you wish to use all data in
the project, untick the box for Surface Filter. Otherwise, you can select the Interpolant
Boundary or another boundary in the project.

You can use both theQuery Filter option and the Surface Filter option together.

The Interpolant Boundary

There are several ways to set the Interpolant Boundary:

l Enter values to set a Custom boundary.

l Use the controls in the scene to set theCustom boundary dimensions.

l Select another object in the project from the Enclose Object list, which could be the numeric
values object being interpolated. The extents for that object will be used as the basis for the
Custom boundary dimensions.

l Select another object in the project to use as the Interpolant Boundary. Click the Existing
model boundary or volume option and select the required object from the list.

Once the interpolant has been created, you can furthermodify its boundary. SeeModifying an
RBF Interpolant’s Boundary with Lateral Extents and Adjusting the Interpolant Boundary
below.
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Compositing Options

When numeric values fromdrillhole data are used to create an interpolant, there are two
approaches to compositing that data:

l Composite the drillhole data, then use the composited values to create an interpolant. If you
select composited values to create an interpolant, compositing optionswill be disabled.

l Use uncomposited drillhole data to create an interpolant, then apply compositing settings to
the interpolated values. If you are interpolating uncomposited values and do not have
specificCompositing values in mind, you maywish to leave this option blank as it can be
changed once themodel has been created.

If you are interpolating points, compositing optionswill be disabled.

SeeNumeric Composites formore information on the effects of theCompositing length, For
end lengths less than andMinimum coverage settings.

General Interpolant Properties

Set the Surface resolution for the interpolant and whether or not the resolution is adaptive. See
Surface Resolution in Leapfrog Geo formore information on the effects of these settings. The
resolution can be changed once the interpolant has been created, so setting a value in theNew
RBF Interpolantwindow is not vital. A lower valuewill producemore detail, but calculations
will take longer.

The Volumes enclose option determineswhether the interpolant volumes encloseHigher
Values, Lower Values or Intervals. Again, this option can be changed once the interpolant has
been created.

Enter a Name for the new interpolant and clickOK.

Once you have created an RBF interpolant, you can adjust its properties by double-clicking on
it. You can also double-click on the individual objects that make up the interpolant.

See also:

l Copying a Numeric Model

l Creating a Static Copy of a Numeric Model

l Exporting Numeric Model Volumes and Surfaces
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The RBF Interpolant in the Project Tree
The new interpolant will be created and added to theNumeric Models folder. The new
interpolant contains objects that represent different parts of the interpolant:

l The Boundary object defines the limits of the interpolant. See Adjusting the Interpolant
Boundary.

l The Trend object describes the trend applied in the interpolant. SeeChanging the Trend for
an RBF Interpolant.

l The points data values object contains all the data used in generating the interpolant. See
Adjusting the Values Used.

l The Isosurfaces folder contains all themeshes generated in building the interpolant.

l TheOutput Volumes folder contains all the volumes generated in building the interpolant.

Other objectsmay appear in the project tree under the interpolant as you make changes to it.

Interpolant Display
Display the interpolant by:

l Dragging the interpolant into the scene or right-clicking on the interpolant and selecting
View Output Volumes. Both actions display the interpolant’s output volumes.

l Right-clicking on the interpolant and selecting View Isosurfaces.
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RBF Interpolant Statistics
You can view the approximated mean for each output volume by right-clicking on the
interpolant and selecting Properties. Click on the Statistics tab:

You can copy the information displayed in the Statistics tab to the clipboard for use in other
applications.

Modifying an RBF Interpolant’s Boundary with Lateral Extents
RBF interpolants are created with a basic set of rectangular extents that can then be refined
using other data in the project. These extents usually correspond to the ground surface and
known boundaries. Creating extents can also be used to restrict modelling to a particular area
of interest; for example, modelling can be restricted to a known distance fromdrillholes by
applying a distance function as a lateral extent. Extents do not need to be strictly vertical
surfaces and can bemodel volumes.

Creating Lateral Extents

To create an extent, expand the RBF interpolant in the project tree. Right-click on the Boundary
object and select from theNew Lateral Extent options. Follow the prompts to create the
extent, which will then appear in the project tree under the interpolant’sBoundary object.

New extents are automatically applied to the boundary being modified. Leapfrog Geo usually
orients a new extent correctly, with red presenting the inside face of the extent and blue
representing the outside face. If this is not the case, you can change the orientation by right-
clicking on the extent in the project tree and selecting Swap Inside.
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Extent from a Polyline

You can create an extent froma polyline that already exists in the project or you can draw a new
one. If you want to use an imported polyline, import it into the Polylines folder before creating
the new extent.

To create a new extent froma polyline, right-click on the interpolant’sBoundary object and
selectNew Lateral Extent > From Polyline. In thewindow that appears, select whether you
will create a new polyline or use an existing one:

You can create the extent as a Vertical Wall or Surface. If you create the lateral extent as a
Surface, you will be able tomodify it using additional data, as described below. A lateral
extent created as a Vertical Wall, however, cannot bemodified.

ClickOK to generate the new extent. If you have chosen to create a New Drawing, the drawing
controlswill appear in the scene and you can begin drawing, as described in Drawing in the
Scene.

The new extent will appear in the project tree as part of the Boundary object.

If the surface generated does not fit the polyline adequately, you can increase the quality of
the fit by adding more points to the polyline. SeeDrawing in the Scene for information on
adding points to polylines.

Extents created frompolylines can bemodified by adding points data, GIS vector data and
structural data. You can also add polylines and structural data to the extent. See Adding Data
to an Extent, Editing an Extent with a Polyline and Editing an Extent with Structural Data
formore information.
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Extent from GIS Vector Data

GIS data in the project can be used to create a lateral extent for an RBF interpolant. Once the
data you wish to use has been imported into the project, right-click on the interpolant’s
Boundary object and selectNew Lateral Extent > From GIS Vector Data.

In thewindow that appears, select the data object you wish to use:

You can create the extent as a Vertical Wall or Surface. If you create the lateral extent as a
Surface, you will be able tomodify it using additional data, as described below. A lateral
extent created as a Vertical Wall, however, cannot bemodified.

If you select the Surface option, you can use the GIS data object with its own elevation data or
projected onto the topography:

Using theOn Topography option makes sense for GIS data as it is, by nature, on the
topography. TheOn Topography option alsomitigates any issues that may occur if elevation
information in the GIS data object conflictswith that in the project.

ClickOK to create the new extent. The new extent will appear in the project tree as part of the
Boundary object.

Extents created fromGIS data can bemodified by adding points data, GIS vector data and
structural data. You can also add polylines and structural data to the extent. See Adding Data
to an Extent, Editing an Extent with a Polyline and Editing an Extent with Structural Data
formore information.
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Extent from Points

To create a new extent frompoints data, right-click on the interpolant’sBoundary object and
selectNew Lateral Extent > From Points. The Select Points To Addwindowwill be displayed,
showing points data available in the project:

Select the information you wish to use and clickOK.

The new extent will appear in the project tree as part of the Boundary object.

Extents created frompoints can bemodified by adding points data, GIS vector data and
structural data. You can also add polylines and structural data to the extent. See Adding Data
to an Extent, Editing an Extent with a Polyline and Editing an Extent with Structural Data
formore information.

Extent from Structural Data

Planar structural data can be used to create a lateral extent for an RBF interpolant. You can
create a new structural data table or use a table that already exists in the project. If you want to
use categories of structural data in creating the extent, use an existing table and create filters for
those categories before creating the lateral extent.

To start, right-click on the interpolant’sBoundary object and selectNew Lateral Extent > From
Structural Data. TheNew Structural Datawindowwill be displayed, showing structural data
available in the project:

Select theNew Drawing option to draw the structural data points directly in the scene.
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Select the Existing Structural Data option to use a table in the Structural Modelling folder.
With this option, you will be able to select from the categories available in the data table, if
query filters have been created for those categories:

ClickOK to generate the new extent. If you have chosen to create a New Drawing, the drawing
controlswill appear in the scene and you can begin drawing, as described in Creating New
Planar Structural Data Tables. To share the new structural data table, right-click on it and
select Share. The table will be saved to the Structural Modelling folder.

The new extent will appear in the project tree as part of the Boundary object.

Extents created from structural data can bemodified by adding points data, GIS vector data and
structural data. You can also add polylines and structural data to the extent. See Adding Data
to an Extent, Editing an Extent with a Polyline and Editing an Extent with Structural Data
formore information.

Extent from a Surface

To use a surface as lateral extent for an RBF interpolant, right-click on the interpolant’s
Boundary object and selectNew Lateral Extent > From Surface. The Select Boundary
windowwill appear, showing all themeshes that can be used as an extent:

Select the required mesh and clickOK. The extent will be added to the interpolant’sBoundary
object.

You cannot modify an extent created froma mesh by adding data, editing with polylines or
structural data or by applying a trend. However, the extent is linked to themesh used to create
it, and updating themesh will update the extent.
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Extent from Distance to Points

Leapfrog Geo can calculate the distance to set of points and use the resulting distance buffer as
a lateral extent for an RBF interpolant. To create a new lateral extent froma distance buffer,
right-click on the interpolant’sBoundary object and selectNew Lateral Extent > From
Distance To Points. The Smoothed Distance Bufferwindowwill appear:

Select theDistance and set an Anisotropy, if required.

The Ellipsoid Ratios determine the relative shape and strength of the ellipsoids in the scene,
where:

l TheMaximum value is the relative strength in the direction of the green line on themoving
plane.

l The Intermed. value is the relative strength in the direction perpendicular to the green line on
themoving plane.

l TheMinimum value is the relative strength in the direction orthogonal to the plane.

You can also use the Set to list to choose different options Leapfrog Geo has generated based
on the data used to build the interpolant. Isotropic is the default option used when the
interpolant is created.

ClickOK to create the new extent, which will appear in the project tree as part of the Boundary
object.

To change the extent’s settings, expand the interpolant’sBoundary object in the project tree
and double-click on the extent. Adjust theDistance and Anisotropy, if required.

Extents created froma distance to points function can bemodified by adding points data and
GIS vector data. See Adding Data to an Extent.

Extent from a Distance Function

A distance function calculates the distance to a set of points and can be used to bound an RBF
interpolant. You can use an existing distance function as a lateral extent or create a new one.

To use a distance function as a lateral extent, right-click on the interpolant’sBoundary and
selectNew Lateral Extent > From Distance Function. If there are no distance functions in the
project, you will be prompted to create a new one. SeeDistance Functions for information on
defining and editing the distance function.

© 2017 ARANZ Geo Limited



Changing a Lateral Extent’s Settings | 395

When there are already distance functions in the project, you will be prompted to choose
between creating a new function or using an existing one:

To use an existing function, select it from the list and set a Buffer distance. ClickOK to create
the lateral extent.

When you create a new distance function, it will be part of the interpolant’sBoundary object
and will not be available elsewhere in the project. To share it within the project, expand the
lateral extent in the project tree and right-click on the distance function. Select Share. The
distance function will be saved to theNumeric Models folder.

To change the extent’s settings, expand the interpolant’sBoundary object in the project tree
and double-click on the extent. Adjust theDistance and Anisotropy, if required.

Changing a Lateral Extent’s Settings

For lateral extents created from frompolylines, GIS data, points and structural data, you can
change the extent’s settings by double-clicking on it in the project tree.

In the Surfacing tab, you can change surface resolution and contact honouring options, which
are described below. In the Trend tab, you can apply a trend to the extent, which is described in
Applying a Trend.

Surface Resolution

For RBF interpolants, the resolution of lateral extents is inherited from the settings in the
interpolant’sOutputs tab, but the adaptive isosurfacer is automatically disabled. Enter a
different Surface resolution value, if required, and tickAdaptive to enable the adaptive
isosurfacer.
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Contact Honouring

Often, surfaces should honour drillhole data and treat data objects such as polylines and GIS
data as interpretations. For extents, the Snap to data setting in the Surfacing tab determines
whether or not the extent honours the data used to create it. Options are:

l Off. The extent does not snap to the data used to create it. This is the default setting.

l All data. The extent snaps to all data within theMaximum snap distance, which includes
drillhole data and any data added to the extent.

l Drilling only. The extent snaps to drillhole data and data objects derived fromdrillhole data
within theMaximum snap distance, but not to other data used tomodify the extent. For
example, the extent will honour points data derived fromdrillhole data, but not points data
imported into the Points folder.

l Custom. The extent snaps to the data objects indicated in the Inputs tab that are within the
Maximum snap distance.

Snapping to data is off by default. Although you can snap to all data, this is not
recommended as it increases the possibility that errors in the data or assumptions inherent in
interpretations (e.g. polylines) will cause distortions in themeshes. If you do enable snapping,
is best to snap only to drilling data.

Whatever the setting, you can seewhat objects are snapped to by clicking on the Inputs tab.

If you need the extent to honour drillhole data but treat other data objects as interpretations,
selectDrilling only. To honour some data objectswhile treating others as interpretations, select
Custom, then click on the Inputs tab to enable snapping for individual objects.

Applying a Trend

You can adjust an extent created frompolylines, GIS data, points and structural data by
applying a trend to it. To do this, add the extent to the scene. Next, double-click on the extent in
the project tree and click the Trend tab.

Often the easiest way to apply a trend is to click on theDraw plane line button ( ) and draw a
plane line in the scene in the direction in which you wish to adjust the surface. You may need to
rotate the scene to see the plane properly.

The Ellipsoid Ratios determine the relative shape and strength of the ellipsoids in the scene,
where:

l TheMaximum value is the relative strength in the direction of the green line on themoving
plane.

l The Intermed. value is the relative strength in the direction perpendicular to the green line on
themoving plane.

l TheMinimum value is the relative strength in the direction orthogonal to the plane.

Once you have adjusted the plane to represent the trend you wish to use, click the Set From
Plane button to copy themoving plane settings.
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The Set to list contains a number of different options Leapfrog Geo has generated based on the
data used in the project. Isotropic is the default option used when the extent was created.
Settingsmade to other surfaces in the project will also be listed, which makes it easy to apply the
same settings tomany surfaces.

ClickOK to apply the changes.

SeeGlobal Trends formore information.

Adding Data to an Extent

Extents created frompolylines, GIS data, points and structural data can bemodified by adding
points data objects, GIS vector data and structural data. Extents created froma distance to
points function can bemodified by adding points data and GIS vector data. To add data to an
extent, right-click on the extent in the project tree and select the data type you wish to use from
the Addmenu.

l Points data. Select from the points data objects available in the project and clickOK.

l GIS vector data. Select from theGIS vector data available in the project and clickOK.

l Structural data. Select from the structural data tables available in the project. If the selected
table has query filters defined, you can apply one of these filters by ticking Use query filter
and then selecting the required filter from the list. ClickOK to add the selected data to the
extent. An alternative to adding an existing structural data table to an extent is to edit the
extent with structural data. This is described in Editing an Extent with Structural Data
below.

You can also add a polyline that already exists in the project. To do this, right-click on the extent
in the project tree and select Add > Polyline. You will be prompted to choose from the polylines
in the Polylines folder.

Editing an Extent with a Polyline

You can edit an extent using a polyline, which is described in Surfaces. A polyline used to edit an
extent will be added to the project tree as part of the extent. To edit the polyline, right-click on it
and select Edit Polyline or add it to the scene and click the Edit button ( ) in the shape list. If
you wish to remove the polyline from the extent, right-click on it in the project tree and select
Delete orRemove.

To add an existing polyline to a lateral extent, use the Add > Polyline option.

Editing an Extent with Structural Data

You can edit an extent using structural data, which is described in Surfaces. A structural data
table will be added to the project tree as part of the extent. To edit the table, right-click on it
and select Edit In Scene or add it to the scene and click the Edit button ( ) in the shape list. If
you wish to remove the table from the extent, right-click on it in the project tree and select
Delete orRemove.
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Removing an Extent from an Interpolant

If you have defined an extent and want to remove it from the interpolant, there are two options.
The first is to right-click on the extent in the project tree and clickDelete. This deletes the extent
from the interpolant, but does not delete parent objects from the project unless theywere
created as part of the interpolant, e.g. a polyline used as a lateral extent but not shared within
the project. Use this option only if you are sure you do not want to use the extent.

The second method is useful if you aremaking changes to the extent and do not want to
recompute the interpolant with each change. Double-click on the interpolant’sBoundary
object or double-click on the interpolant and click on the Boundary tab. The Boundaries part
of thewindow lists all objects used as extents for the interpolant. Untick the box for extents to
temporarily disable them in the interpolant. The interpolant will be reprocessed, but you can
then work on the extent without reprocessing the interpolant. Disabled extentswill bemarked
as inactive in the project tree.

Changing the Settings for an RBF Interpolant
To change the settings for an RBF interpolant, you can either double-click on the interpolant in
theNumeric Models folder or right-click and selectOpen. When creating an RBF interpolant,
only a basic set of parameters is used. The Edit RBF Interpolantwindow provides finer controls
over these basic parameters so you can refine the interpolant to factor in real-world
observations and account for limitations in the data.

For a multi-domained RBF interpolant, these parameters can be changed for the parent
interpolant, and the trend, clipping, transformation and interpolation settings can be changed
for the sub-interpolants.

Adjusting the Values Used

The Values tab in the Edit Interpolantwindow shows the values used in creating the
interpolant and provides options for filtering the data. Although you cannot change the values
used to create an interpolant, you can filter the values using theQuery filter and Surface filter
options.

You can adjust the values using a contour polyline or by adding points. Both options are
available by expanding the interpolant in the project tree, then right-clicking on the values
object:
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These options are described below in Adding a Contour Polyline and Adding Points.

To apply a query filter, tick theQuery filter box in the Values tab and select the available queries
from the list.

To change the object used as the Surface filter, select the required object from the list. Note
that the list contains an object that defines the interpolant’s own boundary, which can be
adjusted in the Boundary tab.

Adding a Contour Polyline

Adding a contour polyline is a useful tool formanually adjusting a surface tomake it more
geologically reasonable. To start adding a contour polyline, draw a slice where you wish to
adjust the surface and decidewhat value you will assign to the contour line. Next, right-click on
the values object and selectNew Contour Polyline. The next step is to choosewhether you will
draw a new polyline or use one already in the project:

OnlyGIS lines, polylines imported into Leapfrog Geo or polylines created using the straight
line drawing tool can be used to create contour lines.

Enter the value to be used for the contour and a name for it. ClickOK. If you have chosen the
New Drawing option, the new object will be created in the project tree and drawing toolswill
appear in the scene. Start drawing in the scene as described in Drawing in the Scene. When
you have finished drawing, click the Save button ( ). The new contourwill automatically be
added to the interpolant and will appear in the project tree as part of the interpolant’s values
object.
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To change the value assigned to a contour polyline, double-click on the interpolant in the
project tree. In the Values tab, contour polylines and their assigned values are shown in the
User contour values table:

To change the value on a contour, click in the Value column and edit the entry.

To edit the polyline, right-click on it in the project tree and select Edit Polyline or add it to the
scene and click the Edit button ( ) in the shape list. If you wish to remove a contour polyline
from the interpolant, right-click on it in the project tree and selectDelete orRemove.

Adding Points

To add points to an RBF interpolant, right-click on the values object in the project tree and
select Add Values. Leapfrog Geowill display a list of all suitable points objects in the project.
Select an object and clickOK.

A hyperlink to the points object will be added to the values object in the project tree. To remove
the points object, right-click on the points object and select Remove.
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Compositing Parameters for an RBF Interpolant

When an RBF interpolant has been created fromuncomposited values, compositing parameters
can be changed by double-clicking on the interpolant in the project tree, then clicking on the
Compositing tab.

TheCompositing tab will only appear for interpolants created fromuncomposited drillhole
data.

You can composite in the entire drillhole or onlywhere the data falls inside the interpolant
boundary. SeeNumeric Composites formore information on the effects of theCompositing
length, For end lengths less than andMinimum coverage settings.
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Adjusting the Interpolant Boundary

SeeModifying an RBF Interpolant’s Boundary with Lateral Extents above for information on
creating and working with lateral extents.

To change an RBF interpolant’s boundary, double-click on the interpolant in the project tree,
then click on the Boundary tab:

Controls to adjust the boundarywill also appear in the scene.

Tick theUse Topography box to use the topography as a boundary. The topography is
normally not used as a boundary for interpolants and so this option is disabled when an
interpolant is first created.

The Boundaries list showsobjects that have been used tomodify the boundary. You can disable
any of these lateral extents by unticking the box.
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Lateral extents can be used to restrict modelling to a particular area of interest; for example,
modelling can be restricted to a known distance fromdrillholes by applying a distance function
as a lateral extent.

Clipping and Transforming Values for an RBF Interpolant

To clip data and apply a transformation to an RBF interpolant, double-click on the interpolant
in the project tree, then click on the Value Transform tab:

The options for Transform Type areNone and Log. Log uses a natural logarithm to compress
the data values to a smaller range. Thismay be useful if the data range spans orders of
magnitude. The function used is:

ln(x+s)+c

where s is the Pre-log shift and c is a constant. In order to avoid issueswith taking the logarithm
of zero or a negative number, Pre-log shift is a constant added tomake theminimumvalue
positive. The value of the pre-log shift will automatically be chosen to add to theminimum
value in the data set to raise it to 0.001. This constant is then added to all the data samples. You
can modify the value of the Pre-log shift, as increasing this value further away fromzero can be
used to reduce the effect of the natural logarithm transformation on the resultant isosurfaces.

Note that a further constant, c, is added to the natural logarithmof the data with the pre-log
shift added to it. If there are any negative numbers that result from taking the natural log of the
data, the absolute value of themost negative number is taken and added to all the transformed
data results. Thiswill raise the value of all the data so theminimumdata value is zero. The value
of c is chosen automatically and cannot bemodified.

Bin count defines the number of bins, where a larger bin count results in a finer histogram.

If you tick theDo pre-transform clipping option, you can set the Lower bound and theUpper
bound to cut off values that are too low or too high. For example, if you set theUpper bound
from14.00 to 10.00, grade values above 10.00will be regarded as 10.00.
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Changing the Trend for an RBF Interpolant

You can apply a global trend or a structural trend to an RBF interpolant. To do this, add the
interpolant to the scene, then double-click on the interpolant in the project tree. Click on the
Trend tab in the Edit RBF Interpolantwindow.

Using a Global Trend

The easiest way to change the trend applied to an interpolant is using a global trend set from
themoving plane.

ClickView Plane to add themoving plane to the scene, then click on the plane to view its
controls. You may need to hide part of the interpolant to click on themoving plane:

You can also use the Set to list to choose different options Leapfrog Geo has generated based
on the data used to build the interpolant. Isotropic is the default option used when the
interpolant is created.

The Ellipsoid Ratios determine the relative shape and strength of the ellipsoids in the scene,
where:

l TheMaximum value is the relative strength in the direction of the green line on themoving
plane.

l The Intermed. value is the relative strength in the direction perpendicular to the green line on
themoving plane.

l TheMinimum value is the relative strength in the direction orthogonal to the plane.

ClickOK to regenerate the interpolant and view changes.
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Using a Structural Trend

You can also set the trend for an RBF interpolant froma structural trend. First, you must create
or import the required mesh and create a structural trend. See Structural Trends formore
information.

Once the structural trend has been created, add it to the interpolant by double-clicking on the
interpolant in the project tree, then clicking on the Trend tab. Select the Structural Trend
option, then select the required trend from the list:

ClickOK. The trend will be added to the interpolant and will appear as part of the interpolant,
as shown:

When you apply a structural trend, you cannot use the Linear interpolant. See Interpolant
Functions formore information.

Once a structural trend has been defined for the interpolant, you can edit it by clicking on the
trend hyperlink in the project tree, then opening the structural trend applied to the interpolant.
The Structural Trendwindowwill appear. See Structural Trends for information on the
settings in this screen.

The structural trend information included as part of the interpolant is a link to the original
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structural trend. When you change the structural trend that is part of the interpolant, the
changes are alsomade for the original structural trend.

When a structural trend that is Strongest along meshes orBlending is used, the interpolant will
regress to the global mean trend away from themeshes. The global trend that will be used is set
in theGlobal Trend tab for the structural trend.

Adjusting Interpolation Parameters

To adjust interpolation parameters for an RBF interpolant, double-click on the interpolant in the
project tree, then click on the Interpolant tab:

Twomodels are available, the spheroidal interpolant and the linear interpolant. See The
Spheroidal Interpolant Function and The Linear Interpolant Function formore information
on the settings in this tab.
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Output Settings for an RBF Interpolant

You can change the parameters used to generate RBF interpolant outputs by double-clicking
on the interpolant, then clicking on theOutputs tab.

The Evaluation limits applywhen interpolants are evaluated against other objects in the
project. When the limits are enabled, all values outside the limitswill be set to theMinimum and
Maximum.

When Exact clipping is enabled, the interpolant isosurfacewill be generated without “tags” that
overhang the interpolant boundary. This setting is enabled by default when you create an
interpolant.

To add a new isosurface, click the Add button and enter the required value. To delete an
isosurface, click on it in the list, then click theRemove button. You can also change the colours
used to display the isosurfaces by clicking on the colour chips.

If you find that grade shells are overlapping, the resolution may be too coarse. SetDefault
resolution to a lower value or enable adaptive resolution in theOutputs tab. See Surface
Resolution in Leapfrog Geo.

Multi-domained RBF Interpolants
This topic describes creating and editing multi-domained RBF interpolants:

l Creating a Multi-domained RBF Interpolant

l Compositing and Filtering the Values Used

l Selecting Domains

l Clipping and Transforming Values

l Setting the Trend
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l Interpolation Parameters

l Output Options

l The Multi-domained RBF Interpolant in the Project Tree

l Interpolant and Sub-interpolant Display

l Sub-interpolant Statistics

Amulti-domained RBF interpolant is an RBF interpolant that has a number of individual sub-
interpolants bounded by the domains of a geological model.

l Changes to all sub-interpolants can bemade by editing the parent interpolant.

l Sub-interpolants can be edited to account for local influences on the values used, the trend
and interpolation parameters.

Amulti-domained RBF interpolant is a single object that can be evaluated as a single column on
points and blockmodels.

Creating a Multi-domained RBF Interpolant
Creating a multi-domained RBF interpolant is a two-step process:

l Selecting the values to be used and the domains in which sub-interpolantswill be created.

l Setting themulti-domained RBF interpolant’s properties.

To start creating a multi-domained RBF interpolant, right-click on theNumeric Models folder
and selectNew Multi Domained RBF Interpolant. TheNew Multi-domained RBF Interpolant
windowwill be displayed:

In thiswindow, select the basic parameters for themulti-domained RBF interpolant. You will be
able to set additional properties once you clickOK.

l Select the Values To Interpolate from the suitable data available in the project. You will be
able to change how data is filtered at the next step, but you will not be able to change the
values used.
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l Select the domains used to generate sub-interpolants. These options cannot be changed
once themulti-domained RBF interpolant has been created, although you will be able to
select which volumes are used to generate sub-interpolants.

l Select from the geological models available in the project.

l If the selectedModel has no faults defined, the Volume Typewill be set to output volumes.

l If the selectedModel is a faulted model, the Volume Type can be output volumes, faulted
output volumesor fault blocks.

ClickOK tomove on to the next step. The Edit RBF Interpolantwindowwill appear:

Compositing and Filtering the Values Used
In the Values tab, you can apply any query filters that have been defined for the data used.

When numeric values fromdrillhole data are used to create an interpolant, there are two
approaches to compositing that data:

l Composite the drillhole data, then use the composited values to create an interpolant. If you
select composited values to create an interpolant, compositing optionswill be disabled.

l Use uncomposited drillhole data to create an interpolant, then apply compositing settings to
the interpolated values. If you are interpolating uncomposited values and do not have
specificCompositing values in mind, you maywish to leave this option blank as it can be
changed once themodel has been created.

If you are interpolating points, compositing optionswill be disabled.

SeeNumeric Composites formore information on the effects of theCompositing length, For
end lengths less than andMinimum coverage settings.
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Selecting Domains
In theDomains tab, you can select the volumes in which sub-interpolantswill be generated.
You cannot, however, change the geological model or the types of volumes used.

Clipping and Transforming Values
In the Value Transform tab, clip data and apply a transformation, if required. SeeClipping and
Transforming Values for an RBF Interpolant formore information about the settings in this
tab.

You will be able to change the Value Transform settings for individual sub-interpolants once
the parent interpolant has been created.

Setting the Trend
In the Trend tab, you can apply a global or structural trend to the interpolant. SeeChanging
the Trend for an RBF Interpolant formore information about these options.

You will be able to change the Trend settings for the interpolant and individual sub-
interpolants once the parent interpolant has been created.

Interpolation Parameters
In the Interpolant tab, you can change interpolation parameters. See Adjusting Interpolation
Parameters formore information about these options.

You will be able to change the Interpolant settings or import variogramparameters for the
interpolant and individual sub-interpolants once the parent interpolant has been created.

Output Options
In theOutputs tab, you can change the parameters used to generate interpolant outputs.

The Evaluation limits applywhen interpolants are evaluated against other objects in the
project. When the limits are enabled, all values outside the limitswill be set to theMinimum and
Maximum.

Set theDefault resolution for the interpolant and whether or not the resolution is adaptive. See
Surface Resolution in Leapfrog Geo formore information on the effects of these settings. The
resolution can be changed once the interpolant has been created, so setting a valuewhen
creating the parent interpolant is not vital. A lower valuewill producemore detail, but
calculationswill take longer.

When Exact clipping is enabled, the interpolant isosurfacewill be generated without “tags” that
overhang the interpolant boundary. This setting is enabled by default when you create an
interpolant.
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To add a new isosurface, click the Add button and enter the required value. To delete an
isosurface, click on it in the list, then click theRemove button. You can also change the colours
used to display the isosurfaces by clicking on the colour chips.

The Volumes enclose option determineswhether the interpolant volumes encloseHigher
Values, Lower Values or Intervals. This option can be changed once the interpolant has been
created.

Enter a Name for the new interpolant and clickOK.

Once you have created a multi-domained RBF interpolant, you can adjust its properties as
described in Changing the Settings for an RBF Interpolant. You can also change trend,
clipping, transformation and interpolation settings for a sub-interpolant. To do this, double-
click on a sub-interpolant. For the settings you wish to change, untick the Inherit parameters
from parent box:

See also:

l Importing a Variogram Model

l Copying a Numeric Model

l Creating a Static Copy of a Numeric Model

l Exporting Numeric Model Volumes and Surfaces
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The Multi-domained RBF Interpolant in the Project Tree
The newmulti-domained RBF interpolant will be created and added to theNumeric Models
folder. It contains objects that represent different parts of the interpolant:

l There is a link to the geological model fromwhich domains are selected for the sub-
interpolants.

l The Trend object describes the trend applied in the interpolant. SeeChanging the Trend for
an RBF Interpolant formore information.

l The points data values object contains all the data used in generating the interpolant. See
Adjusting the Values Used formore information.

l The Sub-interpolants folder contains the sub-interpolants, which can be edited to change
the trend, clipping, transformation and interpolation settings.

l TheOutput Volumes folder contains all the volumes generated in building the interpolant.

Other objectsmay appear in the project tree under the interpolant as you make changes to it.

Interpolant and Sub-interpolant Display
Display the interpolant by:

l Dragging the interpolant into the scene or right-clicking on the interpolant and selecting
View Output Volumes. Both actions display the parent interpolant’s output volumes.

l Right-clicking on the interpolant and selecting View Isosurfaces. This displays the
isosurfaces of each sub-interpolant.
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Sub-interpolant Statistics
You can view the approximated mean for each output volume of a sub-interpolant by right-
clicking on the sub-interpolant and selecting Properties. Click on the Statistics tab:

You can copy the information displayed in the Statistics tab to the clipboard for use in other
applications.

Indicator RBF Interpolants
An indicator RBF interpolant is a useful way of creating a region of interest in which further
processing can be carried out. For example, you can use an indicator RBF interpolant to define a
volume that encloses the values that are likely to be above a cut-off threshold and then carry
out further interpolation inside that volume.

The rest of this topic describes how to create and modify indicator RBF interpolants. It is divided
into:

l Creating an Indicator RBF Interpolant

l Selecting the Values Used

l Setting the Cut-off

l Applying a Query Filter

l Applying a Surface Filter

l The Interpolant Boundary

l Compositing Options

l General Interpolant Properties

l The Indicator RBF Interpolant in the Project Tree

l Indicator RBF Interpolant Display

l Indicator RBF Interpolant Statistics
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l Editing an Indicator RBF Interpolant

l Adjusting the Values Used

l Adding a Contour Polyline

l Adding Points

l Compositing Parameters for an Indicator RBF Interpolant

l Adjusting the Interpolant Boundary

l The Cut-off Value

l Changing the Trend for an Indicator RBF Interpolant

l Adjusting Interpolation Parameters

l Indicator RBF Interpolant Surfacing and Volume Options

Creating an Indicator RBF Interpolant
To create an indicator RBF interpolant, right-click on theNumeric Models folder and select
New Indicator RBF Interpolant. TheNew Indicator RBF Interpolantwindowwill be
displayed:

Thiswindow is divided into four parts, which determine the values used to create the
interpolant, the interpolant boundary, any compositing options and general interpolant
properties.

If you are unsure of some settings, most can be changed later. However, theNumeric values
object selected when the interpolant is created cannot be changed.

Selecting the Values Used

In the Values To Interpolate part of theNew Indicator RBF Interpolantwindow, you can
select the values that will be used and choosewhether or not to filter the data and use a subset
of those values in the interpolant.
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You can build an indicator RBF interpolant fromeither:

l Numeric data contained in imported drillhole data.

l Points data imported into the Points folder.

All suitable data in the project is available from theNumeric values list.

Setting the Cut-off

TheCut-off valuewill be used to create two output volumes:

l An Inside volume that encloses all values likely to be above or equal to theCut-off value.

l AnOutside volume that enclose all values likely to be below theCut-off value.

If you are unsure of whatCut-off value to use, you can view statistics on the distribution of the
data and change theCut-off value once the interpolant has been created.

You can change the namesof the Inside andOutside volumesonce the interpolant has
been created.

Applying a Query Filter

If you have defined a query filter and wish to use it to create the interpolant, select the filter from
theQuery filter list. Once themodel has been created, you can remove the filter or select a
different filter.

Applying a Surface Filter

All available data can be used to generate the interpolant or the data can be filtered so that only
the data that iswithin the interpolant boundary or another boundary in the project influences
the interpolant. The Surface Filter option is enabled by default, but if you wish to use all data in
the project, untick the box for Surface Filter. Otherwise, you can select the Interpolant
Boundary or another boundary in the project.

You can use both theQuery Filter option and the Surface Filter option together.

The Interpolant Boundary

There are several ways to set the Interpolant Boundary:

l Enter values to set a Custom boundary.

l Use the controls in the scene to set theCustom boundary dimensions.

l Select another object in the project from the Enclose Object list, which could be the numeric
values object being interpolated. The extents for that object will be used as the basis for the
Custom boundary dimensions.

l Select another object in the project to use as the Interpolant Boundary. Click the Existing
model boundary or volume option and select the required object from the list.

Once the interpolant has been created, you can furthermodify its boundary. SeeModifying an
RBF Interpolant’s Boundary with Lateral Extents and Adjusting the Interpolant Boundary in
theRBF Interpolants topic formore information.
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Compositing Options

When numeric values fromdrillhole data are used to create an interpolant, there are two
approaches to compositing that data:

l Composite the drillhole data, then use the composited values to create an interpolant. If you
select composited values to create an interpolant, compositing optionswill be disabled.

l Use uncomposited drillhole data to create an interpolant, then apply compositing settings to
the interpolated values. If you are interpolating uncomposited values and do not have
specificCompositing values in mind, you maywish to leave this option blank as it can be
changed once themodel has been created.

If you are interpolating points, compositing optionswill be disabled.

SeeNumeric Composites formore information on the effects of theCompositing length, For
end lengths less than andMinimum coverage settings.

General Interpolant Properties

Set the Surface resolution for the interpolant and whether or not the resolution is adaptive. See
Surface Resolution in Leapfrog Geo formore information on the effects of these settings. The
resolution can be changed once the interpolant has been created, so setting a value in theNew
Indicator RBF Interpolantwindow is not vital. A lower valuewill producemore detail, but
calculationswill take longer.

An indicator RBF interpolant produces a single isosurface that is used to determine the
likelihood of values falling inside or outside of the cut-off threshold. The Iso value can be set to
values from0.1 to 0.9. Clicking the arrows changes the Iso value in steps of 0.1. To use a
different value, enter it from the keyboard. Again, this option can be changed once the
interpolant has been created.

Enter a Name for the new interpolant and clickOK.

Once you have created an interpolant, you can adjust its properties by double-clicking on it.
You can also double-click on the individual objects that make up the interpolant.

See also:

l Copying a Numeric Model

l Creating a Static Copy of a Numeric Model

l Exporting Numeric Model Volumes and Surfaces
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The Indicator RBF Interpolant in the Project Tree

The new interpolant will be created and added to theNumeric Models folder. The new
interpolant contains other objects that represent different parts of the interpolant:

l The Boundary object defines the limits of the interpolant. See Adjusting the Interpolant
Boundary.

l The Trend object describes the trend applied in the interpolant. SeeChanging the Trend for
an Indicator RBF Interpolant.

l The points data values object contains all the data used in generating the interpolant. See
Adjusting the Values Used.

l The isosurface is set to the specified Iso value.

l The Indicator Volumes legend defines the colours used to display the volumes.

l TheOutput Volumes folder contains the Inside andOutside volumes.

Other objectsmay appear in the project tree under the interpolant as you make changes to it.
See Editing an Indicator RBF Interpolant below formore information on the changes you can
make.

Indicator RBF Interpolant Display

Display the interpolant by:

l Dragging the interpolant into the scene or right-clicking on the interpolant and selecting
View Output Volumes.

l Right-clicking on the interpolant and selecting View Isosurfaces.
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You can also display the values ( ) used to create the interpolant, which is useful in making
decisions about theCut-off value and the Iso value:

Indicator RBF Interpolant Statistics

You can view the statistics for the indicator RBF interpolant by right-clicking on the interpolant
and selecting Statistics. Use the information available to adjust the cut-off value and other
interpolant properties:

You can copy the information displayed in the Statistics tab to the clipboard for use in other
applications.

Editing an Indicator RBF Interpolant
To edit an indicator RBF interpolant, you can either double-click on the interpolant in the
Numeric Models folder or right-click and selectOpen. Thewindow that appears is divided into
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tabs that let you change the different objects that make up the interpolant. Many of the options
are the same for RBF and multi-domained RBF interpolants.

When creating an indicator RBF interpolant, only a basic set of parameters is used. The Edit
Indicator RBF Interpolantwindowsprovide finer controls over these basic parameters so you
can refine the interpolant to factor in real-world observations and account for limitations in the
data.

l Adjusting the Values Used

l Adding a Contour Polyline

l Adding Points

l Compositing Parameters for an Indicator RBF Interpolant

l Adjusting the Interpolant Boundary

l The Cut-off Value

l Changing the Trend for an Indicator RBF Interpolant

l Adjusting Interpolation Parameters

l Indicator RBF Interpolant Surfacing and Volume Options

Adjusting the Values Used

The Values tab in the Edit Indicator RBF Interpolantwindow shows the values used in creating
the interpolant and provides options for filtering the data. You cannot change the values used,
but you can filter the values using theQuery filter and Surface filter options.

You can adjust the values using a contour polyline or by adding points. Both options are
available by expanding the interpolant in the project tree, then right-clicking on the values
object:

These options are described below in Adding a Contour Polyline and Adding Points.

To apply a query filter, tick theQuery filter box in the Values tab and select the available queries
from the list.

To change the object used as the Surface filter, select the required object from the list. Note
that the list contains an object that defines the interpolant’s own boundary, which can be
adjusted in the Boundary tab.
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Adding a Contour Polyline

You can adjust the values using contour polylines set to inside (1), outside (0) or to the iso-value.
Adding a contour polyline does not affect the indicator’s statistics.

Setting a contour to inside or outside is a useful way of controlling blowouts. Here, the inside
volume occurs in the corner of themodel because of the high-value points at the bottomof the
drillhole:

This can be adjusted by drawing a contour polyline below the bottomof the drillholes and
setting it to the outside value. For example, adding a polyline (in yellow) below the bottomof
drillhole shown above removes the blowout (the part of themesh with only the edges shown):

Polylinesmust be drawn either on an object or on the slicer. Drawing a contour polyline
precisely on the drillhole gives Leapfrog Geo conflicting data at the same location, which is
why the polyline should be drawn below the drillhole. To draw a polyline below a drillhole,
first draw the polyline on the drillhole, then move its nodes so the polyline lies below the
drillhole.
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To add a contour polyline, expand the interpolant in the project tree. Right-click on the values
object and selectNew Contour Polyline:

Next, choosewhether you will draw a new polyline or use one already in the project, then select
the contour value:

OnlyGIS lines, polylines imported into Leapfrog Geo or polylines created using the straight
line drawing tool can be used to create contour lines.

ClickOK. If you have chosen theNew Drawing option, the new object will be created in the
project tree and drawing toolswill appear in the scene. Start drawing in the scene as described
in Drawing in the Scene. When you have finished drawing, click the Save button ( ). The new
contourwill automatically be added to the interpolant and will appear in the project tree as part
of the interpolant’s values object.

To edit the polyline, right-click on it and select Edit Polyline or add it to the scene and click the
Edit button ( ) in the shape list. If you wish to remove a contour polyline from the interpolant,
right-click on it in the project tree and selectDelete orRemove.

You cannot change the value on the contour once it has been created. You can, however,
share the polyline and use it to create a new contour polyline. To do this, right-click on it in
the project tree and select Share. The polyline will then be added to the Polylines folder and
can be used elsewhere in the project.

Adding Points

To add points to an indicator RBF interpolant, right-click on the values object in the project tree
and select Add Values. Leapfrog Geowill display a list of all suitable points objects in the
project. Select an object and clickOK.
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A hyperlink to the points object will be added to the values object in the project tree. To remove
the points object, right-click on the points object and select Remove.

Compositing Parameters for an Indicator RBF Interpolant

When an indicator RBF interpolant has been created fromuncomposited values, compositing
parameters can be changed by double-clicking on the interpolant in the project tree, then
clicking on theCompositing tab.

TheCompositing tab will only appear for interpolants created fromuncomposited drillhole
data.

You can composite in the entire drillhole or onlywhere the data falls inside the interpolant
boundary. SeeNumeric Composites formore information on the effects of theCompositing
length, For end lengths less than andMinimum coverage settings.
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Adjusting the Interpolant Boundary

To change an indicator RBF interpolant’s boundary, double-click on the interpolant in the
project tree, then click on the Boundary tab:

Controls to adjust the boundarywill also appear in the scene.

Tick theUse Topography box to use the topography as a boundary. The topography is
normally not used as a boundary for interpolants and so this option is disabled when an
interpolant is first created.

The Boundaries list showsobjects that have been used tomodify the boundary. You can disable
any of these lateral extents by unticking the box.

Techniques for creating lateral extents for indicator RBF interpolants are the same as those for
RBF interpolants. SeeModifying an RBF Interpolant’s Boundary with Lateral Extents for
more information.
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The Cut-off Value

To change theCut-off value for an indicator RBF interpolant, double-click on the interpolant in
the project tree, then click on theCut-off tab. The tab also shows the distribution of the data
used to create an indicator interpolate:

Bin count defines the number of bins, where a larger bin count results in a finer histogram.

Adjust theCut-off value, if required, and clickOK to process the changes.

Changing the Trend for an Indicator RBF Interpolant

You can apply a global trend or a structural trend to an indicator RBF interpolant. To do this,
add the interpolant to the scene, then double-click on the interpolant in the project tree. Click
on the Trend tab in the Edit Indicator RBF Interpolantwindow.
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Techniques for setting a trend for an indicator RBF interpolant are the same as those for an RBF
interpolant. SeeUsing a Global Trend and Using a Structural Trend in Changing the Trend
for an RBF Interpolant.

Adjusting Interpolation Parameters

To adjust interpolation parameters for an indicator RBF interpolant, double-click on the
interpolant in the project tree, then click on the Interpolant tab:

Twomodels are available, the spheroidal interpolant and the linear interpolant. See The
Spheroidal Interpolant Function and The Linear Interpolant Function formore information
on the settings in this tab.

Indicator RBF Interpolant Surfacing and Volume Options

To change the properties of the isosurface for an indicator RBF interpolant, double-click on the
interpolant in the project tree, then click on the Volumes tab:
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An alternative to double-clicking on the interpolant is to double-click on one of the output
volumes, which opens the Edit Indicator RBF Interpolantwindowwith the Volumes tab
displayed.

The Iso value can be set to values from0.1 to 0.9. Clicking the arrows changes the Iso value in
steps of 0.1. To use a different value, enter it from the keyboard.

Setting a lower value forResolutionwill producemore detail, but calculations can take longer.
You can also set the resolution to be adaptive. See Surface Resolution in Leapfrog Geo for
more information.

When Exact clipping is enabled, the interpolant isosurfacewill be generated without “tags” that
overhang the interpolant boundary. This setting is enabled by default when you create an
interpolant.

Use Volume filtering to discard smaller parts of the volumes in which you do not wish to carry
out further processing. For example, this interpolant has numerous small volumes:

Enabling Volume filtering removes the smaller parts:
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Distance Functions
A distance function calculates the distance to a set of points. This topic describes how to create
and modify distance functions. It is divided into:

l Creating a Distance Function

l Setting the Boundary

l Setting a Trend

l Adding Buffers

l The New Distance Function in the Project Tree

Creating a Distance Function
To create a distance function, right-click on theNumeric Models folder and selectNew
Distance Function. TheNew Distance Functionwindowwill be displayed:

If any of the objects selected are closed surfaces, you can choosewhether these surfaces are
treated asVolumes or as Surfaces.

l When treated asVolumes, bufferswill be generated only on the outside of themesh. If the
mesh is inverted, bufferswill appear on its inner surface.

l When treated as Surfaces, bufferswill be generated on both sides of themesh.
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For example, here a distance function has been created using a sphere and one isosurface set to
100. The inner surface of the sphere is red, indicating that it is the inside of themesh. The sphere
is treated as a volume and there is a single isosurface (yellow) outside of the sphere:

When the orientation of the sphere is reversed, the isosurface (yellow) is generated on the inner
surface of the sphere:

However, when the sphere is treated as a surface rather than as a volume, isosurfaces are
generated on both sides of the sphere:
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If you are unsure of some settings, most can be changed later. For a basic distance function
click Select Objects to select from the suitable objects available in the project, then click on the
Buffers tab to define at least one buffer so that the distance function can be visualised in the
scene.

See:

l Setting the Boundary

l Setting a Trend

l Adding Buffers

l The New Distance Function in the Project Tree

Setting the Boundary

In the Boundary tab, you can set whether the function boundary is clipped or unclipped. No
distance buffer clipping is the default setting, but if you choose to clip the buffers, you can
choose between:

l Sharing another object’s extents

l Defining a set of extents that is independent of other objects in the project.

When you select the Shared with option, the distance function will be updated when the
extents object it shares is updated.

Setting a Trend

In the Trend tab, you can set a trend using themoving plane or by entering the required values.
You can also use the Set to list to choose different options used in the project. Isotropic is the
default option used when the function is created.

The Ellipsoid Ratios determine the relative shape and strength of the ellipsoids in the scene,
where:

l TheMaximum value is the relative strength in the direction of the green line on themoving
plane.

l The Intermed. value is the relative strength in the direction perpendicular to the green line on
themoving plane.

l TheMinimum value is the relative strength in the direction orthogonal to the plane.
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Adding Buffers

To add buffers, click on the Buffers tab, then click the Add button:

Enter the required value. To delete a buffer, click on it in the list, then click theRemove button.
You can also change the colours used to display the buffers by clicking on the colour chips.

There are two options forVolume Type that affect how the buffers are calculated whenmore
than one buffer is used. Selecting Concentric produces higher distance buffers that include the
lower distance buffers, whereas selecting Intervals produces discrete, non-intersecting buffers.

TheDefault resolution setting is used for all new buffers and for existing buffers that use the
default resolution.

The New Distance Function in the Project Tree
ClickOK to create the distance function, which will be added to theNumeric Models folder.
The new distance function contains objects representing different parts of the function, which
can be expanded to show the inputs to each part of the function:

l The Trend object that describes the trend applied.

l Hyperlinks to objects used for the distance function.

l An Isosurfaces folder that contains all themeshes generated in building the distance
function.

l AnOutput Volumes folder that contains all the distance buffermeshes.

Other objectsmay appear in the project tree under the function as you make changes to it.
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Display the function by dragging it into the scene or by right-clicking on it and selecting View
Buffers.

Once you have created a distance function, you can adjust its properties by double-clicking on
it. You can also double-click on the individual objects that make up the function.
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Combined Models
This topic describes creating and working with combined models. It is divided into:

l Creating a Combined Model

l The Combined Model in the Project Tree

l Editing a Combined Model

l Displaying a Combined Model

l Creating a Static Copy of a Combined Model

l Combined Model Export

A combined model uses information fromup to four geological models, interpolants and
distance functions in order to visualise relationships between different types of data in the
project. For example, you could combine a geological model with an interpolant to seewhat
lithologies higher grades are occurring in.

Creating a Combined Model
To create a combined model, right-click on theCombined Models folder in the project tree and
selectNew Combined Model. In thewindow that appears, select themodels you wish to
combine, then clickOK:

Once you have created a combined model, you cannot edit it to add newmodels or remove
existing ones.
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The next step is to select the output volumes to use in the combined model and arrange them in
order of priority. For this combined model, theQzP volume from the selected geological model
will be subdivided using information from the Au interpolant:

If you are using a distance buffer with concentric buffers, you will be able to select only one
volume.

ClickOK to generate themodel, which will appear in the project tree in theCombined Models
folder.

Add themodel to the scene to view the results:

The Combined Model in the Project Tree
In the project tree, the combined model includes hyperlinks to themodels used to create the
combined model:
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Changesmade in the original modelswill be reflected in the combined model.

Editing a Combined Model
To change how the volumes from the sourcemodels are combined, double-click on the
combined model in the project tree. Once you have created a combined model, you cannot
add newmodels to it, nor can you remove a selected model.

Displaying a Combined Model
To change the colours used to display themodel, double-click on the Legend object ( ). In the
window that appears, click on the colour chip for each category and change it as described in
Display Colours.

To set multiple categories to a single colour, use the Shift and Ctrl keys to select the colour
chips you wish to change, then click on one of the colour chips. The colour changes you
makewill bemade to all selected categories.

Creating a Static Copy of a Combined Model
Creating a static copy preserves a snapshot of a combined model that does not change, even
when changes aremade to the data on which the original model was dependent. This is a
useful way of storing historical models and comparing models. Static copies can be exported
fromLeapfrog Geo, as described in Combined Model Export below.

To create a static copy of a combined model, right-click on it in the project tree and select
Static Copy. Enter a name for the copy of themodel and clickOK. The copywill be added to
theCombined Models folder.

The static copy ( ) ismade up of a Legend object ( ) and the output volumes ( ).

Staticmodels created in versions of Leapfrog Geo before 2.2 copied only the output volumes
and the legend, and the staticmodel appeared in the shape list only as a single line. When
these staticmodels are upgraded and displayed in the scene, the individual output volumes
will be added to the shape list.

To view the date a static copywas created, right-click on it in the project tree and select
Properties. The date the copywas created is in theGeneral tab.

Combined Model Export
There are two options for exporting a combined model’s output volumes. These are:

l Export an output volume as a mesh. Right-click on it in the project tree and click Export. You
will be prompted for a file name and location. See Exporting a Single Mesh.

l Export multiple output volumes. Right-click on the combined model in the project tree and
select Export. See Exporting Multiple Meshes from Models.
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Flow Modelling
Geological models created in Leapfrog Geo can be used as the basis forModFlow and FEFLOW
models. You can create flowmodels directly in Leapfrog Geo and assign hydrological/material
properties based on the lithologies in the geological model. Flowmodels can be exported for
use in other applications, and you can import existing flowmodels and use themas the basis for
the construction of newmodels. Flowmodels can be displayed in the scene, and time-
dependent data can also be visualised.

Working with ModFlow and FEFLOWmodels is available as part of the Hydrogeology
module. Contact Customer Support as described inGetting Support formore information
about licensing the Hydrogeologymodule.

If theHydrogeology folder appears in the project tree asRestricted, you will be able to
displaymodels in the scene and change how they are displayed, but you will not be able to
make changes to themodels themselves.

All tools for building flowmodels are accessed by right-clicking on theHydrogeology folder
and the objects in it. Imported objects and objects created while building a flowmodel are also
stored in theHydrogeology folder, and more complex functions can be carried out by right-
clicking on individual objects.

ModFlow Models

These features are only available as part of the Hydrogeologymodule. See Flow Modelling
formore information.

Once you have created a geological model, you can use it as the basis for a ModFlowmodel.
You can also import existing ModFlowmodels and assign lithologies froma geological model.

Steps for creating a ModFlowmodel that can be exported and run outside Leapfrog Geo are:

1. Create a geological model.

2. Create theModFlowmodel using the geological model to set the grid spacing and layers.

3. Evaluate the newmodel against a geological model, if it wasn’t when it was created.

4. Edit the hydrological properties.

5. Export theModFlowmodel toModFlow or Groundwater Vistas.

Once themodel has been processed outside of Leapfrog Geo, themodel can be imported into
Leapfrog Geo and visualised in the scene.

Creating ModFlowmodels in Leapfrog Geo has the advantage that the resolution can be easily
changed and the properties of the grid can bemade to honour boundaries defined in
geological models. SeeCreating a ModFlow Model.

SeeModFlow Model Display for information on options for displaying models in the scene.
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Models created in Leapfrog Geo can be evaluated against a geological model when they are
created. Models imported into Leapfrog Geo or that were not evaluated when theywere
created can be evaluated as described inModFlow Evaluations.

Once a model has been defined and evaluated against a geological model, hydrological
properties can be assigned and the grid can be exported. SeeModFlow Hydrological
Properties andModFlow Model Export.

Creating a ModFlow Model

This feature is only available as part of the Hydrogeologymodule. See Flow Modelling for
more information.

To create a newModFlowmodel, you must first have at least one geological model defined in
the project. Once this has been defined, add the geological model to the scene. Right-click on
theHydrogeology folder and selectNew ModFlow Model. TheNew ModFlow Modelwindow
will be displayed, together with controls in the scene that will help you to set the grid extents:

The newModFlow grid will be based on the geological model in theGridding from setting. If
you wish to use a geological model other than the one selected when thewindow is opened,
select it from the list. The grid dimensionswill be updated in the scene.

If the Evaluate Gridded Model box is ticked, the selected geological model will be evaluated on
the new grid and set as the evaluation for export. If you do not wish to evaluate the geological
model on the grid, untick the box. You will still be able to use the layers in the geological model
to control the grid layers.

The Preserve Existing Grid Lines option is used when setting a non-uniformgrid in the scene
window. If you are going to define a non-uniformgrid in thisway, create themodel with the
Default Cell Size set to the smallest cell size you wish to use, then edit it as described in Editing
a ModFlow Model.
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The grid should be slightly smaller than the selected geological model. AnyModFlow cells
that exist outside the geological model will bemarked as inactive when the grid is exported
toModFlow.

Horizontal Grid Spacing

By default, the horizontal grid for themodel is uniform, with the size of each cell set by the
Default Cell Size value. You can change the horizontal grid by editing row and column
spacings. When you click on Row Spacings orColumn Spacings, the Edit Spacingswindow
will be displayed:

Changesmade in the Edit Spacingswindowwill be reflected in the scene.

There are four ways to change the spacings:

l Click on a value to edit it.

l Divide a row or column. Click on a row or column, then on theDivide Row orDivide Column
button. Two new rowsor columnswill appear in the list.

l Merge rowsor columns. Hold down the Shift keywhile clicking on each item, then click on
theMerge Rows orMerge Columns button. The selected itemswill be combined.

l Set uniform spacing on selected rowsor columns. You will be prompted to enter the number
of cells you wish to create from the selected rowsor columns.
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ClickOK.

For example, here, the rows and columns away from themodel boundary have been divided to
providemore detail. The different spacings are reflected in the scene:

Use close spacing for steep gradients and increase or decrease spacing gradually.

Vertical Grid Layering

The vertical grid layers are based on the geological model selected in theNew ModFlow Model
window. Click on the Layers tab to view the layers:
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Initially, there are two layers equally spaced between the topography and the geological
model. Change the layers by clicking on Select Layer Guides button. The Layer Guides
windowwill appear, showing the layers available in the selected geological model:

If the grid is required to follow a geological model lithology contact surface, move the layer into
the Selected list and it will be honoured in the gridding process.

ClickOK to return to theNew ModFlow Modelwindow, in which the selected layerswill be
displayed:

ClickOK to create the newModFlow grid, which will appear in theHydrogeology folder. You
can edit themodel by expanding it in the project tree and double-clicking on the grid object (
). See Editing a ModFlow Model.
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For further information on working with the newmodel, see:

l ModFlow Model Display

l ModFlow Evaluations

l ModFlow Hydrological Properties

l Head Values and MT3D Concentrations

l Generating a Head Value Mesh

l ModFlow Model Export

Editing a ModFlow Model

This feature is only available as part of the Hydrogeologymodule. See Flow Modelling for
more information.

Once you have created a ModFlowmodel, you can edit it by expanding themodel in the project
tree and double-clicking on the grid object ( ). The Edit ModFlow Gridwindowwill appear.
You can edit the grid spacings as described in Creating a ModFlow Model, using the
information in the scenewindow as a guide.

Another way to edit the grid is to use the controls in the scene to apply different cell size settings
in different parts of the grid. For example, you maywant to define a grid that has smaller cells in
the centre than at the outer edges:

To set cell sizes in thisway, it is best to start with a ModFlowmodel where theDefault Cell Size
is set to the smallest cell size you will use in themodel.
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For this example, wewill start with a new grid with a Default Cell Size of 50. Wewill set the
adjacent cell size to 100 and the cell size at the outer boundary to 200.

First, we need to reduce the area that uses the cell size of 50 by using the red handles in the
scene:

The blue box in the scene is the geological model extents for themodel used to define the
ModFlowmodel and represents the unedited boundary of theModFlowmodel.

Next, enter the cell size to use for the area adjacent to the 50.0 cells in theNew Cell Size field.
Then, drag the red handles to enlarge the grid. The centre part of the grid is still set to 50, while
the new area is set to 100:

If the Preserve Existing Grid Lines option is enabled, grid lines for cells already defined will
not bemoved to account for new cells.
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Enter the next cell size in theNew Cell Size field and then use the handles to enlarge the grid
again:

ClickOK to update the grid.

For further information on working with the newmodel, see:

l ModFlow Model Display

l ModFlow Evaluations

l ModFlow Hydrological Properties

l Head Values and MT3D Concentrations

l Generating a Head Value Mesh

l ModFlow Model Export

Importing a ModFlow Model

This feature is only available as part of the Hydrogeologymodule. See Flow Modelling for
more information.

Leapfrog Geo imports .nam files and .mfi and .mfn variations of .nam files.

To import a ModFlowmodel, right-click on theHydrogeology folder and select Import
ModFlow Model. Leapfrog Geowill ask you to specify the file location, and then will display the
data in the file in the Import ModFlow Modelwindow:
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If the world origin is available, theGrid Positionwill be displayed but cannot be edited.

ClickOK to import the grid. The newModFlowmodel will appear in the project tree in the
Hydrogeology folder. SeeModFlow Model Display for information on displaying themodel.

If the world origin was not available when themodel was imported, you can change theGrid
Position. To do this, expand the imported model in the project tree and double-click on its grid
object ( ).

To associate lithologieswith the grid, seeModFlow Evaluations.

ModFlow Evaluations

This feature is only available as part of the Hydrogeologymodule. See Flow Modelling for
more information.

When a ModFlowmodel is exported, the evaluated geological model is used to assign
lithologies to the cells in the grid. If the grid has not been evaluated against a geological model,
you must do so before you can edit the hydrological properties and before you can export the
grid.

To evaluate a ModFlowmodel, expand themodel in the project tree, then right-click on the
grid object ( ) and select Evaluations. Although you can evaluate an interpolant or distance
function, they cannot be exported with the grid and are simply used for displaying the grid in
Leapfrog Geo.

A windowwill appear listing all objects in the project that can be used for an evaluation. Once
you have selected one ormore objects, clickOK. You will then be able to select the evaluations
from the view list, as described in Evaluations.

Assigning an Evaluation for Export

ForModFlowmodels created in Leapfrog Geo, the evaluation used when creating themodel
will automatically be assigned as the evaluation for export. A hydrological properties table ( )
will appear in the project tree as part of themodel.

If themodel was imported into Leapfrog Geo or created without being evaluated against a
geological model, you will need tomanually set the evaluation for export. To do this:

l Evaluate the grid against one ormore geological models, as described above.

l Right-click on themodel ( or ) in the project tree and select Set Evaluation for Export.
The Select Evaluationwindowwill appear showing all geological models evaluated on the
grid. Select the required evaluation and clickOK.

A hydrological properties table will be added to themodel in the project tree. Edit hydrological
properties by double-clicking on the table. SeeModFlow Hydrological Properties.

Combined Evaluations

You can combine geological models and set the priority used for evaluation. This is useful when
you have geological models available that describe different parts of the area of interest or if
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you have a refined geological model for part of themodel. To combine geological models for
evaluation, select the required models in the Select Models To Evaluatewindow, then click on
theCombined Evaluation button.

In this example, there are three geological models selected:

The GM and GM fromcontactsmodels describe similar areas, but GM hasmore detail. The GM
largermodel describes a larger area but with less detail. Tick themodels to combine themand
set their priority. ClickOK to create the combined evaluation, then clickOK in the Select Models
To Evaluatewindow. The combined evaluation will be available from the view list and can be
selected as the evaluation for export.

To delete a combined evaluation, click on theDelete Combined button in the Select Models
To Evaluatewindow.

ModFlow Hydrological Properties

This feature is only available as part of the Hydrogeologymodule. See Flow Modelling for
more information.

When a ModFlowmodel is evaluated against a geological model, a hydrological properties
table ( ) is added to themodel in the project tree. You can edit hydrological properties by
double-clicking on the table. You can also open the table by right-clicking on themodel in the
project tree and selecting Edit Hydrological Properties.

If themodel has been imported into Leapfrog Geo and has not yet been evaluated against a
geological model, you will be prompted to do so. Expand themodel in the project tree, right-
click on the grid object and select Evaluations. SeeModFlow Evaluations formore information.

Hydrological properties are assigned tomodel blocks based on the position of the block’s
centroid relative to the geological model used to evaluate the grid. The position of the centroid
is calculated and Leapfrog Geo then determineswhich lithology the centroid falls inside. The K
values for the assigned lithology are assigned to the entire block; there is no averaging.
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If more than one object has been evaluated on the grid, you can set hydrological properties
separately for each evaluation. Select the required evaluation from the Evaluation list:

However, the only hydrological properties information that will be exported is that set for the
evaluation to be exported.

Setting Hydrological Properties
In the Edit Modflow Parameterswindow, you can enter the values for hydrological properties
manually or you can use the values froman interpolant.

To enter valuesmanually, click on a cell, then enter the value in the Value field:

Press the Enter key tomove down the columns.
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To use the values froman interpolant, click the Interpolant button, then select an interpolant
from the list. The interpolant that will be used for the selected valuewill be displayed in the
field:

To use the interpolant for all the values in the selected column, click the All Lithologies button.
Thewindowwill be updated to show that the interpolant valueswill be used for that column:
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Zone Numbers

When themodel is exported, the zone numbers are used to indicate the assignment of
lithologies to blocks and are written to theModFlow zoned layer properties flow (*.lpf) file. In
the Edit Modflow Parameterswindow, you can change the zone number for a lithology by
clicking in a cell and entering a different zone number. If you reorder the zones in thisway, zone
number conflictswill be highlighted in red:

Zone numbersmust be unique and you will not be able to close thewindow and save data if
there are conflicts.

If you click on the Sort Zone Numbers button, the zone numberswill be ordered from top to
bottom.

Zone numbers should not be sorted once a model has been exported as the new numbers
will not be reflected in the exported model.

ClickOK to update the grid.

ModFlow Model Display

If you do not have a licence for the Hydrogeologymodule, ModFlowmodelswill appear in
the project tree asRestricted. You can change howModFlowmodels are displayed, but you
will not be able tomake changes to themodels themselves.

In the project tree, ModFlowmodels aremade up of a grid object ( ), a Simulation Outputs
folder and a hydrological properties table ( ) object. If there is no hydrological properties table,
an evaluation has not yet been set for export. SeeModFlow Evaluations formore information.

ForModFlowmodels created in and imported into Leapfrog Geo, dragging themodel itself into
the scenewill display the grid ( ) object. The different parts of themodel can also be displayed.
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Grid Display Options

Dragging a ModFlowmodel into the scene displays its grid object. Here, an imported model has
been evaluated against a geological model and added to the scene:

The viewing options available are the flat colour option, the evaluated geological model and
zone data imported with themodel. Other inputs imported with a model will also be available
from this list, and once themodel has been evaluated against a geological model or
interpolant, you can also display themodel using the grid’s hydrological properties.

Grids are displayed as cells. When a geological model evaluation or lithological zone
information is displayed, you can also display a legend for the grid.

When Show edges ( ) is enabled, the edges of the cellswill be displayed.

The Show inactive blocks ( ) option displays inactive cells in grey:
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To display a single layer, tick theOne layer box in the shape properties panel, then select the
layer to display.

Head values and MT3D concentrations can also be imported and displayed. SeeHead Values
and MT3D Concentrations.

Viewing Block Information

When a ModFlowmodel is displayed in the scene, you can view information about the
individual cells in themodel by clicking on a block. Thewindow that appears shows information
about the selected block, including its centroid and the lithology assigned to the block from the
evaluated geological model. Information fromall geological models and interpolants the grid
has been evaluated against will be displayed:

Head Values and MT3D Concentrations

This feature is only available as part of the Hydrogeologymodule. See Flow Modelling for
more information.

Leapfrog Geo imports the following output file formats:

l Head values files in *.hds, *.hhd and *.hed formats

l MT3D concentrations files in *.ucn format

To import head values orMT3D concentration files for a ModFlowmodel, right-click on the
Simulation Outputs folder and select the required option. Navigate to select the file, then click
Open.
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The information will be added to theModFlow grid, and you can then select the head values
and MT3D concentrations in the shape list when you display the grid in the scene. If the output
is time-dependent, a timestep slider will be available from the shape properties panel. Click and
drag the slider or click along the timeline to view the different timesteps available:

Imported head values and MT3D concentrations are stored in the project tree in the Simulation
Outputs folder:

To delete head values orMT3D concentrations, right-click on the object in the project tree and
selectDelete.

Once head values have been imported, you can generate a head valuemesh. SeeGenerating a
Head Value Mesh.

Generating a Head Value Mesh

This feature is only available as part of the Hydrogeologymodule. See Flow Modelling for
more information.

Once head values have been imported for a ModFlowmodel, you can generate a head value
mesh. To do this, expand the Simulation Outputs folder. Right-click on the head values object
and selectGenerate Head Value Mesh. TheGenerate Head Value Meshwindowwill appear,
showing the layers in themodel and the timesteps available. Select the layer of themodel you
wish to generate a head valuemesh for, then choose the heads. ClickOK to create themesh,
which will be saved to theMeshes folder.

ModFlow Model Export

This feature is only available as part of the Hydrogeologymodule. See Flow Modelling for
more information.

Leapfrog Geo has three options for exporting ModFlow grids:

l Export the grid as a ModFlow file.

l Export for Groundwater Vistas. Use this option the first time you export a grid for use in
Groundwater Vistas.
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l Export a Groundwater Vistas update. Use this option to generate a set of files that can be
imported into Groundwater Vistas as an update.

The Groundwater Vistas options include a zoned layer properties flow (*.lpf) file that includes
information about the zones in the grid.

As a ModFlow File

To export a grid as a ModFlow file for use in a package other than Groundwater Vistas, right-
click on the grid in the project tree and select Export to ModFlow. You will be prompted to
choose a File name and location. Select the options required, then click Save.

For Groundwater Vistas

To export a grid for use in Groundwater Vistas for the first time, right-click on the grid in the
project tree and select Export to ModFlow for GWV. You will be prompted to choose a File
name and location. Select the options required, then click Save.

If you have previously exported the grid to Groundwater Vistas and havemade changes to the
grid, use the Export to GWV Updates option.

As a Groundwater Vistas Update

If you have exported a grid to Groundwater Vistas but then make changes to the Leapfrog Geo
model, you can export the changes to themodel. The set of files containing the changes can
then be imported to Groundwater Vistas.

To export a Groundwater Vistas update, right-click on the grid in the project tree and select
Export GWV Updates. TheUpdate Groundwater Vistaswindowwill appear listing the files
that will be exported. Enter a Base file name to differentiate the original files from the updates.
Click Export. The fileswill be saved in the specified directory.

FEFLOW Models

These features are only available as part of the Hydrogeologymodule. See Flow Modelling
formore information.

In Leapfrog Geo, creating a 3D FEFLOWmodel requires:

l A geological model that will be used to assign lithologies to the FEFLOWmodel’s blocks.

l A 2D grid that defines the block size, boundaries and surface features.

Steps for creating a 3D FEFLOWmodel that can be exported and run outside Leapfrog Geo are:

1. Create a geological model.

2. Create and refine a 2Dmodel in Leapfrog Geo or import a FEFLOWmodel.

3. Create the 3Dmodel from the 2Dmodel or another 3Dmodel in the project.

4. Evaluate the new 3Dmodel against a geological model.
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5. Edit thematerial types.

6. Export the 3D FEFLOWmodel.

Once themodel has been processed outside of Leapfrog Geo, a results file can be saved that
can be imported into Leapfrog Geo and visualised in the scene.

A 2D grid can be created in or imported into Leapfrog Geo. A 3D grid can also be used, in which
case the layer information is not used in creating the 3D grid. Creating the 2D grid in Leapfrog
Geo provides themost flexibility, as the block sizes can easily be changed, the boundaries
modified and features added to provide finer resolution where there ismore data available.

For information about creating 2D and 3D grids, seeCreating a 2D FEFLOW Model and
Creating a 3D FEFLOW Model.

You can also import FEFLOW problem files and result files, visualise them in Leapfrog Geo and
use themas the basis for newmodels. See Importing a FEFLOW Grid.

See FEFLOW Model Display for information on options for displaying FEFLOWmodels in the
scene.

3D grids created in Leapfrog Geo can be evaluated against a geological model when they are
created. Grids imported into Leapfrog Geo or that were not evaluated when theywere created
can be evaluated as described in FEFLOW Evaluations.

Once a model has been defined and evaluated against a geological model, material types can
be assigned and the grid can be exported. See FEFLOW Material Types and FEFLOW Model
Export.

FEFLOW Model Display

If you do not have a licence for the Hydrogeologymodule, FEFLOWmodelswill appear in
the project tree asRestricted. You can change how FEFLOWmodels are displayed, but you
will not be able tomake changes to themodels themselves.

In the project tree, 3D FEFLOWmodels aremade up of a grid object representing the finite
elements, a nodes object and a material types table ( ) object. If there is nomaterial types table,
an evaluation has not yet been set for export. See FEFLOW Evaluations formore information.

A 2D FEFLOW grid ismade up of a grid object and a nodes object. Here, three types of FEFLOW
models are shown expanded in the project tree:

l Feflow 3D Simulation is a 3Dmodel created in Leapfrog Geo.

l Feflow 2D Simulation is a 2Dmodel created in Leapfrog Geo.

l Feflow Results is an imported 3Dmodel (DAC file).
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From the information in the project tree, we can see that:

l The 3D simulation created in Leapfrog Geo ( ) uses the GM geological model to define the
layers.

l The 2D simulation created in Leapfrog Geo ( ) uses the GM geological model as a boundary
and has had collar points added as a feature.

l The imported resultsmodel ( ) includes a number of simulation outputs.

For each type of FEFLOWmodel, dragging themodel itself into the scenewill display the grid (
) object. The different parts of themodel can also be displayed.
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Displaying a 3D Model

Dragging a 3D simulation into the scene displays its grid object, which represents the finite
elements. Here, a 3Dmodel created in Leapfrog Geo ( ) has been added to the scene:

For 3Dmodels imported into Leapfrog Geo, you can display themodel using other information
available for the grid, such as conductivity data. This is available from the view list.

Grids for 3Dmodels are displayed as blocks. You can also display a legend for the grid when a
geological model evaluation is displayed.

When Show edges ( ) is enabled, the edges of the blockswill be displayed.

To display a single layer, tick theOne layer box in the shape properties panel, then select the
layer to display.
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You can display the nodes by adding the nodes ( ) object to the scene. When a model with
results is displayed, the simulation outputs can be displayed when the nodes are viewed in the
scene. Here, the nodes for an imported results file have been added to the scene. The heads are
displayed for a single layer:

When the results are time-dependent, a timestep slider will be available from the shape
properties panel. Click and drag the slider or click along the timeline to view the different
timesteps available.

Displaying a 2D Model

Aswith 3Dmodels, dragging a 2Dmodel into the scene displays its grid object. Here, a 2D
model created in Leapfrog Geo (( ) has been added to the scene and viewed fromabove:

Also in the scene is a collar points object that shows collar points that have been added to the
grid as a feature.
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2D grids can be viewed as points or as blocks. Aswith imported 3D grids, an imported 2D grid
can also be displayed using other information available for the grid.

Other viewing options are available for 2D grids created in Leapfrog Geo. These are useful in
refining a 2D grid and are described in Creating a 2D FEFLOW Model.

Viewing Block Information

When a FEFLOWmodel is displayed in the scene, you can view information about the individual
blocks in themodel by clicking on a block. Thewindow that appears shows information about
the selected block, including its centroid and the lithology assigned to the block fromall
evaluated geological models and interpolants:

Information fromall geological models and interpolants the grid has been evaluated against
will be displayed:

Importing a FEFLOW Grid

This feature is only available as part of the Hydrogeologymodule. See Flow Modelling for
more information.

You can import 2D and 3D FEFLOW grids and use themas the basis for newmodels. Leapfrog
Geo imports two types of FEFLOW files:

l FEFLOW problem files (*.fem) in ASCII format. Importing these files results in a new 2D or 3D
model with a grid and nodes.

l FEFLOW results files (*.dac). Importing these files results in a new 3Dmodel with a grid, nodes
and simulation outputs.

To import a FEFLOW grid or results file, right-click on theHydrogeology folder and select one
of the Import FEFLOW options. Leapfrog Geowill ask you to specify the file location. Click
Open to import the file.

The new FEFLOW grid will appear in the project tree under theHydrogeology folder. To use
the imported grid or results file as the basis for a new FEFLOWmodel, seeCreating a 3D
FEFLOW Model.

To associate lithologieswith a 3D grid, see FEFLOW Material Types.
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See FEFLOW Model Display for information about displaying the FEFLOW grid in the scene
window.

Creating a 2D FEFLOW Model

This feature is only available as part of the Hydrogeologymodule. See Flow Modelling for
more information.

A 2D FEFLOWmodel defines the block size, boundaries and surface features for a 3D FEFLOW
model. Although existing 2D grids can be imported into Leapfrog Geo and used for creating 3D
models, creating the 2D grid in Leapfrog Geo provides themost flexibility, as the block sizes can
easily be changed, the boundariesmodified and features added to provide finer resolution
where there ismore data available.

It is not necessary to create a geological model before creating a 2D grid. However, you will not
be able to create a 3D grid until a geological model has been created. Therefore, it is a good
idea to create the geological model first, and its dimensions can be used in defining the
boundary of the 2D grid.

To create a 2D grid, right-click on theHydrogeology folder and selectNew 2D FEFLOW
Model. TheNew 2D FEFLOW Gridwindowwill appear:

All settings can be changed once the grid has been created. It is, therefore, reasonable to
accept the default settings and create the grid, then add it to the scene and begin refining it.
ClickOK to create the initial grid.

In the project tree, a 2D FEFLOW grid ismade up of a grid object and a nodes object, as
described in FEFLOW Model Display. Here, a newly-created grid with a rectangular boundary
appears in the project tree:
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Expand the grid in the project tree and double-click on the grid object ( ) to open the Edit 2D
FEFLOW Gridwindow. The Features tab will be displayed. When a grid is first created, this
windowwill be empty, but once features have been added, you can enable them in this tab.

Click on the Boundary tab tomodify the boundary:

Click the Apply button to view the effect of changesmadewithout closing thiswindow.

Boundary Options

When setting the Boundary, you can set a rectangular boundary defined by the From
rectangle settings. You can use the extents of any other object in the project by selecting from
the Enclose Object list, but the grid boundarywill always be a rectangle.

To define a non-rectangular boundary, use the From another object options and select from
the list of objects available in the project. This is useful if, for example, you wish to define a grid
using the boundary of a geological model.

The Simplify boundary option reduces the number of points along the boundary. Reducing the
Tolerance value increases the number of points along the boundary. The two settings together
let you define a basic boundarywith elements that are roughly uniform in size, set by the value
of Element size. Here, a grid has been created froma geological model with the Simplify
boundary option enabled:
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Disabling the Simplify boundary option results in more detail around the edges of the grid:

Element Size

The Element size setting determines the basic size of the triangles that make up the grid,
although the size will vary according to features applied to the grid and the Feature vertex
snapping distance. The size will also vary if the Simplify boundary option is unticked, in which
case the Element size setting is themaximumsize of the triangles.

The Feature vertex snapping distance is automatically set to 1 percent of the Element size. To
use a smaller snapping distance, untick the Auto box and set the value required. You cannot set
a value that is larger than 1 percent of the Element size.

The effects of the Feature vertex snapping distance do not become apparent until features
have been added to the grid.

Adding Features to the Grid

To add features to the grid, right-click on the grid in the project tree and selectNew Feature.
TheNew FEFLOW Featurewindowwill appear:

You can add Point, Line and Polygon features, and the Feature Object list will display all
suitable objects available in the project. Ticking the Simplify Feature option will reduce the
number of points used.

© 2017 ARANZ Geo Limited



460 | Leapfrog Geo User Manual

ClickOK to add the feature, which will appear in the project tree under the FEFLOW grid object:

You can edit the feature by double-clicking on it or by right-clicking and selectingOpen.
However, the feature has not yet been applied to the grid. To enable the feature, double-click
on the grid to open the Edit 2D FEFLOW Gridwindow. Tick the box to enable the feature, then
adjust the number of Refinement Steps:

MoreRefinement Stepswill producemore detail near the feature.

ClickApply orOK to view the effect the feature and its settings have on the grid.

If you want tomodify a feature without having to reprocess the grid, untick it in the Features
tab. If you want to delete a feature, right-click on it in the project tree and selectDelete.

The images below show a grid displayed with collar points (in red) to demonstrate the effects of
no features and collars applied with different refinement steps:

No features Collars with 2 refinement steps Collars with 10 refinement steps
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To view all features added to a grid, right-click on the grid and select View Snapped Features. A
Snapped Features object will appear in the shape list that represents all objects used to add
features to the grid:

Here, four snapped objects appear in the scene: the three features listed in the Features tab and
the grid’s boundary.

SeeCreating a 3D FEFLOW Model for information on using the 2D grid as the basis for a 3D
model.

Creating a 3D FEFLOW Model

This feature is only available as part of the Hydrogeologymodule. See Flow Modelling for
more information.
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To create a new 3D FEFLOWmodel, you must first create or import a 2D FEFLOW grid as
described in Creating a 2D FEFLOW Model and Importing a FEFLOW Grid.

Once you have created or imported a 2D FEFLOW grid, right-click on theHydrogeology folder
and selectNew FEFLOW Model. The Extrude 3D FEFLOW Gridwindowwill appear:

The dimensions and resolution of the grid are set by the 2D or 3D grid selected from the
FEFLOW Grid list. SeeCreating a 2D FEFLOW Model for information on creating and refining a
2D grid that can be used as the basis for a 3D grid.

TheGridding from setting determines the geological model used for layer guides. Ticking the
Evaluate Gridded Model boxwill evaluate the new 3Dmodel against the selected geological
model and set it as the evaluation for export. See FEFLOW Evaluations formore information. If
you do not wish to evaluate the geological model on the grid, untick the box. You will still be
able to use the layers in the geological model to control the grid layers.
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The FEFLOW grid is initiallymade up of two layers equally spaced between the topography and
the geological model, with theminimum thickness of each layer determined by theMinimum
Thickness setting. You can add layers to the grid by clicking on the Select Layer Guides button
and then selecting from the layers available in the geological model:

If the grid is required to follow a geological model lithology contact surface, move the layer into
the Selected list and it will be honoured in the gridding process.

ClickOK to return to the Extrude 3D FEFLOW Gridwindow. The selected layerswill be
displayed:

ClickOK to generate the new FEFLOW grid, which will appear in the project tree under the
Hydrogeology folder.

Once themodel has been created, you can edit it by expanding themodel in the project tree
and double-clicking on its grid object. The layer guides selected, the number defined and the
Minimum Thickness can bemodified, but the FEFLOW grid on which themodel is based and
the geological model used for gridding cannot be changed.
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The boundaries of the selected geological model must be larger than the FEFLOW grid used
as the basis for the newmodel. If this is not the case, you can change the geological model’s
extents so that they enclose the FEFLOW grid.

For further information on working with the new grid, see:

l FEFLOW Model Display

l FEFLOW Evaluations

l FEFLOW Material Types

l FEFLOW Model Export

FEFLOW Evaluations

This feature is only available as part of the Hydrogeologymodule. See Flow Modelling for
more information.

When a 3D FEFLOWmodel is exported, the evaluated geological model is used to assign
lithologies to the blocks in the grid. If the grid has not been evaluated against a geological
model, you must do so before you can edit thematerial types and before you can export the
grid.

To evaluate a FEFLOW grid, expand themodel in the project tree. Right-click on the grid object (
) and select Evaluations. Although you can evaluate an interpolant or distance function, they

cannot be exported with the grid and are simply used for displaying the grid in Leapfrog Geo.

A windowwill appear listing all objects in the project that can be used for an evaluation. Once
you have selected one ormore objects, clickOK. You will then be able to select the evaluations
from the view list, as described in Evaluations.

Assigning an Evaluation for Export

For 3D grids created in Leapfrog Geo, the evaluation used when creating the grid will
automatically be assigned as the evaluation for export. Amaterial types table ( ) will appear in
the project tree as part of the 3D grid.

If the grid was imported into Leapfrog Geo or created without being evaluated against a
geological model, you will need tomanually set the evaluation for export. To do this:

l Evaluate the grid against one ormore geological models, as described above.

l Right-click on themodel ( or ) in the project tree and select Set Evaluation for Export.
The Select Evaluationwindowwill appear showing all geological models evaluated on the
grid. Select the required evaluation and clickOK.

Amaterial types table will be added to the FEFLOW grid in the project tree. Edit material types by
double-clicking on the table. See FEFLOW Material Types.
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Combined Evaluations

You can combine geological models and set the priority used for evaluation. This is useful when
you have geological models available that describe different parts of the area of interest or if
you have a refined geological model for part of themodel. To combine geological models for
evaluation, select the required models in the Select Models To Evaluatewindow, then click on
theCombined Evaluation button.

In this example, there are three geological models selected:

The GM and GM fromcontactsmodels describe similar areas, but GM hasmore detail. The GM
largermodel describes a larger area but with less detail. Tick themodels to combine themand
set their priority. ClickOK to create the combined evaluation, then clickOK in the Select Models
To Evaluatewindow. The combined evaluation will be available from the view list and can be
selected as the evaluation for export.

To delete a combined evaluation, click on theDelete Combined button in the Select Models
To Evaluatewindow.

FEFLOW Material Types

This feature is only available as part of the Hydrogeologymodule. See Flow Modelling for
more information.

When a FEFLOWmodel is first evaluated against a geological model, a material types table ( ) is
added to the FEFLOW grid in the project tree. You can edit material types by double-clicking on
the table. You can also open the table by right-clicking on the grid and selecting Edit Material
Types.

If the grid has been imported into Leapfrog Geo and has not yet been evaluated against a
geological model, you will be prompted to do so. Expand themodel in the project tree, right-
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click on the grid object and select Evaluate Geological Model. See FEFLOW Evaluations for
more information.

If more than one object has been evaluated on the grid, you can set material types separately
for each evaluation. Select the required evaluation from the Evaluation list:

However, the onlymaterial types information that will be exported is that set for the evaluation
to be exported.

In the Edit Material Typeswindow, you can enter the values formaterial typesmanually or you
can use the values froman interpolant.

To enter valuesmanually, click on a cell, then enter the value in the Value field:

Press the Enter key tomove down the columns.
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To use the values froman interpolant, click the Interpolant button, then select an interpolant
from the list. The interpolant that will be used for the selected valuewill be displayed in the
field:

To use the interpolant for all the values in the selected column, click the All Lithologies button.
Thewindowwill be updated to show that the interpolant valueswill be used for that column:

ClickOK to update the grid.

FEFLOW Model Export

This feature is only available as part of the Hydrogeologymodule. See Flow Modelling for
more information.

To export a 3D FEFLOWmodel as an ASCII format FEFLOW file (*.fem), right-click on the grid in
the project tree and select Export To FEFLOW. You will be prompted to choose a File name
and location. Select the options required, then click Save.

2D FEFLOW grids cannot be exported.
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Block Models
The Block Models folder can be used to import and create blockmodels. Model types that can
be imported are:

l Isatis files

l CSV files

l UBC grids

You can also create blockmodels and sub-blocked models, which can then be exported for use
in other applications. Creating blockmodelswithin Leapfrog Geo has the advantage that the
resolution can easily be changed.

Blockmodels can be evaluated against geological models and interpolants as described in
Evaluations.

The rest of this topic describes importing blockmodels in Isatis and CSV formats, creating block
models in Leapfrog Geo, viewing blockmodel statistics and exporting blockmodels. It is divided
into:

l Importing a Block Model

l Importing an Isatis Block Model

l Importing a Block Model in CSV Format

l Creating a Block Model

l Displaying a Block Model

l Statistics

l Block Model Export

l In a Supported Format

l In CSV Format

l In Datamine Block Model Format

l As Points

For information on working with the other type of blockmodel, seeUBC Grids.

Importing a Block Model
Leapfrog Geo imports blockmodels in the following formats:

l CSV + Text Header (*.csv, *.csv.txt)

l CSVwith Embedded Header (*.csv)

l Isatis BlockModel Files (*.asc)

Importing an Isatis Block Model

To import an Isatis format blockmodel, right-click on the Block Models folder and select
Import Block Model. Select the file you wish to import and clickOpen. Themodel will be
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imported and added to the Block Models folder.

Importing a Block Model in CSV Format

Blockmodels imported in CSV format must be regular, rotated only about the Z axis. You will
also need tomap the data in the file to the blockmodel format Leapfrog Geo expects.

To import a blockmodel in CSV format, right-click on the Block Models folder and select
Import Block Model. Select the file you wish to import and clickOpen. An import windowwill
be displayed in which you can map the columns in the file to those Leapfrog Geo expects. Once
you havemapped the required columns, clickNext to define the grid.

In the next window, the data in the file is displayed and you can select the values to use in
formatting the grid:
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You can select information in the file and drag it to the corresponding values on the lefthand
side:

You can also enter the grid definition valuesmanually.

Once all required values have been copied, Leapfrog Geowill check the grid definition against
the data in the file and confirm that the centroidsmatch:

Click Finish. The blockmodel will appear in the Block Models folder.
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Creating a Block Model
To create a new blockmodel, right-click on the Block Models folder and selectNew Block
Model. TheNew Block Modelwindowwill appear, together with a set of controls that will help
you set the size, location and orientation of themodel in the scene:

The blockmodel is defined from itsBase point, and the reference centroid is the Base point
plus one half the Block size. Blockmodels cannot have partial blocks, and when changes are
made to the Block size parameter, themodel’s extentswill be enlarged tomatch the Block
size.

If you know the values you wish to use for themodel’sExtents, enter them inNew Block Model
window. You can also:

l Use the controls in the scene to set the extents.

l The orange handle sets the Base point.

l The red handles adjusts the size of the boundary.

l The blue handle adjusts the Azimuth.

l Use another object’s extents. Select the object from the Enclose Object list.

If you wish to define a tilted blockmodel, create a sub-blocked model with no triggers. See
Sub-blocked Models.

It is a good idea to use larger values for the Block size as processing time for largemodels can
be considerable. Once you have created a blockmodel, you can change its properties to
providemore detail.

You can also evaluate the blockmodel against geological models, interpolants and distance
functions in the project. To do this, click on the Evaluations tab. All objects available in the
project will be displayed. Move themodels you wish to use into the Selected list.

Enter a Name for the blockmodel and clickOK. Themodel will appear under the Block Models
folder. You can make changes to it by double-clicking on it.
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Displaying a Block Model
When a blockmodel is displayed in the scene, there is an Index Filter option for displaying the
grid:

ForNone, no X, Y or Z filter is applied. For Subset, the grid is filtered to show the union of the
selected X, Y and Z ranges. For Sliced, the grid is filtered to show the intersection of the selected
X, Y and Z ranges.

For the Subset and Sliced options, tick the boxes for X, Y and Z. To adjust the range, drag the
white handles left and right. Double-clicking on the slider alternates between displaying a
single value and displaying the full range.

Statistics
You can view statistics for all evaluationsmade on a blockmodel broken down into categories
and organised by numeric evaluations. To view statistics, right-click on a blockmodel in the
project tree and select Statistics.

When you first open thewindow, it will be empty. Click on the Select Numeric Items button to
select from the numeric data columns that have been evaluated on the blockmodel:
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Next, select from theCategory columns available:

You can view statistics for asmany numeric data columns as you wish, but only oneCategory
column can be used.

When you have a Category selected, you can organises information displayed in twoways:
Group by Category orGroup by Numeric. Here, statistics are displayed organised by the
numeric data columns:
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Here data is organised by the category column:

Other controls in thiswindow are as follows:

l The arrow buttons at the top of thewindow ( and ) allow you to quickly expand or
collapse the rows.

l The Select button ( ) selects all rows in the table.

l Select multiple rowsby holding down the Shift or Ctrl keywhile clicking rows.

l TheCopy button ( ) copies the selected rows to the clipboard so you can paste them into
another application.

Block Model Export
There are two options for exporting a blockmodel created in Leapfrog Geo: exporting the
model in one of the supported formats or exporting themodel as points.

In a Supported Format

Blockmodels created in Leapfrog Geo can be exported in the following formats:

l CSV + Text Header (*.csv, *.csv.txt)

l CSVwith Embedded Header (*.csv)

l Isatis BlockModel Files (*.asc)

l Surpac BlockModel Files (*.mdl)

l Datamine BlockModel Files (*.dm)
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All evaluations on the blockmodel will be exported as part of the file.

To export a blockmodel in one of the supported formats, right-click on the blockmodel in the
project tree and select Export. You will be prompted to select the file format. Enter a name and
location for the file and click Save.

In CSV Format

When exporting themodel in CSV format, you will be prompted to choose encoding options.

Null Values for Unevaluated Blocks

When blocks fall outside the boundary of the evaluated model, you can set specific null values.
Select from the options listed forNumeric null value and Category null value or enter a
customvalue.

If none of the evaluations on themodel have data for specific rows, you can exclude those rows
from the exported file by ticking the boxOmit rows where all values are null.

Numeric Precision

There are three options forNumeric Precision:

l TheDouble, floating point option provides precision of 15 to 17 significant decimal places.

l The Single, floating point option provides precision of 6 to 9 significant decimal places.

l TheCustomoption lets you set a specific number of decimal places.

To change either theCentroid and size precision and Column data precision options, untick
theUse default precision box and select the required option.

In Datamine Block Model Format

When exporting themodel in Datamine format, column names for the evaluated objects have a
maximum length of 8 characters. Leapfrog Geowill recommend truncated column names, but
if you wish to use different abbreviations, selectCancel and rename the affected objects before
exporting themodel.

As Points

Blockmodels can also be exported as points in CSV format, which does not include the block
sizes and model description. To do this, right-click on the blockmodel and select Export as
Points. Next, enter a name and location for the file and click Save. You will then be prompted to
select the CSV encoding. These options are described in In CSV Format above.

© 2017 ARANZ Geo Limited



476 | Leapfrog Geo User Manual

Sub-blocked Models
A sub-blocked model is a blockmodel that is subdivided into smaller blockswhere triggering
surfaces intersect the blocks. Sub-blocked models can be rotated in two axes by adjusting the
dip and azimuth. This topic describes creating and exporting sub-blocked models. It is divided
into:

l Creating a Sub-blocked Model

l Model Extents and Rotation

l The Grid Pattern

l Triggers and Evaluations

l Sub-blocked Model Export

l Sub-blocked Model Export

l In a Supported Format

l In CSV Format

l In Datamine Block Model Format

l As Points

Creating a Sub-blocked Model
To create a new sub-blocked model, right-click on the Block Models folder and selectNew
Sub-blocked Model. TheNew Sub-blocked Modelwindowwill appear, together with a set of
controls that will help you set the size, location and orientation of themodel in the scene:

The blockmodel is defined from itsBase point, and the reference centroid is the Base point
plus one half the Block size. Blockmodels cannot have partial blocks, and when changes are
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made to the Block size parameter, themodel’s extentswill be enlarged tomatch the Block
size.

Model Extents and Rotation

It is a good idea to set the sub-blocked model’s extents fromanother object in the project,
selecting the required object from the Enclose Object list.

TheDip and Azimuth set the rotation of themodel. If you know the values you wish to use,
enter them inNew Sub-blocked Modelwindow. You can also:

l Use the controls in the scene to set the orientation. The yellow handle adjusts theDip and the
blue handle adjusts the Azimuth.

l Use either the slicer or themoving plane to set the orientation. To do this, add the slicer or the
moving plane to the scene and adjust the orientation. Then select the object to use from the
Set Angles From list.

If you have set the extents fromanother object and then rotated themodel, you will need to
reset the extents by selecting the object again from the Enclose Object list.

The Grid Pattern

The cross-hatched pattern showshow the parent blockswill be divided up into sub-blocks.
These properties can be changed by adjusting the Parent blocks and Sub-blocks settings. The
Sub-block count is the number of blocks each parent block is divided intowhen it intersects a
trigger. The number of blocks in the Z axis can be:

l A variable value, based on when the parent blocks intersect triggers. Tick the Variable height
box and set aMinimum height, if required.

l A fixed value. Untick the Variable height box and set the Z value required.

Triggers and Evaluations

Click on the Sub-blocking Triggers tab to select triggers from the volumes available in the
project. Triggers can be:

l Geological model volumes

l Interpolant volumes

l Openmeshes

All suitable objects in the project will be displayed in the Available triggers list.

Sub-blocked models can be evaluated against geological models, interpolants and distance
functions in the project. To do this, click on the Evaluations tab. All objects available in the
project will be displayed. Move themodels you wish to use into the Selected list, then select the
Evaluation Type, which can be on the sub-block centroids or on the parent block centroids.

Enter a Name for the sub-blocked model and clickOK. Themodel will appear under the Block
Models folder. You can make changes to it by double-clicking on it.
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Sub-blocked Model Statistics
You can view statistics for all evaluationsmade on a sub-blocked model broken down into
categories and organised by numeric evaluations. To view sumary statistics, right-click on a sub-
blocked model in the project tree and select Statistics.

See Statistics in the Block Models topic formore information.

Sub-blocked Model Export
There are two options for exporting a sub-blocked model created in Leapfrog Geo: exporting
themodel in one of the supported formats or exporting themodel as points.

In a Supported Format

Sub-blocked models created in Leapfrog Geo can be exported in the following formats:

l CSV + Text header (*.csv, *.csv.txt)

l CSVwith embedded header (*.csv)

l Datamine BlockModel (*.dm)

All evaluations on themodel will be exported as part of the file.

To export a sub-blocked model in one of the supported formats, right-click on themodel in the
project tree and select Export. You will be prompted to select the file format. Enter a name and
location for the file and click Save.

In CSV Format

When exporting themodel in CSV format, you will be prompted to choose encoding options.

Null Values for Unevaluated Blocks

When blocks fall outside the boundary of the evaluated model, you can set specific null values.
Select from the options listed forNumeric null value and Category null value or enter a
customvalue.

If none of the evaluations on themodel have data for specific rows, you can exclude those rows
from the exported file by ticking the boxOmit rows where all values are null.

Numeric Precision

There are three options forNumeric Precision:

l TheDouble, floating point option provides precision of 15 to 17 significant decimal places.

l The Single, floating point option provides precision of 6 to 9 significant decimal places.

l TheCustomoption lets you set a specific number of decimal places.

To change either theCentroid and size precision and Column data precision options, untick
theUse default precision box and select the required option.
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In Datamine Block Model Format

When exporting themodel in Datamine format, column names for the evaluated objects have a
maximum length of 8 characters. Leapfrog Geowill recommend truncated column names, but
if you wish to use different abbreviations, selectCancel and rename the affected objects before
exporting themodel.

As Points

Sub-blocked models can also be exported as points in CSV format, which does not include the
block sizes and model description. To do this, right-click on themodel and select Export as
Points. Next, enter a name and location for the file and click Save. You will then be prompted to
select the CSV encoding. These options are described above.
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UBC Grids
Leapfrog Geo importsUBC grids in *.msh format, together with numeric values in properties
files in *.gra, *.sus, *.mag and *.den formats. UBC grids can be evaluated against geological
models and interpolants, which can then be exported with the grid.

Importing a UBC Grid
To import a UBC grid, right-click on the Block Models folder and select Import UBC Model. In
thewindow that appears, clickBrowse to locate the file to be imported. ClickAdd to add any
properties file, although these are not required.

For any properties file, click the Inactive Value field tomark cells as inactive. Doing so does not
change the data but ensures that cellswith the inactive value can be hidden when the grid is
displayed in the scene. If you do not set this valuewhen importing the grid, you can set it later by
double-clicking on the grid in the project tree.

Click Import. The grid will appear in the Block Models folder.

Evaluating UBC Grids
UBC grids can be evaluated against geological models and interpolants as described in
Evaluations. However, UBC grids cannot be evaluated against fault blocks and mutli-
domained RBF interpolants, although they can be evaluated against the parent geological
model and the parent interpolant.

Mapping Category Evaluations
When a UBC grid is exported with a category evaluation, category data ismapped to an editable
numeric value. You can edit this by double-clicking on the grid in the project tree, then clicking
on the Export Mappings tab:
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Change the numeric value assigned to each lithology, if required. You can also change the
value assigned to blocks that have no lithology.

The Export Mappings tab does not appear for UBC grids that have no geological model
evaluations.

Exporting a UBC Grid
To export a UBC grid, right-click on it in the project tree and select Export. Select the
evaluations to export with the grid, then select a folder. ClickOK to export the grid.
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Presentation

Leapfrog Geo has a number of tools for displaying and presenting data for use in reports and
presentations.

l Create and export cross sections, fence sections and serial sections.

l Create and export contours.

l Render and save images for use outside of Leapfrog Geo.

l Save scenes that demonstrate different aspects of themodel and themodel-building
process. These scenes can then be saved as a movie or as a scene file that can be opened in
Leapfrog Viewer.

See Visualising Data for information about the tools available in Leapfrog Geo for changing
how data is displayed.
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Sections
There are three types of sections in Leapfrog Geo:

l A typical cross section is a vertical planewith an image or geologic cross section applied to it.
In Leapfrog Geo, this type of cross section can be created directly in the scene, from the slicer
or froman imported image.

l A fence section deviates. In Leapfrog Geo, a fence section can be created froma polyline
drawn in the scene or fromany line object in the project.

l A serial section is a series of typical cross sections taken at an offset froma single base section.

Evaluating Sections
Sections can be evaluated against different objects in the project, as described in Evaluations.
All sections can be evaluated against:

l Geological models

l Numericmodels

l Distance functions

l Surfaces

l Combined models

Cross sections can also be evaluated against blockmodels, but serial sections and fence
sections cannot.

Objects a section is evaluated on can be included when the section is exported.

Exporting Sections
There are two options available for exporting sections: Export in DXF Format and Export
Section Layouts.

Export in DXF Format
Exporting a section as a DXF file (*.dxf) exports a series of DXF lines created from the intersection
of the evaluation volumes and the section plane. The lines generated fromeach volume are
saved as separate layers in the file.

For serial sections, the section will be exported in a single file with a collection of DXF lines
based on intersections between the selected evaluation and the section planes.

To export a section in DXF format, right-click on it in the project tree and select Export. You will
be prompted to select an evaluation to export with the section. Enter a filename and location,
then click Save.
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Export Section Layouts
Another way to export a section is to create a section layout and then export it as a PDF file
(*.pdf), Scalable Vector Graphics file (*.svg), PNG image (*.png) or GeoTIFF (*.tiff, *.tif). This
option ismore flexible than exporting the section as a DXF file as you havemore control over the
section layout. You can customise the page layout and includemultiple evaluations and
annotations. For typical cross sections and serial sections, you can also display drillholes and
planned drillholes.

For serial sections, you can batch export multiple section layouts.All selected sections can be
exported as a single PDF or individually in PDF file (*.pdf), Scalable Vector Graphics file (*.svg),
PNG image (*.png) or GeoTIFF (*.tiff, *.tif) formats. When section layouts are exported
individually, all outputs can be combined into a zip archive. To do this, right-click on the section
and select Batch Export Layouts.

See Section Layouts formore information.

Creating Cross Sections
To create a cross section in the scene, add a model to the scene. Next, right-click on theCross
Sections and Contours folder and selectNew Cross Section. TheNew Cross Sectionwindow
will appear, together with a section plane and controls in the scene that let you adjust the
position of the section plane:

If the slicer is already in the scenewhen you selectNew Cross Section, the position of the
slicer will be used to define the initial orientation of the section. This is an effective way of
creating a section from the slicer: add themodel to the scene, draw a slice and then create a
cross section.

The front (F) and back (B) of the section plane is indicated in the scene. To swap the front and
back, click the Swap Front button ( ).

Use the handles in the scene to position the section plane. The handleswork in the same
manner as themoving plane controls, as described in The Moving Plane.
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Two buttons in theNew Cross Sectionwindow let you create a cross section that is aligned
north-to-south ( ) or east-to-west ( ):

The other two buttons are active when the slicer is in the scene. Clicking the Set section to
slicer button ( ) creates a cross section from the position of the slicer in the scene. When the
Lock section to slicer button ( ) is enabled, moving the position of the slicer will update the
position of the cross section in theNew Cross Sectionwindow.

Once the section plane is positioned as required, clickOK to create the new cross section, which
will appear in theCross Sections and Contours folder. Display it by clearing the scene, then
adding the cross section to the scene.

Cross sections can be evaluated against geological models, interpolants, distance functions
and surfaces in the project, as described in Evaluations. Objects a cross section or fence section
is evaluated on can be included when the section is exported.

Importing Cross Sections
To import an image and use it to create a new cross section, right-click on theCross Sections
and Contours folder and selectNew Cross Section From Image. Leapfrog Geo supports the
following file formats for creating cross sections:

l PNG files (*.png)

l JPEG files (*.jpg, *.jpeg)

l TIFF and GeoTIFF files (*.tiff, *.tif)

l WindowsBitmap files (*.bmp)

l Graphics Interchange Format files (*.gif)

Select an image, then clickOpen. The Import Section Imagewindowwill be displayed.

Cropping the image to only the area of interest will reduce video RAM usage and may improve
graphics performance. To crop the image, click on theCrop Image button ( ) at the top of the
window, then drag around the part of the image you wish to use. Click on theRemove Crop
button ( ) to clear the cropping.

If the image is georeferenced and you are satisfied that this information is correct, click Import.
The new cross section will be created and added to theCross Sections and Contours folder.

If the image does not contain georeferencing information, you will need to add it manually by
adding referencemarkers and then entering coordinates. First, tick the box for any Section
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Type options as these constrain themarkers that need to be set. For example, selecting East
facing sectionmeans you will only need to enter the East (X) coordinates once.

To add coordinates to the image, click on a marker and move it to the required location. Then
enter the coordinates for themarker:

The Image (X) and Image (Y) fields give you fine control over the location of themarker on the
image.

If the image is georeferenced and you wish to discard the information, tick theOverride
georeference data from image box and edit themarkers.

Once the coordinates for each marker have been set, click Import. The new cross section will
be created and added to theCross Sections and Contours folder. Display it by dragging it into
the scene or by right-clicking on the cross section and selecting View Object.

Once you have georeferenced an image, you can export it as a GeoTIFF. To do this, right-
click on it in the project tree and select Export. You will be prompted for a filename and
location. Click Save.

Once you have created a cross section, you can edit it or use it to evaluate geological models,
interpolants, distance functions and surfaces. See Evaluations.
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Fence Sections
You can draw a polyline or use any existing line object in the project to create a cross section
that deviates. To do this, right-click on theCross Sections and Contours folder and selectNew
Fence Section. TheNew Fence Sectionwindowwill be displayed:

You can draw the polyline in the scene directly by selecting theNew Polyline option. You can
also use any polyline in the project by selecting the Existing Polyline option.

OnlyGIS lines, polylines imported into Leapfrog Geo or polylines created using the straight
line drawing tool can be used to create fence sections.

ClickOK to create the fence section. If you chose to create a New Polyline, the drawing
controlswill appear in the scene and you can begin drawing, as described in Drawing in the
Scene.

The fence section will appear under theCross Sections and Contours folder and you can edit
it by double-clicking on it. You can also use it to evaluate geological models, interpolants,
distance functions and surfaces, as described in Evaluations.

If you create a section layout for a fence section, you can includemultiple evaluations and
annotations on the section layout, but you cannot include drillholes and planned drillholes.
See Section Layouts.

Serial Sections
This topic describes the process of creating a serial section, which is a series of cross sections
taken at an offset froma single base section. The topic is divided into:

l Setting the Base Section

l Setting the Offset Sections

l The Serial Section in the Project Tree

l Displaying a Serial Section

l Exporting a Serial Section
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To create a serial section, add a model to the scene. Next, right-click on theCross Sections and
Contours folder and selectNew Serial Section. TheNew Serial Sectionwindowwill appear
and planes representing the base section and the offset sectionswill be added to the scene:

If the slicer is already in the scenewhen you selectNew Serial Section, the position of the
slicer will be used to define the initial orientation of the base section.

Setting the Base Section
The handles in the scene control the position of the base section and work in the samemanner
as themoving plane controls (see The Moving Plane).

The front (F) and back (B) of the base section plane are indicated in the scene. To swap the front
and back, click the Swap Front button ( ).
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Two buttons in theNew Serial Sectionwindow let you create a base section that is aligned
north-to-south ( ) or east-to-west ( ). The other two buttons are active when the slicer is in
the scene. Clicking the Set section to slicer button ( ) creates a cross section from the position
of the slicer in the scene. When the Lock section to slicer button ( ) is enabled, moving the
position of the slicer will update the position of the cross section in theNew Serial Section
window.

Setting the Offset Sections
The number of offset sections is determined by the value of the Spacing setting and the Front
and Back Extents:

You can change the number of offset sections by:

l Changing the Spacing setting. The number of offset sectionswill be recalculated and
updated in the scene.

l Changing the Front orBack settings. For example, increasing the Front setting adds an offset
section on the front of the base section, increasing the extents by the value of Spacing.

l Changing the object used to define the extents. Select an object from the Enclose Object list.
The base section will bemoved to the centre of the selected object.
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The Serial Section in the Project Tree
ClickOK to create the section. In the project tree, the serial section includes the individual cross
sections:

The serial section can be evaluated against geological models, interpolants, distance functions
and surfaces in the project, as described in Evaluations.

Displaying a Serial Section
When you display a serial section in the scene, you can add the slicer to the scene and use it to
move easily between the sections in the stack. To do this, click on the slicer in the shape list, then
select the base section from the Set to list:

Next, set the Step size to the Spacing setting used to create the section. You can then use the <
and > keys to view each individual cross section.

Exporting a Serial Section
The options for exporting serial sections differ for the section itself and the offset sections:

l A serial section cannot be used to create a section layout. When exported as a DXF file, the
serial section will be exported in a single file with a collection of DXF lines based on
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intersections between the selected evaluation and the section planes.

l The offset sections that make up a serial section can be exported in DXF format or as a section
layout. See Exporting Sections and Section Layouts formore information.
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Section Layouts
With the Section Layout Editor, you can create a section layout for an existing section and then
export the section. You can customise the section layout by:

l Adding models and surfaces the section has been evaluated against

l Adding drillholes and planned drillholes

l Changing the page size, orientation and margins

l Adding titles, a scale bar, legends, annotations and images, such as a standard formor logo

The appearance of all objects can be customised without changing how objects from the
project tree are displayed in the scene.

This topic describes how toworkwith section layouts. It is divided into:

l Creating New Section Layouts

l The Section Layout Editor

l Object Names and Colours

l Styling Layout Objects

l Setting Up the Page

l Organising the Section

l Adding and Styling Models

l Adding and Styling Drillholes and Planned Drillholes

l Adding and Styling Surfaces

l Organising the Legend Group

l Adding and Organising Annotations

l Displaying Section Layouts

l Exporting Section Layouts

l Batch Exporting Section Layouts

l Copying Section Layouts

© 2017 ARANZ Geo Limited



493 | Leapfrog Geo User Manual

Once you have created a section but before you start creating the section layout, take the
following steps.

1. Check the section’s extents and orientation.

The initial dimensions of the section on the page are determined by the size of the section plane,
and its orientation on the page is determined by the front (F) and back (B) faces of the section
plane. Here, the front and back faces of the section have been swapped, which results in the
section displayed on the page being flipped:

2. Check that the section has been evaluated against objects you wish to display on the page.

To do this, right-click on the section in the project tree and select Evaluations or Evaluate
Surface.

3. Add planned drillholes to the project.

Planned drillholes can be displayed on the section, but thesemust be defined before you start
the process of laying out the section.
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Creating New Section Layouts
To create a new section layout, right-click on an existing section in the project tree and select
New Section Layout. TheNew Section Layoutwindowwill appear, together with the Section
Layout Editor:

The settings in theNew Section Layoutwindow determine the basic section layout. Each
setting is described below. All settings in theNew Section Layoutwindow can be changed
once the layout has been created.

Changing how objects are displayed on the section page does not change those objects in
the project.

As you add objects to the section, the preview in the Section Layout Editorwindowwill be
updated.

ClickOK to close theNew Section Layoutwindow. You can then make further changes to the
page layout in the Section Layout Editor. See The Section Layout Editor.

Scale

The Scale settings determine the scale used to display the section on the page. As you change
the scale settings, the layout of the section on the pagewill be updated in the preview. If you
want a specific page size, select Fit to Page to set a scale that best fits the pagewidth. You will
be able to change the pagemargins once you have closed theNew Section Layoutwindow.
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Page Properties

The Page Properties settings determine the page size and orientation. If you wish to use a
specific Scale, select theOrientation required, then click Fit to Section to choose the best
page size.

Evaluations

For Evaluations, select from themodels and surfaces the section has been evaluated against.
When you select a model or surface, it will be added to the preview. Note that when you add a
model to the page, a legend for themodel is also added.

If you wish to use the extents froma model evaluation, select only that model and then select
the Section Extents option below. Once you have closed thiswindow, you will be able to add
furthermodels using the section layout editor.

Extents

For Extents, choosewhether to use the Section Extents or Evaluation Extents.

The Section Layout Editor
In Section Layout Editor, the Layout Tree shows the different layers that can be added to the
page. The different parts of the Layout Tree as they relate to the page preview are shown
below:
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Formore information about working with the different parts of the section layout, see:

l Setting Up the Page

l Organising the Section

l Organising the Legend Group

l Adding and Organising Annotations

Click on an object in the page preview tomove or resize it. Thiswill also select the object in the
Layout Tree and you can seewhat properties can be changed. For example, in the preview,
click on the Title to view its styling options:
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The Section object controls all themodels and surfaces displayed on the section:

Models and surfaces selected in theNew Section Layoutwindow are automatically added to
the page preview. Further objects can be added by right-clicking onModels, Drillholes or
Surfaces. Whenmodels are surfaces are added to the layout, entries are automaticallymade in
the Legend Group.

Object Names and Colours

The names and colours of objects in the layout are linked to their parent objects in the project
tree. You can override themby selecting the object in the Layout Tree, then ticking the Edit
box:
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If Edit is disabled for an object’s text or colour and changes aremade to the parent object while
the Section Layout Editorwindow is open, the changeswill not be reflected in the section
layout until it is next opened.

If Edit is enabled for an object’s text or colour, then that propertywill not changewhen the
parent object’s colour or title are changed.

Styling Layout Objects

All layout objects are styled by clicking on them in the Layout Tree, then adjusting their
appearance in the properties panel.

Text displayed in the section layout is controlled by a style sheet that can be accessed whenever
you are editing a text object. For example, clicking on Edit Styles for the Title opens the list of
Text Styleswith the Title selected, but also allows you to change the appearance of styles used
for other text objects visible in the preview:
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Line, border and swatch properties are also changed in the properties panel. Swatches for
output volumes can be displayed using a hatched fill, which is enabled by clicking on the
output volume in the project tree, then changing its properties:
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The styling of objects in the Layout Tree controls how they appear in their associated
legend. The Legend Group object controls the position and size of the legend, but not the
colour, line style and fill used to display each object. For example, the appearance of the
volume <0.5 in the interpolant is controlled from theModels object (left). Whether or not the
legend is visible on the page and how it is displayed is controlled from the Legend Group
object (right):

When a model or other object is added to the section, a legend for that object is added to the
Legend Group.

Some objects, such asmodels, drillholes and surfaces, occupy the same space on the page.
These objects can be organised into layers, and opacity settings changed to emphasise relevant
information. To change the order of objects on the page, right-click on themand select how
you wish to organise the layers:
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To change the opacity of an object, click on it, then adjust the object’sOpacity using the slider:

Setting Up the Page

Page Properties are set in theNew Section Layoutwindow, but these can be changed in the
Layout Tree. Click on the Page object to change the Page Size,Orientation andMargins:

If you wish to use a specific Scale, select theOrientation required, then click Fit to Section to
choose the best page size.

Organising the Section

The Section object controls the appearance of the section and the objects in the project that
are displayed on the section. The properties for the Section object itself control the size of the
section on the page and how the axes are displayed. Any changesmade in these tabs are
displayed in the preview so you can experiment with these settings.

l The Section tab includes the Scale settings from theNew Section Layoutwindow.

l The Extents tab includes the settings from theNew Section Layoutwindow and additional
options for displaying Additional sky and end point labels.
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l The settings in the X-Axis and Y-Axis tabs determine how the axes are displayed. By default,
the axes are displayed only on the lefthand side and along the bottomof the section. To
display axes along the righthand side and above the section, tick the Secondary option.

The other objects that are part of the Section object are used to add models and surfaces that
are displayed on the section and to customise how they are displayed. For cross sections and
serial sections, you can also add drillholes and planned drillholes.

Changing how objects are displayed on the section layout does not change those objects in
the project.

Adding and Styling Models

If you selected models and surfaces in theNew Section Layoutwindow, these are
automatically added to theModels and Surfaces objects in the Layout Tree. To add more
models, right-click on theModels object and select Add Model. Themodels the section has
been evaluated on will be listed. Select those required and clickOK. The newmodelswill be
added to theModels object and legend items added to the Legend Group.

Sections can be evaluated against different objects in the project, as described in
Evaluations. All sections can be evaluated against:

l Geological models

l Numericmodels

l Distance functions

l Surfaces

l Combined models

Cross sections can also be evaluated against blockmodels, but serial sections and fence
sections cannot.

If you selected a geological model with a fault system, the faultswill automatically be added to
the section and to the Legend Group. Change a fault system’s properties by expanding the
geological model in the Layout Tree and clicking on the Fault System and its faults.

When you displaymultiplemodels on the section:

l Use theOpacity setting for each model to expose and emphasise information.

l Right-click on themodels tomove themup or down in the layer hierarchy.

l Expand each model in the Layout Tree to change the Fill andHatch for each output volume
tomake some volumesmore apparent.

l Hide some of theOutput Volumes.
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A single line style is used to display a model’s output volumes. There is, however, a Highlight
option that can be enabled tomake a volume of interest stand out from the other volumes:

TheOpacity setting for each output volume in a model is inherited from themodel as a
whole. You cannot change theOpacity on a volume-by-volume basis; however, you can
hide individual volumes.

For geological modelswith a fault system, the fault systemdoes not inherit itsOpacity
setting from the parent model.
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Blockmodels and flowmodels evaluated on the section can be displayed using a flat colour or
any of theColouring options available for themodel:

ClickOptions to change the colours used to display themodel:

l For category evaluations, you can changewhat categories are visible and the colours used to
display them.

l For numeric evaluations, you can filter values and use a different colourmap.

If a blockmodel or flowmodel is too big for the section layout, changing the section extents
or the section layout extentswill effectively “crop” themodel and make it small enough to
display on the section layout. There are twoways to do this:

l Change the section layout extents by clicking on Section in the Layout Tree, then clicking
on the Extents tab. If Extents is set to Evaluation Extents, change it to Section Extents.

l Change the size of the section by double-clicking on it in the project tree and then editing
its dimensions in the scene.

Adding and Styling Drillholes and Planned Drillholes

Drillholes and planned drillholes can be added to section layout for cross sections and serial
sections, but not for fence sections.

Drillholes and planned drillholes can be added to the cross section. Up to three columnsof
data can be displayed, and numeric data can be displayed as a graph.

To add drillholes to the section, right-click on theDrillholes object and select eitherAdd
Drillholes orAdd Planned Drillholes.

For adding drillholes, you will be prompted to select the interval table to display.
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For both drillholes and planned drillholes, you can filter the drillholes based on a minimum
distance from the section plane:

This is theminimumdistance to any point on each drillhole trace.

If you tick theClip geometry to filter distance option, only parts of the drillhole within the
filter distancewill be included in the section layout. Select the required drillholes and clickOK.

How drillholes are displayed is controlled by theColourings settings in the Lines tab:

© 2017 ARANZ Geo Limited



Adding and Styling Drillholes and Planned Drillholes | 506

Click theOptions button for a column to filter values or display data on the drillholes:

For columnsof numeric data, you can display data as a bar graph or line graph. These options
are available in theDisplay style tab. Here, data is displayed as a bar graph:

© 2017 ARANZ Geo Limited



507 | Leapfrog Geo User Manual

Select aMax length that means that displayed data does not interfere with other drillholes or
data displayed on the section layout. This is especially useful when two graphs are displayed:

If you onlywant to plot a limited range of data, tick the Axis limit box and set the required
range.

Displaying data with the logarithmic scale enabled may enhance differences in the values, and
negative values can be scaled.

The bar and line graph options are not available for the centre of the drillhole, although the
solid option can be used.

Adding and Styling Surfaces

To add a surface to the section, right-click on the Surfaces object and select Add Surface. The
surfaces the section has been evaluated on will be listed. Select those required and clickOK.

The options for styling surfaces are the same as for lines. A surface can be displayed in the
legend, if required.
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Organising the Legend Group

The Legend Group controls how the legend is displayed on the page.

When you add a model, surface or drillhole object to the section, a legend for that object will be
added to the Legend Group. For example, here, legends have been added for an interpolant,
the surfaces and drillhole data objects:

Note that:

l The Surfaces that appear on the section have been added to a single legend.

l Because the drillholes displayed on the section use Left and Right Colourings, a legend has
been added for each, a lithology legend and a numeric data legend.
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Changing the Legend Group Layout

Select the Legend Group itself to change its layout. These settings apply to the Legend Group
as a whole. Columns can be laid out vertically or horizontally:

You can also change the swatch size and gradient and add a Boundary box.

For each individual legend, you can change the number of Rows used to display the values

The order in which legends appear in the Legend Group is the order in which they appear in the
Layout Tree. To change the order in which the legends appear, right-click on themand select
aMove option.
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Use the Legend GroupLayout > Columns setting and theRows setting for each individual
legend tomake the best use of the space available on the page.

Styling Legend Swatches

The colours, line widths, fills and hatches displayed in the Legend Group are controlled by the
objects themselves. For example, to change how the < 0.5 shell is displayed for the interpolant,
click on the output volume, under theModels object:
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Making Legends Visible and Invisible

If you do not wish to include a legend in the Legend Group, click on it in the Legend Group and
untickVisible:

This does not changewhether or not the object itself is visible, it simply excludes it from the
Legend Group.

Adding and Organising Annotations

Once you have laid out themain Section object and organised the Legend Group, you can add
a number of different types of annotation to the layout.

Title

The Title object formats the title displayed on the page. Tomove the title, click on it in the
layout preview. The text used for the Title is the name for the section in the project tree, but this
can be changed in the properties panel.
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Title Block

The Title Block object adds a title block based on ISO 7200:

To display the Title Block on the section, select it in the Layout Tree, then tick the Visible box.

Scale Bar

The Scale Bar object controls the size and format of the scale bar. Its position is controlled by
moving it in the preview.

Location

The Location object controls how location information is displayed.
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Text Boxes

With the Text Boxes object, you can add text boxes and arrows to highlight information and
details on the section:

Arrows are connected to text boxes, and so initially only text boxes can be added. Right-click on
a text box to add an arrow to it. When the Automatic anchoring option is enabled for an arrow,
the arrow’s anchorwill movewhen its associated text box ismoved. If this option is disabled, the
arrow will movewhen you move the text box, but you will have to place its anchormanually.

Images

If you wish to import an image such as a logo ormap, right-click on the Images object and
select Add Image. Navigate to the folder that contains the image file and select the file. Click
Open to import the file, which will automatically be added to the section layout.
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Displaying Section Layouts
You can display section layouts in the scene. Dragging a layout into the scene displays the
layout evaluated on the section:

Some sectionswill be too large to display in the scene, which will be indicated in the section
layout editor.

Displaying section layouts in the scene is useful when you are editing a section layout and wish
to see the effect of changes. Detach the section layout tab from themain window and position
it adjacent to the scenewindow. Periodically save your changes to the section layout to see the
effects of those changes in the scene.

Exporting Section Layouts
Once you have finished adjusting the section layout, you can export it in one of the following
formats:

l PDF Files (*.pdf)

l Scalable Vector Graphics Files (*.svg)

l PNG Image Files (*.png)

l GeoTIFF Files (*.tiff, *.tif)

Click the Save and Export button ( ) at the top of thewindow. You will be prompted for a
filename and location.

Batch Exporting Section Layouts
When working with a serial section, you can batch export multiple section layouts for that
section. The section layouts can be exported as a single PDF or individually in the formats
shown in Exporting Section Layouts above.
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To export multiple layouts, right-click on a section and select Batch Export Layouts. In the
window that appears, selection the layouts you wish to export, then select a format. If you
select a format other than Single PDF, you can combine all outputs into a zip archive. Select
where you wish to save the outputs, then click Export. Progresswill be displayed at the top of
the Batch Export Section Layoutswindow:

Copying Section Layouts
If you have already created a section layout and wish to reuse it, you can copy it to other
sections.

How section layouts are copied was changed in Leapfrog Geo 4.1. In previous versions of
Leapfrog Geo, layoutswere copied by selecting a section and then choosing from the
layouts available in the project.

Copying a section layout copies the evaluations used in the original section layout, together
with the page size and orientation and the position of the Layout Tree objects on the page.
Howmodels, surfaces and drillholes are copied dependson the section towhich the layout is
being copied:

l All models and surfaces that can be displayed on the section will be copied.

l The drillholes copied to the layout will depend on whether or not a filter is set for the layout:
o If no distance filter was set for the original layout, all drillholes selected for the original

layout will be copied.

o If a distance filter was applied to the original section, the filter will be applied and drillholes
selected that are within that distance of the section towhich the layout is being copied.

To copy a layout, right-click on the layout you wish to copy and selectCopy Layout To. In the
window that appears, a summary of the information that will be copied is displayed so you can
seewhat information will be copied to the selected sections. Move the sections you wish to
copy the layout to into the Selected Sections list, then clickOK. A copy of the layout will appear
in the project tree under each section you selected. The layout copies are not linked to the
original layout and sowill not be updated when the original is updated.

Copying section layouts tomultiple sections can result in numerous section layouts in a
project, which can be difficult to workwith. The recommended workflow for creating a
section layout that you intend tomakemultiple copies of is to first get the layout right on one
section before copying it to other sections.
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Rendered Images
Leapfrog Geo can render high-quality images that you can save on your computer in a format
that can be used in presentations and documents.

To save a rendered image, click on the Leapfrog Geomenu and select Render Image. Leapfrog
Geo renders an image from the current scenewindow, then displays it in theRender Image
window:

Use the zoom tools to view the rendered image. You can change the image settings by:

l Selecting a new image size. To constrain the image’s proportionswhen changing size, tick the
Keep aspect box.

l Changing supersampling options to smooth jagged edges. Select the required option from
the list. The highest sampling option (4x4) will take longer to process than the lowest
sampling option or turning supersampling off.

l Viewing the imagewith or without overlays. SeeOverlay Settings formore information
about further customising the overlays displayed in the scene.

ClickRender to render a new imagewith the updated settings. Once you are satisfied with the
rendered image, click Save. You will be prompted to enter a filename and location.

Background Rendering
You can keep theRender Image tab open while continuing towork in your project, which is
useful for rendering a series of images. Towork in thisway, dock theRender Image tab adjacent
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to the scenewindow. When you have set up your scene, right-click on theRender Image tab
and choose one of the options:

TheRender and Copy Image option will render a new image from the scene and copy it to the
clipboard.

TheRender and Save Image option will render a new image and prompt you for a filename
and location.
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Saved Scenes
A saved scene is a way of storing the shape list and settings so that the scene can be retrieved
later. Saved scenes are the basis of scene files exported to Leapfrog Viewer and Leapfrog
Aspect. Saved scenes are also used in creating movies, which is described in theMovies topic.

This topic describes:

l Saving Scenes

l Exporting Scenes

l Exporting Scenes for Leapfrog Aspect

l Linking to Scene Files

A saved scene is, in effect, a bookmark of a specific view of the project data. A saved scene does
not maintain an independent copy of the data in the project, and so if the data changes, then
the appearance of the scenewill also change.

When a scene is saved, comments can be entered documenting what is in the scene. Saved
scenes provide a stable point of reference in a project and can explain important aspects of the
project, which is especially useful for explaining aspects of a model to others using the project
or viewing scene files.

Saving Scenes
To save the current scene, right-click on the Saved Scenes and Movies folder and select Save
Current Scene. The Save Scenewindowwill be displayed:

Enter a name and description for the scene and clickOK. The scenewill be saved and added to
the Saved Scenes and Movies folder.

When you save a scene, the properties settings in the shape list are saved for the objects
displayed in the scene. For example, if a lithology table is displayed with the legend in the
scene, the legend will be displayed when the scene is restored. However, saved scenes do
not store copies of the objects in the project tree, and objects deleted from the project tree
are no longer available in saved scenes.

To edit a scene, double-click on it. The Edit Saved Scenewindowwill be displayed and you can
update the information.
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To display a scene, drag it into the scene.

Exporting Scenes
Once you have a series of saved scenes, you can use them to create a scene file that can be
opened in Leapfrog Viewer or Leapfrog Aspect. See Exporting Scenes for Leapfrog Aspect for
points to consider when creating scene files that will be opened in Leapfrog Aspect.

To export a scene, right-click on the Saved Scenes and Movies folder and select Export
Scenes. The Export Sceneswindowwill be displayed:

Move the scenes you wish to export to the Selected scenes list and reorder them, if required.

If you tick the Export hidden shapes box, objects in the shape list that are not visible in the
scenewindowwill be included in the exported scene.

You can also export the data associated with the objects in the scenewindow, if required. To do
so, select the Export all data that appears when I click option. If viewing the data is not
required, or if you wish to keep sensitive data secure, select the Export shapes only option.

When the Export all data that appears when I click option is selected, all data represented
by shapes in the exported scenewill be accessible when the scene is opened in Leapfrog
Viewer.

When you have the scenes arranged, click Export. You will be prompted for a filename and
location.

Exported scenes cannot be reimported to the project.
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Exporting Scenes for Leapfrog Aspect
When exporting scenes for use in Leapfrog Aspect, keep in mind the following:

l When viewing 3D data on a 2D screen, objectsmay appear closer or further from the viewer
than expected. For this reason, it is a good idea to include a current topographic surface in
the dataset to aid in orienting the view relative to the camera feed.

l Although newer Android devices have a significant amount of processing power, they are not
as graphically capable as a typical desktop computer. Try to limit the amount of data to be
displayed as there are likely to be issues if a scene contains 10,000 drillholes or a million
points.

l Sceneswith complexwireframeswill load more slowly than simple wireframes. It is a good
idea tomake a simplified copy of a wireframe in Leapfrog Geo and use that wireframe to
create a scene.

l Both Export all data that appears when I click and Export shapes only optionswill work
for Leapfrog Aspect. If you wish to display collar IDs, use the Export all data that appears
when I click option, but keep in mind that displaying hole IDs can be slow and choppy.

Linking to Scene Files
Links to scene files can be included in HTML files using the following format:

<a href="LeapfrogViewer:[path or URL]">link text</a>

Linked scene fileswill be opened directly in Leapfrog Viewer only frombrowsers that support
customURI schemes.
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Movies
Once you have a series of saved scenes (see Saved Scenes), you can use them to create a
storyboard and export a movie.

To create a newmovie, right-click on the Saved Scenes and Movies folder and selectNew
Movie. A tab will open in which you can create a storyboard and edit how each scene and
transition is displayed. You can detach the tab from themain window and create scenes in the
main windowwhile working on scenes in themovie tab. Click theRefresh Scenes button to
refresh the scenes in themovie tab when you havemade changes.

Select the saved scenes you wish to add to themovie by clicking on them in the list, then click
the Add To Storyboard button ( ). When subsequent scenes are added, transitionswill be
added to separate the scenes:

Change properties for the selected scene or transition, then click the play button ( ) to preview
the settings. To preview thewholemovie, click the Select Whole Movie button ( ), then click
play.

You can make changes to the included sceneswithout having to close and reopen themovie
window. Simply update the scenes, then, in themovie editor, click theRefresh Scenes
button.

Enter a name and description for themovie and click the Save button ( ). Themovie will be
saved in the Saved Scenes and Movies folder.
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To export themovie, click the Save and Export button ( ). The Export Moviewindowwill
appear:

If you tick Export frame images, individual frameswill be saved as images, together with the
movie file. Click Export. You will be prompted to select a filename and location. Click Save to
export themovie. Leapfrog Geowill then save themovie in the specified location, which may
take some time.
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Contour Lines
You can create contour lines from surfaces in the project and export those contour lines to GIS
packages.

Creating Contour Lines
To create contour lines froma surface, right-click on theCross Sections and Contours folder
and selectNew Contour Lines From Surface. In theNew Contourswindow, select the surface
to contour from the list. Adjust theContour Spacing, if required.

If you want to offset the contours by a vector, enter a Contour offset value.

ClickOK to generate the contours.

The new contourswill appear in the project tree under theCross Sections and Contours
folder.

You can edit the contours by double-clicking on them.

Exporting GIS Contours
To export a contour lines object, right-click on the contour lines in theCross Sections and
Contours folder and select Export. Select whether or not to export the contours in 2.5D format,
then click Export. You will be prompted for a filename and location.
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